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Preface

Preface

Audience

Oracle APEX App Builder User’s Guide describes how to use the Oracle APEX
development environment to build and deploy database-centric web applications.
Oracle APEX turns a single Oracle database into a shared service by enabling multiple
workgroups to build and access applications as if they were running in separate
databases.

* Audience

e Documentation Accessibility
e Diversity and Inclusion

* Related Documents

e Conventions

Oracle APEX App Builder User’s Guide is intended for application developers who are
building database-centric web applications using Oracle APEX. The guide describes
how to use the Oracle APEX development environment to build, debug, manage, and
deploy applications.

To use this guide, you must have a general understanding of relational database
concepts and an understanding of the operating system environment under which you
run Oracle APEX.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
if you are hearing impaired.

Diversity and Inclusion

ORACLE

Oracle is fully committed to diversity and inclusion. Oracle respects and values having
a diverse workforce that increases thought leadership and innovation. As part of our
initiative to build a more inclusive culture that positively impacts our employees,
customers, and partners, we are working to remove insensitive terms from our
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products and documentation. We are also mindful of the necessity to maintain compatibility
with our customers' existing technologies and the need to ensure continuity of service as
Oracle's offerings and industry standards evolve. Because of these technical constraints, our
effort to remove insensitive terms is ongoing and will take time and external cooperation.

Related Documents

For more information, see these Oracle resources:

* Oracle APEX Release Notes

* Oracle APEX Installation Guide

* Oracle APEX End User’s Guide

»  Oracle APEX Administration Guide

e Oracle APEX SQL Workshop Guide

* Oracle APEX API Reference

*  Oracle Database Concepts

*  Oracle Database Administrator’s Guide

e Oracle Database SQL Language Reference

e SOQL*Plus User's Guide and Reference

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLSs, code in
examples, text that appears on the screen, or text that you enter.
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Changes in Release 22.2 for Oracle APEX
App Builder User’s Guide

ORACLE

All content in Oracle APEX App Builder User’s Guide has been updated to reflect release
22.2 functionality and user interface changes.

New Features and Updates

The following are features and updates in Oracle APEX:

e Application Search

Add declarative searches to an application by creating a search configuration and then a
search page that displays the search results. Features include:

Create multiple search configurations containing meta data about a searchable data
source (such as tables or views, columns, search type and features, result list
columns, and so on).

Create search configurations usign an existing Oracle TEXT index, enabling
developers can use this functionality and provide linguistic and fuzzy search
capabilities.

Create a new Search Page automatically using the Create Page Wizard or by adding
search component manually. A Search page features a search field (or page item)
which enables users to submit search terms and a Search Results region. The
Search Results region contains Search Sources which map to search configurations.

When a user types a search term at runtime search search configuration executes
and returns the relevant results.

Includes options for pagination, search-as-you-type, custom layout, page size limit,
show results count, lazy loading, sorting, and custom messages for No Query
Entered and No Results Found..

See Adding Search to an Application.

e Invoke API Process Type

Invoke APl is a new page-level process type enables the execution of procedures and
functions completely declaratively, without having to write PL/SQL code.

See About Page Processes and Creating Page Processes.

e Dynamic Content Region

Dynamic Content is new region type that very similar to the legacy PL/SQL Dynamic
Content region type, with some key differences:

The region source must return the HTML value as a CLOB. The value is no longer
output via the HTP package.

Dynamic Content regions are refreshable and support lazy loading.
The region supports PL/SQL and JavaScript (MLE).

See Managing Regions and Supported Region Types.
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Approvals Component Enhancements

The approvals component now includes a Request and Submit Information
process for the task owner and task initiator to provide more information about a
specific task during the approval process. Business administrators can now update
due dates for tasks or renew expired tasks. When configuring the approvals
component, developers can:

— Copy an existing task definition

— Customize the type of actions logged in the task history

— Set due dates dynamically using a SQL Query, Expression, or Function Body
— Set tasks to automatically renew or expire after the due date
See Managing Approvals.

Page Item Session State Data Type - CLOB

The data type CLOB is now available for the following item types:
— Display Only

— Hidden

— Markdown Editor

— Rich Text Editor

— TextArea

In Page Designer, these items have a new attribute group Session State, the Data
Type select list is now populated with VARCHAR?2 (default) and CLOB.

See Available Item Types.
Date Picker

New Date Picker web component (a-date-picker) replaces for the Oracle JET
implementation, supporting the existing functionality of the JET implementation,
plus a few improvements.

— Today button of the desupported jQuery Date Picker is available again. You
can toggle the button on or off via Component Settings or in the Item
Attributes.

— Use HTML attributes to change the behavior of the date picker on the client
side without needing to use JavaScript calls. This change improves loading
performance and operation speed.

— Supports full keyboard operation, recommended by ARIA APG
See Available Item Types.
Support for Template Directives in Classic and Interactive Reports

This release includes template directives in classic reports and interactive reports
for columns that have an HTML expression..

See Using Template Directives.
Vector-Based Map Support

APEX now supports Vector-Based Map Tiles in the map region. There are three
layers available: OpenStreetMap Positron, OpenStreetMap Dark, and
OpenStreetMap Bright. New applications use Vector Layers by default. Existing
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applications continue to use Raster Layers, but you can change them to use Vector
Layers by editing Shared Components, Component Settings, Map.

See Creating Maps and Configuring Vector Tile Layers for Maps.
PWA and Mobile Enhancements:

— You can now include screenshots when prompting users to install the Progressive
Web App.

— Shortcuts can be added to PWA for better navigation in an installed application only
certain devices.

See Creating a Progressive Web App (PWA).
Naming Actions of Dynamic Actions Enhancements:
New attributes available in Page Designer when creating or editing dynamic actions:

— Identification, Name - You can now specify a dynamic actions Name for better self-
documentation in Page Designer.

— Execution, Type - Debounce an action with a delay to execute it once after a
specified time delay from the last time an event fires. Throttle an action immediately
to execute it immediately and then in timed intervals if the event continues to fire.

You can now specify a dynamic actions Name for better self-documentation in Page
Designer.

See Creating a Dynamic Action.
Drawer Modal Dialog Template

There is a new Drawer template available for Modal Dialog pages. The Drawer template
is an overlay window that slides out from the viewport.

See Creating Dialog Pages.

Deprecated and Desupported Features

See Deprecated Features and Desupported Features in Oracle APEX Release Notes.
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Quick Start

"Quick Start" offers a quick introduction to Oracle APEX. This section explains how to access
your development environment, describes the Workspace home page, the App Builder home
page, and the Application home page, explains how to edit your account profile and user
preferences, and how to access product documentation.

Tip:

If you are accessing an on-premises installation, complete the installation process
before continuing. See Oracle APEX Installation Guide.

e About Accessing Your Development Environment
How you sign in and access Oracle APEX depends upon your user role and where APEX
resides.

e Understanding Oracle APEX
Oracle APEX provides you with all the tools you need to build apps in a single, extensible
platform, which runs as a part of Oracle Database.

e Understanding the Workspace Home Page
When you sign in to Oracle APEX, the Workspace home page appears.

« Developer Navigation Tools
Developer Navigation tools display in the header region on many Oracle APEX pages,
including the Workspace home page, App Builder home page, the Application home
page, Page Designer, and Shared Components.

e Understanding App Builder
Developers use App Builder to create and manage applications and application pages.

e Changing Your Profile or Password
Edit your account profile to update your profile (email address, first or last name), upload
a profile photo, or change your password.

e Editing User Preferences and Enabling Dark Mode
Click the Account menu to enable or disable Dark Mode or edit user preferences.

e Using Oracle APEX Documentation
Oracle APEX provides a hosted online documentation library and field-level Help. You
can browse or search content or download the entire library by going to the APEX
Documentation page in the Oracle Help Center.

e Using the App Gallery
Use the App Gallery to install Sample Apps, Starter Apps, and Custom Apps.

2.1 About Accessing Your Development Environment

ORACLE

How you sign in and access Oracle APEX depends upon your user role and where APEX
resides.
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Oracle APEX may reside in a local on-premises Oracle Database or in a hosted
environment, such as a Oracle Cloud service. The sign in process differs depending
upon the installation type.

Oracle APEX On-premises

If you are running APEX on-premises, sign in to your APEX as described in Signing In
to Your Workspace in Oracle APEX Installation Guide

About Accessing Oracle APEX in Oracle Cloud
In Oracle Cloud, APEX is installed and enabled in:

* Oracle APEX Application Development (APEX Service)
« Autonomous Database for Transaction Processing and Mixed Workloads
*  Autonomous Database for Analytics and Data Warehousing

APEX is available in Exadata Cloud Service and Database Cloud Service in Oracle
Cloud Infrastructure. However, you need to manually customize your databases to
install and enable APEX by following on-premises installation process or using cloud
tooling such as Terraform.

¢ See Also:

« Get an Environment

*  Welcome to Oracle APEX Application Development Service in Getting
Started with Oracle APEX Application Development

e Creating Applications with Oracle APEX on Autonomous Database in
Using Oracle Autonomous Database on Shared Exadata Infrastructure

2.2 Understanding Oracle APEX

Oracle APEX provides you with all the tools you need to build apps in a single,
extensible platform, which runs as a part of Oracle Database.

*  Whatis Oracle APEX?
Oracle APEX is an enterprise low-code application platform that enables you to
build scalable, secure enterprise apps.

* How Oracle APEX Works
Oracle APEX provides all the tools you need to build apps in a single, extensible
platform, which runs as a part of Oracle Database.

*  About the Differences Between Runtime and Full Development Environments
Install Oracle APEX into a runtime or a full development environment.

2.2.1 What is Oracle APEX?

Oracle APEX is an enterprise low-code application platform that enables you to build
scalable, secure enterprise apps.
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Oracle APEX is a hosted declarative development environment for developing and deploying
database-centric web applications. Thanks to built-in features such as user interface themes,
navigational controls, form handlers, and flexible reports, APEX accelerates the application
development process.

The APEX engine renders applications in real time from data stored in database tables.
When you create or extend an application, APEX creates or modifies metadata stored in
database tables. When the application is run, the APEX engine then reads the metadata and
displays the application.

To provide stateful behavior within an application, APEX transparently manages session state
in the database. Application developers can get and set session state using simple
substitutions and standard SQL bind variable syntax.

2.2.2 How Oracle APEX Works

Oracle APEX provides all the tools you need to build apps in a single, extensible platform,
which runs as a part of Oracle Database.

Oracle APEX uses a simple 3-tier architecture where requests are sent from the browser,
through a web server, to the database. All processing, data manipulation and business logic
is executed in the database. This architecture guarantees zero latency data access, top
performance, and scalability, out of the box.

Oracle APEX installs with your Oracle database and consists of data in tables and PL/SQL
code. Whether you run the APEX development environment or run an application built using
APEX, the process is the same. Your browser sends a URL request that is translated into the
appropriate APEX PL/SQL call. After the database processes the PL/SQL, the results are
relayed back to your browser as HTML. This cycle happens each time you either request or
submit a page.

APEX does not use a dedicated database connection. Instead, each request is made through
a new database session, consuming minimal CPU resources. Application session state is
managed in the database tables by the APEX engine.

Behind the scenes, the APEX engine renders and processes pages. The APEX engine also
performs these tasks:

» Session state management
* Authentication services

e Authorization services

» Page flow control

* Validation processing

2.2.3 About the Differences Between Runtime and Full Development
Environments
Install Oracle APEX into a runtime or a full development environment.

When you install Oracle APEX, you can install two different environments:

* Runtime environment. In a runtime environment users can run applications but cannot
modify them. Select this option for production implementations.
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* Full development environment. In a full development environment, users can
develop, modify, run, and delete APEX applications. This option provides complete
access to the APEX environment described in this document.

# See Also:

e Oracle APEX Installation Guide

* Installing Exported Applications into a Runtime Environment in Oracle
APEX Administration Guide

2.3 Understanding the Workspace Home Page

When you sign in to Oracle APEX, the Workspace home page appears.

Each Oracle APEX development instance can contain multiple workspaces. A
workspace is a virtual private database which enables multiple users to work within
the same APEX installation while keeping their objects, data and applications private.
This section describes the sections that make up the Workspace home page.

*  Menu Bar and Icons
Learn about the menu bar and icons on the Workspace home page.

e Top Apps and Top Users Dashboards
Learn about the Top Apps and Top Users regions.

e Summary and Messages Regions
Learn about the Summary and Messages regions.

e Resources and Available Updates Regions
Learn about the Resources and Available Updates regions.

2.3.1 Menu Bar and Icons

Learn about the menu bar and icons on the Workspace home page.

Use the Workspace home page to access key development components including App
Builder, SQL Workshop, Team Development, and the Gallery.

Menu Bar

A menu bar displays at the top of the page. This menu bar displays on most App
Builder pages. Click a menu to access an alternate navigation path to different
components or functions within App Builder, SQL Workshop, Team Development, or
Gallery. The illustration that follows shows the App Builder menu.
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Workspace Home Page Icons
The center of the Workspace home page features the following large icons:

e App Builder - Create an application, composed of a set of HTML pages, based on
database objects.

e SQL Workshop - Access tools for viewing and managing database objects.

 Team Development - Track and manage issues in a conversational fashion. You can
create templates to provide users with starter text for issues and comments. You can
apply labels and label groups, assign issue owners, and set milestones.

e Gallery - The Gallery (or App Gallery) enables you to access to Starter Apps, Sample
Apps, and Custom Apps.

Starter Apps are functional apps that provide stand-alone point-solutions, designed to
meet simple requirements that do not require a large and unnecessarily complex solution.
You can use these apps "out of the box" or extend them with your own custom
functionality. Sample Apps highlight specific functionality and are intended to serve as a
developer guide on how to make use of a particular feature. Custom Apps are custom
applications that can be installed on your workspace if made available by your Instance
Administrator.
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*  App Builder Concepts
e Getting Started with SQL Workshop in Oracle APEX SQL Workshop

e Managing Team Development

e Using the App Gallery

2.3.2 Top Apps and Top Users Dashboards

Learn about the Top Apps and Top Users regions.

5 o@

About

Oracle APEX is 3 low-code
development platform that
enables you to build scalable,
secure enterprise apps, with
world-class features, that can be
deployed anywhere.

Learmn More

APEX Website

Blog

Tutorizls

Videos

Educational Resources

Ideas & Feature Requests

apex.world
Social
O oD a n

The Top Apps and Top Users regions display real time information about development
activities in the current workspace. In the previous image, no apps displays in the Top
Apps region, but the Top Users region displays the admin user.
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2.3.3 Summary and Messages Regions

O apex

App Builder

Top Apps
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App Builder

Learn about the Summary and Messages regions.

Summary Region

The Summary region list total applications, tables, and developers in the current workspace.
In the following example, this workspace has 17 application, 109 tables, and 4 developers.
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Workspace Message and System Message Regions

The Workspace Message region displays beneath the Summary region. In the previous
image, no message it defined so the region reads No Workspaces Message.. Administrators
can update or edit a workspace message by clicking the Edit icon.

The System Message region displays next. Instance administrator can create a System
Message to communicate with other users within an instance. In the previous image, the
System Message reads Sample System Message.

¢ See Also:

« Defining a Workspace Message in Oracle APEX SQL Workshop Guide
« Defining a System Message in Oracle APEX SQL Workshop Guide
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2.3.4 Resources and Available Updates Regions
Learn about the Resources and Available Updates regions.

Resources

The Resources region displays below System Message. Administrators can add links
to the Resources list to communicate important user information such as training,
discussion forums, and user feedback applications. The Resources region only
appears if resources have been defined in Administration Services.

Oracle APEX is a low-code
development platform that

enables you to build scalable,
secure enterprise apps, with
world-class features, that can be

deployed anywhere.

App Builder SQL Workshop Team Development Gallery
Leam More
APEX Website
Top Apps Top Users Summary
Blog
m admin 54 11 Applications 109 Tables S
Videos

4 Developers
Educational Resources

Ideas & Feature Requests

Workspace Message 7
apex.world
Sodial
System Message n m n n

Q Sample Systemn Message

Resources
Example Link 1

Example Link 2

o

Ayailable Updates

Oy
{t"‘ Set Preferences for Available Updates
° Systern is up-to-date

¢ See Also:

Managing the Site-Specific Resources List in Oracle APEX Administration
Guide
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Available Updates

< Note:

APEX updates on Oracle Autonomous Database are managed by Oracle. See
Control Oracle APEX Upgrades in Using Oracle Autonomous Database on Shared
Exadata Infrastructure to learn more.

The Available Updates region displays on the lower right side of the page and indicates if
updates are available for APEX and Oracle REST Data Services. If your installation is current
the following message displays:

System is up-to-date

To configure updates, click the Set Preferences for Available Updates icon which displays
on the right side of the region. In the dialog, enable or disable updates by selecting Yes or No
from the Check for Available Updates list and click Apply Changes.

" Note:

To perform this check, APEX transmits the version number of APEX and other
system components to Oracle Corporation. In order to continuously improve our
products, Oracle is interested in learning about product usage. To that end,
statistics can occasionally be sent to Oracle describing the product features in use.
No personally identifiable information is sent. To review Oracle's privacy policy see
http://www.oracle.com/us/legal/privacy/overview/index.html.

2.4 Developer Navigation Tools

Developer Navigation tools display in the header region on many Oracle APEX pages,
including the Workspace home page, App Builder home page, the Application home page,
Page Designer, and Shared Components.

* Global Search
Use Global Search to navigate App Builder.

e Administration Menu
Click the Administration menu to access Workspace Administration pages such as
Manage Service, Manage Users and Groups, Monitor Activity, Dashboards, or to change
your password.

e Help Menu
Click the Help menu to link to documentation on Oracle Help Center, the Discussion
Form, the Oracle APEX page, and the About Oracle APEX dialog.

*  Account Menu
Click the Account menu to configure appearance settings, edit your user profile or
preferences, or sign out.
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2.4.1 Global Search

O arex

App Builder

Top Apps

ORACLE

Use Global Search to navigate App Builder.

The Global Search field (also known as Spotlight Search) displays in the header
region.

pp Builder SQL Workshop Team Development Gallery (), search .—9& @ m

About

Oracle APEX is a low-code
development plath

1th
m € enables you to build s
— seCure enterprise app

world-class features, that can be

deployed anywhere.

SQL Workshop Team Development Gallery
Learn More
Top Users Summar
P y APEX Website
m admin 2 17 applications 109 Tables Blog
Tutorial
4 Developers
Videos
Educational Resources
Warkspace Message ra _
deas & Feature Requesis
spaces Message apexworld
Sodal
System Message

Q Sample Systermn Message

Key features of Global Search include:

»  Offers effortless navigation within a workspace enabling you to quickly find
applications, pages, Shared Components, APEX menus, and so on.

»  Search for component names and immediately set focus to those items in Page
Designer.

* Provides a unified search experience throughout APEX.

About Using Global Search
You can activate Global Search in two ways:

e Click the Global Search field in the in the header region
e Use the keyboard shortcut (Ctrl + Quote) (') (US Keyboards only)

Use Global Search to search all applications in the workspace no matter what your
location in the current workspace. For example, if your workspace contains the
Sample Reporting sample app, entering Sample will find it. Similarly, you can access
global navigation menus that appear at the top window adjacent to the Oracle logo.
For example, enter SQIL. Commands in the Global Search field to instant access SQL
Commands.
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To close the Global Search dialog, press the Esc key, or click anywhere outside the results.

Syntax to Navigate to a Page or Search for a Regular Expression

Search by page name and page alias. With in an in-app, use a colon (:) or dash () between
the application ID or alias and the page ID, name, or alias.

Within App Builder and on the Application home page, use the following syntax to navigate to
a specific page or search for a regular expression:

page ID

page NAME

page ALIAS

application ID:page ID
application NAME:page ID
application ALIAS:page ID
application ID-page ID
application NAME-page ID
application ALIAS-page ID
regexp:expression

Where:
* page ID-Numeric identification number (or ID) that identifies a specific page.
* page NAME- An alphanumeric name that identifies a specific page.

* page ALIAS - An alternate alphanumeric page identifier. You can use this identifier in
place of the page name.

* application ID- A numeric identification number (or ID) that identifies an application.
* application NAME is the alphanumeric name that identifies an application.

* application ALIAS - An alternate alphanumeric application identifier. You can use this
identifier in place of the application name.

* regexp: is literal text.
° expressionis aregular expression to search for.

You can replace page IDfor page NAME Orpage ALIAS when searching by application ID or
application ALIAS.

The following example navigates you to page 10 of application 570:

10
570-10
570:10

You can also use this syntax to navigate to the Shared Components page of a given
application:

application ID:s
application ID-s

Where:

* application IDis the numeric identification number (or ID) that identifies an application.
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The following example demonstrates how to navigate to the Shared Components page
of application 570:

570:s
570-s

About Navigating Search Results

Global Search results display in a dialog. Use the Up and Down arrows keys to
navigate the results and press Enter to make a selection. Since the the Global
Search icon displays on nearly every page in APEX, you can continue to narrow your
search until you find the app, page, or component (such as the item, button, or region)
which contains the keyword.

Other available shortcuts change depending on where you are in App Builder, for
example:

* In Page Designer - To search for a page, press Ctrl + 4.
* In App - To search within an application, press ctrl + 3.
e All Apps - To search all applications, press Ctrl + 2.

e Current Workspace - To search a workspace, press Ctrl + 1.

Tip:

Some browsers map these Cctrl key shortcuts for quick tab navigation. In
that case, the shortcut does not work as described above. Instead, they
simply activate a particular open browser tab.

Example 2-1 Search Example

Suppose you need to find an application called Employees which includes interactive
grid built on the EMP table.

1. Find the application.
a. On the Workspace home page, click the Global Search field and enter emp.
Global Search would return the results:
*  Employees (App)
e Templates
*  Create Email Template
e Search all applications for emp (Ctrl + 2)

»  Search Workspace for emp (Ctrl + 1)
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Templates

shared Components  Create Email Template

a Search all applications for emp Cirl + 2

a Search Workspace for emp Crl +1
< Note:

Templates and Create Email Template appear because they contain the
text string emp.

b. Select Employees to view that application.
The Employees application appears.
2. Search the application.
a. On the Application home page, click the Global Search field and enter EMP.
Global Search returns the results that include numerous pages and other items.
b. Select the option the includes a page reference.
The page appears in Page Designer.
3. Search the page.
a. In Page Designer, find the Global Search field and enter EMP again.
Global Search returns the results that include numerous components.

b. Select a component (such as a process, column, region, and so on).

2.4.2 Administration Menu

Click the Administration menu to access Workspace Administration pages such as Manage
Service, Manage Users and Groups, Monitor Activity, Dashboards, or to change your
password.

The Administration menu displays to the right of the Global Search field and features an
outline person with a wrench.
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o APEX App Builder SQL Workshop Team Development Gallery ), Search .,_gs @ m
Administration Administration
e & low-code
VIGN3EE >ErVICE > latform that
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Monitor Activity N
SQL Warkshop Team Development
Dashboards
Top Users Summary Chenes bivbessnon
m admin 2 17 Applications 109 Tables Blog
Tutorizl
4 Developers o
Videos
Educational Resources
Workspace Message v

deas & Feature Requests

paces Message apex.world

Clicking the Administration menu displays the following options:

ORACLE

Administration links to the Workspace Administration page. To access the Oracle
APEX development environment, users sign in to a shared work area called a
workspace. Workspace administrators monitor and administer a workspace.
Common workspace administration tasks include managing service requests,
configuring workspace preferences, creating workspace announcements,
managing session state, creating user accounts, and managing groups.

Manage Service displays a submenu of options on the Manage Service page.
Administrators use the Manage Service page to manage service requests,
configure workspace preferences, edit workspace announcements, and view
workspace utilization reports.

Manage Users and Groups links to Manage Users and Groups page. Workspace
administrators can create new user accounts, manage existing user accounts, and
change user passwords.

Monitory Activity links to the Monitor Activity page. Use this page to monitor
changes to page views, developer activity, page view analysis, and active
sessions. It also shows reports on such information as login attempts and external
click counts.

Dashboards links to the Dashboard page. Use this page to view details about the
current workspace and monitor users, activity, developer activity, performance,
application development, and view database details.

Change My Password links to the Change Password section of the Edit Profile
dialog box.
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¢ See Also:

e Workspace and Application Administration in Oracle APEX Administration
Guide

* Manage Service Page in Oracle APEX Administration Guide

e Managing Users in a Workspace in Oracle APEX Administration Guide

e Monitoring Activity Within a Workspace in Oracle APEX Administration Guide
*  Viewing Workspace Dashboards in Oracle APEX Administration Guide

e Changing Your Profile or Password

2.4.3 Help Menu

Click the Help menu to link to documentation on Oracle Help Center, the Discussion Form,
the Oracle APEX page, and the About Oracle APEX dialog.

The Help menu features a question mark enclosed with a circle.

O APEX App Builder SQL Werkshop Team Development Gallery (| search é}. @ m
Documentation Help
Discussion Forum le
wat
Learn More about Oracle APEX able,
ith
tcan be
About
App Builder SQL Waorkshop Team Development Gall
Learn More
Top Apps Top Users Summary
APEX Website

E admin 15 10 Applications Blog

Tutorials
106 Tables 4 Developers

Videos

Educational Resources

Click the Help menu to access the following menu items:

« Documentation links to Oracle APEX, Oracle Help Center.

» Discussion Forum links to the Categories page where you can access APEX
Discussions.

e Learn More about Oracle APEX links to the Oracle APEX page.

e About. Links to the About APEX dialog. This dialog includes information about the APEX
instance and the database version.
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¢ See Also:

Using Oracle APEX Documentation

2.4.4 Account Menu

Click the Account menu to configure appearance settings, edit your user profile or

preferences, or sign out.

Chapter 2
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The Account menu displays in the upper right corner of the page. Open the Account
menu by clicking on the User icon in the header.

O arex

App Builder

Top Apps

ORACLE

App Builder

SQL Workshop

Top Users

m aclTi’

Q Tip:

access to.

S0L Workshop

Team Development Gallery (. search

Team Development

summary
2 17 Applications

4 Developers

Waorkspace Message

Mo Workspaces Messape

System Massage

Q Sample Systern Message

Key controls on Account menu include:

Preferences

s o

ADMIN

admin@sxample.com

. EXAMPLE

.&aﬁinistrator

Sign out
Videos

Educational Resources

/ Ideas & Feature Requests
apex.world
Sodial
O O G o

The Account menu displays your username, email address, the current workspace,
and your user role. If Single Sign On (SSO) is enabled, the link Change Workspace

also appears.

If you are using Single Sign-on authentication, Change Workspace also
displays. Click Change Workspace to view a list of workspaces you have

2-16



Chapter 2
Developer Navigation Tools

» Edit Profile. Click Edit Profile to edit the options. Click Apply Changes to save your
changes.

Profile Detalils:

*  Email Address - Specifies the email address for use with general
correspondence, notifications about resetting passwords, and so on.

*  First Name - Specify the first or given name to further identify the user. This
optional field is used for informational purposes only.

*  Last Name - Specify the last or family name to further identify the user. This
optional field is used for informational purposes only.

Profile Photo - Select a photo to further identify the user. This optional field is used for
informational purposes only.

Password - If you wish to change your password, enter a new password. Otherwise,
leave the password fields empty and the current password will not be changed.

*  Enter Current Password - Enter your current password. Do not enter a password
unless you want to change the current password.

*  Enter New Password - The password used to log in to the system. Do not enter a
password unless you want to change the current password.

*  Confirm Password - Enter the password again. Do not enter a password unless
you want to change the current password.

* Appearance. Configure how the Oracle APEX user interface displays. Options include:

Automatic (default) detects the appropriate setting based on existing system or
browser settings.

Light Mode renders the user interface using dark-colored text, icons, and graphical
user interface elements on a lighter background.

Dark Mode renders the user interface using light-colored text, icons, and graphical
user interface elements on a darker background.

» Preferences. Click Preferences to configure the options. Click Apply Changes to save
your changes.

Default Scheme - Specifies the default schema used for data browsing, application
creation, and SQL script execution.

Default Date Format - Specify the default Oracle date format for the user. This
option controls the default date format within SQL Workshop.

Unicode CSV Downloads - Specify whether to provide SQL Workshop CSV
downloads in Unicode. This only affects SQL Workshop and not custom applications.

Run application in new window - Specify how Oracle APEX manages windows or
tabs when running applications from the App Builder when using Mozilla Firefox and
Microsoft Internet Explorer.

Use single window to run all applications - Specify whether different applications
reuse the same application runtime window or tab.

* Sign Out. Click Sign Out to log out of the current workspace.

ORACLE
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¢ See Also:

e Changing Your Profile or Password

e Editing User Preferences and Enabling Dark Mode

2.5 Understanding App Builder

Developers use App Builder to create and manage applications and application pages.

The App Builder home page displays all installed applications in the current Oracle
APEX instance. When a developer selects an application to edit, the Application home
page appears. Use the Application home page to run, edit, import, export, copy, or
delete applications.

e Accessing App Builder
Access App Builder by clicking the App Builder icon on the Workspace home
page.

e Understanding the App Builder Home Page
Use App Builder to create new applications, select an application to edit, import
previously exported applications, view the Dashboard, or access workspace
utilities.

e Accessing the Application Home Page
Access the Application home page by clicking the App Builder icon on the
Workspace home page and then selecting an application.

e Understanding the Application Home Page
Use the Application home page to run, edit, import, export, copy, or delete
applications.

¢ See Also:

e Quick Start
*  App Builder Concepts

2.5.1 Accessing App Builder

ORACLE

Access App Builder by clicking the App Builder icon on the Workspace home page.

To access App Builder:

1. Signinto Oracle APEX.

2. On the Workspace home page, click the App Builder icon.
The App Builder home page appears.
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o APEX App Builder SQL Workshop - Team Development Gallery (), search 8 @ m

About

The App Builder enables you to
design, develop and deploy

" ’ applications which are beautiful
CJ and responsive.

Learn More
Create Import Dashboard Workspace Utilities

Recent

Q~ Go g BB Actions ~ Reset Demonstration - Cust - 476

Sample Calendar - 475

Demonstration - Demonstration - Demonstration - ; )
lﬂ Customer Orders l‘i'-“ EMP / DEPT Projects Demeonstration - Proj - 363
== 475 = 44 263
Sample Cards - 537

Demonstration - EMP - 144
Sample Reporting - 535

Mobile Reports and F - 510

Use the App Builder home page create new applications, select an application to edit,
import previously exported applications, view the Dashboard, or access workspace
utilities. In the above image, currently installed applications display as large icons at the
bottom of the page.

2 Tip:

In a new workspace, the bottom of the page displays two additional regions.
Click Create a New App to access the Create Application Wizard and create a
new application. Click Install a Starter or Sample App to access the Gallery
and install sample apps, plug-ins, and pre-built apps you can use as is or
customize.

" See Also:

e Understanding the App Builder Home Page

e Creating Applications

2.5.2 Understanding the App Builder Home Page

Use App Builder to create new applications, select an application to edit, import previously
exported applications, view the Dashboard, or access workspace utilities.
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< Tip:

In a new workspace, the bottom of the page displays two additional regions.
Click Create a New App to access the Create Application Wizard and create
a new application. Click Install a Productivity and Sample Apps to access
the App Gallery page and install a Productivity and Sample App and load
sample data. Once you create an application or install a sample or
productivity application, these regions no longer appear.

*  App Builder Home Page Icons and Navigation Bar
Learn about using the icons and navigation bar on the App Builder home page.

* Reset and Create Buttons
Learn about the App Builder home page Reset and Create buttons.

* Recent List and Tasks List
Learn about the App Builder home page Recent and Tasks regions.

# See Also:

e Accessing App Builder

< Developer Navigation Tools

2.5.2.1 App Builder Home Page Icons and Navigation Bar

Learn about using the icons and navigation bar on the App Builder home page.

The App Builder home page features four large icons (Create, Import, Dashboard, and
Workspace Utilities) and the bottom of the page displays all currently installed
applications.

About App Builder Home Page Icons
The top of App Builder home page contains four large icons:

e Create. Launches the Create Application Wizard. Use the Create Application
Wizard to build a complete application containing multiple pages. See Creating
Applications.

e Import. Launches the Import Wizard. Use this wizard to import export files from
the export repository. See Importing Export Files.

e Dashboard. Links to the App Builder Dashboard which displays metrics about
applications in the current workspace.

*  Workspace Utilities. Use the Workspace Utilities page to access REST Enabled
SQL Services, Remote Servers, Application Groups, Web Credentials, Workspace
Themes, Export, Oracle APEX Views, Manage Backups, and REST Source
Catalog. See Using Workspace Utilities.
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About the Navigation Bar

The bottom of App Builder home page displays all installed applications. You can customize
how the applications display using the navigation bar in the center of page.

Available controls include:

» Select columns to search - This control features a magnifying glass button. Click this
button to narrow your search to only specific columns. To search all columns, select All
Columns.

» Text area - Enter case insensitive search criteria (wildcard characters are implied) and
click Go.

* Go button - Executes a search or applies a filter.

* View Icons (default) - Displays each application as a large icon identified by the
application name.

* View Report - Displays each application as a line in a report. Each line includes the
application ID, the application name, when the application was last updated, the page
count, and who last updated the application.

* Actions menu - Displays the Actions menu. Use this menu to customize the report view.
For example, display additional columns by selecting Actions, Columns.

Q Tip:

In a new workspace, the bottom of the App Builder home page displays two
regions: Create a New App and Install a Starter or Sample App. Follow the on-
screen instructions. Once you create or install an application, these region
disappear.
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¢ See Also:

e Choosing the Application Type
* Importing Export Files

*  About the Actions Menu

2.5.2.2 Reset and Create Buttons

Learn about the App Builder home page Reset and Create buttons.

The Reset and Create buttons display in the center of the page to the right of the
navigation bar.

O APEX App Builder SQL Workshop ~ Team Development Gallery ) search & @ m

About

The App Builder enables you to
design, develop and deploy

s 4 applications which are beautiful
and responsive.

Learn More ...
Create Import Dashboard Workspace Utilities

Recent

Qv Go s EE Actions Reset Demenstration - Cust - 476

Sample Calendar - 475

Demonstration - -~ Demaonstration - Demonstration - i }
I"‘ Customer Orders l“ EMP / DEPT Projects Demonstration - Proj - 363
- — 478 M= 44 363
Sample Cards - 537

Demonstration - EMP - 144

Sample Reporting - 535

Mobile Reports and F - 510

Use the Reset and Create buttons as follows:

» Click Reset to return the page to the default display.

* Click Create to create a new application, create an application from a file, install a
starter app, launch Quick SQL, or copy an application.

2.5.2.3 Recent List and Tasks List

Learn about the App Builder home page Recent and Tasks regions.

The App Builder home page feature two regions on the right side of the page: Recent
and Tasks.

ORACLE" 2-22



Chapter 2
Understanding App Builder

o APEX App Builder - SQL Werkshop ~ Team Development - Gallery (| Search 8‘, @ m

Create

Maobile Reports Opportunities Sample Calendar Demonstration - EMP - 144

and Forms

sample Ca

Demonstration - Demonstration - Demonstration -
Customer Orders EMP / DEPT Projects Sample Cards - 537

About

The App Builder enables you to
design, develop and deploy

applications which are beautiful
{:;) ,"/‘ and responsive.

Learn Mare __

Import Dashboard Workspace Utilities
Recent

Sample Calendar - 475
Go oo | BB Actions v Reset i
Demonstration - Cust - 474

Demonstration - Proj - 363

505

Sample Reporting - 535

i

Mobile Reports and F - 510

endusertest - 371
rds Sample REST sample Reparting
Services 555

Tasks

Manage Backups

Browse by Facets

Recent

The Recent region contains links to recently viewed applications. Click an application name
to view it on Application home page.

Tasks

The Tasks region displays next and features the following links:

* Manage Backups - Links to the Manage Backups page.

* Browse by Facets - Links to the Search Applications page. Use Search Applications find

applications in the current workspace.

¢ See Also:
Managing Application Backups

2.5.3 Accessing the Application Home Page

Access the Application home page by clicking the App Builder icon on the Workspace home

page and then selecting an application.

Use the Application home page to run, edit, import, export, copy, or delete applications.

ORACLE"
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To access the Application home page:

1. Signinto Oracle APEX.
The Workspace home page appears.
2. Click the App Builder icon.
The App Builder home page appears.
3. Select an application on the Application home page.

The Application home page appears.

¢ See Also:

Understanding the Application Home Page

2.5.4 Understanding the Application Home Page

Use the Application home page to run, edit, import, export, copy, or delete
applications.

When a developer selects an application on the App Builder home page, the
Application home page appears.

e Edit Application Definition Button
Learn how to identify the application ID and name and edit the application
definition.

e Application Home Page Icons
Learn about the icons on the Application home page.

* Create Page Button
Learn about Create Page button on the Application home page.

e Application Home Page Navigation Bar
Learn about navigation bar on the Application home page.

e Application Home Tasks List
Learn about Application home page Tasks list.

* Recently Edited Pages
Learn about Application home page Recently Edited Pages region.

¢ See Also:

e Accessing App Builder

«  Developer Navigation Tools
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2.5.4.1 Edit Application Definition Button

Learn how to identify the application ID and name and edit the application definition.

The application ID and the application name display at the top of the Application home page.
The application ID also displays in the breadcrumb at the top of the page.

o APEX App Builder 5QL Workshop ~ Team Development Gallery () search é)}. @ m

(1) Application 363 O % & [edtrager | (B

Application 363 - Demonstration - Projects I Editt Application Definftion I About

Use the Application home page
to run, edit, import, export,
copy, or delete an application.
Select a page to edit the page

— properties, or click Create Page
E E'JL‘I:I to add & page to the application.
Learn More

Run Application Supporting Objects  Shared Components Utilities Export / Import
Tasks

Q~ Go 0e | EB Actions ~ Create Page > Delete this Application

Copy this Application

. Updated
Page Name Alias Updated By Type Group Lock Run Add Feature Page
= o 4 weeks I - - Manage Backups
0  Global Page - -0 admin3 Global Page Unassigned i) vianag ps
a
4 vmeke Browse by Facets
1 Home horme _g‘C’EE © admin3 Home Unassigned o) O]
=
Recently Edited Pages
2 Dashboard dashboard 4 vesks admin3 Chart Unassigned ?—J IE)
ago £ Tac
5. Tasks
- ) . 4 weeks : ) - )
3 Projects projects ag0 admin3 Cards Unassigned ?—J () 12. Projects
a

The Edit Application Definition button displays to the right of the application ID and name.
Click Edit Application Definition to edit the application definition, including the application
Name and Application Alias.

¢ See Also:

Editing the Application Definition
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2.5.4.2 Application Home Page Icons

Learn about the icons on the Application home page.

C) APEX App Builder SQL Workshop Team Development Gallery (] search .-_O}- @ m
(1) Application 363 ® | % | & | [Cedtree1 | ®
Application 363 - Demonstration - Projects Edit Application Definttion About

Use the Application home page

to run, edit, import, export,
copy, or delete an application.
Select a page to edit the page

properties, or click Create Page
E E to add & page to the application.

Learn hore ..
Run Application Supporting Objects  Shared Components Utilities Export / Import
Tasks
Q- Go 88 ER Actions ~ Create Page > DEEEITE A TerT
Copy this Application
Page Mame Alias Updated U;}dated Type Group Lock Run Add Feature Page
0  Global Page ;:EEK zdmin3  GlobalPage  Unassigned in Manage Backups
. - Browse by Facets
Home home jé.;eek-.- admin3 Home Unassigned i) »
Recently Edited Pages
2  Dashboard dashboard __1-""25*5 admin3 Chart Unassigned i) »
ago 5. Tasks
3 Projects projects ;:EEK admin3 Cards Unassigned ?—] 'ZE‘- 12. Projects

The following large icons appear beneath the application ID and application name:

* Run Application submits the home page in the current application to the Oracle
APEX engine to render viewable HTML.

*  Supporting Objects links to the Supporting Objects page. Use Supporting
Objects to define database object installation scripts that are invoked when
importing an application. You can also define deinstallation scripts to drop objects
when deleting an application.

* Shared Components links to the Shared Components page. Shared components
can display or be applied to any page within the application.

« Utilities links to the Utilities page. Use this page to monitor developer activity, view
dashboards, run Advisor, and view numerous other reports.

*  Export/import links you to the Export/Import Wizard. Use this wizard to import
and export an entire application and related files such as cascading style sheets,
images, static files, script files, themes, user interface defaults, and workspace
users.
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¢ See Also:

¢ Running an Application or Page

e How to Create a Custom Application
e Managing Shared Components

e Using Application Utilities

e Exporting Workspaces, Applications, and App Components

2.5.4.3 Create Page Button

Learn about Create Page button on the Application home page.

O APEX App Builder - SQL Workshop - Team Development - Gallery (), search ,._Qp @ m

() Application 363 @ % & | [editragel || (®

Application 363 - Demaonstration - Projects Edit Application Definition About

Use the Application home page
to run, edit, import, export,
copy, or delete an application.
Select a page to edit the page
properties, or click Create Page
to add a page to the application.

® El & &

Run Application Supporting Objects  Shared Components Utilities Export / Import

Learn Mare __

Tasks

Q e Go oo i< Actions Create Page > Delete this Application

Copy this Application

Updated

Page Name Alias Updated By Type Group Lock Run Add Feature Page
0 Global Page - ?;;EEKS admin3 Global Page Unassigned s Manage Backups
a
4 vmek Browse by Facets
1 Home home _ééee = admin3 Home Unassigned ?3 @
d
Recently Edited Pages
2 Dashboard dashboard 4 viesks admin3 Chart Unassigned ?3 @
ag0 5 Tae
5. Tasks
3 Projects projects ?;;EEKS admin3 Cards Unassigned ?3 @ 12. Projects
a

Clicking the Create Page button launches a wizard that walks you through creating a page in
an application.
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2.5.4.4 Application Home Page Navigation Bar

¢ See Also:

Adding a New Page to an Application

Learn about navigation bar on the Application home page.

Chapter 2

Understanding App Builder

A navigation bar displays in the center of the Application home page. You can use the
navigation to search for pages or customize the appearance of the page.

() APEX  AppBuilder

() Application 363

SQL Workshop

Application 363 - Demonstration - Projects

Run Application

=
Qv

Page Name

0 Global Page

Home

Dashboard

ra

&

Projects

Supporting Objects

o
=

View Report

Alias Updated

4 weeks
EEG]

4 weeks
ago

nome

dashbozrd 4 wesks

4 weeks
EEG]

projects

Team Development

Shared Components

a8

Select columns to search

By

admin3

admin3

admin3

admin3

Edit Application Definttion

Export / Import

Create Page >
Lock Run
i)
Y ®
ol ®
BH®

o

CHNON o

™ .
Le E

dit Page | ®

About

Use the Application home page
to run, edit, impaort, export,
copy, or delete an application.
Select a page to edit the page
properties, or click Create Page
to add a page to the application.

Learn More ...

Tasks

Delete this Application
Copy this Application
Add Feature Page
Manage Backups
Browse by Facets
Recently Edited Pages
5. Tasks

12. Projects

The Application home page navigation bar contains the following controls:

ORACLE

Select columns to search - This field contains a magnifying glass icon. Click this
icon to narrow your search to only specific columns. To search all columns, select

All Columns.

Text area - Enter case insensitive search criteria (wildcard characters are implied)

and click Go.

Go button - Executes a search or applies a filter.

View icons. Use these icons to toggle between two views:

— View Icons (default) - Displays each page as a large icon identified by the

page name.

To view a page, click the page icon.
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— View Report - Displays each page as a line in a report. Each line includes the page
number (ID), the page name, when the page was last updated and by whom, the
page type, any associated group, the user interface, and lock status.

To view a page, click the page name. Click the Lock icon to prevent conflicts during
application development. Click the Run icon to run the associated page and render
viewable HTML.

* Actions menu - Displays the Actions menu. Use this menu to customize the report view.

# See Also:

e App Builder Home Page Icons and Navigation Bar

e Locking and Unlocking a Page

2.5.4.5 Application Home Tasks List

Learn about Application home page Tasks list.
A Tasks list displays on the right side of the Application home page.
The Tasks list contains the following links:

» Delete this Application deletes the current application. See Deleting an Application.

* Copy this Application creates a copy of the current application. See Copying an
Application from the Application Home Page.

* Add Feature Page launches the Feature page of the Create Page Wizard enabling you
to add features to an existing application. See Adding Features to an Existing App.

* Manage Backups - Links to the Manage Backups page. See Managing Application
Backups.

* Browse by Facets - Links to the Search Applications page. Select a Page Type to filter
the view.

2.5.4.6 Recently Edited Pages

Learn about Application home page Recently Edited Pages region.

Recently Edited Pages region contains links to recently edited pages within the current
application. To link to specific page, click the page ID and name.

2.6 Changing Your Profile or Password

ORACLE

Edit your account profile to update your profile (email address, first or last name), upload a
profile photo, or change your password.

To edit your account profile:
1. Click the Account menu in the header region.
2. Click Edit Profile.
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O APEX  AppBuilder SQL Workshop Team Development Gallery (] Sesrch & @ m

App Builder SQL Workshop Team Development Administratar
O .

m admin 15 ]0 Application Preferences Sign out

Top Apps Top Users Summary

106 Tebles 4 Developers

Videos

Educational Resources
Workspace Message 4

deas & Feature Requests

apexworld

The Edit Profile dialog appears.
3. Under Profile Details, edit the following:

» Email Address - Enter the email address used for general correspondence and
notifications about resetting passwords.

» Email Address - Enter the first or given name to further identify the user. This
optional field is used for informational purposes only.

» Last Name - Enter the last or given name to further identify the user. This
optional field is used for informational purposes only.

4. Under Profile Photo, add, change, or remove your photo.
5. Under Change Password, enter a new password.

6. Click Apply Changes.

Q Tip:

You can also reset your password and recover your workspace name from
the Sign In page. See Resetting Your Password from the Sign In Page and
Recovering Your Workspace Name in Oracle APEX Installation Guide.

2.7 Editing User Preferences and Enabling Dark Mode

ORACLE

Click the Account menu to enable or disable Dark Mode or edit user preferences.

Configure the Appearance switch to determine if the Oracle APEX user interface
displays in Dark Mode, Light Mode, or Automatic Mode.

Click Preferences to change your default schema, default date format, configure
whether SQL Workshop CSV downloads are in Unicode, and control how windows
display when App Builder runs applications.

To enable Dark Mode or edit preferences:

To configure the Appearance switch or user Preferences:

2-30



Chapter 2
Editing User Preferences and Enabling Dark Mode

1. Click the Account menu in the header region.

Top Apps Top Users Summary

O APEX App Builder 5QL Workshop Team Development Gallery ), Search 9;. @ m

ADMIN

Administrator

m admin 5 10 application; Sign out

106 Tables 4 Developers o

App Builder SQL Workshop Team Development

Videos
Educational Resources
Workspace Message 7

deas & Feature Requests

apex.world

2. Configure the Appearance switch to determine if the APEX user interface displays in
Dark Mode or Light Mode. Options include:

Automatic detects the appropriate setting based on existing system or browser
settings.

Light Mode renders the user interface using the standard color scheme.

Dark Mode renders the user interface using an inverted color scheme, applying light-
colored text, icons and graphical user interface elements on a darker background.

3. To configure Preferences, click Preferences. In the Preferences dialog, edit the following:

ORACLE

Default Schema - Specifies the default schema used for data browsing, application
creation, and SQL script execution. When using workspaces that have more than one
schema available, this schema is the default for creating applications, performing
SQL queries, and so on. This feature does not control security, only the user's
preference.

Default Date Format - Specify the default Oracle date format for the user. This
option controls the default date format within SQL Workshop.

Unicode CSV Downloads - Specify whether to provide SQL Workshop CSV
downloads in Unicode. This does only affect SQL Workshop and not custom
applications.

Run application in new window - Specify how APEX manages windows or tabs
when running applications from App Builder when using Mozilla Firefox and Microsoft
Internet Explorer. This setting has no effect when using other browsers, such as
Google Chrome and Apple Safari.

If set to On, the default, browser preferences are ignored and a new window always
opens. If set to Off, the runtime application opens in a new window or tab based on
Browser preferences. Mozilla Firefox and Microsoft Internet Explorer generally do not
set focus to another tab in the same window, except when that tab is first launched.

Use single window to run all applications - Specify whether different applications
reuse the same application runtime window or tab.

If set to On, applications run from the App Builder reuse the window or tab used for
running the previous application. If set to Off, applications you run display in its own
window or tab.
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4. Click Apply Changes.

2.8 Using Oracle APEX Documentation

Oracle APEX provides a hosted online documentation library and field-level Help. You
can browse or search content or download the entire library by going to the APEX
Documentation page in the Oracle Help Center.

* Accessing Oracle Help Center
Access Oracle Help Center from by clicking Documentation on the Help menu.

»  Searching the Oracle Help Center
Search Oracle Help Center by book, product, category, or all publications.

* Downloading the Documentation Library
Download a ZIP file of the online documentation library.

» Redirecting the Help Menu
Redirect the Help menu at the instance-level.

* Viewing Field-level and Page Designer Help
Learn about field-level Help and Help in Page Designer.

2.8.1 Accessing Oracle Help Center

Access Oracle Help Center from by clicking Documentation on the Help menu.

Oracle Help Center publishes a comprehensive library of publications for each Oracle
APEX release. Whether you are new to APEX or an advanced user, you can find
useful information about building stunning, scalable, secure apps with Oracle APEX.

Access Oracle Help Center by either clicking the Help menu and selecting
Documentation, or clicking Learn More... links in the product Ul.

O APEX App Builder SQL Workshop Team Development Gallery () search ,9;. @ m
Drocumentation
Discussion Forum le
Aat
m Learn Mare about Oracle APEX able,
with
t can be
About
App Builder SQL Workshop Team Development Gall
Learn More
Top Apps Top Users summary R
APEX Website

E admin 15 10 Applications Blog

Tutorials
106 Tables 4 Developers

Videos

Educational Resources

When the Oracle Help Center appears, you can:

e Select a release (if applicable).

*  Browse topics by selecting a subject area.
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* View all publications in the library:
— In the left navigation menu, select Books.
— Find and select the appropriate publication.
*  Download the library locally:

— In the left navigation menu under Books, select Download.

2.8.2 Searching the Oracle Help Center

Search Oracle Help Center by book, product, category, or all publications.

Q Tip:

Searching a specific publication tends to yield the best results.

To search a specific publication:
1. Access Oracle Help Center:

a. Click the Help menu in the upper right corner. The Help menu features a question
mark enclosed with a circle.

b. Select Documentation.
Oracle Help Center appears, displaying documentation for the current release.
2. Locate the publication:
a. From the left navigation menu, select Books.
b. Locate the publication and click the HTML link.
The publication appears.

Note that the Search bar at the top of page displays the title of the selected
publication.

= Help Center

Database / Oracle / APEX / Release 221 grfdg APEX Anp Buiider Useir's
uide

App Builder User's Guide

3. To search the publication, enter keywords in the Search bar and press Enter.
Search results appear.
4. Select a topic to review.

The topic appears and the table of contents highlights the selected topic.
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= Help Center (Yo

Database / Oracle / APEX / Release 221

App Builder User's Guide

3.4 About Enabling Support for Bookmarks

» 3.5 Understanding Session State Management 3_6 Managiﬂg SESSIOn State

~ 3.6 Managing Session State |

View session state and manage session state overrides fram the Runtime Developer toolbar
3.6.1 Viewing Session State : p : N
which displays at the bottom of any editable page at runtime.
3.6.2 Managing Session State Overrides }
Viewing Session State
» 3.7 Understanding URL Syntax View the Session page at runtime by clicking Session and then View Session State on the

Runtime Developer toolbar.
» 3.8 Managing Session State Values

b A e faten 5 Managing Session State Overrides
., SN, ubstitution rngs . . c =
g e Access the Session Overrides dialog from the Runtime Developer tool bar to manage E
» 310 Using Template Directives session state values at runtime.

The following icons display to the left side of the table of contents:

Table of Contents - Click the Table of Contents icon to show or hide the
table of contents.

D

Search - Click the Search icon to search the book, product, or category.

2.8.3 Downloading the Documentation Library

Download a ZIP file of the online documentation library.

To download the online documentation library:
1. Access Oracle Help Center:

a. Click the Help menu in the upper right corner. The Help menu features a
guestion mark enclosed with a circle.

b. Select Documentation.

Oracle Help Center appears, displaying documentation for the current release.
Under Books, select Download.

Save the ZIP file locally.

Download the ZIP file and extract it locally.

Open the extracted folder and click Readme.html.

@ o W N

Click Start Here.

2.8.4 Redirecting the Help Menu

Redirect the Help menu at the instance-level.

Administrators can redirect the Help menu at the instance-level in Manage Instance,
Instances Settings in the Oracle APEX Administration Services application. APEX
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Administration Services is a separate application that enables an Instance administrator to
manage an entire APEX hosted instance. This functionality is not available to some
customers who are using a hosted instance.

¢ See Also:

Configuring the Help Menu in Oracle APEX Administration Guide

2.8.5 Viewing Field-level and Page Designer Help

Learn about field-level Help and Help in Page Designer.

Most select lists, checkboxes, items, and fields within APEX include field-level Help. Page
Designer also includes Help for all Property Editor attributes.

* Viewing Field-level Help in Oracle APEX

* Viewing Help in Page Designer

2.8.5.1 Viewing Field-level Help in Oracle APEX

Most select lists, checkboxes, items, and fields within Oracle APEX include field-level Help.
To view field-level help:
1. Navigate to the attribute you need information about.

Most attributes in APEX include field-level Help. Attributes with field-level Help have a
light gray icon that resembles a question mark (?). Passing your cursor over the icon
displays the tooltip, Help Text: ....

Availability

Available with Developer Toolbar v o (2)

Build Status  Run and Build Application Help Text: Status

Message for unavailable applicstion  This application is currently unavailable at this time.

(%]
=
ar
'
=
i

Restrict to comma separated user list (status
must equal Restricted Access)

2. To view field-level Help, click the Help Text icon.

A Help window appears.
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Security Globalizz <
ERZ v o s

Application 144

Specifies whether or not the application is available or unavailable for use. =
Options include:
Show All Name Properties At

.

Available - Application is available with no restrictions. o F

.

Available with Developer Toolbar - Application is available for use
For developers, the Developer Toolbar is included on each page.
Requires the developer to be logged in to the App Builder in the same
Stat browser session.

Availability

Available to Developers Only - Application is available to users having

Build Stat developer privileges.

.

. . Restricted Access - Application is available to developers named in
Message for unavailable applicatii ) )
Restrict to comma separated user list.

.

Unavailable - Application cannot be run or edited. The message in
Message for unavailable application displays when users attempt to

access the application.
Restrict to comma separated user list (stat
must equal Restricted Acce:

Unavailable (Status Shoven with PL/SQL) - Application cannot be run
or edited.

Unavailable (Redirect to URL) - Application cannot be run. The useris

Error Handling linked to the URL entered in Message for unavailable application

Default Error Display Locati View Documentation

Frrar Handling Functic

Q Tip:

To access field-level help with the keyboard, focus on the correct field
and then press Alt+F1.

" See Also:

Accessing Oracle Help Center

2.8.5.2 Viewing Help in Page Designer

Page Designer includes Help for all attributes in the Property Editor.
To view Help in Page Designer:
1. Access Page Designer.
Page Designer appears.
2. Select a component or control in either the left pane or the central pane.

As you change focus in either view, the Property Editor automatically updates to
reflect the currently selected component.

3. Inthe Property Editor, select an attribute.

4. To view help for an attribute, select the attribute in the Property Editor and click the
Help tab in the central pane.
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App Builder SQL Workshop Team Development Gallery () search ,_Q)L @ m

Go

(%}

L/-e ’ 5::_] SE."‘ : E

1= C; s Layout  PzgeSearch  Help m Region  Aftributes  Printing

Page 5: Departments

Pre-Rend

= Where Clause Filter (Locs
Enter a valid SQL where condition, used to limit the records
retrigved. Identification
Examples Title Departments
Only include those employees which have a manager or Type Interactive Report W iz
have a job of salesman.
{ MGR is not null or JOB = "SALESMAN' ) Source
4 »
Additional Information Location Local Database W
N Groups * Type: Where Clause Type Table / View B4
» Supported Bind Varizbles: Application, Page tems and
- \ariahles Table Owner Parsing Schema W
System Variables
Table Name DEPT i=
B e B w
Column

Where Clause [E]]

Once you activate the Help pane, the content that displays changes every time you select
another attribute.

Q Tip:

To view an online summary that describes just the Page Designer window, view
a page in Page Designer, click the Help menu at the top of the page, and select
Getting Started with Page Designer.

¢ See Also:

Viewing a Page in Page Designer

2.9 Using the App Gallery

Use the App Gallery to install Sample Apps, Starter Apps, and Custom Apps.

ORACLE

About Sample Apps, Starter Apps, and Custom Apps
Sample Apps and Starter Apps are available with every Oracle APEX workspace.
Custom Apps are only available if your instance administrator has enabled them.

About the Oracle APEX GitHub Repository
The Oracle APEX GitHub repository contains Starter Apps, Sample Apps, sample code,
and plug-ins you can use in your workspace.

Installing Apps from the Gallery
Install Sample and Starter Apps directly from the Gallery by clicking Install.
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* Uninstalling Apps from the Gallery
Uninstall Sample and Starter Apps directly from the Gallery by clicking the
Remove App icon.

2.9.1 About Sample Apps, Starter Apps, and Custom Apps

Sample Apps and Starter Apps are available with every Oracle APEX workspace.
Custom Apps are only available if your instance administrator has enabled them.

You can access the Gallery from the top menu or by typing Gallery in the spotlight
search. The Gallery includes three types of applications:

e Sample Apps - built with sample data that highlight specific functionality. You can
use them as a developer guide for how particular features work.

e Starter Apps - fully functional apps that provide standalone solutions for simple
requirements. You can use them as is or extend them with custom functionality.

e Custom Apps - specific to your workspace. They are only available if your
instance administrator has enabled them.

You can install Sample Apps, Starter Apps, and Custom Apps directly from the Gallery.
You can also download Sample Apps and Starter Apps from GitHub to import into your
workspace.

¢ See Also:

e Importing an Application, Page or Component Export

e Configuring the Gallery in Oracle APEX Administration Guide

2.9.2 About the Oracle APEX GitHub Repository

The Oracle APEX GitHub repository contains Starter Apps, Sample Apps, sample
code, and plug-ins you can use in your workspace.

» Navigating the GitHub Repository
Use the GitHub repository to access documentation, license information (if
applicable), and installation files for Sample and Starter Apps.

2.9.2.1 Navigating the GitHub Repository

ORACLE

Use the GitHub repository to access documentation, license information (if applicable),
and installation files for Sample and Starter Apps.

The Oracle APEX GitHub repository can be accessed at https://github.com/oracle/
apex. The repository contains information you can use to customize apps:

* docs contains the installation source file.
* plugins contains examples for APEX plug-ins.
* sample-apps contains the sample apps found in the Gallery.

* sample-code contains code examples for APEX functionality.

2-38


https://github.com/oracle/apex
https://github.com/oracle/apex

Chapter 2
Using the App Gallery

starter-apps contains the starter apps found in the Gallery.

To access GitHub from an APEX workspace:

1.
2.

6.

Navigate to the Workspace home page.

Click the Gallery icon.

The Gallery page opens, displaying cards for Sample Apps. Starter Apps, and Custom
Apps.

Choose either Sample Apps or Starter Apps.

Click the More Info button to access GitHub.

The GitHub directory for the app opens.

All files associated with the app including the README, licenses (if applicable), and
installation files are available for viewing.

The README contains instructions for installing the app.

Download the files you need.

You can now install the app.

2.9.3 Installing Apps from the Gallery

Install Sample and Starter Apps directly from the Gallery by clicking Install.

Sample and Starter Apps can be installed from the Gallery. Custom Apps can be installed
from the Gallery if they have been enabled by your instance administrator.

To install apps from the Gallery:

1.
2.

6.

Navigate to the Workspace home page.
Click the Gallery icon.

The Gallery page opens, displaying cards for Sample Apps, Starter Apps, and Custom
Apps.

Choose Sample Apps or Starter Apps.

The apps are listed as cards. Each card has an Install button unless the app has already
been installed. If the app is already installed, it has a Remove App icon and a Run icon.

Click Install App to install the app.
(Optional) Expand the Advanced Settings section.

a. Specify whether the Application ID will be assigned automatically (default) or
manually.

b. Modify the Parsing Schema.

Click Install Application to complete the installation.

The installed app opens in the Application home page.

ORACLE
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¢ See Also:

* Importing an Application, Page or Component Export

e Editing Pages in Page Designer

2.9.4 Uninstalling Apps from the Gallery

Uninstall Sample and Starter Apps directly from the Gallery by clicking the Remove
App icon.

Sample and Starter Apps can be easily uninstalled from the Gallery.

Only apps that were installed from the Gallery can be uninstalled this way. Apps that
were downloaded from GitHub and imported will not display an uninstall icon and must
be deleted to be removed from the workspace.

© Important:

Any customizations that were made to the app will be lost after the app is
uninstalled. These customizations will not be restored if the app is
reinstalled.

To uninstall apps from the Gallery:
1. Navigate to the Workspace home page.
2. Click the Gallery icon.

The Gallery page opens, displaying cards for Sample Apps, Starter Apps, and
Custom Apps.

3. Choose Sample Apps or Starter Apps.

Any apps that were installed directly from the Gallery will display a Remove icon
and a Run icon.

4. Click Remove to uninstall the app.
5. On the confirmation screen, click Remove.

The app is uninstalled. It can be reinstalled if needed.

" See Also:

Deleting an Application
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To efficiently use App Builder, developers must understand some key concepts including
managing user interface design, viewing rendered application pages, understanding page
processing and rendering, managing session state, understanding URL syntax, managing
session state values, and using built-in substitution strings.

e Understanding Applications
An Oracle APEX application is an HTML interface that exists on top of database objects
such as tables or procedures.

* Running an Application or Page
To view a rendered version of your application, you run or submit it to the Oracle APEX
engine. The APEX engine dynamically renders and processes pages based on data
stored in database tables.

* How Does Page Processing and Page Rendering Work?
Learn how the Oracle APEX engine renders and processes pages, when APEX issues
implicit commits, how conditional rendering and processing works, and how to verify user
identity or control access to controls and components.

e About Enabling Support for Bookmarks
Developers can assist users who bookmark application pages by either using zero as the
session ID, or enabling Rejoin Sessions.

e Understanding Session State Management
Oracle APEX transparently maintains session state and provides developers with the
ability to get and set session state values from any page in the application.

* Managing Session State
View session state and manage session state overrides from the Runtime Developer
toolbar which displays at the bottom of any editable page at runtime.

e Understanding URL Syntax
Oracle APEX applications support two types of URL syntax: Friendly URL Syntax and
f?p Syntax.

* Managing Session State Values
Manage session state to store and retrieve values for a user as the user navigates
between different application pages.

e Using Substitution Strings
Use substitution strings within templates, region source, or any attribute to pass
information and replace a character string with another value.

* Using Template Directives
Use template directives to control how attributes that support substitution strings are
processed.

3-1



Chapter 3
Understanding Applications

¢ See Also:

Understanding App Builder

3.1 Understanding Applications

ORACLE

An Oracle APEX application is an HTML interface that exists on top of database
objects such as tables or procedures.

About Applications

An application is a collection of pages linked together using navigation menus, tabs,
buttons, or hypertext links. Application pages share a common session state and
authentication.

To create an application, a developer runs the Create Application Wizard to
declaratively assemble pages and navigation. Individual pages are organized using
containers called regions. Regions can contain text, custom PL/SQL, reports, charts,
maps, calendars, web service content, or forms. Forms are made up of fields (called
items) which can be selected from the multitude of built-in types (such as text fields,
text areas, radio groups, select lists, checkboxes, date pickers, and popup list of
values).

Developers can also create their own custom item types using plug-ins. Session state
(or application context) is transparently managed and the user interface presentation is
separated from the application logic enabling developers to manage the look and feel
of an application by simply selecting a different theme.

What Is an Application Page?

A page is the basic building block of an application. Every application consists of one
or multiple pages. Each page can have buttons and fields (called items) which are
grouped into containers called regions. Pages can include application logic (or
processes). You can branch from one page to the next using conditional navigation;
perform calculations (called computations); perform validations (such as edit checks);
and display reports, calendars, and charts. You view and edit a page in Page
Designer.

# See Also:

e Creating Applications
e Understanding App Builder
e Editing Pages in Page Designer
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3.2 Running an Application or Page

To view a rendered version of your application, you run or submit it to the Oracle APEX
engine. The APEX engine dynamically renders and processes pages based on data stored in
database tables.

* Run Application and Run Page Buttons
Learn how to run pages individually, or run an entire application.

e How Your Browser Impacts the Way Applications Run
Learn about what determines if a running application displays in a new tab or new
browser window.

* Running an Application from the App Builder Home Page
Run an application from the App Builder home page.

e Running an Application from the Application Home Page
Run an application from the Application home page.

* Running a Page on the Application Home Page
Run an application page from the Application home page.

¢ See Also:

Running a Page from Page Designer

3.2.1 Run Application and Run Page Buttons

ORACLE

Learn how to run pages individually, or run an entire application.

Run Application Button

The Run Application button displays on the Application home page and features with a large
run (or play) button. To run the application from the application home page, click Run
Application.

O APEX App Builder SQL Workshop Team Development Gallery ). search 8& ® m
(%) Application 144 ® % &  [OEdtPages ®
Application 144 - Demonstration - EMP / DEPT Edit Application Definition About

Use the Application home page
to run, edit, import, export,
copy, or delete an application.
Select a page to edit the page

. properties, or click Create Page
@ E E to add & page to the application.

Learn More ...

Run Application Supporting Objects ~ Shared Components Utilities Export / Import

Tasks
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Run Page Button

The Run Page button resembles a small, black play button and displays in the upper
right corner of many pages within App Builder. Clicking the Run Page button runs the
current page or the last selected page.

O APEX  App Builder SQL Workshop Team Developme Gallery % & m
';' Application 144 S || &y [ Edit Page 5 ®
Application 144 - Demonstration - EMP / DEPT Edit Application Definttion About

Use the Application home page
torun, port, export,

lete an application.
Select a page to edit the page
properties, or click Create Page
to add a page to the application.

Run Application

Supporting Objects

Learn More ...

Shared Components Utilities Export / Import

Tasks

3.2.2 How Your Browser Impacts the Way Applications Run

Learn about what determines if a running application displays in a new tab or new
browser window.

When you run an application, the application displays in a new window. Whether that
new window is a new tab or new browser windows depends upon how you have
configured your web browser. If you are using Google Chrome or Apple Safari, the
running application displays in a new tab by default. If you are using Microsoft Edge or
Mozilla Firefox, the application displays in a new browser window by default. You can
further control how Oracle APEX manages tabs and windows when running an
application by editing your account preferences.

¢ See Also:

Editing User Preferences and Enabling Dark Mode

3.2.3 Running an Application from the App Builder Home Page

ORACLE

Run an application from the App Builder home page.

To run an application from the App Builder home page:
1. On the Workspace home page, click App Builder.

2. You can customize the App Builder home page by selecting the following icons in
the navigation bar:

*  View Icons (default)
* View Report

3. To run the application in Icon View:
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a.  On the navigation bar, click the View Icons icon:
Each application displays as a large icon identified by the application name.
b. Click Run Application at the top of the page.
4. To run the application in Report View:
a.  On the navigation bar, click the View Report icon:

Each application displays as a line in a report. Each line includes the application ID,
the application name, when the application was last updated, the page count, and
who last updated the application.

b. Click Run Page in the far right column.

¢ See Also:

How Your Browser Impacts the Way Applications Run

3.2.4 Running an Application from the Application Home Page

Run an application from the Application home page.

To run an application from the Application home page:

1. Onthe Workspace home page, click App Builder.
The App Builder home page appears.

2. Select an application.

3. Click Run Application in the middle of page.

The application displays in a new window.

¢ See Also:

How Your Browser Impacts the Way Applications Run

3.2.5 Running a Page on the Application Home Page

Run an application page from the Application home page.

To run a page from the Pages list:

1. Onthe Workspace home page, click App Builder.
2. Select an application.

3. Click the View Report icon.

Selecting View Report displays each page as a line in a report. Each line includes the
page number, the page name, when the page was last updated, who last updated the
page, the page type, the selected user interface, a lock icon, and a Run button.
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4. Locate the page you want to run.
5. Click Run Page in the far right column.

The application displays in a new window.

# See Also:

Locking and Unlocking a Page and How Your Browser Impacts the Way
Applications Run

3.3 How Does Page Processing and Page Rendering Work?

Learn how the Oracle APEX engine renders and processes pages, when APEX issues
implicit commits, how conditional rendering and processing works, and how to verify
user identity or control access to controls and components.

e How the APEX Engine Renders and Processes Pages
The Oracle APEX engine dynamically renders and processes pages based on
data stored in Oracle database tables.

e About Implicit Commit Points
Learn about when Oracle APEX issues implicit commits.

e Understanding Conditional Rendering and Processing
Use conditions in an application to control how pages and page components
display and when processes, computations, and validations execute.

e About Verifying User Identity
Authentication is the process of establishing users' identities before they can
access an application.

e About Controlling Access to Controls and Components
Learn about controlling access to controls and components.

3.3.1 How the APEX Engine Renders and Processes Pages

ORACLE

The Oracle APEX engine dynamically renders and processes pages based on data
stored in Oracle database tables.

To view a rendered version of your application, you request it from the APEX engine
with a URL. When you run an application, the APEX engine relies on two processes:

» Show Page - Show Page is a page rendering process that assembles all the page
attributes (including regions, items, and buttons) into a viewable HTML page.
When you request a page using a URL, the engine is running Show Page.

* Accept Page - Accept Page performs forms page processing, including
computations, validations, processes, and branching. When you submit a page,
the APEX engine is running Accept Page or performing page processing during
which it saves the submitted values in the session cache and then performs any
computations, validations, or processes.
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3.3.2 About Implicit Commit Points

Learn about when Oracle APEX issues implicit commits.

Oracle APEX issues implicit commits at the following points:

e Onload, after a page finishes rendering

e On submit, before branching to another page

e On submit, if one or more validations fail, before re-rendering the page

e After a computation

e After changing the value of an item, for example after a PL/SQL process that modifies a
bind variable value or when APEX UTIL.SET SESSION STATE is called.

e When APEX MAIL.PUSH QUEUE is called

# See Also:

SET_SESSION_STATE Procedure and PUSH_QUEUE Procedure in Oracle APEX
API Reference

3.3.3 Understanding Conditional Rendering and Processing

Use conditions in an application to control how pages and page components display and
when processes, computations, and validations execute.

A condition is a small unit of logic that helps you control the display of regions, items, buttons,
and tabs and the execution of processes, computations, and validations. For example, when
you apply a condition to a button, the rendering engine evaluates the condition during the
rendering (or Show Page) process. Whether the condition passes or fails determines if the
button displays.

You specify a condition by selecting a condition type. You can select a condition type when
you first create the control or component, or later when editing the control or component.

Depending upon the type of condition you select, you enter the appropriate values in the
fields provided. The condition evaluates to true or false based on the values you enter. Click
the select list to view a complete list of all available conditions for a given component or
control.

¢ See Also:

Available Conditions for a detailed listing of available condition types
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Example 3-1 Current Page is NOT in comma delimited list

Current Page is NOT in comma delimited list evaluates to true if the current page
number is contained within the comma-delimited list of pages provided. For example:

3,100,203

If the current page is 100, then this condition evaluates to true and the condition
passes.

Example 3-2 PLSQL Expression

Use PLSQL Expression to specify an expression in valid PL/SQL syntax that evaluates
to true or false. For example:

NVL(:MY ITEM,'NO') = 'YES'

If the value of :MY ITEMis YES, as in the previous example, then the condition
evaluates as true. If the value of :MY_ITEM is anything other than YES, then the
condition evaluates as false.

Example 3-3 Rows returned

Rows returned expressed as a SQL query. If the query returns one or more rows,
then the condition evaluates as true. For example:

SELECT 1 FROM employees WHERE department id = :P101 DEPTNO

This example references item P101_DEPTNO as a bind variable. You can use bind
variables within application processes and SQL query regions to reference items from
session state. If one or more employees are in the department identified by the value
of P101 DEPTNO, then the condition evaluates as true.

¢ See Also:

Referencing Session State Using Bind Variable Syntax

3.3.4 About Verifying User Identity

ORACLE

Authentication is the process of establishing users' identities before they can access
an application.

Authentication may require a user to enter a user name and password, or may involve
the use of a digital certificate or a secure key.

Oracle APEX supports modular authentication, making it easy to switch authentication
methods when needed. You can establish a user's identity by selecting from several
built-in authentication methods, or by using a wizard to create your own custom
authentication approach.
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¢ See Also:

Establishing User Identity Through Authentication

3.3.5 About Controlling Access to Controls and Components

Learn about controlling access to controls and components.

While conditions control the rendering and processing of specific controls or components on
a page, authorization schemes control user access. Authorization is a broad term for
controlling access to resources based on user privileges.

Authorization schemes use the identities established by authentication to grant privileges on
applications and objects within them. You can specify an authorization scheme for an entire
application, a page, or a specific page control such as a region, item, or button. For example,
you could use an authorization scheme to selectively determine which tabs, regions, or
navigation bar entries a user sees.

# See Also:

Providing Security Through Authorization

3.4 About Enabling Support for Bookmarks

Developers can assist users who bookmark application pages by either using zero as the
session ID, or enabling Rejoin Sessions.

In previous releases, if the pages within an application were public and did not require
authentication, you could assist users in bookmarking pages by using zero as the session ID.
Although this approach is still supported, Oracle APEX now includes a new feature called
Rejoin Sessions that enables developers to control this type of support at the page,
application, or instance-level.

" See Also:

About Rejoin Sessions

3.5 Understanding Session State Management

ORACLE

Oracle APEX transparently maintains session state and provides developers with the ability
to get and set session state values from any page in the application.

* What is Session State?
Session state enables developers to store and retrieve values for a user as the user
navigates between different application pages.
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*  About Session IDs
A session ID is a uniqgue number assigned a specific user for the duration of that
user's visit (or session).

*  What Is a Session?
A session is a logical construct that establishes persistence (or stateful behavior)
across page views.

3.5.1 What is Session State?

Session state enables developers to store and retrieve values for a user as the user
navigates between different application pages.

Hypertext Transfer Protocol (HTTP), the protocol over which HTML pages are most
often delivered, is a stateless protocol. A web browser is only connected to the server
for as long as it takes to download a complete page. Each page request is treated by
the server as an independent event, unrelated to any page requests that happened
previously or that may occur in the future. To access form values entered on one page
on a subsequent page, the values must be stored as session state. Oracle APEX
transparently maintains session state and provides developers with the ability to get
and set session state values from any page in the application.

3.5.2 About Session IDs

ORACLE

A session ID is a unique number assigned a specific user for the duration of that user's
visit (or session).

The Oracle APEX engine establishes the identity of the user for each page request
and the session ID to fetch session state from the database. The most visible location
of the session ID is in the URL for a page request. The session ID displays as the third
parameter in the URL:

* f?p URL Syntax:
https://apex.example.com/ords/f?p=392:3:13766599855150

e Friendly URL Syntax:

https://apex.example.com/ords/mycompany/r/hr-app/update-employees?
session=13766599855150

In both examples, the session ID is 13766599855150.

Another visible location is in the page's HTML POST data and indirectly in the contents
of a session cookie. This cookie is sent by the APEX engine during authentication and
is maintained for the life of the application (or browser) session.

APEX assigns new session IDs during authentication processing, records the
authenticated user's identity with the session ID, and continually checks the session ID
in each page request's URL or POST data with the session cookie and the session
record in the database. These checks provide users with flexibility and security.

While the session ID is the key to session state, the session cookie and the session
record safeguard the integrity of the session ID and the authentication status of the
user.
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¢ See Also:

Understanding URL Syntax

3.5.3 What Is a Session?

A session is a logical construct that establishes persistence (or stateful behavior) across
page views.

Each session is assigned a unigue identifier. The Oracle APEX engine uses this identifier (or
session ID) to store and retrieve an application's working set of data (or session state) before
and after each page view. Because sessions are entirely independent of one another, any
number of sessions can exist in the database at the same time. A user can also run multiple
instances of an application simultaneously in different browser programs.

Sessions are logically and physically distinct from Oracle database sessions used to service
page requests. A user runs an application in a single APEX session from sign in to sign out
with a typical duration measured in minutes or hours. Each page requested during that
session results in the APEX engine creating or reusing an Oracle database session to access
database resources. Often these database sessions last just a fraction of a second.

¢ See Also:

Viewing Active Sessions in Oracle APEX Administration Guide

3.6 Managing Session State

View session state and manage session state overrides from the Runtime Developer toolbar
which displays at the bottom of any editable page at runtime.

* Viewing Session State
View the Session page at runtime by clicking Session and then View Session State on
the Runtime Developer toolbar.

* Managing Session State Overrides
Access the Session Overrides dialog from the Runtime Developer tool bar to manage
session state values at runtime.
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See Also:

¢ Runtime Developer Toolbar
e Understanding Page Items
*  Managing Application Items
e About Using Collections

e Using Substitution Strings for information about referencing item values

3.6.1 Viewing Session State

View the Session page at runtime by clicking Session and then View Session State on
the Runtime Developer toolbar.

The Session page provides valuable information about the session in which the
application is currently running. Must of the behavior of an Oracle APEX application is
driven by values in session state. For example, a button may display conditionally
based on the value of an item session state. This section describes how to view
session state for a page.

To view the Session page:

1. Run the application as a developer.

2. Locate the Runtime Developer toolbar. By default, the Runtime Developer toolbar
displays at the bottom of the page.

ORACLE

3. On the Runtime Developer toolbar, click Session and then View Session State.

The Session page appears and displays the following information displays at the
center of the page.

Application - Identifies the application name.

Session - Displays the session ID for the current session.
User - Identifies the current user.

Workspace - Displays the current workspace ID.

Browser Language - Identifies the current browser language.

4. Configure the fields at the top of the page and click Set to alter the display:

Page - Locate a page. Enter a page number.

Find - Enter a case insensitive query. Use Find to search item name and item
value, or collection name (depending upon your view).

Rows - Select the number of items to display.

View - Select a session state report to view.
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3.6.2 Managing Session State Overrides

Access the Session Overrides dialog from the Runtime Developer tool bar to manage session
state values at runtime.

ORACLE

The Enable Session Overrides switch eanbles you to enable or disable all session values.
Likewise, every session value has a switch that enables you control session state value

overrides.

For example, if you need to translate an application you can change the Application
Language attribute. Another common use case for session overrides is to change the file
path values such as #aPP_FILES#. This type of change would redirect the URL to somewhere
else, like localhost:PORT for local development.

To access the Session Overrides dialog:

1.
2.

Run the application as a developer.

Locate the Runtime Developer toolbar. By default, the Runtime Developer toolbar
displays at the bottom of the page.

On the Runtime Developer toolbar, click Session and then Session Overrides.

In the Session Overrides dialog:

a.

b.

Enable Sessions Overrides - Use this switch to enable or disable all session values.

Globalization:

Application Language - Change the language of the current application for the
current user.

Document Direction- Change the document direction (Left to Right, Right to Left)
of the current application for the current user

Timezone - Change the timezone of the current application for the current user.

You can also edit these attributes in Globalization attributes. See Configuring
Globalization Attributes.

File Paths:

APEX Files #APEX FILES# - Enable this option to change the value of

#APEX FILES# to point to another location. #APEX FILES# determines the virtual
path the Web server uses to point to the static files when using the #APP FILES#
substitution string.

You can also edit this attribute in User Interface, Advanced. See Editing User
Interface Attributes.

Application Files #ApP_FILES# - Enable this option to change the value of
#APP_FILES# to point to another location. #APP_FILES# determines the virtual
path the web server uses to point to the images directory distributed with App
Builder. During installation, the virtual path is configured as /i/ . If you are
unsure, contact your administrator.

You can also edit this attribute in User Interface, Advanced. See Editing User
Interface Attributes.

Workspace Files #WORKSPACE FILES# - Enable this option to change the value of
#WORKSPACE FILES# to point to another location. #WORKSPACE FILES# references
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uploaded images, JavaScript, and cascading style sheets that are shared
over many applications within a workspace.

* Theme Files #THEME FILES# - Enable this option to change the value of
#THEME FILES# to point to another location. Use the #THEME FILES# tO
reference files which are stored with your theme definition

d. Additional Files:

» JavaScript URLs - Load additional JS file URLSs to this application for the
current user.

You can also edit this attribute in User Interface, JavaScript. See Editing
User Interface Attributes.

* CSS URLs - Load additional CSS file URLSs to this application for the
current user.

You can also edit this attribute in User Interface, CSS. See Editing User
Interface Attributes.

5. Exit the dialog:
» Click Save to save your changes.
» Click Reset to undo any changes.

» Click Cancel to exist dialog without making any changes.

3.7 Understanding URL Syntax

Oracle APEX applications support two types of URL syntax: Friendly URL Syntax
and f?p Syntax.

Tip:

Applications created using Application Express release 20.1 or later use
Friendly URL Syntax. You can change existing applications to use Friendly
URLSs by editing the Friendly URLSs attribute in the application definition. See
Enabling or Disabling Friendly URL Syntax.

e Understanding Friendly URL Syntax
Friendly URL Syntax creates a URL structure that identifies the address of Oracle
APEX, the application, the page, and uses standard web parameter syntax.

e Understanding f?p URL Syntax
f?p URL Syntax is a legacy syntax that creates a unique URL structure that
identifies the address of Oracle APEX, the application ID, page number, and
session ID.

* Hiding the Session ID on Public Pages
Hide the session ID in a URL by making a page public.

3.7.1 Understanding Friendly URL Syntax

Friendly URL Syntax creates a URL structure that identifies the address of Oracle
APEX, the application, the page, and uses standard web parameter syntax.
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< Note:

The Friendly URL Syntax described in this section is different from a vanity URL or
custom domain name. Configuring a vanity URL (or custom domain name) for your
APEX instance is typically done at the web server or load balancer-level and is not
discussed in this publication.

Tip:

Applications created using Application Express release 20.1 or later use Friendly
URL Syntax. You can revert to f?p Syntax by disabling the Friendly URLSs attribute.

e About Friendly URL Syntax
Friendly URL Syntax uses a standard URL hierarchy and passes parameters in a similar
fashion to other web applications.

* Enabling or Disabling Friendly URL Syntax
Determine if an application uses Friendly URL Syntax or f?p Syntax by enabling or
disabling the Friendly URLSs attribute.

e Customizing a Friendly URL
Customize a Friendly URL by editing the Path Prefix, Application Alias, or Page Alias.

3.7.1.1 About Friendly URL Syntax

ORACLE

Friendly URL Syntax uses a standard URL hierarchy and passes parameters in a similar
fashion to other web applications.

Friendly URL Hierarchy and Syntax

Friendly URL Syntax creates a URL with the following directory hierarchy and syntax:

https://hostname:port/ords/r/path prefixapp alias/page alias?parameters

Friendly URL Example

https://hostname:port/ords/r/mycompany/hr-app/update-employees?
session=13766599855150

Where:
* https: stands for HyperText Transfer Protocol and operates at the application layer.

e hostname is the domain name of the server. It can also include a port number or an IP
address.

* port is the port number assigned when configuring Oracle REST Data Services.
* ords is the service name defined when configuring Oracle REST Data Services.

» risthe router shortcut. This value is a constant and should never be changed.

3-15



ORACLE

Chapter 3
Understanding URL Syntax

* mycompany iS the path prefix which is URI path prefix used to access RESTful
Services. When you create a workspace, this value defaults to workspace name.
You can customize the URI path prefix by editing the Path Prefix attribute in
Administration, Manage Service, Workspace Preferences, SQL Workshop.

* hr-appisthe app alias.In anew application, the Application Alias defaults to the
application Name. You can edit the Application Alias in the application Definition.
The Application Alias must be unique within the workspace.

* update-employees is the page alias. In a new application, the Page Alias defaults
to the page Name. You can edit the Page Alias in Page Designer. Page aliases
must be unique within the application. When creating a new page, if a Page Name
is already used as a Page Alias, then a numeric value is appended to the new
Page Alias to make it unique.

e ?session=13766599855150 identifies the session ID. When you run an application,
the Oracle APEX engine generates a session number that serves as a key to the
user's session state.

About URL Parameters
The part of the URL after /? can list parameters.

http://hostname:port/ords/r/path prefix/app alias/page alias?
parameters (Such as —

p7 customer id=377&clear=7&session=1247058356345&cs=3MdkfQa9NLmkyHAbWGP
g3U-nmA7XIw5sWjU2rMzSvOy wPl z7BBI-Gbh2JgvifARgcYJy8id4VtL3d011tYmOw)

Supported parameters include:
* session

° request

e clear

* debug

°* application/page items
* printerFriendly

° trace

* timezone

e lang

* territory

* cCs
e dialogCs
o x01
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¢ See Also:

e Understanding Session State Management

e About Publishing an Application URL

3.7.1.2 Enabling or Disabling Friendly URL Syntax

Determine if an application uses Friendly URL Syntax or f?p Syntax by enabling or disabling
the Friendly URLSs attribute.

Applications created using Oracle APEX release 20.1 or later use Friendly URL Syntax. You
can revert to f?p Syntax by disabling the Friendly URLs attribute.

To enable Friendly URL Syntax:
1. On the Workspace home page, click the App Builder icon.
2. Select an application.
The Application home page appears.
3. Navigate to the Edit Application Definition page. Navigation options include:
* Click the Edit Application Definition button.
* From Shared Components:
— Click Shared Components.
— Under Application Logic, click Application Definition.
The Definition page appears.
4. Under Properties, configure the Friendly URLSs attribute:

* On - If set to On, application uses Friendly URLs Syntax in which the URL consists of
a directory structure based on the Application Alias, Page Alias, and standard web
parameter syntax.

o Off - If set to Off, the application uses f?p= Syntax.
5. Click Apply Changes to save your changes.

3.7.1.3 Customizing a Friendly URL

ORACLE

Customize a Friendly URL by editing the Path Prefix, Application Alias, or Page Alias.

Friendly URL Syntax creates a URL with the following directory hierarchy and syntax:

https://hostname:port/ords/r/path prefix/app alias/page alias?parameters

You can customize the follow parts of Friendly URL:

» Path Prefix - path prefixis URI path prefix to be used to access RESTful Services.
When you create a workspace, this value defaults to workspace name. You can
customize the URI path prefix by editing Path Prefix attribute in Workspace
Administration.
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* Application Alias - app alias is an alternate alphanumeric application identifier
called the Application Alias. In a new application, the Application Alias defaults to
the application Name. You can edit the Application Alias in the application
Definition.

» Page Alias - page _alias is an alphanumeric alias for this page called the Page
Alias. In a new application, the Page Alias defaults to the page Name. You can edit
the Page Alias in Page Designer.

Friendly URL Customization Example

Suppose you have an application with the following URL:

http://hostname:port/ords/r/example/355/2?session=13766599855150

Suppose you want to make the following changes:
* path prefix- Change example t0 mycompany.
* app alias- Change 355 to myapp .

* page alias-Change 2 to myinfo.

The revised URL will display as:

http://hostname:port/ords/r/mycompany/myapp/myinfo?
session=13766599855150

To customize a Friendly URL by editing the Path Prefix, Application Alias, or Page
Alias:

1. Sign into Oracle APEX.
2. To change the Path Prefix:

a. Navigate to the Workspace Administration page. At the top of the Workspace
home page, click the Administration menu and select Administration.

b. On the Workspace Administration home page, click Manage Service and then
click Set Workspace Preferences.

c. Scroll down to SQL Workshop.

d. In Path Prefix, enter a new Path Prefix. In a new workspace, Path Prefix
defaults to the workspace name. For example change the Path Prefix to
mycompany.

Tip:

Path Prefix only displays if Enabled RESTful Services is set to Yes.

e. Click Apply Changes to save your changes.
Manage Service page appears.

f. Return to the Workspace home page. Click the APEX logo (Oracle APEX
Home) in the upper left corner.

3. To change the Application Alias:
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a. On the Workspace home page, click the App Builder icon.

b. Select the application.

c. On Application home page, click the Edit Application Definition button.
The application Definition page appears.

d. Under Name, edit the Application Alias attribute. For example, enter nyapp.

e. Click Apply Changes to save your changes.

To change the Page Alias:

a. View the page in Page Designer.

b. In either the Rendering tab, select the page name.

c. Inthe Property Editor, find the Identification group.

d. Under Identification, Page Alias attribute - Enter an alphanumeric alias for this page.
For example, enter myinfo.

e. To save your changes, click Save or Save and Run Page.
Run the page. Click or Save and Run Page.

The revised URL displays as:

http://hostname:port/ords/r/mycompany/myapp/myinfo?session=13766599855150

¢ See Also:

Enabling RESTful Services and Defining a Path Prefix for a Workspace in Oracle
APEX Administration Guide

3.7.2 Understanding f?p URL Syntax

f?p URL Syntax is a legacy syntax that creates a unique URL structure that identifies the
address of Oracle APEX, the application ID, page number, and session ID.

ORACLE

About f?p URL Syntax
f?p URL Syntax creates a unique URL structure that identifies the location and address of
Oracle APEX, the application ID, page number, and session ID.

About Using f?p Syntax to Link Pages
Create links between application page using £?p syntax.

Calling a Page Using an Application Alias or Page Alias
Use URL syntax to call a page using an application alias and/or page alias.

Calling a Page from a Button URL
Use URL syntax to call a page from a button URL.
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3.7.2.1 About f?p URL Syntax

f?p URL Syntax creates a unique URL structure that identifies the location and
address of Oracle APEX, the application ID, page number, and session ID.

f?p URL Structure and Syntax

f?p URL Syntax creates a URL with the following structure and syntax:

https://hostname:port/ords/f?p=app id:page number:session id

f?p URL Example

https://hostname:port/ords/f?2p=392:3:13766599855150

This example indicates:

* https: stands for HyperText Transfer Protocol and operates at the application
layer.

*  hostname is the domain name of the server. It can also include a port number or an
IP address.

* port is the port number assigned when configuring Oracle REST Data Services.
e ords is the service name defined when configuring Oracle REST Data Services.

e f?p=is a prefix used by Oracle APEX to route the request to the correct engine
process.

* 392 isthe ID of the application being called. The application ID is a unique number
that identifies each application.

* 3 is the number of the page within the application. Page number must be unique
within the application.

° 13766599855150 is the session number. When you run an application, the APEX
engine generates a session number that serves as a key to the user's session
state.

¢ See Also:

¢ Understanding Session State Management

e About Publishing an Application URL

3.7.2.2 About Using f?p Syntax to Link Pages

Create links between application page using f?p syntax.

App Builder includes many wizards that automatically create these references for you.
However, you may have to create the syntax yourself in some situations.
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To create links between pages in an application, use the following £?p syntax:

f?p=App:Page:Session:Request:Debug:ClearCache:itemNames:itemValues:PrinterFriendly

The following table describes the arguments you can pass when using f2p syntax.

Table 3-1 f?p Syntax Arguments

Syntax

Description

App

Page

Session

Request

Debug

ORACLE

Indicates an application ID or alphanumeric application alias.

An application alias is a unique alternate alphanumeric application identifier
that developers can use in place of the application ID. You define an
Application Alias editing the Application Definition.

See Also: Managing Application Attributes

Indicates a page number or alphanumeric page alias.

A page alias is a unique alternate alphanumeric for a page number.
Developers can use a page alias in place of the page number ID. You define a
Page Alias by editing the page attributes.

See Also: Managing Page Attributes
Identifies a session ID. You can reference a session ID to create hypertext

links to other pages that maintain the same session state by passing the
session number. You can reference the session ID using the syntax:

e Short substitution string: §SESSION.

e PL/SQL:V('SESSION')

»  Bind variable: :APP_SESSION

Sets the value of REQUEST. Each application button sets the value of REQUEST
to the name of the button which enables accept processing to reference the
name of the button when a user clicks it. You can reference REQUEST using
the syntax:

. Substitution string: §REQUEST.

e PL/SQL: V('REQUEST'")

e Bind variable: :REQUEST

Displays application processing details. Valid values for the DEBUG flag
include:

« YES.
. LEVELn
. NO

Setting this flag to YES displays details about application processing. Setting
this flag to LEVELn (where n is between 1 and 9) controls the level of debug
detail that displays. The value of YES equals LEVEL4.

You can reference the Debug flag using the following syntax:

e Short substitution string: §DEBUG.

e PL/SQL: V('DEBUG")

e Bind variable: : DEBUG

See Also: Debugging an Application
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Table 3-1 (Cont.) f?p Syntax Arguments

- _________________________________________________________________________|
Syntax Description

ClearCache Clears the cache. This sets the value of items to null.
To clear cached items on a single page, specify the numeric page number. To
clear cached items on multiple pages, use a comma-separated list of page
numbers. Clearing a page's cache also resets any stateful processes on the
page. Individual or comma-separated values can also include collection
names to be reset or the keyword RP, which resets region pagination on the
requested page. The keyword APP clears cache for all pages and all
application-level items in the current application and removes sort preferences
for the current user. The keyword SESSION achieves the same result as the
APP keyword, but clears items associated with all applications that have been
used in the current session.

See Also: Clearing Session State
itemNames Comma-delimited list of item names used to set session state with a URL.

itemValues List of item values used to set session state within a URL. To pass a comma
in an item value, enclose the characters with backslashes. For example:

\123,45\

Every character sequence except backslash comma (\,) can be enclosed
with backslash.

PrinterFriendly Determines if the page is being rendered in printer friendly mode. If
PrinterFriendly is set to Yes, then the page is rendered in printer friendly
mode. The value of PrinterFriendly can be used in rendering conditions to
remove elements such as regions from the page to optimize printed output.

You can reference the printer friendly preference by using the following
syntax:

V('PRINTER FRIENDLY')

When referenced, the page displays using a printer friendly template. The
APEX engine displays all text within HTML form fields as text. The printer
friendly template does not need to have the #FORM_OPEN# or #FORM CLOSE#
tags. The objective is to be able to display information with few tables and in a
format suitable for printing.

3.7.2.3 Calling a Page Using an Application Alias or Page Alias

Use URL syntax to call a page using an application alias and/or page alias.

Application and page aliases must consist of valid Oracle identifiers, cannot contain
any whitespace, and cannot be case-sensitive. The following example calls a page
from within an application using an application alias and a page alias. This example
runs the page home of the application myapp and uses the current session ID.

f?p=myapp: home: &APP SESSION.

Application aliases must be unique within a workspace. If an application in a different
workspace has the same application alias, use the &c argument to specify the
workspace name. For example:

f?p=common_alias:home:&APP SESSION.&C=WORKSPACE A
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3.7.2.4 Calling a Page from a Button URL

Use URL syntax to call a page from a button URL.

When you create a button, you can specify a URL to redirect to when the user clicks the
button. This example runs page 6001 of application 6000 and uses the current session ID.

£?p=6000:6001:&APP_SESSION.

Note that this is only one approach to using a button. This method bypasses page
submission and acts as a hyperlink on the page. You can also have a button click submit a
page. In that approach, clicking the button submits the page for processing, allowing forms to
be submitted and session state to be saved.

¢ See Also:
Managing Buttons and APP_SESSION

3.7.3 Hiding the Session ID on Public Pages

ORACLE

Hide the session ID in a URL by making a page public.

By default, all pages require Authentication. However, if a page is public and the user has not
signed in, the page URL will not display the session ID.

Tip:

For security reasons, Oracles recommends that administrators disable Rejoin
Sessions unless they implement workspace isolation by configuring the Allow
Hostname attribute at the workspace or instance-level. See About Isolating
Workspaces.

To specify a page as public:
1. On the Workspace home page, click the App Builder icon.
2. Select an application.
3. Atthe Application-level, edit the Rejoin Session attribute:
a. Click the Edit Application Definition button.
The Application Definition appears.
b. Click Security.
c. Session Management, Rejoin Sessions - Select Enabled for Public Sessions.
d. Click Apply Changes to save your changes.
4. Atthe page-level, edit the Authentication attribute:
a. View the page in Page Designer.

The Application Definition appears.
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b. Inthe Rendering tab, select the page name.
c. Security, Authentication - Select Page is Public.

d. Click Apply Changes to save your changes.

¢ See Also:

e About Rejoin Sessions
e About Enabling Support for Bookmarks
¢ Session Management
e Configuring Rejoin Sessions for a Page

e Configuring Rejoin Sessions for an Instance in Oracle APEX
Administration Guide

3.8 Managing Session State Values

Manage session state to store and retrieve values for a user as the user navigates
between different application pages.

When building interactive, data-driven web applications, the ability to access and
manage session state values is critical. In Oracle APEX, session state is automatically
managed for every page and easily referenced in static HTML or logic controls such as
processes or validations.

* About Referencing Session State
Reference item values stored in session state in regions, computations,
processes, validations, and branches. An item can be a field, a text area, a
password, a select list, or a checkbox.

* About Setting Session State
Set session state using form submissions, bind variables, computations, or f?p
syntax. Session state can also be set using the APEX SESSION STATE.SET APIs.

» Clearing Session State
Clearing a cached value resets the value to null. You can clear the cached value
for specific items, all items on a page, all pages in an application, or the current
user session.

» Referencing Session State Using Bind Variable Syntax
Use bind variable syntax anywhere where you are using SQL or PL/SQL to
reference session state of a specified item.

*  About Session Cloning
Use session cloning to open a new browser window in an Oracle APEX application
and have it generate a new distinct session identifier and copy the session values
from the original APEX session to the new one.
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¢ See Also:

Understanding Session State Management and Referencing Item Values

3.8.1 About Referencing Session State

Reference item values stored in session state in regions, computations, processes,
validations, and branches. An item can be a field, a text area, a password, a select list, or a
checkbox.

The following table describes the supported syntax for referencing item values.

Table 3-2 Syntax for Referencing Item Values
|

Type Syntax Description
SQL Standard item syntax: For items whose names are no longer than 30 characters,
‘MY ITEM precede the item name with a colon (:). Use this syntax for

. o references within a SQL query and within PL/SQL.
Syntax for items containing

special characters: To reference page items containing special, multibyte, or

unicode characters, wrap the page item name in double

:"MY_ITEM" quotation marks.
The data type of the bind variable is the Session State Data
Type of the item. Most items are VARCHAR? by default, but
certain item types can be set to CLOB.
PL/SQL V('MY ITEM') or Use PL/SQL syntax to reference an item value using the vV
APEX SESSION STATE.GET V function. You can use the shorthand, V function, in place of
ARCHARZ ('MY ITEM') APEX SESSION STATE.GET VARCHARZ.
Use this syntax when utilizing Oracle APEX variables directly
within an Oracle database object, such as a function, trigger,
or Oracle Data Redaction policy.
Tip: When using V ('MY ITEM'),
apex session state.get clob('MY ITEM') or similarin
a SQL query, Oracle recommends using Fast Dual
functionality => (select v('my item') from dual) to
improve performance.
PL/SQL APEX SESSION STATE.GET C This function returns the value of a CLOB page item.
LOB('MY_CLOB_ITEM') Tip: When using V ('MY ITEM'),

apex session state.get clob('MY ITEM') or similarin
a SQL query, Oracle recommends using Fast Dual
functionality => (select v('my item') from dual) to
improve performance.

PL/SQL APEX SESSION STATE.GET N This function returns the value of a page item as a NUMBER.
UMBER ('MY NUMERIC ITEM') The item's Format Mask is used to perform the conversion.
Tip: When using V('MY ITEM'),
apex session state.get clob('MY ITEM') or similarin
a SQL query, Oracle recommends using Fast Dual
functionality => (select v('my item') from dual) to
improve performance.
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Table 3-2 (Cont.) Syntax for Referencing Item Values

Type

Syntax

Description

PL/SQL

Static text (exact)

APEX_SESSION STATE.GET T
IMESTAMP ('MY NUMERIC ITE
M')

Standard item syntax:
&MY ITEM.

Syntax for items containing
special characters:

This function returns the value of a page item as a
TIMESTAMP. The item's Format Mask is used to perform the
conversion.

Tip: When using V ('MY ITEM'),

apex session state.get clob('MY ITEM') or similarin
a SQL query, Oracle recommends using Fast Dual
functionality => (select v('my item') from dual) to
improve performance.

For static text or an exact substitution, use the convention
&ITEM NAME followed by a period (.).

To reference page items containing special, multibyte, or
unicode characters, wrap the page item name in double
quotation marks.

&"MY_ITEM".

- Page items of Session State Data Type CLOB cannot be
references via this syntax. A different output mechanism must
be used to fetch their values, such as a page item in Read
Only mode, a Display Only page item, or its manual output
using a Dynamic Content region.

# See Also:

Changes in Oracle APEX API Reference in Oracle APEX API Reference

3.8.2 About Setting Session State

Set session state using form submissions, bind variables, computations, or f?p syntax.
Session state can also be set using the APEX SESSION STATE.SET APIs.

ORACLE

¢ See Also:

Changes in Oracle APEX API Reference in Oracle APEX API Reference

Methods for Setting Session State

You can set the value of a page item in your application and therefore set session
state using the following methods:

Form submission. See the next section.

Bind variable. See Referencing Session State Using Bind Variable Syntax.

Computation. See Understanding Application Computations.

f?p syntax. See About Using f?p Syntax to Link Pages.
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About Setting Session State with a Form Submission

When a user submits a page, the Oracle APEX engine automatically stores values typed into
fields (items) in session state. For example, suppose you have an application containing two
pages. The first page of the application contains a form in which a user can enter a phone
number. You defined this form by creating an item named P1_PHONENO. On the second page,
you want to display the information the user enters in the form.

When the page is submitted, APEX captures the value entered in the phone number field and
stores the value for future use. On the second page, the phone number entered by the user
can then be retrieved from session state using the name P1_PHONE NO with the appropriate
syntax from Table 3-2.

About Controlling How Items Write Session State

You can control whether a page item writes its session state into persistent (disk) session
state or just into memory by configuring the item attribute, Maintain Session State. Available
Maintain Session State options include:

* Per Request (Memory Only) - Do not save state in the database. State is only available
when processing the current request. When AJAX requests need to use an item, make
sure to pass the item name using the Page Items To Submit attribute.

» Per Session (Disk) - Maintain for each session by storing the value in the database, to
access it across requests.

* Per User (Disk) - Value is saved in a user attribute repository and it is also available for
later APEX sessions.

¢ Note:

When creating database items that work with a Form region (for example as part of
a wizard), Per Request (Memory Only) is the default. Per User (Disk) is not
available for these items.

" See Also:

Controlling How Page Items Write Session State

3.8.3 Clearing Session State

ORACLE

Clearing a cached value resets the value to null. You can clear the cached value for specific
items, all items on a page, all pages in an application, or the current user session.

e About Clearing Cache for an Item
View examples for clearing cache for a single item.

*  About Clearing Cache for All Page ltems
View examples for clearing cache for all page items.

* About Clearing Report Regions
Learn about clearing report cache.
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» Clearing Cache for an Entire Application
View an eample of clearing cache for an application.

» About Resetting an Application Completely
Learn about resetting an application completely.

* About Clearing Cache for the Current User Session
View an example of clearing application cache for the current user session.

3.8.3.1 About Clearing Cache for an Item

View examples for clearing cache for a single item.

Clearing cache for a single item resets the value of the item to null. For example, you
might use this approach to make sure a specific item's value is null when a page is
prepared for rendering.

Example 3-4 Example: Clearing Cache for an Item

The following example uses standard f2p syntax to clear the cache for an item. This
example calls page 5 of application 100. Placing MY ITEM in the ClearCache position of
the £2p syntax resets the value of My ITEM to NULL.

£?p=100:5:&4APP_SESSION.::NO:MY ITEM

The following example resets the value of the items THE _EMPNO and THE DEPTNO:

£2p=100:5:&APP_SESSION.::NO:THE EMPNO, THE DEPTNO

3.8.3.2 About Clearing Cache for All Page Items

ORACLE

View examples for clearing cache for all page items.

Caching application items is an effective way to maintain session state. However, there
are occasions when you may want to clear the cache for all items on a page. For
example, suppose you needed to clear all fields on a page when a user clicks a link
that creates a new order. By clearing the cache for an entire page, you set the value of
all items on the page to null.

Example 3-5 Example: Clearing Cache for Two Pages and Resetting Pagination

This example clears the session cache for two pages and resets pagination.

£2p=6000:6003:&APP_SESSION.::NO:RP,6004,6014

This example:
* Runs page 6003 of application 6000 and uses the current session ID.
* Indicates to not show debug information (N0).

» Clears all values maintained by the current session's cache for items of pages
6004 and 6014.

* Resets region pagination (RP) on page 6003 (the requested page).
Example 3-6 Example: Clearing Cache on a Page and Passing an Item Value

This example shows how to implement an update form. It clears existing information
and sets the item's value (typically a primary key).

£?p=6000:6003:&APP SESSION.::NO:6003:MY ITEM:1234
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This example:

* Runs page 6003 of application 6000 and uses the current session ID

* Indicates to not show debug information (N0)

e Clears all values maintained by the current session's cache for items on page 6003
»  Sets the session state of an item called My ITEM to the value 1234

Example 3-7 Example: Clearing Session Cache on a Page and Passing Values to
Multiple Items

This example demonstrates how to implement an update form. It clears existing information,
sets the item's value (typically a primary key), and passes values to multiple items.

£2p=6000:6004:&APP_SESSION.::NO:6003:MY ITEMI1,MY ITEM2,MY ITEM3:1234,,5678

This example:

* Runs page 6004 of application 6000 and uses the current session ID
e Clears the current session's cache for items on page 6003
e Indicates to not show debug information (N0)

» Sets the value of MY ITEMI to 1234, sets the value of MY ITEM?2 to null (indicated by the
comma used as placeholder), and sets the value of MY ITEM3 to 5678

3.8.3.3 About Clearing Report Regions

Learn about clearing report cache.

Report settings can be cached. Depending on the report types, different settings are cached.
Use the following to clear report cache settings:

° RR - Resets interactive report, interactive grids, or classic report and also resets report
pagination. If the target page contains interactive report or interactive grids, the report is
returned to the default report settings specified by the developer or saved by the user. If
the target page contains classic report, the report sorting resets to developer defined
sorting.

* CR- This applies only to interactive report. CR clears interactive report and resets report
pagination. This clears all of the session report settings such as control break, aggregate,
flashback, chart, number of rows to display, filter, highlight, computation, group by, and
pivot.

* RP - Resets interactive report or classic report pagination.

Example 3-8 Resetting Report Settings and Pagination

This example resets report settings and pagination of the target page report regions:

£2p=6000:6003:&APP_SESSION.::NO:RR

¢ Note:

Starting with Oracle APEX release 2.1, you do not need to define separate clear
cache syntax to reset report and reset pagination. RR will handle both.
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3.8.3.4 Clearing Cache for an Entire Application

View an eample of clearing cache for an application.

This example clears the application's cache by using f?p syntax and creating a Clear
Cache argument using the keyword APP.

f?p=RApp:Page:Session: :NO:APP

3.8.3.5 About Resetting an Application Completely

Learn about resetting an application completely.

Resetting the cache for an entire application does not restore the application to a
completely reset state. For example, if an application includes on-new instance
computations or on-new instance processes, the Oracle APEX engine runs these
computations and processes when the application session is created. Then, it
processes the clear cache request and displays the requested page.

To reset an application completely without a session ID (if no cookie is used to track
the session ID), you must request it using a URL without a session ID, or by calling
APEX UTIL.CLEAR APP CACHE from another application. If the session ID is tracked
using a cookie, you must logout to reset the state.

3.8.3.6 About Clearing Cache for the Current User Session

View an example of clearing application cache for the current user session.

Another approach to clearing an application's cache is to create a Clear Cache
argument using the keyword SESSTION. For example:

£?p=6000:6004:12507785108488427528: :NO:SESSION

3.8.4 Referencing Session State Using Bind Variable Syntax

Use bind variable syntax anywhere where you are using SQL or PL/SQL to reference
session state of a specified item.

e About Using Bind Variable Syntax
Learn about bind variable syntax.

» About Using Bind Variables in Regions Based on a SQL Query or LOV
Learn about using bind variables in regions defined as a SQL Query, SQL Query
(plsqgl function body returning SQL query), or list of values (LOV).

* About Using Bind Variables in Regions Based on PL/SQL
Learn about using bind variables in regions based on PL/SQL.

3.8.4.1 About Using Bind Variable Syntax

Learn about bind variable syntax.

In the following example, the search string is a page item.

SELECT * FROM employees WHERE last name like '%' || :SEARCH STRING || '%'
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If the region type is defined as SQL Query, you can reference the value using standard SQL
bind variable syntax. Using bind variables ensures that parsed representations of SQL
gueries are reused by the database, optimizing memory usage by the server.

When using bind variable syntax, remember the following rules:

e Bind variable names must correspond to an item name.
e Bind variable names are not case-sensitive.

e Bind variable names cannot be longer than 30 characters (that is, they must be a valid
Oracle identifier).

Although page item and application item names can be up to 255 characters, if you
intend to use an application item within SQL using bind variable syntax, the item name
must be 30 characters or less.

e The data type of bind variables is always VARCHAR2. When a bind variable semantically
contains a datetime or numeric value, you must perform an explicit conversion to the
appropriate data type. For example:

SELECT * FROM employees WHERE start date < to date(:DATE STRING, 'DD-MON-
YYYY')

3.8.4.2 About Using Bind Variables in Regions Based on a SQL Query or LOV

Learn about using bind variables in regions defined as a SQL Query, SQL Query (plsql
function body returning SQL query), or list of values (LOV).

If your region type is defined as a SQL Query, SQL Query (plsgl function body returning SQL
query), or list of values (LOV), you can reference session state using the following syntax:

:MY ITEM
One common way to do this is to incorporate a session state variable in a WHERE clause. The

following example shows how to bind the value of the item THE DEPTNO into a region defined
from a SQL Query.

SELECT last name, job id, salary
FROM employees
WHERE department id = :THE DEPTNO

¢ See Also:

About Regions for information about creating regions

3.8.4.3 About Using Bind Variables in Regions Based on PL/SQL

ORACLE

Learn about using bind variables in regions based on PL/SQL.

For region types, processes, computations, validations, conditions, and so on that are defined
as PL/SQL dynamic content, regions are constructed using PL/SQL anonymous block syntax.
In other words, the beginning and ending keywords are used to enclose the PL/SQL block.
For example:
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IF :P1 JOB IS NOT NULL THEN
INSERT INTO employees (employee id, first name, job_ id)
VALUES (:Pl_EMP_ID, :P1 NAME, :P1 JOB)

end if;

In this example, the values of the employee id, first name, and job id are populated
by the values of P1_EMP ID, P1 NAME, and P1_JOB.

3.8.5 About Session Cloning

Use session cloning to open a new browser window in an Oracle APEX application
and have it generate a new distinct session identifier and copy the session values from
the original APEX session to the new one.

In previous releases, opening multiple windows (or browser tabs) in the same APEX
application resulted in a number of issues. Typically, all the browser tabs shared the
same session and session state which resulted in unpredictable and undesirable
results.

To use session cloning, the developer must provide a method for end user to open a
new browser tab and specify the REQUEST value of APEX CLONE_SESSION. The following
is an example URL:

£?p=&APP_ID.:&APP PAGE ID.:&APP SESSION.:APEX CLONE SESSION

Best Practices When Using Session Cloning
When using this session cloning, developers should remember:

* The idle time associated with the Oracle APEX session would be affected by any
of the APEX sessions, original or cloned ones.

*  When a user logs out of one session (original or cloned), all other associated
sessions will be logged out.

*  The maximum session duration would be a function of the original APEX session
and when it was created.

* An administrative user can enable or disable this feature using the procedure:

apex_instance admin.set parameter (
p_parameter => 'CLONE SESSION ENABLED',
p_value => 'Y");

¢ See Also:
Oracle APEX API Reference

3.9 Using Substitution Strings

ORACLE

Use substitution strings within templates, region source, or any attribute to pass
information and replace a character string with another value.
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< Note:

If an attribute supports substitutions, Page Designer help includes the section called
Additional Information which describes the supported substitution strings. See
Viewing Help in Page Designer.

e About Using Substitution Strings
Learn about using substitution strings.

e Controlling Output Escaping in Substitution Strings
Learn about controlling output escaping in substitution strings.

e About Determining Substitution String Usage within Templates
Learn about determining substitution string usage within templates.

e Using Built-in Substitution Strings
Learn about built-in substitution strings available in App Builder.

3.9.1 About Using Substitution Strings

ORACLE

Learn about using substitution strings.
You can use substitution strings in App Builder in the following ways:

* Include a substitution string within a template to reference component values
» Reference page or application items using ¢ITEM. syntax

e Use built-in substitution strings

Substitution Strings within Templates

Special substitution strings available within a template are denoted by the number symbol (#).
For example:

#ABCH

Tip:

You can also use JavaScript APl apex.util.applyTemplate to evaluate templates
on the client side. See applyTemplate in Oracle APEX JavaScript APl Reference.

Substitution Strings for Page or Application Iltems

To reference page or application items using substitution variables:
1. Reference the page or application item in all capital letters.

2. Precede the item name with an ampersand (&).

3. Append a period (.) to the item name.

For example, you would refer to an application item named F101_X in a region, a region title,
an item label, or in any of numerous other contexts in which static text is used, for example:

§F101_X.
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Tip:

Notice the required trailing period. When the page is rendered, APEX engine
replaces the value the substitution string with the value of the item F101 X .

Substitution Strings for Interactive Grid, Cards, and Map Columns

To reference columns in an interactive grid, cards page, or map page using
substitution variables:

1. Reference the column name in all capital letters.
2. Precede the column name with an ampersand (&).
3. Append a period (.) to the item name.

For example, to reference the interactive grid column ENAME:

&ENAME .

Substitution Strings for Other Report Columns
To reference columns in other reports using substitution variables:

1. Reference the column name in all capital letters.
2. Precede the column name with a pound sign (#).
3. Append a pound sign (#) to the item name.

For example, to reference the interactive or classic report column ENAME:

#ENAME #

Using Double Quotation Marks for Special Characters or Case Sensitivity

Enclose items or columns with double quotation marks if the name contains special
characters or is case sensitive. For example:

&"ITEM-OR-COLUMN-NAME" .

Use the following syntax:
&"<name>"[!<format>].
Where:

*  "<name>"is an application item or page item or column name. If not quoted, then it
must be in set A-Z-0-9_$#

*  "<name>"is APP_TEXT$<message-name>
Where <message-name>is an APEX text message nhame.

e <format>is a predefined filter name: HTML, ATTR, JS, RAW, STRIPHTML as described
in Controlling Output Escaping in Substitution Strings.
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¢ See Also:

Translating Messages

3.9.2 Controlling Output Escaping in Substitution Strings

Learn about controlling output escaping in substitution strings.

You can escape special characters in the substitution value by appending an exclamation
mark (!) followed by a predefined filter name to a page or application item name, report
column, or other substitution string. Output escaping is an important security technique to
avoid Cross Site Scripting (XSS) attacks in the browser. Oracle APEX already makes a best
effort to automatically escape characters in a HTML or JavaScript context. With this extended
syntax, developers have fine-grained control over the output.

Available Escape Filters
Available escape filters include:
e HTML escapes reserved HTML characters, for example:

- ltem:
&P1 DEPTNO!HTML.

— Interactive grid column:
&ENAME | HTML .

— Columns in other reports:
#ENAME | HTML#

¢ See Also:
APEX_ESCAPE.HTML in Oracle APEX API Reference

° ATTR escapes reserved characters in a HTML attribute context, for example:
— Interactive grid column:
&ENAME | ATTR.
— Columns in other reports:
#ENAME | ATTR#

¢ See Also:
APEX_ESCAPE.HTML_ATTRIBUTE in Oracle APEX API Reference

e JS escapes reserved characters in a JavaScript context, for example:

- ltem:
&P1 DEPTNO!JS.
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— Interactive grid column:

§ENAME!JS.
— Columns in other reports:

#ENAME ! JS#

# Note:

The JS escape filter is not supported by substitutions performed on the
client.

¢ See Also:
APEX ESCAPE.JS_LITERAL in Oracle APEX API Reference

*  RAW preserves the original item value and does not escape characters, for
example:

—  ltem:

&P1 DEPTNO!RAW.

— Interactive grid column:

&ENAME ! RAW.

— Columns in other reports:
#ENAME | RAW#

°  STRIPHTML removes HTML tags from the output and escapes reserved HTML
characters, for example:

- ltem:

&P1 DEPTNO!STRIPHTML.

— Interactive grid column:

&ENAME ! STRIPHTML.
— Columns in other reports:
#ENAME ! STRIPHTML#

3.9.3 About Determining Substitution String Usage within Templates

Learn about determining substitution string usage within templates.

You can determine what template-specific substitution strings are supported in which
templates by viewing the template definition. See Creating Custom Themes.

3.9.4 Using Built-in Substitution Strings

Learn about built-in substitution strings available in App Builder.
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App Builder supports many built-in substitution strings. You can reference these substitution
strings to achieve specific types of functionality.

Q Tip:

Note that bind variable : USER has special meaning within the database. Also, the
term Direct PL/SQL refers to PL/SQL that can be used in stored database objects
such as procedures and functions.

- APEX_FILES
< APEX$ROW_NUM

- APEX$ROW_SELECTOR

- APEX$ROW_STATUS

- APP_ID

- APP_ALIAS

- APP_AJAX_XO1, ... APP_AJAX_X10
- APP_BUILDER_SESSION

- APP_DATE_TIME_FORMAT

- APP_FILES

- APP_NLS_DATE_FORMAT

« APP_NLS_TIMESTAMP_FORMAT

«  APP_NLS_TIMESTAMP_TZ_ FORMAT
- APP_PAGE_ALIAS

- APP_PAGE_ID

- APP_REGION_ID

- APP_REGION_STATIC_ID

- APP_REQUEST DATA HASH

- APP_SESSION

- APP_SESSION_VISIBLE

- APP_TITLE

- APP_UNIQUE_PAGE_ID

- APP_USER

- APP_VERSION

«  AUTHENTICATED_URL_PREFIX

- BROWSER_LANGUAGE

- CURRENT_PARENT TAB_TEXT

- DEBUG

«  HOME_LINK
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e JET_BASE_DIRECTORY
e JET_CSS DIRECTORY
e JET_JS_DIRECTORY

e LOGIN_URL

e LOGOUT_URL

* APP_TEXT$Message Name, APP_TEXT$Message Name$Lang
*  PRINTER_FRIENDLY

*  PROXY_SERVER

* PUBLIC_URL_PREFIX

*  REQUEST

* Using REQUEST

« SCHEMA OWNER

e  SQLERRM

e SYSDATE_YYYYMMDD
- THEME_DB_FILES

e THEME_FILES

*  WORKSPACE_FILES

e WORKSPACE_ID

# See Also:

Substitutions and Establishing User Identity Through Authentication

3.9.4.1 APEX_FILES

ORACLE

# Note:

IMAGE PREFIX has been renamed to APEX FILES. Although the legacy name,
IMAGE PREFIX, is still supported, Oracle recommends using the new name.

The value of APEX FILES determines the virtual path the web server uses to point to
the images directory distributed with Oracle APEX. To reference uploaded images, use
WORKSPACE FILES and APP FILES.

Table 3-3 APEX_FILES Syntax

L _____________________________________________________________________|
Reference Type Syntax

Bind variable :APEX FILES
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Table 3-3 (Cont.) APEX_FILES Syntax

__________________________________________________________________________|
Reference Type Syntax

Direct PL/SQL Note: Direct PL/SQL is an exception. Use G_IMAGE PREFIX as
described in this example.

APEX APPLICATION.G IMAGE PREFIX

PL/SQL V('APEX FILES'")

Substitution string &APEX FILES.

Template Substitution #APEX FILES#
# See Also:

e APP_FILES
*  WORKSPACE_FILES
e Editing the Application Definition

3.9.4.2 APEX$ROW_NUM

APEXSROW NUM refers the currently processed row number of a submitted tabular form data.
You can use this placeholder in validations, processes, and conditions associated with a
tabular form to refer to the row number of the currently processed tabular form row.

Table 3-4 APEX$ROW_NUM Syntax

Reference Type Syntax

Bind variable :APEXSROW NUM
PL/SQL V ('APEXSROW NUM')
Substitution string &APEXSROW NUM.

3.9.4.3 APEX$ROW_SELECTOR

ORACLE

Use APEX$SROW_SELECTOR in validations, processes, and conditions associated with a tabular
form to refer to the row selector checkbox in a tabular form. This placeholder returns X if the
tabular form row selector checkbox of the currently processed tabular form row is checked
and NULL if it unchecked.

Table 3-5 APEX$SROW_SELECTOR Syntax

Reference Type Syntax

Bind variable :APEX$ROW_SELECTOR
PL/SQL V( ’APEX$ROW_SELECTOR' )
Substitution string &APEXSROW SELECTOR.
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3.9.4.4 APEX$ROW_STATUS

Use APEXSSTATUS in validations, processes, and conditions associated with a tabular
form to refer to the row status in a tabular form. This placeholder returns the status of C
if created, U if updated, or D if deleted for the currently processed tabular form row.

Table 3-6 APEX$ROW_STATUS Syntax
L

Reference Type Syntax

Bind variable :APEXSROW_STATUS

PL/SQL V ('"APEXSROW STATUS')

Substitution string &APEXSROW STATUS.
3.9.45APP_ID

APP_ID identifies the application ID of the currently executing application.

Table 3-7 APP_ID Syntax
|

Reference Type Syntax

Bind variable :APP ID

Direct PL/SQL APEX APPLICATION.G FLOW ID (A NUMBER)
PL/SQL NV ('APP ID')

Substitution string &APP ID.

SYS_CONTEXT variable SYS CONTEXT ('APEXSSESSION', 'APP ID')

Substitution String Reference Example

The following is an example of a substitution string reference:

f£?p=&APP ID.:40:&APP SESSION.

SYS_CONTEXT Variable Example
The following is a SYS CONTEXT variable example:

SELECT ... WHERE application id = SYS CONTEXT ('APEX$SESSION', 'APP ID')

APEX sets up the APEX$SSESSION context when it starts to process an incoming
request. For example, you can use the value of 'APP_ID' to access the current
application ID in queries and Virtual Private Database (VPD) security policies that
protect your table data.

3.9.4.6 APP_ALIAS

ORACLE

APP ALIAS is an alphanumeric name for the current application. APP ALIAS is different
from the APP_ID in that the APP ID must be unique over all workspaces and all
applications hosted in one database. In contrast, APP_ALIAS must be unique within a
workspace. For example, by using the same APP_ALIAS you can create the application,
ABC, in two different workspaces. You can use APP_ALIAS almost anywhere APP ID
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can be used. For example, £?p syntax can use an APP ALIAS or an application ID as
demonstrated in this example:

f?p=ABC:1:&APP SESSION.

This example runs application ABC, page 1 using the current session.

Table 3-8 APP_ALIAS Syntax
I

Reference Type Syntax

Bind variable :APP ALIAS
PL/SQL V('APP ALIAS')
Substitution string &APP ALIAS.

The following is an HTML example:

Click me to go to page 1 <a href="f?p=6APP ALIAS.:1:&APP SESSION."> of the current

application</a>
3.9.4.7 APP_AJAX_XO01, ... APP_AJAX_X10
APP AJAX Xnn specifies the values of the APP_AJAX X01, ... APP AJAX X10 URL

parameters most recently passed to or set within the show or accept modules. You typically
use these variables in On Demand AJAX processes.

Table 3-9 APP_AJAX_Xnn Syntax
]

Reference Type Syntax
Bind variable ... :APP AJAX X01, ... :APP AJAX X10
PL/SQL ... V('APP AJAX X01'),
v ('APP_AJAX X10')
Substitution string ... &APP AJAX X01., ... &APP AJAX X10.
¢ See Also:
G X01, ... G X10 variables in APEX_APPLICATION in Oracle APEX API
Reference

3.9.4.8 APP_BUILDER_SESSION

If the user is also logged in to the workspace as a developer, APP BUILDER SESSION contains
the current session ID of the development environment. Otherwise, APP BUILDER SESSION is
null.
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Table 3-10 APP_BUILDER_SESSION Syntax
L

Reference Type Syntax

Bind variable :APP BUILDER SESSION
PL/SQL V('APP BUILDER SESSION')
Substitution string &APP _BUILDER SESSION.

3.9.4.9 APP_DATE_TIME_FORMAT

APP DATE TIME FORMAT is the application date time format of the application. This
value reflects the format specified in the Application Date Time Format attribute of the
Globalization settings of an application. If the Application Date Time Format is not set
in an application, then a reference to APP_DATE TIME FORMAT returns the database
session NLS date format and the NLS time format.

Table 3-11 APP_DATE_TIME_FORMAT Syntax
e

Reference Type Syntax

Bind variable :APP DATE TIME FORMAT
PL/SQL V('"APP DATE TIME FORMAT')
Substitution string &APP_DATE TIME FORMAT.

3.9.4.10 APP_FILES

ORACLE

¢ Note:

APP IMAGES has been renamed to APP_FILES. Although the legacy name,
APP IMAGES, is still supported, Oracle recommends using the new name.

Use this substitution string to reference uploaded images, JavaScript, and cascading
style sheets that are specific to a given application and are not shared over many
applications. If you upload a file and make it specific to an application, then you must
use this substitution string, or bind variable.

Table 3-12 APP_FILES Syntax
|

Reference Type Syntax

Bind variable :APP_FILES
Direct PL/SQL Not available.
PL/SQL V('APP FILES')
Substitution string &APP_FILES.
Template substitution #APP FILES#
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¢ See Also:

APEX_FILES, WORKSPACE_FILES, and About Managing Images

3.9.4.11 APP_NLS_DATE_FORMAT

APP NLS DATE FORMAT is the application date format of the database session. This value
reflects the format specified in the Application Date Format attribute of the Globalization
settings of the application. However, if the Application Date Format is not set, then

APP NLS DATE FORMAT returns the NLS DATE FORMAT value of the database session at the start
of the request to the APEX engine.

Table 3-13 APP_NLS_DATE_FORMAT Syntax

Reference Type Syntax

Bind variable :APP NLS DATE FORMAT
PL/SQL V('APP_NLS DATE FORMAT')
Substitution string &APP NLS DATE FORMAT.

3.9.4.12 APP_NLS_TIMESTAMP_FORMAT

APP NLS TIMESTAMP FORMAT is the application timestamp format of the database session.
This value reflects the format specified in the Application Timestamp Format attribute of the
Globalization settings of the application. However, if the Application Timestamp Format is not
set, then APP NLS TIMESTAMP FORMAT return the NLS TIMESTAMP FORMAT value of the
database session at the start of the request to the APEX engine.

Table 3-14 APP_NLS_TIMESTAMP_FORMAT Syntax

Reference Type Syntax

Bind variable :APP _NLS TIMESTAMP FORMAT
PL/SQL V('APP NLS TIMESTAMP FORMAT')
Substitution string &APP NLS TIMESTAMP FORMAT.

3.9.4.13 APP_NLS_TIMESTAMP_TZ_FORMAT

ORACLE

APP NLS TIMESTAMP TZ FORMAT is the application timestamp time zone format of the
database session. This value reflects the format specified in the Application Timestamp Time
Zone Format attribute of the Globalization settings of an application. However, if the
Application Timestamp Time Zone Format is not set, then APP NLS TIMESTAMP TZ FORMAT
returns the NLS_TIMESTAMP TZ FORMAT value of the database session at the start of the
request to the APEX engine.

Table 3-15 APP_NLS_TIMESTAMP_TZ_FORMAT Syntax

Reference Type Syntax

Bind variable :APP_NLS_TIMESTAMP TZ FORMAT
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Table 3-15 (Cont.) APP_NLS_TIMESTAMP_TZ_FORMAT Syntax

Reference Type Syntax
PL/SQL V('APP_NLS TIMESTAMP TZ FORMAT')
Substitution string &APP NLS TIMESTAMP TZ FORMAT.

3.9.4.14 APP_PAGE_ALIAS

APP PAGE ALIAS is an alphanumeric name for the current application page. A page
alias is not case-sensitive and it is an optional page attribute. APP_PAGE ALIAS is
unique within an application. You can use APP PAGE ALIAS almost anywhere

APP PAGE ID can be used.

Table 3-16 APP_PAGE_ALIAS Syntax

Reference Type Syntax

Bind variable :APP_PAGE_ALIAS
PL/SQL V(APP_PAGE_ALIAS))
Substitution string &APP_PAGE_ALIAS.

The following is an HTML example:

The alias of the current page is: §éAPP_PAGE ALIAS.

3.9.4.15 APP_PAGE_ID

APP PAGE ID is the current application page ID. For example, if your application was
on page 3, then the result would be 3. Using this syntax is useful when writing
application components that must work generically in multiple applications.

Table 3-17 APP_PAGE_ID Syntax

Reference Type Syntax

Bind variable :APP_PAGE ID
PL/SQL :APP PAGE ID
PL/SQL and Direct PL NV ('APP PAGE ID')
Substitution string &APP PAGE ID.

The following is an example of a substitution string reference:

£7p=§APP_ID.:&APP PAGE ID.:&APP SESSION.

3.9.4.16 APP_REGION_ID

APP REGION_ID identifies the ID of the current executing region.
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Table 3-18 APP_REGION_ID Syntax

Reference Type Syntax

Bind variable :APP_REGION ID
PL/SQL v ('APP REGION ID')
Substitution string &APP_REGION ID.

3.9.4.17 APP_REGION_STATIC_ID

APP REGION STATIC ID identifies the static ID of the current executing region. If no static ID
has been entered by a developer, NULL is returned.

Table 3-19 APP_REGION_STATIC_ID Syntax

Reference Type Syntax

Bind variable :APP REGION STATIC ID
PL/SQL v ('APP REGION STATIC ID')
Substitution string &APP REGION STATIC ID.

3.9.4.18 APP_REQUEST DATA HASH

APP REQUEST DATA HASH is a hash value of the request, item name, and item value parts in
the URL. It is primarily useful to detect whether two browser requests passed different
parameters to APEX.

Table 3-20 APP_REQUEST_DATA_HASH Syntax

Reference Type Syntax

Bind variable :APP REQUEST DATA HASH
PL/SQL V('APP_REQUEST DATA HASH'")
Substitution string &APP REQUEST DATA HASH.

3.9.4.19 APP_SESSION

ORACLE

APP SESSION is the most commonly used built-in substitution strings. You can use this
substitution string to create hypertext links between application pages that maintain a session
state by passing the session number. Note that you can also use the substitution string
SESSION in place of APP_SESSION.

Table 3-21 APP_SESSION Syntax

Reference Type Syntax
Bind variable :APP SESSION
PL/SQL V('APP_SESSION')
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Table 3-21 (Cont.) APP_SESSION Syntax

Reference Type Syntax

Short PL/SQL V('SESSION')

Substitution string &APP_SESSION.

SYS_CONTEXT variable SYS_CONTEXT('APEX$SESSION', '"APP SESSION')

Consider the following examples:

e From within an HTML region:
<a href="f?p=100:5:&APP_SESSION.">click me</a>

e Using PL/SQL:
htf.anchor ('£?p=100:5:"||[V('APP_SESSION'), 'click me');

» Using a SQL query:
SELECT htf.anchor ('£?p=100:5:"||:APP_SESSION, 'click me') FROM DUAL;

* Using the SYS CONTEXT variable:
SELECT ... WHERE apex session id = SYS CONTEXT ('APEXSSESSION', 'APP SESSION')
APEX sets up the APEX$SSESSION context when it starts to process an incoming
request. For example, you can use the value of 'APP_SESSION' to access the

current application session in queries and VPD (Virtual Private Database) security
policies that protect your table data.

3.9.4.20 APP_SESSION_VISIBLE

APP SESSION VISIBLE is similar to the built-in substitution APP_SESSION. Use this
substitution string to create hypertext links between application pages that maintain a
session state by passing the session number. APP SESSION VISIBLE always returns 'O’
when users are not authenticated to an application and they are using the Zero
Session ID feature of APEX.

Table 3-22 APP_SESSION_VISIBLE Syntax

Reference Type Syntax

Bind variable :APP SESSION VISIBLE
PL/SQL V('APP_SESSION VISIBLE')
Substitution string &APP SESSION VISIBLE.

Consider the following examples:
e From within an HTML region:
<a href="f?p=100:5:§4APP SESSION VISIBLE.">click me</a>
e Using PL/SQL:
sys.htf.anchor ('£?p=100:5:"| |V ('APP_SESSION VISIBLE'), 'click me');

* Using a SQL query:
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SELECT sys.htf.anchor ('f?p=100:5:"||:APP_SESSION VISIBLE, 'clickme') FROM DUAL;

3.9.4.21 APP_TITLE

APP_TITLE is an alphanumeric title for the current application. The title is derived from an
application substitution string called 2PP_TITLE. If not defined the Logo attribute will be used if
it is of type text. The last fallback is the application name.

Table 3-23 APP_TITLE Syntax

Reference Type Syntax

Bind variable :APP_TITLE
PL/SQL v ('APP_TITLE'")
Substitution string &APP TITLE.

The following is an HTML example:

The title of the current application is: &APP TITLE!HTML.

3.9.4.22 APP_UNIQUE_PAGE_ID

APP UNIQUE PAGE ID is an integer generated from an Oracle sequence which is unique for
each page view. This number is used by applications to prevent duplicate page submissions
and can be used for other purposes. For example, to make a unique URL and avoid browser
caching issues, you can embed this number in the request or debug column in calls to the £
procedure.

Table 3-24 APP_UNIQUE_PAGE_ID Syntax

Reference Type Syntax

Bind variable :APP_UNIQUE PAGE ID
PL/SQL V('APP UNIQUE PAGE ID')
Substitution string &APP_UNIQUE PAGE ID.

The following is an HTML example:

SELECT '£?p=100:1:"||:APP_SESSION||':"||:APP _UNIQUE PAGE ID| |
':::P1 EMPNO:'||employee id,
first name,
job id
FROM employees

Note the use of the APP_UNIQUE PAGE ID in the request column. This makes this URL unique
and may avoid excessive browser caching problems.

3.9.4.23 APP_USER

ORACLE

APP USER is the current user running the application. Depending upon your authentication
model, the value of the user is set differently. If the application is running using database
authentication, then the value of the user is the same as the database pseudo column USER.
If the application uses an authentication scheme that requires the user to authenticate, the
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value of APP USER is set by the authentication scheme, usually to the user name used
during authentication.

Table 3-25 APP_USER Syntax
L

Reference Type Syntax

Bind variable :APP USER

PL/SQL V('APP USER')

Substitution string &APP USER.

SYS CONTEXT variable SYS CONTEXT ('APEXSSESSION', 'APP USER')

Consider the following examples:

e From within an HTML region:
Hello you are logged in as &APP_USER.
e Using PL/SQL:
htp.p('Hello you are logged in as'||V('APP_USER'));
* As abind variable:
SELECT * FROM some table WHERE user id = :APP USER
* Using the SYS CONTEXT variable:
SELECT ... WHERE username = SYSi(ﬁONTEXT('APEX$SESSION', 'APP USER')
APEX sets up the APEXS$SSESSION context when it starts to process an incoming
request. For example, you can use the value of 'APP_USER' to access the current

application user in queries and VPD (Virtual Private Database) security policies
that protect your table data.

# See Also:

Authentication for information about the Public User attribute

3.9.4.24 APP_VERSION

Use APP_VERSION to get the entered version of your application. You can use
APP VERSION to display it in your application or append it to external static files to
automatically invalidate the browser cache when the application gets updated.

Table 3-26 APP_VERSION Syntax

|
Reference Type Syntax

Substitution string #APP VERSION#

3.9.4.25 AUTHENTICATED_URL_PREFIX

This application-level attribute identifies a valid authenticated prefix (that is, a logged in
URL prefix). You can use a relative path or a full path beginning with http. This item is
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useful if your application can be run in both authenticated (logged in) and public (not logged
in) modes. You can use AUTHENTICATED URL PREFIX to construct a link to an authenticated
page. This item is most useful when using basic database authentication because changes to
the URL can require authentication.

Table 3-27 AUTHENTICATED_URL_PREFIX Syntax

Reference Type Syntax

Bind variable :AUTHENTICATED URL PREFIX
PL/SQL V('AUTHENTICATED URL PREFIX')
Substitution string &AUTHENTICATED URL PREFIX.

3.9.4.26 BROWSER_LANGUAGE

BROWSER LANGUAGE refers to the web browser's current language preference.

Table 3-28° BROWSER_LANGUAGE Syntax
|

Reference Type Syntax

Bind variable :BROWSER_LANGUAGE

Direct PL/SQL APEX APPLICATION.G BROWSER LANGUAGE
PL/SQL V ('"BROWSER LANGUAGE')

Substitution string &BROWSER_LANGUAGE.

3.9.4.27 CURRENT_PARENT_TAB_TEXT

CURRENT PARENT TAB TEXT is most useful in page templates, but is only relevant for
applications that use two-level tabs (that is, parent and standard tabs). Use this string to
reference the parent tab label. This substitution string enables you to repeat the currently
selected parent tab within the page template.

Table 3-29 CURRENT_PARENT_TAB_TEXT Syntax
I

Reference Type Syntax

Bind variable Not Available.

Substitution string &CURRENT PARENT TAB TEXT.
3.9.4.28 DEBUG

Valid values for the DEBUG flag are Yes or No. Turning debug on shows details about
application processing. If you write your own custom code, you may want to generate debug
information only if the debug mode is set to Yes.
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Table 3-30 DEBUG Syntax
|

Reference Type Syntax

Bind variable :DEBUG

Direct PL/SQL APEX APPLICATION.G DEBUG
PL/SQL V('DEBUG'")

Substitution string &DEBUG.

The following is an example of a substitution string reference that preserves the
current value of DEBUG:

£?p=100:1:&APP SESSION.::&DEBUG

3.9.4.29 HOME_LINK

HOME LINK is the home page of an application. The APEX engine redirects to this
location if no page is given and if no alternative page is dictated by the authentication
scheme's logic. You define the Home URL on the User Interface page, under
Attributes.

Table 3-31 HOME_LINK Syntax
|

Reference Type Syntax
Direct PL/SQL APEX APPLICATION.G HOME LINK
PL/SQL V('HOME LINK')
Template Reference #HOME LINK#
Substitution String &HOME LINK.
¢ See Also:

Editing User Interface Attributes and Attributes

3.9.4.30 JET_BASE_DIRECTORY

Use the JET BASE DIRECTORY substitution string to reference the base directory of the
Oracle JavaScript Extension Toolkit (JET) which ships with APEX. Supported syntax
for referencing JET BASE DIRECTORY :

#JET BASE DIRECTORY#

3.9.4.31 JET_CSS_DIRECTORY

Use the JET_CSS_DIRECTORY substitution string to reference the base directory of the
Oracle JavaScript Extension Toolkit (JET) which ships with APEX. Supported syntax
for referencing JET _CSS_DIRECTORY:
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#JET CSS_DIRECTORY#

3.9.4.32 JET_JS_DIRECTORY

Use the JET_JS_DIRECTORY substitution string to reference the JavaScript directory of the
Oracle JavaScript Extension Toolkit (JET) components which ships with APEX. Supported
syntax for referencing JET_JS DIRECTORY:

#JET JS DIRECTORY#

3.9.4.33 LOGIN_URL

Use LOGIN URL to display a link to a login page for users that are not currently logged in.

¢ See Also:

Authentication and Security Page

Table 3-32 LOGIN_URL Syntax
L

Reference Type Syntax

Bind variable :LOGIN URL

Direct PL/SQL APEX APPLICATION.G LOGIN URL
PL/SQL V('LOGIN URL')

Substitution string &LOGIN URL.

Template Substitution #LOGIN URL#

3.9.4.34 LOGOUT_URL

LOGOUT URL is an application-level attribute used to identify the logout URL. This is a URL that
navigates the user to a logout page or optionally directly logs out a user. To create a logout
navigation bar entry, add a trailing period to §LOGOUT URL (&LOGOUT URL.). If you are coding a

page template, use #LOGOUT URL#.

Table 3-33 LOGOUT_URL Syntax
L

Reference Type Syntax

Bind variable :LOGOUT URL
PL/SQL V('LOGOUT URL'")
Substitution string &LOGOUT URL.
Template substitution #LOGOUT URL#

3.9.4.35 APP_TEXT$Message Name, APP_TEXT$Message Name$Lang

With APP TEXT$Message Name, APP TEXT$Message Name$Lang built-in substitution, you can
access application defined or system defined text messages, like APEX LANG.MESSAGE.
Message Name is the name of the text message, Message Name has to be a valid identifier (-
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z, 0-9, $, #, ). The optional $Lang parameter can be used to access a specific
translation, sLang defaults to the current language for the page request.

Table 3-34 APP_TEXT$Message_Name, APP_TEXT$Message_Name$Lang

Syntax

. ___________________________________________________________________________________________________|
Reference Type Syntax
Bind variable :APP TEXT$Message Name , :APP TEXTSMessage NameS$Lang
PL/SQL V('APP_TEXTS$Message Name') ,

V ('APP_TEXT$Message NameS$Lang')

Substitution string &APP TEXTSMessage Name. ,
&APP TEXTS$Message Name$Lang.

The following is an example for the default and the French text message MY MESSAGE,
using HTML escaping:

Default text: &APP TEXTSMY MESSAGE!HTML.
Pardon my French: &APP TEXT$MY MESSAGESFR!HTML.

3.9.4.36 PRINTER_FRIENDLY

The value of PRINTER FRIENDLY determines if the APEX engine is running in print view
mode. This setting can be referenced in conditions to eliminate elements not desired in
a printed document from a page.

Table 3-35 PRINTER_FRIENDLY Syntax

Reference Type Syntax

Direct PL/SQL APEX APPLICATION.G_PRINTER FRIENDLY (VARCHAR2
DATATYPE)

PL/SQL V('PRINTER FRIENDLY')

Substitution string &PRINTER FRIENDLY.

3.9.4.37 PROXY_SERVER

PROXY SERVER is an application attribute. The attribute may be used by regions whose
source comes from a URL. The following is the correct syntax for a direct PL/SQL
reference used when you are writing PL/SQL to access remote web servers from
within the database (for example, when using the utl http package shipped with the
database).

APEX APPLICATION.G PROXY SERVER

3.9.4.38 PUBLIC_URL_PREFIX

PUBLIC URL PREFIX is an application-level attribute that identifies a URL to toggle out
of a logged in mode to a public view.
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Table 3-36 PUBLIC_URL_PREFIX Syntax
L]

Reference Type Syntax

Bind variable :PUBLIC URL PREFIX

PL/SQL V('PUBLIC URL PREFIX')

Substitution string &PUBLIC URL PREFIX.

Template substitution #PUBLIC URL PREFIX#
3.9.4.39 REQUEST

Each application button sets the value of REQUEST to the name of the button or to the request
value attribute associated with the button, enabling accept processing to reference the name
of the button when a user clicks it. In the £?p syntax, REQUEST may be set using the fourth
argument.

REQUEST is typically referenced during Accept processing (that is, the processing that occurs
when you post a page).

Table 3-37 REQUEST Syntax
]

Reference Type Syntax
Bind variable :REQUEST
Direct PL/SQL APEX APPLICATION.G REQUEST
PL/SQL V ('REQUEST'")
Substitution string &REQUEST.
# See Also:

Using REQUEST

3.9.4.40 Using REQUEST

ORACLE

REQUEST is typically referenced during Accept processing (that is, the processing that occurs
when you post a page). This section describes additional information about how to use the
REQUEST substitution string.

* About Scope and Value of REQUEST for Posted Pages

*  About the When Button Pressed Attribute

* About Referencing REQUEST Using Declarative Conditions
e About Using REQUEST for Show Processing

e About Using BRANCH_TO_PAGE_ACCEPT

3-53



Chapter 3
Using Substitution Strings

¢ See Also:
REQUEST

3.9.4.40.1 About Scope and Value of REQUEST for Posted Pages

When you post a page, you initiate Accept processing. Accept processing consists of
computations, validations, processes, and branches. The value of REQUEST is available
during each phase of the Accept processing. Once an application branches to a
different page then REQUEST is set to NULL.

The value of REQUEST is the name of the button the user clicks, or the name of the tab
the user selects. For example, suppose you have a button with a name of CHANGE, and
a label 2pply Change. When a user clicks the button, the value of REQUEST is CHANGE.

3.9.4.40.2 About the When Button Pressed Attribute

Validations, processes, and branches have a When Button Pressed attribute. This
attribute displays as a select list and contains the names of buttons that exist on the
current page. If you make a selection from When Button Pressed, you associate the
button's REQUEST value with the validation, process, or branch.

When you use a button to submit a page, the REQUEST value is passed to the page.
The Accept processing logic evaluates each validation, process, and branch that uses
a When Button Pressed attribute to determine whether the component should run (or
fire). When one of these components runs, do not assume that a user actually clicked
the associated button and caused the page to be submitted. Keep in mind, that
another button using the same request value may have submitted the page. Similarly,
JavaScript on the page can also submit the page and pass in a request value.

3.9.4.40.3 About Referencing REQUEST Using Declarative Conditions

Many developers reference REQUEST using conditions. For example, you may want to
reset pagination when a user clicks Go on a report page. You can reset pagination by
creating an on-submit page process. The page process can be made conditional using
the condition Request = Expression 1.

To conditionalize an on-submit page process:

1. Under Condition, select the condition type Request = Expression 1.

2. In Expression 1, enter GO.

3.9.4.40.4 About Using REQUEST for Show Processing

ORACLE

You can also use REQUEST for Show processing when navigating to a page using £?p
syntax. For example:

£?p=100:1:&APP_SESSION.:GO

Remember that the fourth argument in the £2p syntax is REQUEST. This example goes
to application 100, page 1 for the current session, and sets the value of REQUEST to GO.
Any process or region can reference the value of REQUEST using Show processing.
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The following is a similar example using PL/SQL:
IF V ('REQUEST') = 'GO' THEN

htp.p('hello');
END IF;

Note that htp.p('hello') is a call to a PL/SQL Web Toolkit package to print the specified
text string.

" See Also:

Oracle Database Development Guide

3.9.4.40.5 About Using BRANCH_TO_PAGE_ACCEPT

You can use a special request BRANCH TO PAGE ACCEPT for Show processing to automatically
submit the page. For example:

£?p=100:1:&4APP_SESSION.:BRANCH TO PAGE ACCEPT|SAVE:::P1 DATA:value

Using BRANCH TO PAGE ACCEPT is the same as navigating to page 1, entering a value into the
item P1_DATA, and clicking a button that submits the page with a SAVE request.

3.9.4.41 SCHEMA OWNER

If you are generating calls to applications from within your PL/SQL code, you must reference
the owner of the APEX schema. The following describes the correct syntax for a direct
PL/SQL reference:

APEX APPLICATION.G FLOW_SCHEMA OWNER

You may also use #FLOW_OWNER# to reference this value in SQL queries and PL/SQL (for
example, in a region or a process).

3.9.4.42 SQLERRM

SQLERRM is a template substitution only available in the Applications Region Error Message.
Supported syntax for a region template substitution reference:

#SQLERRM#

3.9.4.43 SYSDATE_YYYYMMDD

ORACLE

SYSDATE YYYYMMDD represents the current date on the database server, with the YyyYMMDD
format mask applied. You may use this value instead of repeated calls to the SYSDATE ()
function. The following list describes the supported syntax for referencing SYSDATE YYYYMMDD.

e Bind variable
:SYSDATEiYYYYMMDD
e« PL/SQL

V('SYSDATE YYYYMMDD')
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e Direct PL/SQL

APEX APPLICATION.G SYSDATE (DATE DATATYPE)

Table 3-38 SYSDATE_YYYYMMDD Syntax
|

Reference Type Syntax

Bind variable :SYSDATE YYYYMMDD

Direct PL/SQL APEX APPLICATION.G SYSDATE (DATE DATATYPE)
PL/SQL V('SYSDATE YYYYMMDD')

3.9.4.44 THEME_DB_FILES

# Note:

THEME DB IMAGES has been renamed to THEME DB FILES. Although the
legacy name, THEME DB IMAGES, is still supported, Oracle recommends using
the new name.

Use the THEME DB FILES substitution string to always reference files which are stored
with your theme definition in the database, regardless of the "File Prefix" setting of
your theme. Supported syntax for a template substitution:

#THEME DB FILES#

3.9.4.45 THEME_FILES

" Note:

THEME IMAGES has been renamed to THEME FILES. Although the legacy
name, THEME IMAGES, is still supported, Oracle recommends using the new

name.

Use the THEME_FILES substitution string to reference files which are stored with your
theme definition. Supported syntax for a template substitution:

#THEME FILES#

3.9.4.46 WORKSPACE_FILES

¢ Note:

WORKSPACE IMAGE has been renamed to WORKSPACE FILES. Although the
legacy name, WORKSPACE IMAGE, is still supported, Oracle recommends using
the new name.
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Use this substitution string to reference uploaded images, JavaScript, and cascading style
sheets that are shared over many applications within a workspace.

Table 3-39 WORKSPACE_FILES Syntax
]

Reference Type Syntax

Bind variable :WORKSPACE FILES

Direct PL/SQL Not available

PL/SQL V ('"WORKSPACE FILES')

Substitution string &WORKSPACE FILES.

Template substitution #WORKSPACE FILES#
# See Also:

APP_FILES and APEX_FILES

3.9.4.47 WORKSPACE_ID

Use this substitution string to reference the workspace ID.

Table 3-40 WORKSPACE_ID Syntax
L

Reference Type Syntax
Bind variable :WORKSPACE ID
PL/SQL V ('WORKSPACE ID')
Substitution string &WORKSPACE ID.
SYS CONTEXT variable SELECT ... WHERE workspace id =
SYS CONTEXT ('APEXSSESSION', ''WORKSPACE ID')

Consider the following examples:
e From within an HTML region:
Hello your workspace id is &WORKSPACE ID.
e Using PL/SQL:
htp.p('Hello your workspace id is '||V('WORKSPACE ID'));
e Using a bind variable:
SELECT * FROM some table WHERE workspace id = :WORKSPACE ID
e Using the SYS CONTEXT variable:
SELECT ... WHERE workspace_id = SYS CONTEXT ( 'APEXS$SESSION', 'WORKSPACE_ID')
APEX sets up the APEX$SESSION context when it starts to process an incoming request.
For example, you can use the value of 'WORKSPACE ID' to access the current workspace

ID value in queries and VPD (Virtual Private Database) security policies that protect your
table data.
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3.10 Using Template Directives

Use template directives to control how attributes that support substitution strings are
processed.

Template directives are only supported by specific attributes of the cards, interactive
grid, classic report, interactive report regions, and email templates. These directives
are processed as part of client side substitutions. To determine if an attribute supports
template directives, Page Designer Help includes the text "Supports Template
Directives." See apex.util.applyTemplate in Oracle APEX JavaScript APl Reference for
more details on directive syntax.

" Note:

Syntax descriptions text in square brackets is optional. You do not actually
type the square brackets. Upper case text represents something as
described in the description.

e If Condition Directives
Use the if directive to conditionally show text based on if an item or column has a
value.

» Case Condition Directives
Use the case directive to show text based on the value of an item or column.

e Loop Directives
Use the loop directive to repeat text once for each item in a multi-value
(character delimited) item or column value.

3.10.1 If Condition Directives

ORACLE

Use the if directive to conditionally show text based on if an item or column has a
value.

Syntax

{if [!]NAME/}

TRUE TEMPLATE TEXT
{elseif [!]NAMEZ2/}
ELSE TRUE TEMPLATE TEXT
{else/}

FALSE TEMPLATE TEXT
{endif/}

The NAME is an item or column name. If the value of the column or item is true then the
following text is output. The value is false if it is an empty string or ‘F’, ‘N, or ‘0’. Any
value that is not false is true. If the NAME is proceeded by exclamation point (/) then the
following text is output if the value is false rather than true.
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There can be zero or more elseif directives. The else directive is optional. The text after the
first 1f or elseif directive that is true is output. If no if or elseif is true then the text after
the else directive, if any, is output.

Example

A cards report contains a column named DESCRIPTION. The following HTML Expression
attribute will display the description if it is not null (empty string) and “No description.”
otherwise.

{if DESCRIPTION/}&DESCRIPTION. {else/}No description.{endif/}

3.10.2 Case Condition Directives

ORACLE

Use the case directive to show text based on the value of an item or column.
Syntax

{case NAME/}
{when STRINGI1/}
TEMPLATE_TEXT]
{when STRING2/}
TEMPLATE_TEXTZ
{otherwise/}
TEMPLATE TEXT
{endcase/}

The NAME is an item or column name. The value is compared with the strings after each when
directive and if they are equal then the following text is output. If no when directive matches
then the text after the otherwise directive, if there is one, is output. The value and each string

is trimmed of leading and trailing spaces before comparison. The comparison is case
sensitive.

Example

This example using the sample EMP table displays the compensation differently depending on
the JoB. For sales people it shows both the salary and commission. For the president it
shows “--" rather than salary and for all other jobs it shows just the salary.

{case JOB/}

{when SALESMAN/}
&SAL. (&COMM.)
{when PRESIDENT/}

{otherwise/}

&SAL.
{endcase/}
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3.10.3 Loop Directives

ORACLE

Use the loop directive to repeat text once for each item in a multi-value (character
delimited) item or column value.

Syntax

{loop ["SEP"] NAME/}
TEMPLATE TEXT
{endloop/}

The NAME is an item or column name that has multiple values separated by the
character given by SEp. The default separator is ":". If SEP is more than one character
it is treated as a regular expression.

The template text within the loop can use these substitution symbols:
° APEXSITEM - This is the value of the current item in the list.

e APEXSI - This is 1 based index of the current item in the list.

Example

The following example takes a column called TAGS that contains a comma ()
separated list of tags such as "apples,cherries,pears” and turns it into an HTML list
that can be nicely styled with CSS.

<ul class="tags">{loop "," TAGS/}

<li class="tag-item">&APEXSITEM.</1i>
{endloop/}</ul>
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Use Team Development to track and manage issues in a conversational fashion. You can
create templates to provide users with starter text for issues and comments. You can apply
labels and label groups, assign issue owners, and set milestones.

Getting Started with Team Development
Access Team Development, complete the setup process, and learn about the Team
Development toolbar.

Creating and Updating Issues
Create and update issues by either updating issues one at a time, or performing bulk
updates of multiple issues at once.

Viewing Your User Profile
Click the Notifications icon on the Team Development toolbar view and manage your own
notifications and view all issues you own.

Managing Labels
Create and update label groups and labels to classify issues.

Managing Milestones
Create and update issues milestones to track events.

Managing Templates
Create and update templates for issues and issue comments.

Using Team Development Utilities

Use Utilities page to manage deleted issues, manage templates, milestones, and labels,
view uploaded files, purge data, reassign issues to another user, reassign issue owners,
remove a milestone or label from all issues, and manage user notifications.

Managing Feedback
Feedback provides a mechanism for end users to post general comments for application
administrators and developers.

4.1 Getting Started with Team Development

Access Team Development, complete the setup process, and learn about the Team
Development toolbar.

ORACLE

Accessing Team Development
Access Team Development by clicking the Team Development menu, or by clicking the
Team Development icon on the Workspace home page.

Setting Up Team Development
Complete the setup process by installing sample labels, sample templates, sample
milestones, and selecting a default language.

Team Development Toolbar
Use the toolbar at the top of the most Team Development pages to link to notifications,
jump to other pages, or create a new issue.
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4.1.1 Accessing Team Development

Access Team Development by clicking the Team Development menu, or by clicking the
Team Development icon on the Workspace home page.

You can access Team Development in two ways:

e Click the Team Development menu at the top of most pages in Oracle APEX.

e On the Workspace home page, click the Team Development icon.

deployed anywhere.

App Builder SQL Workshop Team Development Gallery
Learn More
Top Apps Top Users Summary
APEX. Website
E admin 5 10 Applications Blog

Tutorials

106 Tables 4 Developers

m admin2 23 Videos

Educational Resources

Workspace Message v _
deas & Feature Requests

apexworld

The Issues page appears.

¢ See Also:

Issues Page

4.1.2 Setting Up Team Development

ORACLE

Complete the setup process by installing sample labels, sample templates, sample
milestones, and selecting a default language.

When you access Team Development for the first time in a new workspace, a welcome
screen appears. Oracle recommends you follow the on-screen instructions and
completing the setup process.

To setup Team Development:
1. Access Team Development.
The Team Development Welcome page appears.

2. For Install Sample Labels, Install Sample Templates, and Install Sample
Milestones, select Yes.

3. From Sample Data Language, select a language.
4. Click Complete Setup.

The Issues page appears.
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4.1.3 Team Development Toolbar

Use the toolbar at the top of the most Team Development pages to link to notifications, jump
to other pages, or create a new issue.

Team Development Toolbar

O APEX App Builder 5QL Workshop Team Development Gallery () Search (o e
New Issue
T Issues W’ 2| Jumpto..v
= = I
4 = All Te: Go 5= E Actions v i= lssues
2, View My Profile
A i 1 :
! Welcome to Team Development in Oracle APEX! m S0 T (o
~  #10pened 3 weeks ago by ADMIN
5 Manzge Milestones
[ Manzge Templates
_/,'-’-' Litilities
wpEn msuTs
1 1
Tatal Owned

The Team Development toolbar contains the following controls:

* Notifications - Links the Notifications page where you can view or clear notifications for
all issues which you own or are monitoring. See Viewing Your Notifications.

* Jump to... - Access other Team Development pages. Available links include:
— Issues - Links to the Issues page. See Issues Page.

— View My Profile - Links to the User Profile page where you can view a report of all
issues you own or are monitoring. See Viewing Your Issues.

— Manage Labels - Links to the Labels page. Use labels and label groups to classify
issues. See Managing Labels.

— Manage Milestones - Links to the Milestones page. Create milestones to track
events. See Managing Milestones.

— Manage Templates - Links to the Templates page. Templates provide starter text for
issues and issue comments. See Managing Templates.

— Utilities - Links to the Team Development Utilities page. See Using Team
Development Utilities.

4.2 Creating and Updating Issues

ORACLE

Create and update issues by either updating issues one at a time, or performing bulk updates
of multiple issues at once.

* |ssues Page
Use the Issues page to view issues.

e Creating an Issue
Create new issues on the Issues page by clicking the New Issue button.
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Updating Multiple Issues at Once

Update status, assignees, labels, and milestones for multiple issues at once by
selecting the issues on the Issues page and then selecting options from the
Update menu.

Updating an Issue
Update an issue by viewing the Issue Details and then updating the Issue
Timeline.

4.2.1 Issues Page

Use the Issues page to view issues.

ORACLE

The Issues page displays all issues being tracked in Team Development.

Navigation Bar

Qv

Select columns to search m View Report

Issues \ Jump to... v New Issue

Textarea [Actore nens

Search: Al Text Columns Go 5= B Actions v

About

Welcome to Team Development in Oracle APEX!

#1 Opened 2 weeks ago by ADMIN

Sample Bug
—  #3 Opened 10 minutes ago by ADMIN

1-2 Open Issues

2 2

Total COwned

A navigation bar displays at the top of the Issues page and contains the following
controls.

Select columns to search - This control features a menu with a magnifying glass.
Click this menu to narrow your search to only specific columns. To search all
columns, select All Text Columns.

Search: All Text Columns - Enter case insensitive search criteria (wildcard
characters are implied) and click Go.

Go button - Executes a search or applies a filter.

View icons. Use these icons to toggle between two views:
— Cards (default) - Displays issue details as card.

— Grid - Displays issues in an interactive grid report.

To view issue details, click the issue title. To update status, assignees, labels, or
milestones in either view, select the issue and then appropriate option on the
Update menu.

Actions menu - Use the Actions menu to customize the report.

Update. Update multiple issues at once by selecting them and then selecting an
option from the Actions menu. Update menu options include:

— Status - Apply a status (Open or Closed) to all selected issues.

— Assignees - Add or remove assignees for all selected issues.
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— Labels - Assign or remove labels for all selected issues.

— Milestones - Assign or remove milestones for all selected issues.

Q Tip:

To view or edit an issue (including adding issue comments), click issue title.

* Reset - Click the Reset button to remove any customizations, such as filters or sorting,
Select this option to reload the report definition from the server.

" See Also:

Team Development Toolbar

List of Issues

Issues appear next and can be viewed as Cards or as an interactive grid. Click the View
Cards and Grid icons to change the display. This example shows View Cards.

'QV Search: All Text Columps Go ES i=]

- Welcome to Team Development in Oracle APEX!

#1 Opened 2 months ago by ADM = Code Freeze
Closed Issue
L sampie sug
@ 47 0pened 2 SN s sue Owner |
- How Do l... Example
~ #6 Opened 2 day o by ADMIN

~. Feature1 | Feature Reguest || Security Issue |

> by ADMIN

o o by ADMIN

#5 Opened 2 day

Key features of the Cards view include:

™
LA Jump to... v New Issue

About

Team Development enables you
to track and manage issuesina
g Y conversational fashion. You can
- classify issue using labels,
assign users to issues, link an
issue with milestones, and
attach files to an issue.

Learn Mare ..

Open Issues

4 4
0 Total Owned
B 1 0
&0
Assigned Subscribed

* Issue Title - Click the issue title to view and update details.

* Open Issue/Closed Issue icons - Displays the status of the issue. The Open Issue icon
appears as a green circle around an exclamation point. The Closed Issue icon displays
as a red circle around an exclamation point and a check mark.

* Issue Owner - Displays beneath the issue title.

* Labels - Assigned labels display to the right of the issue title. The color indicates the

associated label group.

* Assignee - The assignees or an issue appear to the right of the labels.

* Issue Details - Click the Comment icon/number on the far right to link to the Issue
Details. The number indicates the number of issue comments.
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Open Issues and Feedback Regions

Summary regions display on the right-side of the page. The Open Issues summary
region includes the following:

» Total - Total issues in the workspace.

* Owned - Total issues owned by the current user.

* Assigned - Total issues assigned to the current user.

* Subscribed - Total issues to which the current user subscribes.

The Feedback summary region displays on the bottom right of the page and includes
the following:

» Total - Total feedback entries.

e Open - Total open feedback entries.

¢ See Also:

e Creating and Updating Issues
e Team Development Toolbar

e Managing Feedback

4.2.2 Creating an Issue

ORACLE

Create new issues on the Issues page by clicking the New Issue button.

Tip:

To create a new issue, you must select a template. Templates provide starter
text for issues and issue comments. Use the sample templates provided
when you completed Team Development setup, or create your own. See
Managing Templates.

To create an issue:

1. Click the Team Development menu.
2. Onthe Issues page, click New Issue.
3. Inthe New Issues dialog:

a. Select a template, or select Continue without a template. Templates provide
users with starter text for issues and comments.

b. Title - Enter a descriptive title.

c. Issue Text - Enter a description of the issue. Use the Markdown tools above
the field to add formatting.

d. To preview the HTML, click Preview.
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4. Click Create Issue.

¢ See Also:

e Adding Issue Comments or Attaching a File

* Managing Templates

4.2.3 Updating Multiple Issues at Once

Update status, assignees, labels, and milestones for multiple issues at once by selecting the
issues on the Issues page and then selecting options from the Update menu.

To update multiple issues at once:
1. Click the Team Development menu.
The Issues page appears.
2. Select the issues to update by clicking the checkbox to the left the issue title.
3. To update status:
a. From the Update menu, select Status.
b. Status - Select a new status (that is, Open or Closed).
c. Click Apply Changes.
4. To update assignees:
a. From the Update menu, select Assignees.
b. For each assignee, select Assigh or Remove.
c. Click Apply Changes.
5. To update labels:
a. From the Update menu, select Labels.
b. For each label, select Assign or Remove.
c. Click Apply Changes.
6. To update milestones:
a. From the Update menu, select Milestones.
b. For each milestone, select Assign or Remove.

c. Click Apply Changes.

4.2.4 Updating an Issue

ORACLE

Update an issue by viewing the Issue Details and then updating the Issue Timeline.

Only an issue owner or an administrator can update an issue title or description, or delete an
issue.

* Issue Details Page
Use the Issue Details page to update issues.
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* Updating the Issue Title
View an issue and then update the issue title.

* Updating the Issue Description
View an issue and update the issue description (also known as the Issue Text).

* Managing Comments
Add or edit issue comments on the Issue Details page.

e Setting Assignees
View an issue and then set assignees.

e Setting Labels
View an issue and then set labels.

e Setting Milestones
View an issue and then set milestones.

» Associating an Issue with an App and Page
View an issue and then associate it with an application and page.

* Marking an Issue as Duplicate
View an issue and then mark it as duplicate.

* Closing an Issue
Close an issue on the Issues Details page.

* Managing Deleted Issues
Issue owners or administrators can delete an issue on the Issue Details page.
Manage deleted issue (that is, delete them forever or reinstate them) by navigating
to Utilities, Manage Deleted Issues.

4.2.4.1 Issue Details Page

Use the Issue Details page to update issues.
Issues Timeline

T ) Issues . Issue Details n Jump to.. m

About
New Featurem JumptoLatest  Actions v
e #19 Opened 2 minutes age by ADMIN - 0 comments Q—W ~

@ admin Created this issue 2 minutes ago

Feature Summary

* Provide a one paragraph general overview of the feature request.

Context

s Does this request relate to a specific situation or process? For example, "I am always frustrated when [.J7

Preferred Solution GTETTT

* Provide a clear description of what you would like to see implemented. BB developer?
Labels Vi
Q admin assigned developer 88 developer? to this issue 2 minutes ago
— TN
a Q admin added| Enhancement Request to this issue 2 minutes ago
Milestones V4

Add Comment

Add Comment
No Milestones Assigned
H B I 5 4 == A Select a Response Template 5] Preview

Motifications
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The Issue Details page contains an Issue Timeline. Updates to the Issue Timeline are called
events. Newer events display at the top of the timeline. The Issue Timeline is divided into the
following sections:

Issue Title - Displays at the top of the page.
Issue Text field - The text that describes the issue.

Events - Each update to the Issue Timeline is logged as an event. Events displays after
the Issue Text.

Add Comment - Displays at the bottom of the Issue Timeline. Use this field to record
comments about the issue. The Add Comment region includes formatting tools, enables
you to select a Response Template, and Preview the text.

Issue Details Controls

T ) Issues ' lssue Details Q Jump to.. m

Jump to Latest m
New Feature GLE

Jump to Latest Actions ~
- #19 Opened 2 minutes ago by ADMIN - 0 commenits
@ admin Created this issue 2 minutes ago Show Actions 2

Feature Summary

* Provide a one paragraph general overview of the feature reguest.
Context

* Does this request relate to a specific situation or process? For example, "I am always frustrated when [.]7
Preferred Solution

* Provide a clear description of what you would like to see implemented.

Labels 7

@ admin assigned €3 developer @ developer? to this issue 2 minutes ago

Enhancement Request

s @ admin added| Enhancement Request ” Critical | to this issue 2 minutes ago m Set Milestones

Milestones Z

Add Comment

No Milestones Assigned

H B £ = i = = e & BA Select a Response Template R Preview

ml\ otifications

General controls on the Issue Details page include:

Jump to Latest - Links to the Add Comment section at the bottom of the page.
Actions - Use Actions menu options to update the issue. Actions menu options include:
— Edit Title

— Edit Issue Text

— Set Assignees

— Set Labels

— Set Milestones

— Associate App or Page

— Mark as Duplicate

— Delete Issue
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— Close Issue

# Note:

Only an issue owner or an administrator can update an issue title or
description, or delete an issue.

Show Actions - Shortcut menu containing two options: Edit and Delete Issue.
Edit functions the same as Edit Issue Text on the Actions menu.

Set Assignees - Shortcut menu in the right region that functions the same as Set
Assignees on the Actions menu.

Set Labels - Shortcut menu in the right region that functions the same as Set
Labels on the Actions menu.

Set Milestones - Shortcut menu in the right region that functions the same as Set
Milestones on the Actions menu.

Notifications - Enable Subscribe to receive notifications regarding updates to the
current issue.

Attachments - Click Attachments to view attachments associated with this issue.

4.2.4.2 Updating the Issue Title

View an issue and then update the issue title.

ORACLE

Only an issue owner or an administrator can update an issue title.

To update the issue title:

1.

2.

3.

View the issue:
a. Click the Team Development menu.
b. Click the issue title.

The Issue Details page appears.
From the Actions menu, select Edit Title.

= . p
lssues ' Issue Details o Jump to... v m

New Feature ghou

#19 Opened 2 weeks ago by ADMIN - 1 comments

Jump to Latest Actions v

& Edit Iss.e! et n

@ admin Created this issue 2 weeks ago d

M, set Assignees

Feature Summary

) . © Set Labels
* Provide a one paragraph general overview of the feature reguest. b SetLabels
b Set Milestones
Context
» Does this request relate to a specific situation or process? For example, "I am always frustratec whe T Assotiste with App or Fage 7
: 51 Ma Duplicat:
Preferred Solution i Mk as Luplieate
* Provide a clear description of what you would like to see implemented. [l Delete Issue
(7) Close lssue
&
0 admin  assigned developer 88 developer2 to this issue 2 weeks ago
Enhancement Requests
m @ admin added| Enhancement Request || Critical | to this issue 2 weeks ago Critical

In Edit Issue Title dialog:
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Issue Title - Update the title.
Click Apply Changes.

4.2.4.3 Updating the Issue Description

View an issue and update the issue description (also known as the Issue Text).

Only an issue owner or an administrator can update an issue description (or text).

To update the Issue Text:

1.

2.

3.

View the issue:

a.

b.

Click the Team Development menu.
Click the issue title.

The Issue Details page appears. You can update an Issue Text by either selecting
Edit Issue Text from the Actions menu, or by clicking Show Actions, Edit.

From the Actions menu, select Edit Issue Text.

. New Feature

o #19 Opened 2 weeks ago by ADMIN - 1 comments

T ) Issues ' Issue Details Jﬁ Jump to.., ~ m

About
Jump to Latest Actions v

& Edit Title

. ~ [ Edit Issue Text
@ admin Created this issue 2 weeks ago

B, Set Assigiiees e
Feature Summary » SELASSIONEES khat help

) . €S <ot Lamelc
* Provide a one paragraph general overview of the feature request. b Setlabels

<& Set Milestones
Context
« Does this request relate to a specific situation or process? For example, "I am always frustrated whe T+ Associate with App or Fage 7
. 3] Mark as Duplicate
Preferred Solution -
* Provide a clear description of what you would like to see implemented. W Delete Issue
-(:.i Close Issue
Vi
@ admin assigned 3 developer 8 developer? to this issue 2 weeks ago
E Q admin added| Enhancement Request ” Critical | to this issue 2 weeks ago

In the Edit Issue dialog:

a.

Update the description of the issue. Use the Markdown tools above the field to add
formatting.

Click Preview to preview the HTML.
Click Apply Changes.

4.2.4.4 Managing Comments

ORACLE

Add or edit issue comments on the Issue Details page.

Adding Issue Comments or Attaching a File
View an issue and then add comments.

Editing Issue Comments
View an issue to edit, hide, or delete existing comments.
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4.2.4.4.1 Adding Issue Comments or Attaching a File

ORACLE

View an issue and then add comments.

To add issue comments:

1.

SSues

View the issue:
a. Click the Team Development menu.
b. Click the issue title.
The Issue Details page appears.
Scroll down to Add Comment.
Tip:
You can also click the Jump to Latest button adjacent to the issue title
Enter a comment. Under Add Comment:
a. Select a Response Template - Select a template if appropriate.
b. Enter comments in the field provided.
c. To add formatting (such as bold or italic), click the icons in the toolbar. To
preview the rendered HTML, click the Preview button.
Attach a file. Under Add Comment, click Attach Files.
Tip:
The Attach Files icon does not appear unless you have enabled the
workspace-level attribute, Enable Issue File Repository.
To save your changes:
e If the issue is open:
— Click Comment to save your changes.
— Click Comment and Close to save your changes and close the issue.
* Ifthe issue is closed:
— Click Comment to save your changes.
— Click Comment and Close to save your changes and close the issue.
# See Also:

e Closing an Issue

e Configuring Team Development in an Existing Workspace in Oracle
APEX Administration Guide
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4.2.4.4.2 Editing Issue Comments

View an issue to edit, hide, or delete existing comments.

To edit issue comments:

1.

View the issue:
a. Click the Team Development menu.
b. Click the issue title.

The Issue Details page appears.
Scroll down to the comment.

Find the Show actions menu which resembles three stacked circles. Click the Show
actions menu and select one of the following:

» Edit - Only available for administrators or the comment creator.

» Hide/Unhide - Only available for administrators.

* Delete- Only available for administrators or the comment creator.
To save your changes, click Apply.

To exit without saving your changes, click the Close icon (that is, the "X" enclosed with a
circle) in the upper right.

¢ See Also:

Closing an Issue

4.2.4.5 Setting Assignees

ORACLE

View an issue and then set assignees.

Assignees are users in the Oracle APEX workspace. To create a new assignee, a workspace
administrator or Instance administrator must create a new usetr.

To set assignees:

1.

View the issue:
a. Click the Team Development menu.
b. Click the issue title.

The Issue Details page appears.

4-13



Chapter 4
Creating and Updating Issues

T ) Issues ' Issue Details .ﬂ. Jump to... » m

7 New Feature ot e gbcul
ump to Latest
o #19 Opened 2 weeks ago by ADMIN - 1 comments

@ admin Created this issue 2 weeks ago

Feature Summary

* Provide a one paragraph general averview of the feature request.

Context
» Does this request relate to a spedfic situation or process? For example, "I am always frustrated when [..]" G TEE 7
Preferred Solution developer
* Provide a clear description of what you would like to see implemented. DE) Gevsloper?
Labels Vi
@ admin assigned €3 developer @8 developer? to this issue 2 weeks ago
B © worin e [t [ o i e 2 vesis oo

2. From the Actions menu, select Set Assignees.

You can also click the Set Assignees icon on far right side of the page.
3. Inthe Assignees dialog:

a. Select assignees to add to the issue.

b. Click Apply Changes.

A new event is added to the Event Timeline and the new assignees display under
Assignees in the far right region.

¢ See Also:

Managing Users in a Workspace and Managing Users Across an APEX
Instance in Oracle APEX Administration Guide

4.2.4.6 Setting Labels

ORACLE

View an issue and then set labels.

To set labels:

1. View the issue.
a. Click the Team Development menu.
b. Click the issue title.

The Issue Details page appears.
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T Issues Issue Details Jﬁ Jump to.. v m
- New Feature ) gbott
: Jump to Latest Actions

- #19 Opened 2 weeks ago by ADMIN - 1 comments

@ admin Created this issue 2 weeks ago

Feature Summary

* Provide 2 one paragraph general overview of the feature request.

Context

* Does this request relate to a specific situation or process? For example, "I am always frustrated when [.]"

Preferred Solution

* Provide a clear description of what you would like to see implemented.

Labels ra
@ admin assigned 3 developer @ developer? to this issue 2 weeks ago
) © aorin s [Eomancemen st vt o this s 2 nesks ag0

2. From the Actions menu, select Set Labels.

You can also click the Set Labels icon on far right side of the page.
3. Inthe Labels dialog:

a. Select labels to add to the issue.

b. Click Apply Changes.

A new event is added to the Event Timeline and the new labels display under Labels in
the far right region.

¢ See Also:

Managing Labels

4.2.4.7 Setting Milestones

View an issue and then set milestones.
Use Milestones to track events. You can assign one or more milestones to an event.
To set milestones:
1. View the issue:
a. Click the Team Development menu.
b. Click the issue title.

The Issue Details page appears.
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T ) Issues ' Issue Details .Q. Jump to... » m

About

New Feature Jump to Latest
#19 Opened 2 weeks ago by ADMIN - 1 comments

@ admin Created this issue 2 weeks ago

Feature Summary

* Provide a one paragraph general averview of the feature request. -

Context
» Does this request relate to a spedfic situation or process? For example, "I am always frustrated when [..]" Assignees 7
Preferred Solution e rores
* Provide a clear description of what you would like to see implemented. DE| gevsloper2
Labels £

Q admin assigned €3 developer @8 developer? to this issue 2 weeks ago

Enhancement Requests

[© [ P ey 1o this ssue 2 weeks ago

2. From the Actions menu, select Set Milestones.

You can also click the Set Milestones icon on far right side of the page.
3. In the Milestones dialog:

a. Select milestones to add to the issue.

b. Optionally select Show Closed Milestones.

c. Click Apply Changes.

A new event is added to the Event Timeline and the new milestones display under
Milestones in the far right region. The color of the milestone indicates the
following:

* Red - The milestones date is in the past.
*  Yellow - The milestones date is within two weeks.

* Green - The milestones date is more than two weeks 2 weeks in the future.

¢ See Also:

Managing Milestones

4.2.4.8 Associating an Issue with an App and Page

View an issue and then associate it with an application and page.
To associate an issue with an application and page:
1. View the issue:
a. Click the Team Development menu.
b. Click the issue title.
The Issue Details page appears.
2. From the Actions menu, select Associate with App and Page.

3. Inthe Associate App/Page dialog:

ORACLE 4-16



a. Application & Page Search - Select an application
b. Page - Select a page.

c. Comments - Enter any comments.

d. Click Apply.

A new event is added to the Event Timeline.

4.2.4.9 Marking an Issue as Duplicate

View an issue and then mark it as duplicate.

To mark an issue as duplicate:

1.

View the issue:
a. Click the Team Development menu.
b. Click the issue title.
The Issue Details page appears.
From the Actions menu, select Mark as Duplicate.
In the Mark Duplicate dialog:
a. Duplicate Issue - Select the duplicate issue.
b. Click Apply.

Chapter 4
Creating and Updating Issues

A new event is added to the Event Timeline identified by a an icon which resembles two

green pages.

4.2.4.10 Closing an Issue

Close an issue on the Issues Details page.

Closing an Issue
View an issue and then close it.

Viewing or Reopening a Closed Issue
View or reopen a closed issue on the Issues page.

4.2.4.10.1 Closing an Issue

ORACLE

View an issue and then close it.

To close an issue:

1.

View the issue:
a. Click the Team Development menu.
b. Click the issue title.

The Issue Details page appears.

From the Actions menu, select Close Issue.

The icon adjacent to the issue title changes from green to red and contains a red check
mark. In addition, a new event is added to the Event Timeline which reads:

set status for this issue to CLOSED Now
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4.2.4.10.2 Viewing or Reopening a Closed Issue
View or reopen a closed issue on the Issues page.

To view or reopen a closed issue:
1. Click the Team Development menu.

The Issues page appears. Open issues have a green icon and closed issues have
a red icon and check mark.

1) Issues 0o Jump to... v m

Cf'\ o Search: All Text Columns Go o= BB Actions Update Reset About
Team Development enables you
to track and manage issuesin a
 Welcome to Team Development in Oracle APEX! =5 conversational fashion. You can
~ Opened 7 weeks ago by ADMIN <5 Code Freeze o EEEST) BRI EES,
- - assign users to issues, link an
issue with milestones, and
attach files to an issue.
rg Sample Issue 1 1
W . - v Learn Mare ...
#2 Opened 7 weeks ago by ADMIN i
Open Issues
—~, Sample Issue 2 —
L) =0
& %3 0Opened 57 seconds ago by ADMIN
@ 3 ’ ’
Total COwmed

2. Find the closed issue and click the issue title.
The Issue Details page appears.

3. From the Actions menu, select Reopen Issue.

T Issues Issue Details "‘ Jump to... m

— About
TN
! Sa mple |SSUE 1 Jump to Latest Actions . ~ .
= #2 Opened 7 weeks ago by ADMIN - 1 comments Issued Details enables you to
issue. On
(& Edit Title see the
g all
. o _ [ Edit Issue Text 5 inmorder
E admin Created this issue 7 weeks ago cright
D, sSetAssignees ons that
Feature Summary L mafeslblas |
N . : o # 1 ahels
+ Provide a one paragraph general overview of the feature request. b Setlabels
<& Set Milestones
Context 7
« Does this request relate to a specific situation or process? For example, "l am always frustrat T+ Associate with App and Page
(-] 1 Mark as Duplicate
+ Please provide any supporting information, including screenshots, use cases, and so forth. T Delete Issue Vi
Preferred Solution [© Reopen lssue
+ Provide a clear description of what you would like to see implemented.
Milestones Vi

The icon adjacent to the issue title changes from red to green and the red check
mark disappears.
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A new event is added to the Event Timeline which reads:

set status for this issue to OPEN Now

4.2.4.11 Managing Deleted Issues

Issue owners or administrators can delete an issue on the Issue Details page. Manage
deleted issue (that is, delete them forever or reinstate them) by navigating to Ultilities,
Manage Deleted Issues.

e Deleting an Issue
Issue owners or administrators can delete an issue.

e Reinstating Deleted Issues
Reinstate deleted issues on the Manage Deleted Issues Page.

e Permanently Remove Deleted Issues
Permanently remove deleted issues on the Manage Deleted Issues page.

4.2.4.11.1 Deleting an Issue
Issue owners or administrators can delete an issue.
To delete an issue:
1. View the issue:
a. Team Development menu.
b. Click the issue title.
The Issue Details page appears.
2. From the Actions menu, select Delete Issue.
A confirmation page appears asking if you are sure you want to delete the issue.

3. On the confirmation page, click OK.

4.2.4.11.2 Reinstating Deleted Issues

Reinstate deleted issues on the Manage Deleted Issues Page.
To reinstate a deleted issue:

1. From the Team Development menu, select Utilities.

2. Click Manage Deleted Issues.

3. Select the issue.

4. From the Update menu, select Reinstate Selected.

Confirm your selection, and click Apply.

4.2.4.11.3 Permanently Remove Deleted Issues
Permanently remove deleted issues on the Manage Deleted Issues page.

To permanently remove deleted issues:

1. From the Team Development menu, select Utilities.
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Click Manage Deleted Issues.

Select the issue.

To permanently delete selected issue:

a. Select the issues to be removed.

b. From the Update menu, select Permanently Delete Selected.
Confirm your selection, and click Apply.

To purge all deleted issues, click Purge All.

4.3 Viewing Your User Profile

Click the Notifications icon on the Team Development toolbar view and manage your
own notifications and view all issues you own.

Viewing Your Issues
View the User Profile, Issue page to view a report of all issues you own or are
monitoring.

Viewing Your Notifications
View and manage your notifications on the Notifications page.

4.3.1 Viewing Your Issues

View the User Profile, Issue page to view a report of all issues you own or are
monitoring.

To view issues you own;

1.
2.

ORACLE

Click the Team Development menu.

On the Issues page, click the Notifications icon on the toolbar at the top of the
page.

The User Profile, Notifications page appears displaying notifications.

Click the Issues tab.

The Issues page appears displaying all issues you own or are monitoring.

To view an issue, click the issue title.

To configure the type and frequency of your notifications, click Notification
Preferences.

" See Also:

e Editing Your Own Notification Preferences
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4.3.2 Viewing Your Notifications

View and manage your natifications on the Notifications page.

Whenever a users interacts with an issue, Team Development creates an event. For
example, an event can be creating issue or involve updating the issue. Notifications are a
record of these events.

To view your own user naotifications:
1. Click the Team Development menu.
2. On the Issues page, click the Notifications icon on the toolbar at the top of the page.

The User Profile, Notifications page appears displaying notifications for all issues you
own or are monitoring.

3. To delete all notifications, click Clear Notifications

4. To configure the type and frequency of your notifications, click Notification Preferences.

¢ See Also:

Editing Your Own Notification Preferences

4.4 Managing Labels

ORACLE

Create and update label groups and labels to classify issues.

If you completed the setup process, you can view sample labels and label groups by going to
Team Development, Utilities, Manage Labels.

e About Labels Groups and Labels
Use label groups and the associated labels to classify issues.

» Creating Label Groups
Create label groups clicking Create on the Labels page.

» Editing Label Groups
Edit label groups on the Manage Labels page.

* Adding Labels
Create labels on the Manage Labels page.

» Editing or Deleting Labels
Edit labels on the Manage Labels page.

# See Also:

Setting Labels
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4.4.1 About Labels Groups and Labels

Use label groups and the associated labels to classify issues.

Label Groups and Labels

Labels are organized into label groups and enable you to classify issues. For
example, the Label Group Level of Effort could contain the labels Easy Fix,
Moderate Effort, and Large Development Effort.

Each label group has an identifying color to enable you to quickly identify labels
associated with the same group. You can define label groups as exclusive or non-
exclusive. In exclusive label groups, only one label from the group may be assigned
to an issue at a time. Applying another label from the same exclusive group removes
any current label from that group. In non-exclusive label groups, you can assign
multiple labels to an issue from the same label group.

Sample Label Groups and Labels

The following are two sample label groups and labels included in Team Development
when you complete the setup process and install Sample Labels:

e Importance (Label Group)
—  Critical (Label)
— Important (Label)
— Normal (Label)
— Backlog (Label)
—  Will Not Address (Label)

This Label Group is exclusive meaning that only one label can be applied to an
issue.

e Functional Area (Label Group)
— Bug (Label)
— Enhancement Request (Label)
— Feature Request (Label)
—  Security Issue (Label)
— Performance Issue (Label)
— Documentation Issue (Label)
— Training Issue (Label)

This Label Group is non-exclusive meaning that only one label can be applied
one or more labels.

If you completed the setup process, you can view the other sample label groups and
labels by clicking the Team Development menu and selecting Labels. To view the
labels within a label group, click a label group name.
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Tip:

You also access Labels page from the Utilities page. Click the Team Development
menu and select Utilities and then Manage Labels.

4.4.2 Creating Label Groups

Create label groups clicking Create on the Labels page.

To create a label group:

1.

4,

Click the Team Development menu and then select Labels.

The Labels page appears.

On the Labels page, click Create.

In Create/Edit Label Group dialog:

a. Group Name - Enter a unique name for the label group.

b. Group Label Color - Select a color to display all labels within the group.

c. Values are Exclusive - Determines if the values of the group are exclusively assigned
to an issue. Options include:

* On - Only one label from the group can be assigned to an issue at any given
time.

e Off - Multiple labels from the same group may be assigned to an issue.
d. Group Description - Enter a description of the group.

Click Create.

4.4.3 Editing Label Groups

Edit label groups on the Manage Labels page.

ORACLE

Use label groups to classify labels.

To edit a label group:

1.

Click the Team Development menu and then select Labels.
The Labels page appears.

Note that each a label group has an identifying color making it and the associated labels
easier to identify.

On the Labels page, select the label group name.

The Manage Labels page appears, displaying labels in the current group.
Click Edit Group.

The Create/Edit Label Group dialog appears.

To edit the label group, edit the following attributes:

a. Group Name - Enter a unique name for the label group.

b. Group Label Color - Select a color to display all labels within the group.
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c. Values are Exclusive - Determines if the values of the group are exclusively
assigned to an issue. Options include:

* On - Only one label from the group can be assigned to an issue at any
given time.

»  Off - Multiple labels from the same group may be assigned to an issue.
d. Group Description - Enter a description of the group.
e. Click Apply Changes.
To delete the label group, click Delete in the Create/Edit Label Group dialog.

4.4.4 Adding Labels

Create labels on the Manage Labels page.

To add a new label to a label group:

1.
2.

4,
5.

Click the Team Development menu and then select Labels.

On the Labels page, select the label group name.

The Manage Labels page appears, displaying labels in the current group.

On the Manage Labels page, click Add Row.

A new row appeatrs.

In the new row, enter the Sequence, Label Name, Label Slug, and Label Desc.
Click Save.

4.4.5 Editing or Deleting Labels

Edit labels on the Manage Labels page.

ORACLE

To edit existing labels:

1.
2.

Click the Team Development menu and then select Labels.
On the Labels page, select the label group name.

The Manage Labels page appears, displaying an editable interactive grid of labels
in the current group.

To edit a single cell:

a. Double-click the cell you want to edit.
b. Enter your changes and click Save.
To edit a multiple rows:

a. Select rows by selecting checkboxes in the checkbox column.

Tip:

To select all rows, click the checkbox in the column. With all rows
selected, click it again to deselect all rows.

b. Select the cells you wish to edit and enter your changes.
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c. Click Save.
5. To delete multiple rows:
a. Select the rows to be deleted.

b. Click the Actions menu and then select Selection, Delete Rows.

Tip:

To delete a single row, click Row Actions icon (to the right of the checkbox)
and select Delete Row.

c. Click Save.

" See Also:
Using an Editable Interactive Grid in Oracle APEX End User’s Guide

4.5 Managing Milestones

Create and update issues milestones to track events.

If you completed the setup process, you can view sample milestones clicking the Team
Development menu and selecting Milestones.

* Creating Milestones
Create milestones by clicking Create on the Milestones page.

» Editing and Deleting Milestones
Edit or delete an existing milestone by selecting the milestone name on the Milestones

page.

¢ See Also:

Setting Milestones

4.5.1 Creating Milestones

Create milestones by clicking Create on the Milestones page.

To create a milestone:

1. Click the Team Development menu and then select Milestones.
2. On the Milestones page, click Create Milestone.

3. On the Milestone page:

a. Milestone Name - Enter a unique name for the milestone.
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Slug - A unique string identifier for the milestone that will be used in URLSs.

Date - Select a date for the milestone.

Milestone Status - Select Open or Closed.

Description - Enter a description of the milestone.

4. Click Create.

4.5.2 Editing and Deleting Milestones

Edit or delete an existing milestone by selecting the milestone name on the Milestones

page.

To edit or delete a milestone:

1. Click the Team Development menu and then select Milestones.

The Milestones page appears.

2. To edit a milestone:

a.
b.

C.

d.

On the Milestones page, click the milestone name.
Click Edit Milestone.

On the Milestone page:

Milestone Name - Enter a unique name for the milestone.

Slug - A unique string identifier for the milestone that will be used in URLSs.
Date - Select a date for the milestone.

Milestone Status - Select Open or Closed.

Description - Enter a description of the milestone.

Click Apply Changes.

3. To delete a milestone:

a.
b.
c.

d.

On the Milestones page, click the milestone name.
Click Edit Milestone.
Click Delete.

In the confirmation dialog, confirm the deletion by clicking OK.

4.6 Managing Templates

Create and update templates for issues and issue comments.

ORACLE

Templates enable you to provide users with starter text for issues and comments.
Once you create a new template, you can select it when you create a new issue or
add a comment.

If you completed the setup process, you can view sample template by going to Team
Development, Utilities, Manage Templates.

* Creating Issue Templates
Create an issue template by clicking Create on the Templates page.

e Editing or Deleting Issue Templates
Edit existing templates by selecting the template title on the Templates page.
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4.6.1 Creating Issue Templates

Create an issue template by clicking Create on the Templates page.

The text of a template defines the outline of what a user should enter.

To create an issue template:

1.
2.
3.

4.

Click the Team Development menu and then select Manage Templates.

On the Templates page, click Create Template.

On Edit Template page:

a. Template Name - Enter a unique name for the template.

b. Template Description - Describe the purpose of template, including what it should be
used for.

c. Template Type - Select a template type:
e Issue - Select Issue when creating a new issue from scratch.
* Response - Select Response when entering a comment.

d. Enter the template text and provide an outline of what a user should enter.
Use the Markdown tools above the field to add formatting. Click Preview to preview
the HTML.

Click Create.

4.6.2 Editing or Deleting Issue Templates

Edit existing templates by selecting the template title on the Templates page.

ORACLE

To edit or delete a template:

1.
2.
3.

Click the Team Development menu and then select Manage Templates.

On the Templates page, click the template name.

Click Edit Template.

The Edit Template page appears.

Edit the template attributes:

a.

b.

e.

Template Name - Enter a unique name for the template.

Template Description - Describe the purpose of template, including what it should be
used for.

Template Type - Select a template type:

Enter the template in the field provided. To add formatting (such as bold or italic),
click the icons in the toolbar. To preview the rendered HTML, click the Preview
button.

Click Apply Changes.

To delete the template:

a.

b.

Click Delete.

In the confirmation dialog, confirm your selection and click OK.
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4.7 Using Team Development Utilities

Use Utilities page to manage deleted issues, manage templates, milestones, and
labels, view uploaded files, purge data, reassign issues to another user, reassign issue
owners, remove a milestone or label from all issues, and manage user natifications.

4.7.1 Team

ORACLE

Team Development Utilities
Access the Utilities page by selecting Team Development, Utilities.

Managing Uploaded Files
View and delete uploaded files attached to issues in the workspace.

Purging Data
Users with administrator privileges can purge data for selected components.
Reassigning Issues to Another Assignee

Users with administrator privileges can reassign issues from one assignee to
another for all issues, or only issues having an Open status.

Reassigning the Issue Owner
Users with administrator privileges can reassign the issue owner.

Removing a Milestone for All Issues
Users with administrator privileges can emove a specific milestone from all issues.

Removing Labels for All Issues
Users with administrator privileges can remove specific labels for all issues.

Managing Notification Preferences
Enables administrators to manage notification preferences.

Development Utilities

Access the Utilities page by selecting Team Development, Utilities.

User with administrator rights can see the following links on the Utilities page:

Manage Deleted Issues - Purge or reinstate issues that have been deleted. See
Managing Deleted Issues.

Manage Templates - Manage templates for issues and comments. See Managing
Templates.

Manage Milestones - Create and update issues milestones used to track events.
See Managing Milestones.

Manage Labels - Manage Label Groups and Label used to classify issues. See
Managing Labels.

View Files - View and delete uploaded files attached to issues in the workspace.
See Managing Uploaded Files.

Purge Data - Purge all data for selected components. See Purging Data.

Update Assignments - Perform bulk reassignment of issues to a given user. See
Reassigning Issues to Another Assignee.

Reassign Owner - Perform bulk reassignment of issue owners to a given user.
See Reassigning the Issue Owner.
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Remove Milestone from All Issues - Remove a milestone from all issues. See
Removing a Milestone for All Issues.

Remove Labels from all Issues - Remove a label from all issues. See Removing Labels
for All Issues.

Manage User Notifications Preferences - Manage issue notification preferences of all
users within the workspace. See Managing Notification Preferences.

4.7.2 Managing Uploaded Files

View and delete uploaded files attached to issues in the workspace.

The Issues Files page displays a report of uploaded files. Each file displays on a separate
row and includes the file name, associated issue, file size, date the file was added, and the
associated user.

To view and delete uploaded files:

1.
2.

From the Team Development menu, select Utilities.

Click View Files.

The Issues Files page appears.

On the Issues Files page you can:

 Download the File - Under Name, click the file name.

* Link to the Issue - Click the Issue Title to link to the Issue Details page.

» Delete the File (Administrators only) - Select the file and click Delete Checked.

4.7.3 Purging Data

Users with administrator privileges can purge data for selected components.

WARNING:

Purging data removes all the data for the selected component.

To purge data:

1.
2.
3.

From the Team Development menu, select Utilities.

Click Purge Data.

On the Purge Data page you can:

a. Select the components for which you wish to purge data.
b. Click Delete.

4.7.4 Reassigning Issues to Another Assignee

Users with administrator privileges can reassign issues from one assignee to another for all
issues, or only issues having an Open status.

To reassign issues:

ORACLE
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From the Team Development menu, select Utilities.
Click Update Assignees.
The Update Assignees page appears.

On Update Assignee:

a. Change From - Select current assignee that you wish to reassign. Users
marked as Orphan are current assignees whose related APEX user has been
removed.

b. Change To - Select the new assignee.

c. For Open Issues Only? - Choose whether assignments should be changed for
Open issues only, or for all issues.

Click Next.
A report appears detailing the issues to be reassigned.

Click Change Assignee.

4.7.5 Reassigning the Issue Owner

Users with administrator privileges can reassign the issue owner.

To reassign the issue owner:

1.
2.

5.

From the Team Development menu, select Utilities.
Click Reassign Owner.
The Reassign Owner page appears.

On Reassign Owner:

a. Change From - Select current owner that you wish to reassign. Users marked
as Orphan are current assignees whose related APEX user has been
removed.

b. Change To - Select the new owner.

c. For Open Issues Only? - Choose whether assignments should be changed for
Open issues only, or for all issues.

Click Next.
A report appears detailing the issues to be reassigned.

Click Change Owner.

4.7.6 Removing a Milestone for All Issues

Users with administrator privileges can emove a specific milestone from all issues.

ORACLE

To remove a specific milestone from all issues:

1.
2.

From the Team Development menu, select Utilities.
Click Remove Milestone from All Issues.
The Remove Milestone page appears.

On Remove Milestone:

a. Milestone - Select the milestone that you wish to disassociate from the
selected issues.
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b. For Open Issues Only? - Choose whether the disassociation should occur for Open
issues only, or for all issues.

Click Next.
A report appears detailing the issues to be reassigned.

Click Remove Milestone.

4.7.7 Removing Labels for All Issues

Users with administrator privileges can remove specific labels for all issues.

To remove specific labels for all issues:

1.
2.

5.

From the Team Development menu, select Utilities.

Click Remove Labels from All Issues.

The Remove Labels page appears.

On Remove Labels:

a. Label - Select the Label or Label Group to be removed.

b. For Open Issues Only? - Choose whether Labels should be removed for Open issues
only, or for all issues.

Click Next.
A report appears detailing the issues to be reassigned.

Click Remove Labels.

4.7.8 Managing Notification Preferences

Enables administrators to manage notification preferences.

Whenever a users interacts with an issue, Team Development creates an event. For
example, an event can be creating an issue, closing an issue, or adding a comment.
Notifications are a record of these events. Users can view their own notifications on the
User Profile, Notification page. Administrators can configure user notifications preferences
by going to Utilities, Manage User Notification Preferences.

Editing Your Own Notification Preferences
Edit your own notification preferences.

Adding User Notification Preferences
Users with administrator privileges can add notification preferences for any user.

Editing Notification Preferences for Other Users
Users with administrator privileges can edit notification preferences for other users.

4.7.8.1 Editing Your Own Notification Preferences

Edit your own notification preferences.

To edit your notification preferences:

1.
2.

ORACLE

Click the Team Development menu.

On the Issues page, click the Notifications icon.
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The Notifications page appears displaying notifications for all issues you own or
are monitoring.

Click Notification Preferences to specify which notifications you would like to
receive.

The Notification Preferences dialog appears.
On Notification Preferences:

a. For Receives Emails? - Choose whether the user receives emails for
subscribed events.

b. Frequency - If the user has opted to receive emails, this setting determines
how often emails are sent. Select a Frequency:

* Immediately
e Hourly Summary
e Daily Summary

c. Receive Notifications When - Select the types of notifications the user is
interested in.

If the user is receiving emails, the selected notifications are sent at the
selected Frequency. If the user has opted not to receive emails, notifications
are viewable using the user's profile page.

Click Save Settings.

4.7.8.2 Adding User Notification Preferences

ORACLE

Users with administrator privileges can add notification preferences for any user.

To add user notification preferences for any user:

1.
2.

From the Team Development menu, select Utilities.
Click Manage User Notification Preferences.

The Manage Notification Preferences page appears.

To add a new notification, click Add Preference for User.
On Manage Notification Preference:

a. Add User - Indicates the user whose notification preferences are being added.
Only users who do not already have notification preferences set will appear in
this list.

b. For Receives Emails? - Choose whether the user receives emails for
subscribed events.

c. Frequency - If the user has opted to receive emails, this setting determines
how often emails are sent. Select a Frequency:

* Immediately
*  Hourly Summary
o Daily Summary

d. Receive Notifications - Select the types of naotifications the user is interested
in.
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If the user is receiving emails, the selected notifications are sent at the selected
Frequency. If the user has opted not to receive emails, notifications are viewable
using the user's profile page.

Click Save Settings.

4.7.8.3 Editing Notification Preferences for Other Users

Users with administrator privileges can edit notification preferences for other users.

To user notification preferences for other users:

1.
2.

5.

From the Team Development menu, select Utilities.
Click Manage User Notification Preferences.

The Manage Notification Preferences page appears.
Select a user to edit.

On Manage Notification Preference:

a. Edit User - Displays the current user.

b. For Receives Emails? - Choose whether the user receives emails for subscribed
events.

c. Frequency - If the user has opted to receive emails, this setting determines how often
emails are sent. Select a Frequency:

* Immediately
*  Hourly Summary
o Daily Summary
d. Receive Notifications When - Select the types of notifications the user is interested in.

If the user is receiving emails, the selected notifications are sent at the selected
Frequency. If the user has opted not to receive emails, notifications are viewable
using the user's profile page.

Click Save Settings.

4.8 Managing Feedback

Feedback provides a mechanism for end users to post general comments for application
administrators and developers.

ORACLE

About Feedback

Adding Feedback enables you to gather and track real-time comments, enhancement
requests, and bugs from application users. Feedback enhances communication between
the user community and the application owners.

Adding Feedback Using the Create Application Wizard
Add a Feedback page when running the Create Application Wizard.

Adding Feedback Using the Create Page Wizard
Use the Create Page Wizard to add Feedback to an existing application.

Submitting Feedback Within a Running Application
Users can submit feedback by clicking the Feedback navigation bar icon in the upper
right of a running application.
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* Reviewing Feedback Within an Application
View feedback within a running application by clicking User Feedback on the
Administration page.

»  Configuring Feedback to Support Attachments
Configure feedback to add support for attachments.

e Tracking Feedback
Track all feedback within a workspace on the Feedback page.

4.8.1 About Feedback

ORACLE

Adding Feedback enables you to gather and track real-time comments, enhancement
requests, and bugs from application users. Feedback enhances communication
between the user community and the application owners.

Feedback provides a mechanism for end users to post general comments for
application administrators and developers. The posts include useful session state
information to help developers determine where the end user sent the feedback from.
Providing such an easy feedback loop enhances communication between the user
community and the application owners, which leads to greatly improved end user
satisfaction.

Creating Feedback:

* Adds a Feedback navigation bar icon in the running application which users can
click to leave feedback.

» Creates an report for viewing and triaging feedback.
»  Captures the application name, page ID and name, feedback comments, date and
time, and user information.

Choosing How to Add Feedback

You can create a Feedback page automatically using a wizard when you create a new
application, or by adding a page to an existing application. In both the Create
Application Wizard and the Create Page Wizard, you simply select the Feature,
Feedback.

How Customers Submit Feedback

Users can submit feedback by clicking the Feedback navigation bar icon in the upper
right of a running application. In the Feedback window, they can rate their user
experience by selecting an emoji, entering feedback comments, or uploading files.

Viewing Feedback within an Application

Administrators and developers can track and manage Feedback at the application
level by running the application and accessing the Feedback region on the
Administration page. To control whether users can upload attachments, click
Feedback Settings. To view feedback entries, select User Feedback to view the
Manage Feedback report.

Tracking Feedback in Team Development

Administrators and developers can track all feedback within a workspace in Team
Development, Feedback. Each feedback entry tracks the application and page ID and
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name, displays any feedback comments. Administrators and developers can assign a status
and create an issue.

4.8.2 Adding Feedback Using the Create Application Wizard

Add a Feedback page when running the Create Application Wizard.

To create an application which includes a Feedback page:

g M @ Db P

On the Workspace home page, click the App Builder icon.

Click the Create button.

Click Application.

For Name, enter the name used to identify the application to developers.

For Appearance, accept the default Theme Style and menu layout (Vita, Side Menu) or
change it by clicking the Set Appearance icon adjacent to the Appearance field.

To add a new page (such as a blank page, calendar, chart, form, report, and so on), click
Add Page and select the desired page type.

Under Features, select Feedback.

Under Settings, specify settings used to generate this application. To learn more about an
attribute, click the Help icon adjacent to Settings.

Click Create Application.
¢ See Also::

Understanding Page Types, Features, and Settings

4.8.3 Adding Feedback Using the Create Page Wizard

Use the Create Page Wizard to add Feedback to an existing application.

ORACLE

Tip:

This section describes how to create a feedback by running the Create Page
Wizard from the Application home page. You can also run this wizard in Page
Designer by clicking the Create menu and selecting Page.

To add a feedback page:

1.
2.

On the Workspace home page, click App Builder.
Select an application.

The Application home page appears.

Click the Create Page button.

For Create a Page:

a. Page Type - Select Feature and then Feedback.
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Tip:

Component pages provides page-level functionality and can be
added multiple times within a given application such as reports,
forms, charts, or calendars. Feature pages provide application-level
functionality and can only be added once per application.

The Create Feedback Page appears.
Click Next.

5. On the Create Feedback Pages:

a.

g.

Starting Page Number - Enter an unused starting page number. This feature
will create multiple pages starting with the number specified.

Page Group - Identify the name of the page group to associate with this page.
Page groups help developers manage the pages within an application. To use
an existing page group, select the name from the list.

Build Option - The listed build option(s) to be created to support this feature.

Include in Navigation Bar - Select On to create a navigation bar entry within
the current application to invoke your new feedback page.

Navigation Bar Label - Enter the name of the new navigation bar entry used to
access the new feedback page.

Administration Page Preference - Specify the administration page to which a
list will be added for this feature.

Options include:

* Create a new page

- ldentify an existing page

Depending upon your selection, the Ul changes.

Follow the on-screen instructions.

6. Click Create.

4.8.4 Submitting Feedback Within a Running Application

Users can submit feedback by clicking the Feedback navigation bar icon in the upper
right of a running application.

ORACLE

To submit feedback managed with the application:

1. Run the application for which you want to submit feedback.

2. Click the Feedback navigation bar icon in the upper right corner.

A Feedback window appears.

3. In Feedback:

a.

b.

Experience - Select an emoji that reflects your user experience (Positive,
Neutral, or Negative).

Feedback - Enter a comment.
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c. Attachment - Click Choose File to upload an attachment.

Tip:

Administrators can enable and disable attachments by selecting
Administration and editing Feedback Settings.

4. Click Submit Feedback.

4.8.5 Reviewing Feedback Within an Application

View feedback within a running application by clicking User Feedback on the Administration
page.

To view feedback within an application:
1. Run the application.
2. Click Administration in the left navigation bar.
3. Click User Feedback.
The Manage Feedback page displays an interactive report.
4. Click the Edit icon adjacent to the entry you wish to view.
5. On the Feedback page:
a. Review the user feedback.
b. Response - Respond to the feedback.
c. Status - Select one of the following:
* No Action
 Acknowledged
 Open
¢ Closed
6. To delete the feedback, click Delete.

7. To save your changes, click Apply Changes.

4.8.6 Configuring Feedback to Support Attachments

ORACLE

Configure feedback to add support for attachments.

# Note:

For this feature to work, an administrator must set Enable Feedback File
Repository to Yes for the workspace. See Configuring Team Development in an
Existing Workspace in Oracle APEX Administration Guide.

Developer and administrators can also configure Feedback Settings to enable support for
attachments.
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To configure Feedback Settings:

5.

Run the application.

Click Administration in the left navigation bar.
Click Feedback Settings .

Feedback Settings appears.

For Enable Attachments, select On to enable users to upload attachments or Off
to disable this functionality.

To save your changes, click Apply Changes.

4.8.7 Tracking Feedback

Track all feedback within a workspace on the Feedback page.

Administrators and developers can track all feedback within a workspace in Team
Development. Each feedback entry tracks the application and page ID and name,
user, user email, and user comments. Administrators and developers can review the
feedback, assign a type, create an issue and assign a status.

Viewing the Feedback Dashboard
Viewing the Feedback Report
Viewing Feedback by Filing User
Viewing the Feedback Calendar

4.8.7.1 Viewing the Feedback Dashboard

To access the Feedback report:

1.

Click the Team Development menu and select Feedback.
The Feedback Dashboard appears.

Click the Report tab.

The Feedback Dashboard appears.

To link from the Feedback Dashboard:

» Open Feedback, Feedback Users, or Feedback Entries - Click the number
enclosed by a circle to link to the appropriate page or report.

- By Status, By Application, or By Filer - Lists feedback details. Click the link
to view more details.

*  Summary - Summaries feedback entries. Click the number above to summary
entry to link the appropriate report or page.

4.8.7.2 Viewing the Feedback Report

To access the Feedback report:

1.

2.

ORACLE

Click the Team Development menu and select Feedback.
The Feedback Dashboard appears.
Click the Report tab.
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The Feedback Report appears.

To customize the report, use the Actions menu in Search bar at the top of the page. Click
Reset to return the report to the default view.

3. Select a number in the Feedback column.
The View/Edit Feedback dialog appears.
4. On View/Edit Feedback:
a. Review the user feedback.
b. Type - Classify the feedback. Select one of the following:
* General Comment
 Enhancement Request
* Bug
c. Disposition - Select one of the following:
* Logas Bug
e Logas To Do
* Log as Feature
* Log as Issue
5. For Status, select a status of the feedback entry:
* 0. No Status
* 1. Acknowledged
* 2. Additional information requested
e 3. Open Processing Feedback
* 4.Closed
6. To delete a feedback entry, click Delete.

7. To save your changes, click Apply Changes.

4.8.7.3 Viewing Feedback by Filing User

To view feedback by filing user:

1. Click the Team Development menu and select Feedback.
The Feedback Dashboard appears.

2. Click the By Filing User tab.
The By Filing User report appears.

To customize the report, use the Actions menu in Search bar at the top of the page. Click
Reset to return the report to the default view.

3. To view the feedback, click the user in Filing User column.

4.8.7.4 Viewing the Feedback Calendar

To view the Feedback Calendar:

1. Click the Team Development menu and select Feedback.
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The Feedback Dashboard appears.
2. Click the Calendar tab.

The Calendar appears.
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An application is a collection of pages linked together using navigation menus, tabs, buttons,
or hypertext links. Application pages share a common session state and authentication.

To create an application, a developer runs wizards to declaratively assemble pages and
navigation. Individual pages are organized using containers called regions. Once created,
developers can modify an application by editing application attributes and add new pages
using the Create Page Wizard. Developers can further manage the development process by
creating page groups, locking and unlocking pages, adding developer and application
comments, and accessing a variety of application, page, and cross page utilities and reports.

*  About the Create Application Wizard
Learn about using the Create Application Wizard to design and quickly create Oracle
APEX applications.

* Creating an Application Based on a Table or Query
Run the Create Application Wizard and select New Application to create an application
containing multiple pages based on a table you select, or by providing a valid SQL query.

»  Creating an Application from a File
Run the Create Application Wizard and select From a File to upload a file and then
create an application on the uploaded data.

e Using Application Blueprints
Each iteration of the Create Application Wizard saves an application blueprint which you
can use to start adding pages to an application, or edit the application definition as a
JSON document.

e Copying an Application
Create a copy of an existing application.

*  Creating Applications for Mobile Devices
Build applications for mobile devices with mobile-specific design patterns that can provide
an optimal user experience for small screens.

* Deleting an Application
You can delete an application from the Application home page, or while editing
application attributes.

* Managing Application Attributes
Application attributes control the behavior of an entire application and are divided into the
categories: Definition, Security, Globalization, User Interface, and Progressive Web App.

e Managing Application Logos
Add and update an application logo in an Oracle APEX application.

e Managing Application Icons
Add and update the icon that displays as the Favicon, the PWA icon, the Apple touch
icon, and the App Builder icon in Oracle APEX applications.

e Adding Developer Comments
Add comments to an application, a page, or a group of pages using the Developer
Comment, Bug, or To Do button. You can use developer comments to communicate
application changes, report issues, or record developer suggestions.
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* Using the Find Icon
Click the Find icon to search for items, pages, queries, tables, PL/SQL code, view
debug reports, view session state, and view errors.

e Adding Application Comments
Use Application Comments to describe an application or track developers involved
in the application development.

* Managing Application Groups
Organize applications by assigning them to application groups. To use application
groups, first create a group and then assign applications to it.

* Using Application Utilities
Access the Utilities page to view useful application summaries and reports.

» Using Workspace Utilities
Use the Workspace Utilities page to acccess REST Enabled SQL Services,
Remote Servers, Application Groups, Web Credentials, Workspace Themes,
Export, Oracle APEX Views, Manage Backups, and REST Source Catalogs.

5.1 About the Create Application Wizard

Learn about using the Create Application Wizard to design and quickly create Oracle
APEX applications.

*  Overview of Creating a New Application
Learn about how the Create Application Wizard works.

» Create Application Wizard Use Cases
Review common use cases when using the Create Application Wizard.

e Choosing the Application Type
Running the Create Application Wizard prompts you to choose the type of
application you want to create.

» Understanding Page Types, Features, and Settings
Learn about the supported page types, features, and configurable settings
available in the Create Application Wizard.

5.1.1 Overview of Creating a New Application

ORACLE

Learn about how the Create Application Wizard works.

Creating a new application with the Create Application Wizard is a multiple step
process. Once you specify the application name and appearance, you add pages.
Applications can contain multiple pages that include various components such as
calendars, cards, charts, dashboards, forms, interactive grids, master detail or editable
grids, and reports. Once created, you can edit the page names, alter the page order,
and delete them.

Features provide application-level functionality and can only be added once per
application. Available features include an Application About page, role-based user
authentication, end user activity reports, configuration options to enable or disable
specific functionality, a feedback mechanism to gather end user comments, and a
Customize button to enable end users to choose their own theme style.

Then, you configure Settings. Settings are used in the generation of the application
and include the application ID, the database schema, Advanced Settings (such as the
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application definition, security, and globalization attributes), and application authentication.

After you create an application using the Create Application Wizard, you can modify pages
and add additional pages using the Create Page Wizard. You can also take advantage of
application blueprints. Each time you run the Create Application Wizard, it saves an
application blueprint which you can use to start adding pages to an application, or edit the
application definition as a JSON document.

¢ See Also:

* Running the Create Application Wizard

e Managing Pages in an Application

5.1.2 Create Application Wizard Use Cases

Review common use cases when using the Create Application Wizard.
Common use cases when using the Create Application Wizard include:

» Create an app from existing data. Create an application and set of initial pages based
on existing data from a table or a query. Then, select application features, specify a
theme, and configure options. These initial pages can be used as is, or function as a
blueprint for creating a similar set of pages in the future. See Running the Create
Application Wizard and Using Application Blueprints.

* Create an app and add pages. Create an application and then add pages one at a time
using the Create Page Wizard. See Running the Create Application Wizard and Adding a
New Page to an Application.

* Create an app from a file. Create an application from a file by uploading a Csv, XLSX,
XML, or JSON file, or by copying and pasting data directly into the wizard. See Creating an
Application from a File.

e Create an app based on a script. Create an application containing many pages from a
saved script in SQL Scripts. See Creating an Application from a Script in Oracle APEX
SQL Workshop Guide.

» Create an app based on a dataset. After you install a sample data set, you have the
option to create an application containing multiple pages on that dataset. See Installing a
Sample Dataset in Oracle APEX SQL Workshop Guide.

¢ See Also:

Copying an Application

5.1.3 Choosing the Application Type

Running the Create Application Wizard prompts you to choose the type of application you
want to create.

To run the Create Application Wizard, click the Create button on the App Builder home page.
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Tip:

The first time you access the App Builder home page, a grey box labeled
Create a New App appears. Clicking Create New App is a shortcut to
accessing the Create Application Wizard.

Create an Application

New Application From a File Starter App

=

The wizard prompts you to choose the type of application you want to create. Options
include:

New Application. Create a fully functional application based on tables you select
or by providing a valid SQL. You can add pages that include various components
including calendars, cards, charts, dashboards, forms, interactive grids, master
detail or editable grids, and reports. Add application-level features such as an
Application About page, role-based user authentication, end user activity reports,
configuration options to enable or disable specific functionality, a feedback
mechanism to gather end user comments, and a Customize button to enable end
users to choose their own theme style. See Running the Create Application
Wizard

From a File. Upload a CSV, XLSX, XML, or JSON file, or copy and paste data and
then create your application. See Creating an Application from a File.

Starter App. Links to the Gallery. The Gallery enables you to access to Starter
Apps, Sample Apps, and plug-ins available in the Oracle APEX GitHub
Repository. Follow the on-screen instructions.

Quick SQL. Generate the SQL required to create a relational data model from an
indented text document. Quick SQL is designed to reduce the time and effort
required to create SQL tables, triggers, and index structures. See Using Quick
SQL in Oracle APEX SQL Workshop Guide.

Copy Application. Create a copy of an existing application. See Copying an
Application.
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* Help. Links to this page in Oracle Help Center.

5.1.4 Understanding Page Types, Features, and Settings

Learn about the supported page types, features, and configurable settings available in the
Create Application Wizard.

e Available Page Types in the Create Application Wizard
Learn about available page types when running the Create Application Wizard.

e Available Features in the Create Application Wizard
Learn about available features when running the Create Application Wizard. Features
provide application-level functionality and can only be added once per application.

e Available Settings in the Create Application Wizard
Learn about Settings available when running the Create Application Wizard. Settings are
used in the generation of the application and include the application ID, the database
schema, Advanced Settings (such as the application definition, security, and globalization
attributes), and application authentication.

e About Removing Features Created with the Create Application Wizard
Remove features created with a wizard using build options.

¢ See Also:

*  Running the Create Application Wizard

e Creating Applications for Mobile Devices

5.1.4.1 Available Page Types in the Create Application Wizard

Learn about available page types when running the Create Application Wizard.

Available Page Types

Table 5-1 Create Application Wizard - Available Page Types

Page Type Description To Learn More
Blank Creates a page with no built-in functionality. Once you See online Help when creating this
create the application, you can create regions on the page page.
in Page Designer.
Calendar Generates a calendar with monthly, weekly, and daily See Creating Calendars
views.
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Table 5-1 (Cont.) Create Application Wizard - Available Page Types

Page Type

Description To Learn More

Cards

A cards page features an orderly layout of information See: Managing Cards
tiles. Developers choose between three layouts: Grid,
Float, or Horizontal (Row).

Features:

»  Customize every aspect of a cards region's Ul
(including layout, appearance, icon, badge, and
media).

»  Declaratively create links from a cards page by adding
actions. Action types include Button, Full Card, Title,
Subtitle, or Media.

e Supports advanced HTML expressions including
template directives for client-side conditional
formatting.

Chart

Creates a new page containing a chart. Supported chart See Creating Charts
types include area, bar, box plot, bubble, combination,

status meter gauge, donut, funnel, gantt, line, line with

area, pie, polar, pyramid, radar, scatter, and stock charts.

Dashboard

Creates a dashboard page. Choose from four different See online Help when creating this
chart layouts which you can easily customize in Page page.

Designer. Available chart layouts include Primary and 2

secondary charts, Grid of 4 charts, Primary and 3

secondary charts, and Grid of 6 charts.

Faceted Search

A faceted search page displays and filters data using an ~ See: Managing Faceted Search
intuitive experience users recognize from ecommerce sites

(a left Search region and report region). Displays search

results as cards or a classic report.

Features:
»  Select options from facets in the left Search region to
narrow down search results.

e Set filters using facets that show possible values
together with the occurrence count within the result
set.

*  Built-in search capability.

e Optionally include a chart for any facet.

»  Toggle between a bar chart (which is the default) and
pie chart type.

»  Create facet groups for data models having multiple
flag columns.

ORACLE
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Table 5-1 (Cont.) Create Application Wizard - Available Page Types
]

Page Type

Description To Learn More

Smart Filters

A smart filters page features single search field at the top See: Managing Smart Filters

of the page and a search results report (classic report,

cards, map, or calendar). While a Smart Filter behaves

similarly to faceted search, it features a more space

efficient layout.

Features:

* Includes a search field at the top of the page with
filters that display as suggestion chip.

»  The Search Results can display as a classic report,
cards, map, or calendar.

»  Clicking a filter name displays a list of values.

»  Clicking to right of a suggestion chip changes it to an
applied filter chip and moves to the Applied Filters
Area. Clicking the applied filter chip again displays a
list.

*  Built-in search capability.

Form Create a page containing a form which enables end users See: Creating a Form
to maintain data. Select the table on which to build the form
and specify whether or not to include a report.

ORACLE
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Table 5-1 (Cont.) Create Application Wizard - Available Page Types

____________________________________________________________________________________________|]
Description To Learn More

Page Type

Interactive Grid

An interactive grid presents data in a searchable, See: Managing Interactive Grids
customizable report. Includes similar customization

capabilities available in interactive reports plus the ability to

rearrange the report interactively using the mouse or

keyboard.

Features:

Extensive customization capabilities using menus or

inline editing.

Turn editing on or off using the region Attribute, Edit,

Enabled.

Built-in search capability.

For both editable and non-editable reports, users can
change the report layout and create private reports:

Column Heading menu - Change the report layout

with Control Break, Aggregations, Freeze, Hide,

and Filter.

Actions menu:

*  Columns - Configure the columns to show or
hide.

*  Filters - Create filters to alter the display.

*  Data - Sort, Aggregate, Refresh, Flashback.

*  Format - Control Break, Highlight, Stretch
Column Widths.

*  Selection - Cell Selection, Copy to Clipboard,
Refresh Rows.

*  Chart - Create chart.

*  Report - Create, edit, and manage saved
Private or Alternative reports.

*  Download - Download or email the report as
a CSV, HTML, PDF, or Excel file

If editable, users can edit the data directly:

Row Actions menu - Single Row View, Add Row,
Duplicate Row, Delete Row, Refresh Row, Revert
Changes.

Add Rows - Add new rows by clicking the Add
Row button.

Edit Rows - Edit a row by selecting or double-
clicking a cell with the mouse, editing the content,
and clicking the Save button.

ORACLE
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Table 5-1 (Cont.) Create Application Wizard - Available Page Types

Page Type

Description

To Learn More

Interactive Report An interactive report page features a searchable, easily
customizable report.

Features:

Report can display as a standard application page or
as a modal dialog.

Enable the Include Form option to create a report and
update form combination.

Built-in search capability.

Change the report layout and create private reports
using menus:

Column Heading menu: Change the report layout
with Sort Ascending, Sort Descending, Hide
Column, Control Break, and Filter.

Actions menu:

*

Columns - Configure the columns to show or
hide.

Filters - Create filters to alter the display.
Data - Sort, Aggregate, Compute, Flashback.
Format - Control Break, Highlight, Rows Per
Page.

Chart - Create a chart.

Group By - Group sets of results by one or
more columns with Group By.

Pivot - Pivot reports transpose rows into
columns to generate results in a cross tab
format.

Report - Create, edit, and manage saved
Named reports.

Download - Download or email the report as
a CSV, HTML, Excel, or PDF

Subscription - Subscribe to report updates in
CSV, HTML, Excel, or PDF format.

See: Managing Interactive Reports

Map

The map component consists of a background map and
spatial geometry objects (or layers) sourced from data in a
local table. Supported spatial geometry objects (or layers)
include: Points, Lines, Polygons, Heat Map, or Extruded
Polygons. Spatial geometry objects can be either:
Geometry Column - Supported datatypes include
SDO_GEOMETRY, VARCHARZ, or CLOB. VARCHARZ2 and
CLOB columns must contain geometry information in
GeoJSON format.

Two Numeric Columns - These columns must
contain longitude and latitude values. This option only
applies to Point and Heat Map layers.

See Creating Maps

ORACLE
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Table 5-1 (Cont.) Create Application Wizard - Available Page Types

Page Type

Description To Learn More

Master Detail

A master detail reflects a one-to-many relationship See Creating Master Detail Forms
between two tables in a database. Master detail forms

enable users to insert, update, and delete values from two

tables or views. Master Detail options include:

»  Stacked - Creates a single page master detail with
editable interactive grids. Users select a row in the
master grid to update the detail grids.

* Side by Side - Create a single page master detalil
utilizing side by side layout and report regions with
modal edit windows. The left side contains a master
list to navigate to the master record. The right side
contains the selected master record and the
associated detail report.

*  Drill Down - Creates a two page (or Drill Down)
master detail. The first page contains an interactive
report for the master table. The second page features
a standard form for the master and interactive grids for
the detail.

Additional Pages,
Classic Report

Expand the Additional Pages region to view this option. See: Managing Classic Reports

A classic report features a simple report page based on
the formatted result of a SQL query.

Features:

*  Report can display as a standard application page or
as a modal dialog.

*  Enable the Include Form option to create a report and
update form combination.

«  Enable column sorting in Page Designer by selecting a
column and configuring Column, Sorting attributes.

*  The most versatile report as it is template-driven.
Choose from the predefined report templates,
including Media List, Comments, Timeline, Badge List,
Value Attributes Pairs, and so on. Or, create your own
template to customize and visualize data.

. Download the report as a CSV, HTML, Excel, or PDF.

e Supports Report Layouts to format PDF exports.

Additional Pages,
Multiple Reports

Creates multiple report pages containing an interactive See: Managing Interactive Reports
report with form. For each page, you choose a table on See online Help when creating this
which to build the interactive report with form. Click Editto  page,

change the default options (such as providing a custom

SQL Query), specifying another report type (such as,

selectingClassic Report instead of Interactive Report).

Select Include Form to include a form page for creating or
updating records.

Additional Pages,
Timeline

Expand the Additional Pages region to view this option. See online Help when creating this

Create a page which displays a timeline. Especially useful Page.
for displaying updates.

Additional Pages,
Wizard

Create a collection of pages to be used as a wizard. See online Help when creating this
Generally wizards are used for entering data across page.
multiple steps.

ORACLE
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5.1.4.2 Available Features in the Create Application Wizard

Learn about available features when running the Create Application Wizard. Features provide
application-level functionality and can only be added once per application.

This table lists available Features when running the Create Application Wizard.

Table 5-2 Create Application Wizard — Features

Page Type

Description To Learn More

Install Progressive Web App

Progressive Web Applications (PWA) are designed See Creating a Progressive
to be capable, reliable, and installable. A Web App (PWA)
Progressive Web App feels like a platform-specific

application. Enabling this option:

* Adds a new navigation bar entry, Install App

«  Enables users to install the app on devices

About Page

Include an About page in the application which See online Help when
displays the application description. creating feature.

Access Control

Incorporate role-based user authentication within See Controlling Access to
your application. Users can be defined as Applications, Pages, and
Administrators, Contributors, or Readers. You can ~ Page Components

then readily define different access to different roles

for various components throughout your application,

such as pages, menu entries, regions, columns,

items, buttons and so forth.

Activity Reporting

Include numerous reports on user activity for your ~ Not applicable.

application such as the most active users, the most

used pages, the performance of pages, and errors

raised. Includes the following:

*  Top Users report

e Application Error Log report

» Page Performance, activity and performance by
page

*  Application activity by page report

e Page Views detail report

e Automations Log (if the application contains
automations)

Configuration Options

Enables application administrators to enable or Not applicable.
disable specific functionality within the application.
This feature is useful if you select features that need
additional development effort before they can be
used by end users. This feature can also be
expanded to application-specific features. If
developers define additional build options and
associate them with specific functionality throughout
the application, then they can be added to the
configuration settings for administrators. For
example, within the Customer Tracker productivity
app, administrators can turn on or off such features
as Contacts, Data Loading, Geography, and more.

ORACLE
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Table 5-2 (Cont.) Create Application Wizard — Features
]

Page Type

Description To Learn More

Feedback

Feedback provides a mechanism for end users to See Managing Feedback
post general comments for application

administrators and developers. The posts include

useful session state information to help developers

determine where the end user sent the feedback

from.

Creating Feedback:

e Creates a Navigation bar icon which users can
click to leave feedback.

e Creates a report for viewing and updating
feedback.

e Captures the application and page ID, feedback
comments, date and time, and user
information.

Theme Style Selection

Enables administrators to select a default color Not applicable.
scheme (theme style) for the application.

Administrators determine whether end users can

choose their own theme style by enabling and

disabling Allow End Users to choose Theme

Style is enabled.

If enabled, end users simply click on the Customize
link at the bottom of the home page and select from
the available theme styles. For example, users with
visual impairment may prefer to utilize the Vita
theme style which has a much higher color contrast

" See Also:

About Removing Features Created with the Create Application Wizard

5.1.4.3 Available Settings in the Create Application Wizard

Learn about Settings available when running the Create Application Wizard. Settings
are used in the generation of the application and include the application ID, the
database schema, Advanced Settings (such as the application definition, security, and
globalization attributes), and application authentication.

This table lists available Settings when running the Create Application Wizard.

Table 5-3 Create Application Wizard — Settings
|

Page Type

Description To Learn More

Application ID

Unique, numeric identifier for your application. This Not applicable.
field contains an automatically generated identifier
by default.

ORACLE
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Table 5-3 (Cont.) Create Application Wizard — Settings
]

Page Type Description To Learn More
Schema Select the database schema which stores the Not applicable.
database objects you want to use in this application.
Language Select the primary language for this application. Not applicable.
Authentication Select how you want users to authenticate into your See Establishing User
application. Identity Through
Authentication
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Table 5-3 (Cont.) Create Application Wizard — Settings

Page Type

Description To Learn More

Advanced Settings

ORACLE

Set additional definition, security, and globalization  Not applicable.
settings. These settings can be applied when

creating the application and can be edited post

application creation.

Tip: To learn more about these attributes, see field-
level Help.

User Interface Attributes:

*  Apply User Interface Defaults - Select On to
have attribute defaults based on existing User
Interface Defaults defined within this
workspace.

e Copy from Existing Apps - Select On to have
attribute defaults to be based on existing Form
pages, based on the same table, in current
applications defined within this workspace.

* Table Prefixes - Enter table prefixes currently
used by existing database tables on which
pages are based. These prefixes may be
different from the framework table prefix (for
database objects created by this application
when generated).

Description:

e Short Description - Enter text to be displayed
as a subtitle, under the application name on the
home page.

* Description - Enter text to be displayed on the
About This Application page, accessed from
the help icon in the navigation bar.

Settings:

e Add "Built with APEX" to Footer - When set
to On, Oracle APEX adds the text "Built with
Love using Oracle APEX" to the footer of every
page.

e Version - Enter the application version. The
version is displayed by default on the bottom of
each page.

* Logging - Determines whether or not user
activity is recorded in the activity log. When set
to On, every page view is logged, enabling an
administrator to monitor user activity for each
application.

Disabling logging may be advisable for high
volume applications..

Note: You can only modify this attribute if the
feature configuration Application Activity
Logging in Oracle APEX Internal
Administration is set to Use Application
Setting.

*  Debugging - Determines whether debug mode
can be enabled using the browser.

On enables the application to enable debug
mode using the browser at runtime. Off
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Table 5-3 (Cont.) Create Application Wizard — Settings
]

Page Type

Description To Learn More

disables the application from enabling in debug
from the browser.

Debug can be enabled programmatically
regardless of this debug setting. If the
application is run from the APEX development
environment, debugging can always be
enabled.

Security:

e Deep Linking - Enables or prevents deep
linking to an application.

If On, the URL to a specific page ultimately
redirects there, possibly after the user has to
logged in. If Off, the URL does not contain a
valid session ID, APEX redirects to the
application's home page.

¢ Maximum session length in seconds -
Defines how long (in seconds) sessions can
exist and be used by this application.

* Maximum session idle time in seconds -
Defines the time between the last page request
and the next page request.

Globalization:

* Document Direction - Set document direction
left-to-right or right-to-left.

« Date Format - Determines the date format to
be used in the application.

« Date Time Format - Specify the date time
format to be used in the application.

*  Timestamp Format - Determines the
timestamp format to be used in the application.

e Timestamp with Timezone Format -
Determines the timestamp with time zone
format to be used in the application.

5.1.4.4 About Removing Features Created with the Create Application Wizard

ORACLE

Remove features created with a wizard using build options.

When you add a feature using a wizard, the wizard creates one or more pages and other
components and processes to seamlessly integrate it into your application. Each feature is
associated with a build option which contains one or more components. You use the
associated build option to enable, disable, or permanently remove features.

Using Build Options to Include or Exclude Features

Build options have two possible values: Include and Exclude. If you select the build option
status of Include, then the Oracle APEX engine considers the associated components (in
this case features) as part of the application definition at runtime. Conversely, if you specify
the build options status as Exclude, then the APEX engine treats it and any associated
components as if it did not exist.
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Removing Features Permanently

You remove features by first removing the components associated with the build option
and then deleting the build option.

¢ See Also:

e Including or Excluding Build Options

e Deleting Build Options and Associated Components

5.2 Creating an Application Based on a Table or Query

Run the Create Application Wizard and select New Application to create an
application containing multiple pages based on a table you select, or by providing a
valid SQL query.

e Running the Create Application Wizard
Use the Create Application Wizard to create an application containing multiple
pages based on the tables you select, or by providing valid SQL queries.

5.2.1 Running the Create Application Wizard

ORACLE

Use the Create Application Wizard to create an application containing multiple pages
based on the tables you select, or by providing valid SQL queries.

Run the Create Application Wizard by clicking Create on the App Builder home page,
or by selecting Create from the App Builder menu.

To run the Create Application Wizard:

1. On the Workspace home page, click the App Builder icon.
2. Click the Create button.

3. Click New Application.

The Create an Application page appears.
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View Blueprint | Load Blueprint

Create an Application

Name

Pages

Vita, Side Menu 2]

& Set Appearance

Add Page Add Page

I Home

ORACLE

Blank Edit

Cancel Create Application

Set Icon - Click Set Icon to select an application icon. The icon you select is used as the
Favicon, the PWA icon, the Apple touch icon, and the App Builder icon. In the Choose
Application Icon dialog you can include:

* Upload an icon. Click the plus (+) sign and navigate to the icon, or drag and drop
the icon to the Upload your own icon region.

» Select an icon from the library. Select the icon color and then the icon.
Name - Enter the name used to identify the application to developers.
Appearance - Accept the default or click Set Appearance to change it.

In the Appearance dialog, configure the following:

* Theme Style - Select the default theme style used to display the application.

Q Tip:

You can change the style to another pre-defined style, or modify it post
generation. To change the style run the application and then click Theme
Roller in the Developer toolbar.

* Navigation - Select a type of navigation menu. Options include:

— Side Menu - Renders a navigation tree on the side of the screen that can be
collapsed when not in use.

— Top Menu - Renders the navigation as a menu bar in the application header.

— Mega Menu - Renders the navigation in an collapsible floating panel that
displays all navigation items at once.

e Application Icon - Click Choose New Icon to change the icon. Your selection
displays on the home page of the application.

* Click Save Changes.

To add a page, click Add Page and select the desired page type. The user interface
changes based on the selected page type.
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Pages you create display under Pages.

View Blueprint | Load Blueprint

Create an Application

Name Appearance
E Vita, Side Menu 2]

Add Page Add Page

I Home Blank Edit
I Employees Interactive Report [ oshr_smployees ) El—
Drag to reorder page

Cancel Create Application

You can edit existing pages as follows:

* Change the page order. To change the order in which pages appear in your
application, click and hold the Drag to reorder page icon and drag and drop it
to a new location in the list.

The Home page always displays first and cannot be reordered. For
administrative pages, the page order dictates the order they appear in the
Application Administration list on the Administration page.

- Edit a page. To edit a page click Edit. In the dialog, edit the attributes and
click Save Changes.

» Delete a page. To delete a page, click Edit and the click Delete .

8. For Features, select features to include with your application.
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Install Progressive Web App = About Page fa Access Control

Activity Reporting
nclude activity an

The
Update

me Style Selection
te default application look and feel

be installed Add about this application page - able role-based user authorizatio

Configuration Options Feedback

and error reports Enable or disable apphcation Teatures Al users to provide feedback

Oracle APEX Accounts

Cancel Create Application

Features provide application-level functionality and can only be added once per
application. To learn more, see Help. To select all features, click Check All.

9. For Settings:

Application ID - Enter a unique, numeric identifier for your application. This field
contains an automatically generated identifier by default. Application IDs between
3000 to 9000 are reserved for internal use by Oracle APEX.

Schema - Select the database schema which stores the database objects you want
to use in this application. Each application obtains its privileges by parsing all SQL as
a specific database schema.

Languages - The primary language used in the app. To change the primary
language, click the Select Languages icon.

Authentication - Select how you want users to authenticate into your application..

Advanced Settings - Click the icon adjacent to the Advanced Settings to edit the
application definition settings and preferences and security and globalization
attributes. To learn more, see Help.

User Interface Defaults - Click the icon to apply User Interface Defaults to this
application.

10. Click Create Application.

Settings
;’?D )
Engish e
a.
b.
c.
d.
e.
f.
ORACLE
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¢ See Also:

e Available Page Types in the Create Application Wizard
e Available Features in the Create Application Wizard
e Available Settings in the Create Application Wizard

e Managing Navigation Menus

5.3 Creating an Application from a File

Run the Create Application Wizard and select From a File to upload a file and then
create an application on the uploaded data.

*  About Creating an Application from a File
Upload a CSV, XLSX, XML, TXT, or JSON file, or copy and paste CSV data and
then create your application.

»  Creating an Application by Uploading File
Upload a file to the database and then create an application based on the new
table.

* Creating an Application by Copying and Pasting from a File
Copy and paste column delimited data from a CSV file, or selecting a sample and
then create an application based on the new table.

5.3.1 About Creating an Application from a File

ORACLE

Upload a CSV, XLSX, XML, TXT, or JSON file, or copy and paste CSV data and then
create your application.

When you run the Create Application Wizard and select From a File, the Load Data
Wizard appears. On the Load Data Wizard, you can choose to:

e Upload a File. Select this option to load data from a CSV, XLSX, XML, TXT, or
JSON file.

e Copy and Paste. Select this option to copy and paste column delimited data. You
have the option of selecting a sample data set from the Select Sample list.

Once you load data into the database table, the wizard provides an option to Continue
to the Create Application Wizard. When you continue, a report with form and
dashboard pages based on the new table displays under Pages. You then finish the
application creation process by naming the application.

¢ See Also:

Loading Data in Oracle APEX SQL Workshop Guide
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5.3.2 Creating an Application by Uploading File

Upload a file to the database and then create an application based on the new table.
To create an application from a file:

1. On the Workspace home page, click the App Builder icon.
2. Click the Create button.
The Create Application Wizard appears.

@:- Create Application

Create an Application

(\

73

MNew Application From a File Productivity App

Add pages on existing data, Upload a CSV, XLSX, XML or Install one of many included
select application features, set JSOM file, or copy and paste data, Sarmple anc \pps
your theme, and configure other then create your application. from the App Gallery.

optons.

3. Click From a File.

U

Quick SQL - Copy Application - Help

The Load Data page appears with the Upload a File tab selected.

ORACLE
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Load Data

& upload a File [ Copy and Paste

Drag and Drop

Drag and drop file here or

4. Inthe Upload a File tab, you have two options:
» Drag and Drop - Drag and drop the file to the region in the center of the page.
* Choose File - Click Choose File and then navigate to and select the file.

The Load Data page appears containing the sections Where do you want to load
this data?, Settings, Preview. Note that the Load Data page that appears differs
slightly depending upon the selected file type.
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Load Data X

Where do you want to load this data?
Load To New Table Existing Table

able Owner  EXAMPLE w

* Table Name
Primary Keys SYS_GUID | Identity Column
¥ Use Column Data Types
Settings
Column Headers Column Delimiter Enclosed By File Encoding
#| First line contains headers , - z tab Mane U i
Preview

@ Parsed first 126 rows to sample the column types. The preview below only displays the first 9 columns and 5 rows. To view the Preview T3]
-- . . " - TEVIEW
full preview and configure data load settings, please click Preview button.
Is
1 Project Milestone Name Description Assignes Start Date End Date Cost Complete

Tameka TR T T o
10/13,/2019 101472019 2,000

5. Under Where do you want to load this data?, select where to load the data.
What appears next depends upon your selection.

6. To load data to a new table:
a. Load To - Select New Table.
b. Table Owner - Select the database schema.

c. Table Name - Identify the table name you would like to create. By default, all table
names are converted to upper case.

d. Error Table Name - Identify the error table name you would like to save errors during
data load. By default, all table names are converted to upper case. If data load
succeeds without any error, this error table is dropped automatically.

e. Primary Keys - Select how to set the primary key. Options include SYS_GUID or
Identity Column. To learn more, see field-level Help.

f. Use Column Data Types - Select to use the column types parsed from the file. If un-
checked, the table columns will be created as VARCHAR2(4000).

7. To load data to an existing table:
a. Load To - Select Existing Table.
b. Table Owner - Select the database schema.
c. Table Name - Select the database table to load data.

A message appears indicating the number of columns mapped to the target table.
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Click Configure to configure any remaining columns. On Configure, under
Column Mapping:

* Rows to Sample - Select the maximum number of rows to be used to
sample column types.

 Treat as Null - The entered case insensitive value will be treated as NULL.

For example, "tbd", "n/a", "unknown", "-".
e Column Mapping - Configure any additional attributes.
» Click Save Changes.

Error Table Name - Identify the error table name where you would like to save
errors during data load. By default, all table names are converted to upper
case. If data load succeeds without any errors, this error table is dropped
automatically.

Update Method - Options include:

* Append - If data already exists in the table, the wizard appends the new
rows into the table. If data does not exist, the new rows are simply loaded.

* Replace - The entire table is replaced by deleting the table first and then
loading the new rows into the table.

Under Settings:

a.

Column Headers - Select this option if your data contains column names in the
first row.

Column Delimiter - Select a column delimiter character (if CSV or TXT file).

Enclosed By - Select a column enclosed by character (if CSV or TXT file). This
character deliminates the starting and ending boundary of a data value. If you
specify a delimiter character, the wizard ignores white space occurring before
the starting and ending boundary of a data value.

File Encoding (if applicable) - Choose the character set in which the file is
encoded.

Preview displays a sample of columns and rows. The exact nhumber varies based
on the type of file. Click one of the following tabs:

Preview - Displays a sample of columns and rows. The exact number varies
based on the type of file.

Column Mapping - Enables you to configure any remaining columns:

— Rows to Sample - Select the maximum number of rows to be used to
sample column types.

— Treat as Null - The entered case insensitive value will be treated as NULL.

For example, "tbd", "n/a", "unknown", "-".
— Column Mapping - Configure any additional attributes.

— Click Save Changes.

Click Load Data.

A confirmation page appears indicating the table and rows have been created. You
have the following options:

View Table - Click View Table to exit from the current wizard and opens
Object Browser so you can view the newly created table.
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» Continue to the Create Application Wizard - Click Continue to the Create
Application Wizard to load the Create Application Wizard.

Note that if all rows fail to load, this button does not display.
11. Click Continue to Create Application Wizard.

The Create an Application page in the Create Application Wizard appears. Report with
form and dashboard pages based on the new table display under Pages. From here, you
can edit page name or create additional pages based on the imported data.

12. Complete the Create Application Wizard.

¢ See Also:

e Running the Create Application Wizard
e Available Page Types in the Create Application Wizard
e Available Features in the Create Application Wizard

e Available Settings in the Create Application Wizard

5.3.3 Creating an Application by Copying and Pasting from a File

Copy and paste column delimited data from a CSV file, or selecting a sample and then create
an application based on the new table.

To create an application by copying and pasting column delimited data from a CSV file, or
selecting a sample:

1. On the Workspace home page, click the App Builder icon.
2. Click the Create button.
The Create Application Wizard appears.
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Farn . -
'\T/' Create Application

Create an Application

New Application From a File Starter App

X

es on existing data, Upload a CSV, XLSX, XML or Install
lication feat JSON file, or copy and paste data, St
then create your application.

Y

Quick SQL - Copy Application - Help

one of many Sample and

Apps from the Gallery.

me, and configur

3. Click From a File.
The Load Data page appears
4. Select the Copy and Paste tab.

Load Data X

[ Upload a File [& Copy and Paste

@ You can copy and paste C5V data, or select a sample data set. | - Select Sample - w m

& 4

5. To load data, do one of the following:
» Select a Sample - Select a sample database from the Select Sample list.
e Copy and Paste - Copy and paste CSV data.

6. Click Next
The Load Data page appears.
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Load Data X
Lfl Pasted Data
Where do you want to load this data?
Load Te MNew Table Existing Table
" Table Owner  EXAMPLE v
* Table Name
Primary Keys S¥YS5_GUID  Identity Column
¢ Use Column Data Types
Settings
Column Headers Column Delimiter Enclosed By File Encoding
¥ First line contains headers . . = tab Mone Unicode UTE-8 w
Preview
@ Parsed first 74 rows to sample the column types. The preview below only displays the first 8 columns and 5 rows. To .
. N o ) . ) N ! Preview (2]
3 the full preview and configure data load settings, please click Preview button.
1 Project Task Mame Start Date End Date Status Assigned To Cost Budget
2 ACME Web Configuration dentify server requirements 17-May-20 18-May-20 Closed John Watson 100 200
3 Maintain Support Systems HR software upgrades 17-May-20 14-Jul-20 On-Held Pam King 8000 7000
4 Maintain Support Systems Apply Billing Systemn updates 17-May-20 18-Jul-20 On-Hold Russ Sanders 9500 F000

< Cancel

ORACLE

Under Where do you want to load this data?, select where to load the data.
What appears next, depends upon your selection.

To load data to a new table:

a. Load To - Select New Table.

b. Table Owner - Select the database schema.

c. Table Name - Identify the table name you would like to create. By default, all table
names are converted to upper case.

d. Error Table Name - Identify the error table name you would like to save errors during
data load. By default, all table names are converted to upper case. If data load
succeeds without any error, this error table is dropped automatically.

e. Primary Keys - Select how to set the primary key. Options include SYS_GUID or
Identity Column. To learn more, see field-level Help.

f. Use Column Data Types - Select to use the column types parsed from the file. If un-
checked, the table columns will be created as VARCHAR2(4000).

To load data to an existing table:

a. Load To - Select Existing Table.
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b. Table Owner - Select the database schema.
c. Table Name - Select the database table to load data into.
A message appears indicating the number of columns that are mapped.

d. Click Configure to configure any remaining columns. On Configure, under
Column Mapping:

* Rows to Sample - Select the maximum number of rows to be used to
sample column types.

 Treat as Null - The entered case insensitive value will be treated as NULL.

For example, "tbd", "n/a", "unknown", "-".
*  Column Mapping - Configure any additional attributes.
* Click Save Changes.

e. Error Table Name - Identify the error table name you would like to save errors
during data load. By default, all table names are converted to upper case. If
data load succeeds without any error, this error table is dropped automatically.

f. Update Method - Options include:

* Append - If data already exists in the table, the wizard appends the new
rows into the table. If data does not exist, the new rows are simply loaded.

* Replace The entire table is replaced by deleting the table first and then
loading the new rows into the table.

10. Under Settings:

a. Column Headers - Enable First Line Contains if your data contains column
names in the first row.

b. Column Delimiter - Select a column delimiter character.

c. Enclosed By - Select a column enclosed by character . This character
deliminates the starting and ending boundary of a data value. If you specify a
delimiter character, the wizard ignores white space occurring before the
starting and ending boundary of a data value.

d. File Encoding - Choose the characterset in which the file is encoded.

11. Preview displays a sample of columns and rows. The exact number varies based
on the type of file. Click one o the following tabs:

* Preview displays a sample of columns and rows. The exact number varies
based on the type of file.

* Column Mapping enables you to configure any remaining columns:

— Rows to Sample - Select the maximum number of rows to be used to
sample column types.

— Treat as Null - The entered case insensitive value will be treated as NULL.

For example, "tbd", "n/a", "unknown", "-".
— Column Mapping - Configure any additional attributes.
— Click Save Changes.
12. Click Load Data.

A confirmation page appears indicating the table and rows have been created. You
have the following options:
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* View Table - Exits from the current wizard and opens Object Browser so you can
view the newly created table.

e Continue to the Create Application Wizard
13. Click Continue to Create Application Wizard.

The Create Application Wizard appears. The wizard pre-populates pages based on the
new table and the pages display under Pages. From here you can edit the page name or
create additional pages based on the imported data.

14. Complete the Create Application Wizard.

# Note:

e Running the Create Application Wizard
e Available Page Types in the Create Application Wizard
e Available Features in the Create Application Wizard

e Available Settings in the Create Application Wizard

5.4 Using Application Blueprints

Each iteration of the Create Application Wizard saves an application blueprint which you can
use to start adding pages to an application, or edit the application definition as a JSON
document.

e What Is an Application Blueprint?
View or load an application blueprint by running the Create Application Wizard.

e Viewing an Application Blueprint
View an application blueprint by running the Create Application Wizard and clicking the
View Blueprint link at the top of the Create Application Wizard.

e Loading an Application Blueprint
Load an application blueprint by running the Create Application Wizard and clicking the
Load Blueprint link at the top of the Create Application Wizard.

" See Also:

To learn more about JSON, see https://www.json.org/

5.4.1 What Is an Application Blueprint?

ORACLE

View or load an application blueprint by running the Create Application Wizard.

You can view the application blueprint by running the Create Application Wizard and clicking
the View Blueprint link at the top of the Create Application Wizard. The Application Blueprint
window transforms and displays the current application definition as a JSON document. Edit
the document to update application properties and then click Apply Blueprint to change the
current application details.
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If you need to create a large number of similar pages you can copy the relevant JSON
code for one page, paste it numerous times, and then make small adjustments to the
JSON. This approach can be significantly quicker than manually clicking the Add
Page button for each page in the wizard.

You can also replace the blueprint with the definition from a previously generated
application. Click Load a Previous Blueprint to replace the blueprint with the
definition from a previously generated application. This approach is a simple way to
iterate the application design by adding additional pages, changing the features, or
tweaking the settings, before generating the application again.

5.4.2 Viewing an Application Blueprint

ORACLE

View an application blueprint by running the Create Application Wizard and clicking the
View Blueprint link at the top of the Create Application Wizard.

To view an application blueprint:

1. Onthe Workspace home page, click the App Builder icon.
2. Click the Create button.

3. Click New Application.

4. Atthe top of the page, click the View Blueprint link.

The Application Blueprint window appears displaying the application definition in
JSON format.

Application Blueprint X

5. To edit the document:
a. Update application definition.

The following buttons display at the top of the Script Editor:
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 Undo - Ctrl+Z — Removes, or undoes, the most recent line edit made in the

Script Editor.

* Redo - Ctrl+Y — Repeats the most recent line edit made in the Script Editor.

* Find - Ctrl+F — Find resembles a magnifying glass. Click Find to perform a

basic search.

* Replace - Ctrl+Shift+F — Replace resembles a two-sided arrow. Click Replace

to search and replace existing code.

b. Click Apply Blueprint to change the current application definition.

To replace the blueprint with the definition from a previously generated application:

a. Click Load Previous Blueprint.
b. In Load Blueprint, locate the blueprint and click Select.

c. Click Apply Blueprint to change the current application details.

5.4.3 Loading an Application Blueprint

Load an application blueprint by running the Create Application Wizard and clicking the Load
Blueprint link at the top of the Create Application Wizard.

ORACLE

To load an application blueprint:

1.

2
3.
4

5.

On the Workspace home page, click the App Builder icon.
Click the Create button.

Click New Application.

At the top of the page, click the Load Blueprint link.

The Load Blueprint window appears.
Load Blueprint
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On Load Blueprint, you can:
* Load a new blueprint. Locate the blueprint to load and click Select.

* Delete a blueprint. Click the Delete Blue icon.

Loaa

Loaa

Loaa
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5.5 Copying an Application

Create a copy of an existing application.

Create a copy of an existing application by running the Create Application Wizard and
selecting the Copy Application link, or by selecting the application and then Copy
this Application from the Tasks list on the Application home page.

e Copying an Application by Running the Create Application Wizard
e Copying an Application from the Application Home Page

5.5.1 Copying an Application by Running the Create Application
Wizard

To copy application by running the Create Application Wizard:
1. On the Workspace home page, click the App Builder icon.
2. Click the Create button.

The Create Application Wizard appears.
(:E:} Create Application

Create an Application

New Application From a File Starter App

3. Select the Copy Application link at the bottom of the window and click Next.
4. For Identify Copy Target:
a. Copy From - Select the name of the application to copy.

b. Copy To - Enter a short descriptive name for the application to distinguish the
new application in select lists and reports.

c. New Application ID - Specify an integer value that identifies the application.
The application ID must be unique within your Oracle APEX instance.
Application IDs in the range of 3000 to 9000 are reserved for internal use by
APEX
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d. Copy Supporting Object Definitions - You can copy supporting object definitions,
configuration options, and scripts with your application. Select On to include
database object definitions, image definitions, and seed data SQL statements
encapsulated in a single file. Select Off to not include supporting object definitions.

Confirm your selection and click Create Application.

5.5.2 Copying an Application from the Application Home Page

To copy an application from the Application home page:

1.
2.

On the Workspace home page, click the App Builder icon.
Select an application to copy.

The Application home page appears.

From the Tasks list, click Copy this Application.

For Identify Copy Target:

a. New Application ID - Enter a unique integer value to identify the application.
Application IDs between 3000 to 9000 are reserved for internal use.

b. New Application Name - Enter a short descriptive name for the application to
distinguish the new application in select lists and reports.

c. Copy Supporting Object Definitions - Copy supporting object definitions, configuration
options, and scripts with your application.. Options include:

* On - Include database object definitions, image definitions, and seed data SQL
statements encapsulated in a single file.

»  Off - Do not include supporting object definitions.
d. Click Next.
Click Copy Application.

5.6 Creating Applications for Mobile Devices

Build applications for mobile devices with mobile-specific design patterns that can provide an
optimal user experience for small screens.

Advantages of the Universal Theme

Universal Theme - 42 (Universal Theme) features responsive design, a versatile user
interface, and easy customization and enables developers to build modern web
applications without requiring extensive knowledge of HTML, CSS, or JavaScript.

Creating a Progressive Web App (PWA)
Learn about Progressive Web App (PWA) features and requirements.

Forms Optimized for Mobile Environments
Learn about forms optimized for mobile environments.

5.6.1 Advantages of the Universal Theme

Universal Theme - 42 (Universal Theme) features responsive design, a versatile user
interface, and easy customization and enables developers to build modern web applications
without requiring extensive knowledge of HTML, CSS, or JavaScript.

ORACLE

Key advantages of the Universal Theme include:
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* Responsive Design - Designed to work just as well on small screen devices
(such as smartphones and tablets) as it does on larger screen devices (including
laptops and desktops) by responding automatically to the dimensions of the
screen on which it is running. The Ul components in Universal Theme work across
varying screen resolutions while maintaining the same or similar functionality. In
addition, Universal Theme takes full advantage of ultra high screen resolutions by
utilizing vector graphics where possible, and relying upon CSS3 features for Ul
styling.

* Versatile User Interface - Provides all the components and building blocks
necessary to build practically any type of business application user interface. To

browse all of the components provided with Universal Theme go to the Universal
Theme application at https://apex.oracle.com/ut and select Components.

» Easy Customization - Effortlessly customize and fully control the look and feel of
your applications without becoming an expert in Ul design, HTML, CSS, or
JavaScript. Using Theme Roller and Template Options, you can easily customize
your application to fit your company's brand and customize the look and feel of
various components using Template Options.

About Migrating Existing jQuery Mobile Apps to the Universal Theme

jQuery Mobile and the jQuery Mobile User Interface used in previous releases has
been desupported. If you have an existing mobile application that uses the jQuery
Mobile User Interface, you must migrate your existing application to the Universal

Theme.

Tip:

To learn more about migrating existing applications to the Universal Theme,
go to the Universal Theme application at https://apex.oracle.com/ut and
select Migration Guide.

" See Also:

e About Switching the Active Theme
e Understanding Template Options

e Using Theme Styles

5.6.2 Creating a Progressive Web App (PWA)

ORACLE

Learn about Progressive Web App (PWA) features and requirements.

»  About Progressive Web App Support
Progressive Web Apps (PWAs) leverage modern web APIs giving users an
experience that looks and feels like a native app.
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» Creating a Progressive Web App
Create a Progressive Web App by running the Create Application Wizard and enabling
the Install Progressive Web App feature.

»  Configuring Progressive Web App Attributes
Configure Progressive Web App attributes for both new and existing Progressive Web
App applications.

5.6.2.1 About Progressive Web App Support

Progressive Web Apps (PWAs) leverage modern web APIs giving users an experience that
looks and feels like a native app.

Developers can create a PWA when creating a new application with the Create Application
Wizard, or by editing attributes of an existing application.

Progressive Web App Requirements
Requirements for using this feature include:

e The Oracle APEX application must be served over a secured HTTPS environment, or
localhost. If using an unsecured environment, PWA features will not be rendered

e The application Definition, Properties, Friendly URLSs attribute must be On. See
Accessing the Application Definition Page.

About Progressive Web Apps

Enabling PWA functionality:

*  Adds the ability to install the app as a Progressive Web App (PWA).

* Adds a new navigation bar entry named Install App to your application.

*  Optimizes page loading speed on the mobile device. Improves page load rendering time
with a new browser cache architecture for static files (APEX core files and app files).

» Enables users to install the application on devices.

* Provides a customizable offline page when users are offline and cannot request the
network. See Progressive Web App (PWA) Messages Requiring Translation.

*  Supports hooks into the service worker code for a fully customizable PWA experience.
Creating a New PWA

For a new application, you can create a PWA by enabling the Install Progressive Web App
feature in the Create Application Wizard and then configuring the Progressive Web App
attributes.

Making an Existing App a PWA
To make an existing application a PWA, you must:

«  Verify Friendly URLs attribute is On in the Application Definition, Properties section.

e Turn on the Enable Progressive Web App attribute and then configure the remaining
Progressive Web App attributes.
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¢ See Also:

e Accessing the Application Definition Page

e Configuring Progressive Web App Attributes

5.6.2.2 Creating a Progressive Web App

Create a Progressive Web App by running the Create Application Wizard and enabling
the Install Progressive Web App feature.

Tip:

To include mobile friendly reports and forms, create your application and then
add pages to it. See Mobile Friendly Forms.

To create a new application with Progressive Web App functionality enabled:

1.
2.
3.

ORACLE

On the Workspace home page, click the App Builder icon.
Click the Create button.
Click New Application.

The Create an Application page appears.

< Note:

To learn more about all the options available in the Create Application
Wizard, see Running the Create Application Wizard.

For Name, enter the name used to identify the application to developers.

To add a page, click Add Page and select the desired page type. The user
interface changes based on the selected page type.

Tip:

The Create Page Wizard supports the creation of a number of mobile
friendly reports and forms. See Mobile Friendly Forms.

Pages you create display under Pages.

For Features, select features to include with your application. Select Install
Progressive Web App.
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About Page

d about this applic

Access Control
stion page - Enzble role-based user authorization

Configuration Options Feedback

and error reports Enable or disable apphcation Teatures Al users to provide feedback

Oracle APEX Accounts

Cancel Create Application

Features provide application-level functionality and can only be added once per
application. To learn more, see Help. To select all features, click Check All.

Click Create Application.

Configure Progressive Web App attributes. See Configuring Progressive Web App
Attributes.

5.6.2.3 Configuring Progressive Web App Attributes

ORACLE

Configure Progressive Web App attributes for both new and existing Progressive Web App
applications.

To configure Progressive Web App attributes:

1.
2.
3.

On the Workspace home page, click the App Builder icon.
Select an application.

From the Application home page, you can access the Progressive Web App page in two
ways:

» Edit Application Definition button:
— Click Edit Application Definition to the right of the application name.
— Click the Progressive Web App tab.
*  From Shared Components:
a. Click Shared Components.
b. Under User Interface, click Progressive Web App.
Under General, edit the following:
a. Enable Progressive Web App - Confirm this option is enabled.

b. Installable - Confirm this option is enabled.

5-37



ORACLE

Chapter 5
Creating Applications for Mobile Devices

5. Under Appearance:

a.

Display - Select the preferred display mode for the application. This option
controls how much of the browser Ul the user sees. Options include:

* Fullscreen - Opens the PWA without any browser Ul. This option takes
the entirety of the screen or window.

* Standalone- Opens the PWA to look like a standalone application. The
app runs in a distinct window, separate from the browser. Standard
browser Ul components like the URL bar and buttons are not visible.

* Minimal Ul - Similar to standalone, except with browser controlling
navigation buttons like back and refresh.

*  Browser - Opens the PWA is a regular browser Ul.

Note: Some devices and browsers ignore this attribute. Oracle APEX is only
relaying this information to the device which handles the Progressive Web App
appropriately. For more information, see https://web.dev/add-manifest//.

Screen Orientation - Select the preferred screen orientation when using this
Progressive Web App. This option applies mostly for mobile devices.

Note: Some devices and browsers ignore this attribute. Oracle APEX is only
relaying this information to the device which handles the Progressive Web App
appropriately.

Theme Color - Defines the default theme color for the application.

This attribute affects how the operating system displays the application (for
example, for an Android's task switcher, the theme color surrounds the
application).

Note: Some devices and browsers ignore this attribute. Oracle APEX is only
relaying this information to the device which handles the Progressive Web App
appropriately.

Background Color - Select the background color.

The background color defines a placeholder background color for the
application to display before its stylesheet is loaded. Therefore, the
background color should match the theme body background color for a
smooth transition between launching the web application and loading the
application content.

Note: Some devices and browsers ignore this attribute. APEX is only relaying
this information to the device which handles the Progressive Web App
appropriately.

iOS Status Bar Style - Determines the style of the iOS status bar of your
progressive web app. Apple offers three distinct choices:

* Black Text and White Background

* Black Text and Black Background - This option makes it appear
completely black

* Translucent - This option has white text takes the same background color
as the body of your web app. The text color will remain white even if you
use a light background color. If using translucent, the page content is
displayed on the entire screen.
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App Description - Explains what the application does. Use this attribute to provide
more information to users when they are prompted to install the application.

Custom Manifest - Used to store additional JISON properties for the Web App
Manifest file. The properties found here will be used to extend the declarative options
above, by overriding existing properties or appending new properties.

For more information on building a Custom Manifest, you can read the Web App
Manifest specifications: https://www.w3.0rg/TR/appmanifest/.

Screenshots - Include screenshots for promotional purposes when users are
prompted to install the Progressive Web App.

To add a screenshot:
e Click Add Screenshot.

» Description - Enter the PWA screenshot label which is used for accessibility
purposes when installing the PWA.

* Sequence - Identifies the display sequence used by this PWA screenshot.
* Upload a Screenshot:
— Drag and Drop - Drag and drop the file to the region.

— Choose a File - Click the Upload a Screenshot region and then navigate to
and select the file.

» Build Option - Identifies the build option that this PWA screenshot uses.
e Comments - Add comments associated with this PWA screenshot.
e Click Create.

Shortcuts - Include shortcuts to enable users of installed PWAs to quickly access a
specific page. For touch-enabled devices, shortcuts are accessible when doing a
long-press on the application icon on the home screen. For other devices, shortcuts
are accessible when doing a right click on the application icon on the task bar.

To add a shortcut:
* Click Add Shortcut.
* Name - Enter the name of the PWA shortcut.
» Target URL - Specify the page of the application for the current shortcut.
* Sequence - Identifies the display sequence used by this PWA screenshot.
* Upload an icon:
— Drag and Drop - Drag and drop the file to the region.

— Choose a File - Click the Upload an Icon region and then navigate to and
select the file.

» Description - Enter a description for this PWA shortcut.
»  Build Option - Identifies the build option that this PWA shortcut uses.
e Comments - Add comments associated with this PWA shortcut.

e Click Create.
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Tip:

An APEX application can only use PWA Shortcuts if Rejoin Sessions
is enabled. Before configuring shortcuts, click either Enable for
Public Sessions or Enable for All Sessions. To learn more, see
Session Management.

6. Under Service Worker Configuration, select a Service Worker.

Service workers are JavaScript files that can execute code even when the app is
not in use. Service workers can listen to events like fetching resources or handling
notifications. You can modify a service worker through hooks, or by replacing
events completely. Service Worker options include:

* Default - The APEX engine generates it with the following strategy:
— Install and activate the service worker
— Serve resources from cache if cache exists
— Otherwise serve from network, then put resource in cache
— Serve an offline page if network fails

» Configure Hooks - Fill in the placeholders in the service worker code to add
your own. Hooks locations are provided by Oracle APEX. When using this
option, you can choose to "Download Configuration" and use it as a File URL.

* File URL - Provide a URL reference to a file that contains the service worker
hooks interface. This is useful for sharing service worker hooks across multiple
applications. If using the file reference, make sure to follow the interface
architecture appropriately or else the service worker will fail at runtime.

To view the interface structure, see field-level Help for this attribute.

7. Click Apply Changes.

5.6.3 Forms Optimized for Mobile Environments

Learn about forms optimized for mobile environments.

e Mobile Friendly Forms
Oracle APEX includes three mobile friendly reports and forms: List View, Column
Toggle, and Reflow Report.

e Creating a Column Toggle Report
Create a column toggle report in Page Designer.

* Creating a List View Report
Create a list view report in Page Designer.

* Creating a Reflow Report
Create a reflow report in Page Designer.

5.6.3.1 Mobile Friendly Forms

Oracle APEX includes three mobile friendly reports and forms: List View, Column
Toggle, and Reflow Report.
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Although the Universal Theme is optimized to work well on mobile devices, not all
components are mobile friendly. For example, interactive reports and interactive grids do not
work well in mobile environments.

The following mobile friendly reports are optimized for mobile environments:

e List View - A List view report features a responsive design to display data and provide
easy havigation on Smartphones. A list view report contains the formatted result of a SQL
guery based on the data source (local or external) you specify and the table or SQL
guery you provide. Developers edit the report Attributes to determine the database
columns that display, including the column used for List view entry.

e Column Toggle Report - A column toggle report contains the formatted result of a SQL
guery based on the data source (local or external) you specify and the table or SQL
guery you provide. A column toggle report includes a Columns button which enables end
users to select which columns they want to view.

* Reflow Report - A reflow report contains the formatted result of a SQL query based on
the data source (local or external) you specify and the table or SQL query you provide.
When there is not enough space available to display the report horizontally, the report
responds by collapsing the table columns into a vertical value pairs layout where each
column displays on a separate row.

5.6.3.2 Creating a Column Toggle Report

Create a column toggle report in Page Designer.

A column toggle report contains the formatted result of a SQL query based on the data
source (local or external) you specify and the table or SQL query you provide. A column
toggle report includes a Columns button which enables end users to select which columns
they want to view.

By default, column toggle reports are created with all columns set to the same priority.
However, the developer can edit the report column attributes and rank columns by
importance. Columns with a lesser priority (larger number) are hidden at narrower screen
widths. The report includes a Columns button which enables end users to select which
columns they want to view.

To create a column toggle report.
1. Create a Blank page using the Create Page Wizard.
2. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.
3. Click the Layout tab in the central pane.

4. In the Gallery, click the Regions tab. Right-click Column Toggle and select Add To, and
select the appropriate location (for example, Body).
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Tip:

You can also select the Column Toggle region in the Gallery and drag it

to the appropriate location in the Layout tab.
Page Designer indicates what to do next. If there are errors, the Show Messages
icon displays in the Page Developer toolbar.
a. Click the Show Messages icon on the Page Designer toolbar.

The Messages dialog displays errors that must be addressed.

b. Select an error to highlight the associated attribute in the Property Editor.
Select the New region (if not already selected).
Next, edit the Region attributes in the Property Editor (or right pane).

Identification, Title - Enter a region title. The region title only displays when it is
defined in the region template.

Source - Configure the Data Source for the region:

What appears next depends upon the attributes you select. For this example, the
report is built on a local database on EBA_PROJECTS table.

Tip:

To learn more about an attribute and view examples, select the attribute
in the Property Editor and click the Help tab in the central pane.

a. Location - Select the location of the data. For example, select Local
Database.

b. Type - Select how the data is queried. For example, select Table/View.

c. Table Name - Enter the case-sensitive table or view name. You can type in the
name or pick from the list. For example, select EBA_PROJECTS.

Edit any additional attributes as needed.
View the page, click Save and Run Page.
The toggle columns report appears.

End users can control what columns display by clicking the Columns button.

5.6.3.3 Creating a List View Report

ORACLE

Create a list view report in Page Designer.

List view reports feature a responsive design to display data and provide easy
navigation on Smartphones. A list view report contains the formatted result of a SQL
qguery based on the data source (local or external) you specify and the table or SQL
guery you provide. Developers edit the report Attributes to determine the database
columns that display, including the column used for List view entry.

The example in this topic builds a report on the EBA PROJECTS table available in the
sample dataset, Project Data.
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To create a list view report.

1.
2.

ORACLE

If needed, create a Blank page using the Create Page Wizard.

View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.

b. Select an application.
c. Select a page.
Page Designer appears.

In the Gallery, click the Regions tab. Right-click List View and select Add To, and select
the appropriate location (for example, Body).

Tip:
You can also select the List View region in the Gallery and drag it to the
appropriate location in the Layout tab.

Page Designer indicates what to do next. If there are errors, the Show Messages icon
displays in the Page Developer toolbar.

a. Click the Show Messages icon on the Page Designer toolbar.
The Messages dialog displays errors that must be addressed.
b. Select an error to highlight the associated attribute in the Property Editor.
Select the New region (if not already selected).
Next, edit the Region attributes in the Property Editor (or right pane).

Identification, Title - Enter a region title. The region title only displays when it is defined in
the region template.

Source - Configure the Data Source for the region:

What appears next depends upon the attributes you select. For this example, the report
is built on a local database on EBA_PROJECTS table.

Tip:

To learn more about an attribute and view examples, select the attribute in the
Property Editor and click the Help tab in the central pane.

a. Location - Select the location of the data. For example, select Local Database.
b. Type - Select how the data is queried. For example, select Table/View.

c. Table Name - Enter the case-sensitive table or view name. You can type in the name
or pick from the list. For example, select EBA_PROJECTS.

Configure the report Attributes:
a. Inthe Property Editor, click the Attributes tab.

b. Settings - Configure the attributes such as the following:

» Features - Select the features to include with list view report. Depending upon
what you select additional attributes may appear. For example, select Enable
Search.
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» Text Column - Select the database column that contains the main content
for the list view entry. For example, select NAME (required).

*  Supplemental Information Column - -Select the database column that
contains supplemental information for the list view entry. For example,
select DESCRIPTION.

e Counter Column - Select the database column that contains the value to
display in the count bubble. For example, select BUDGET.

9. Edit any additional attributes as needed.
10. View the page, click Save and Run Page.

The list view report appears.

5.6.3.4 Creating a Reflow Report

ORACLE

Create a reflow report in Page Designer.

A reflow report contains the formatted result of a SQL query based on the data
source (local or external) you specify and the table or SQL query you provide. When
there is not enough space available to display the report horizontally, the report
responds by collapsing the table columns into a vertical value pairs layout where each
column displays on a separate row.

The example in this topic builds a report on the EBA PROJECTS table available in the
sample dataset, Project Data.

To create a reflow report.
1. If needed, create a Blank page using the Create Page Wizard.
2. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.

3. Inthe Gallery, click the Regions tab. Right-click Reflow Report and select Add
To, and select the appropriate location (for example, Body).

Tip:
You can also select the Reflow Report region in the Gallery and drag it
to the appropriate location in the Layout tab.
4. Page Designer indicates what to do next. If there are errors, the Show Messages
icon displays in the Page Developer toolbar.
a. Click the Show Messages icon on the Page Designer toolbar.
The Messages dialog displays errors that must be addressed.
b. Select an error to highlight the associated attribute in the Property Editor.
5. Select the New region (if not already selected).

Next, edit the Region attributes in the Property Editor (or right pane).
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Identification, Title - Enter a region title. The region title only displays when it is defined in
the region template.

Source - Configure the Data Source for the region:

What appears next depends upon the attributes you select. For this example, the report
is built on a local database on EBA_PROJECTS table.

Tip:

To learn more about an attribute and view examples, select the attribute in the
Property Editor and click the Help tab in the central pane.

a. Location - Select the location of the data. For example, select Local Database.
b. Type - Select how the data is queried. For example, select Table/View.

c. Table Name - Enter the case-sensitive table or view name. You can type in the name
or pick from the list. For example, select EBA_PROJECTS.

Edit any additional attributes as needed.

For example, to facilitate a better display in a smaller window, you may want to edit the
Column attributes, Heading, Alignment and Layout, Column Alignment attributes.

View the page, click Save and Run Page.
The reflow report appears.

When there is not enough space available to display the report horizontally, the report
responds by collapsing the table columns into a vertical value pairs layout where each
column displays on a separate row as shown in the following example.

5.7 Deleting an Application

ORACLE

You can delete an application from the Application home page, or while editing application
attributes.

When you delete an application, you are prompted whether to remove the application
definition and/or drop supporting objects.

Deleting an Application from the Application Home Page
Delete an application by select Delete this Application from the Tasks list on Application
home page.

Deleting an Application from the Edit Application Definition
Delete an application by clicking Delete on Edit Application Definition page.

¢ See Also:

Deinstalling Supporting Objects
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5.7.1 Deleting an Application from the Application Home Page

Delete an application by select Delete this Application from the Tasks list on
Application home page.

To delete an application from the Application home page:

1.
2.

4,
5.

On the Workspace home page, click the App Builder icon.
Select an application.
The Application home page appears.

On the Application home appears, verify the application ID and name at the top of
the page.

From the Tasks list, click Delete this Application.

When prompted, click Permanently Delete Now.

5.7.2 Deleting an Application from the Edit Application Definition

Delete an application by clicking Delete on Edit Application Definition page.

To delete an application from the Edit Application Definition page:

1.
2.
3.

On the Workspace home page, click the App Builder icon.

Select an application.

Click the Edit Application Definition button to the right of the application name.
The Edit Application Definition page appears.

Verify the application ID and name.

Click Delete at the top of the page.

When prompted, click Permanently Delete Now.

" See Also:

Editing the Application Definition

5.8 Managing Application Attributes

Application attributes control the behavior of an entire application and are divided into
the categories: Definition, Security, Globalization, User Interface, and Progressive Web

App.

Once you create an application, you can review and update all application attributes.

ORACLE
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Tip:

How to Create a Custom Application for information on using the Supporting
Objects utility to create a custom application.

Editing the Application Definition

Use the Application Definition page to change general application attributes such as the
application name, application alias, version number and control various properties and
behaviors such as friendly URLSs, logging, debugging, feedback, compatibility mode,
application availability, error handling, and substitution strings.

Configuring Security Attributes
Use the Security page to set application-wide security settings.

Configuring Globalization Attributes

Edit attributes on the Globalization page to configure application globalization options. In
App Builder you can develop applications that can run concurrently in different
languages.

Editing User Interface Attributes
Use the User Interface page to control the default characteristics of the application and
optimize the display.

Configuring Progressive Web App Attributes
Use the Progressive Web App page to configure attributes for both new and existing
Progressive Web App applications.

5.8.1 Editing the Application Definition

Use the Application Definition page to change general application attributes such as the
application name, application alias, version number and control various properties and
behaviors such as friendly URLSs, logging, debugging, feedback, compatibility mode,
application availability, error handling, and substitution strings.

Accessing the Application Definition Page
Access the Application Definition page from the Application home page.

Application Definition Page

The Application Definition page is divided into the following regions: Name, Properties,
Availability, Error Handling, Gloal Notification, Substitutions, Build Options, and Copyright
Banner.

5.8.1.1 Accessing the Application Definition Page

Access the Application Definition page from the Application home page.

To access the Application Definition page:

1.
2.

ORACLE

On the Workspace home page, click the App Builder icon.
Select an application.

The Application home page appears.
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SQL Workshop

CINON |

™
Le =

Team Development Gallery

dit Page 1 »

Shared Components

Use the Application home page
to run, edit, import, export,
copy, or delete an application.
Select a page to edit the page
properties, or dlick Create Page
to add a page to the application.

Supporting Objects

Shared Components

Learn More .

Utilities

Export / Import

Tasks

Go og =] Actions v Create Page > Delete this Application
Copy this Application
Add Feature Page
Manage Backups

Browse by Facets

1-Home 2 - Dashboard 3 - Projects

From Application home page, you can access the Application Definition page in
two ways:

»  Click the Edit Application Definition button.
*  From Shared Components:
— Click Shared Components.
— Under Application Logic, click Application Definition.
The Edit Application Definition page appears.
Edit the appropriate attributes.
Click Apply Changes to save your changes.

5.8.1.2 Application Definition Page

The Application Definition page is divided into the following regions: Name, Properties,
Availability, Error Handling, Gloal Notification, Substitutions, Build Options, and
Copyright Banner.

ORACLE

# Note:

Required values are marked with a red asterisk (*).

Name

Properties
Availability

Error Handling
Global Notification

Substitutions
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* Report Printing

e Copyright Banner

5.8.1.2.1 Name

Use Name attributes to define basic characteristics of your application, including the
application name, an optional alphanumeric alias, and a version number.

Table 5-4 Application Definition, Name

Attribute

Description To Learn More

Name

Application Alias

Version

Application
Group

A short descriptive name for the n/a
application to distinguish it from other
applications in your development
environment.

Assigns an alternate alphanumeric See:
application identifier. You can use this e Understanding Friendly URL Syntax
identifier for the application ID. - Customizing a Friendly URL

When the Friendly URLs attribute is
enabled, the Application Alias specified
here displays in the URL when running
the application. Applications created
using Oracle APEX 20.1 or later default
the Application Alias to the application
Name.

Enter the application's version number.  n/a
The value enter displays on the page.

You can also automatically tie the version

to the date of last modification using the
following format masks:

e YYYY.MM.DD
e MM.DD.YYYY
d DD.MM.YYYY

If your application version uses
YYYY.MM.DD, then App Builder replaces
this format mask with the date of last
modification of any application attribute.

Displays the application group currently ~ See Managing Application Groups
associated with this application. To select

another application group, make a

selection from the list. To remove an

application from an existing group, select

Unassigned.

5.8.1.2.2 Properties

Use Properties attributes to configure logging, debug behavior, feedback, compatibility, email
from address, and the application proxy server.

ORACLE
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Table 5-5 Application Definition, Properties
|

Attribute Description To Learn More

Friendly URLs Determines whether URLs generated See:
to navigate to other pages in the . Understanding Friendly URL
application should be easier to read. Syntax

Options include:

* On - If setto On, the application
uses Friendly URLs Syntax in
which the URL consists of a
directory structure based on the
Application Alias, Page Alias, and
standard web parameter syntax..

¢ Customizing a Friendly URL
Enabling RESTful Services and
Defining a Path Prefix for a
Workspace in Oracle APEX
Administration Guide

If set to On, Progressive Web
App attributes display on this
page.
*  Off - If set to Off, the application
uses f?p= Syntax.
Note: The friendly URL will include
the workspace Path Prefix in the
URL. To modify the Path Prefix, go to
Workspace Administration, Manage
Service, Set Workspace

Preferences.
Allow Enables support for end user See Managing Feedback
Feedback feedback for this application. Select

Yes or No.

If you select Yes, you must create a
feedback feature page to use this
attribute. If you enable this option, a
Feedback icon displays. Uses can
click the Feedback icon to leave
feedback. Disabling this option hides
the Feedback icon. This enables you
to turn on feedback for testing and
turn it off for production

Logging Determines whether user activity is See Enabling Application Activity
recorded in the Oracle APEX activity = Logging in Oracle APEX
log. Select Yes to log every page view Administration Guide
and enable an administrator to
monitor user activity for each
application.

Disabling logging may be advisable for
high volume applications.

This attribute can only be modified if
the Application Activity Logging
attribute in APEX Administration
Services is set to Use Application
Setting.
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Table 5-5 (Cont.) Application Definition, Properties

Attribute

Description To Learn More

Debugging

Compatibility
Mode

Controls debug mode for the current  n/a
application. Available options include:

* Yes - Enables the application to
run in a debug mode from a
browser at runtime.

* No - Disables the application from
enabling in debug from a browser.

Running an application in debug mode

is useful when an application is under

development. For production
applications, Oracle recommends
disabling debugging and thus
preventing users from viewing
application logic.

Debug can be enabled

programmatically regardless of this

debug setting. If the application is run
from the APEX development
environment, debugging can always
be enabled.

Controls the compatibility mode of the See:
APEX runtime engine. Certain runtime For more information see

behaviors change from release to Changed Behavior
release. To not break or change the Compatibility Mode in Oracle
behavior of existing applications, this APEX Release Notes.

attribute is automatically set during
upgrade if necessary.

Use this attribute to obtain specific
application behavior. To keep
applications maintainable, set
Compatibility Mode to the latest
release after reviewing the changed
behavior in the Release Notes and
making the necessary changes.

Updating App Compatibility Mode

Note: In order to refresh any theme in
release 22.2, you must set
Compatibility Mode to 21.2/22.1/
22.2.
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Table 5-5 (Cont.) Application Definition, Properties

Attribute

Description

To Learn More

Application
Email from
Address

Proxy Server

Determines the email address to use
as the from address in the application.
Enter a valid email address to use as

the from address when sending email
from an email download or

subscription. The value can be a literal

string containing a valid email or a
static substitution reference defined in
the application using substitution
syntax APP EMAIL. Examples:

john.doelabc.com
&MY APP EMAIL FROM.

Oracle does not recommend using an
item substitution at the application or
page-level since it only works in email
download, but not for subscriptions.

Tip: You can also specify the Email
from Address by editing interactive
report attributes. See About Emailing
from an Interactive Report.

Specify a proxy server.

For example, App Builder may require
a proxy server when using a region
source type of URL. The URL region
source embeds the results of the URL
(that is, the page returned by
navigating to the URL) as the region
source. If you use a firewall and the
target of a URL is outside the firewall
relative to App Builder, you may need
to specify a proxy server.

You can reference values entered into
this field from PL/SQL using the
PL/SQL package variable

APEX APPLICATION.G PROXY SERV
ER.

For example:
WWW-Proxy.company.com

n/a

n/a
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Table 5-5 (Cont.) Application Definition, Properties

Attribute Description To Learn More
Oracle Text The Oracle Text query syntax is very  See Understanding Oracle Text
Function complex and powerful and provides a Application Development in Oracle

rich set of query operators to deal with Text Application Developer's Guide

wildcards, stemming, fuzzy searches
and so forth. For end users, this
syntax is often hard to understand.
Often users simply want to type text
and have query features applied
automatically.

For that reason, you can specify the
name of a PL/SQL function which
converts end user input to an Oracle
Text query. The function takes the end
user input as VARCHAR2 and returns
the Oracle Text query as a result
This example uses Oracle Text Fuzzy
Search for all queries.

function
convert end user search (
p_search in varchar2 )
return varchar?
is
begin
return 'FUZZY ({' ||
replace( p search, '}',
"\}'U) Il '}y, 30, 2000)°';
end;

This example makes use of Query
Relaxation. It executes the exact
queries first and adds fuzzy or
wildcard features later on when the
exact query does not return enough
rows. These change are all
transparent to the end user.

create or replace function
convert end user search (
p_search in varchar?2 )
return varchar?
is
c_xml constant
varchar?2 (32767) :=
'<query><textquery><progress
ion>' ||

'<seq>
#SEARCHE </seq>' ||
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Table 5-5 (Cont.) Application Definition, Properties
|

Description To Learn More

'<seqg> ?
#SEARCH# </seq>' ||

'<seq>
#SEARCH#% </seq>' ||

'<seq>
$#SEARCH#% </seq>' ||

'</progression></
textquery></query>';

1 search
varchar2(32767) := p_search;
begin

-- remove special
characters; irrelevant for
full text search

1 search :=
regexp replace( 1 search,
>/ () Fs&S s\,

")
return replace( c xml,

"#SEARCH#', 1 search );
end;
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_________________________________________________________________________|
Description

Attribute

To Learn More

Tokenize Row
Search

Specify how the search terms are
applied when a row search is
performed within a component.

Selecting On treats each word of a
search term separately and matches a
record where the words are contained
in any of the columns, together or
independently. To search for an exact
phrase, use a quotes (") around the
search terms. For example, "ui
developer". To escape a double
guote in a search term, use a double
quote (™).

Examples:

Search for any record including
the words "red" and "shoes"

Search term: red shoes
Search for any record including
the word "developer" and the
exact expression "ui designer"
Search term: developer "ui
designer"

Search for any record including
the word "author" and the exact
expression "the sky is "blue" and
nice"

Search term: author "the sky
is ""blue"" and nice"

Selecting Off treats the whole search
term as an exact match.

5.8.1.2.3 Availability

Use Availability attributes to manage your application by defining an application status and
build status. For example, if you select the status Restricted Access, you can specify which
users have access and can run the application.

ORACLE
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Attribute

Description

To Learn More

Status

Build Status

Message for
unavailable
application

Specifies whether the application is
available or unavailable for use.
Options include:

e Available - Application is
available with no restrictions.

¢ Available with Developer
Toolbar - Application is available
for use. For developers, the
Developer Toolbar displays on
each page. Requires the
developer to be logged in to App
Builder in the same browser
session.

e Available to Developers Only -
Application is available to users
having developer privileges.

* Restricted Access - Application
is available to developers named
in the Restrict to comma
separated user list.

e Unavailable - Application cannot
be run or edited. The message in
Message for unavailable
application displays when users
attempt to access the
application.

¢ Unavailable (Status Shown
with PL/SQL) - Application
cannot be run or edited.

* Unavailable (Redirect to URL) -
Application cannot be run. The
user is linked to the URL entered
in Message for unavailable
application.

Identifies the build status of the

current application. Options include:

*  Run and Build Application -
Developers and users can both
run and develop the application.

*  Run Application Only - Users
can only run the application. This

option is intended for applications

in a production instance.

Use this attribute with Status. If you
set Status to Unavailable,
Unavailable (Status Shown with
PL/SQL), or Unavailable (Redirect
to URL) , the text you enter in this
attribute displays. If you set Status to
Available, the text you enter in this
attribute does not display.

See:

e Changing Build Status for
Multiple Applications and
Changing Application Build
Status in Administration Services
in Oracle APEX Administration
Guide

e Controlling Access to
Applications, Pages, and Page
Components

See Changing Application Build
Status in Administration Services in
Oracle APEX Administration Guide

n/a
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Table 5-6 (Cont.) Application Definition, Availability
|

Attribute Description To Learn More
Restrict to Use this attribute with the Status n/a
comma Restricted Access. If you set Status

separated user to Restricted Access, only the users
list (status must listed in this attribute can run the
equal Restricted application.

Access) To use this attribute:

1. From the Status list, select a
restricted status.

2. Enter a comma-delimited list of
users who can run the
application in the field provided.

3. Click Apply Changes.

5.8.1.2.4 Error Handling

ORACLE

Use the Error Handling attributes described to control or modify how an application logs
errors.

Tip:

Error handling functions specified here are overridden by similar page-level
attributes.

Table 5-7 Application Definition, Error Handling

- __________________________________________________________________________|
Attribute Description To Learn More

Default Error Identifies where the validation error n/a
Display Location messages display for basic validations
performed by Oracle APEX or by plug-

ins. Validation error messages can

display in a notification area (defined as

part of the page template), or within the

field label. Options include:

* Inline with Field and in
Notification - Error messages
display in a notification area defined
as part of the page template.

* Inline with Field - Error messages
display within the field label.

* Inline in Notification - Displays in
the #NOTIFICATION MESSAGE#
template substitution string when an
error occurs on the page.
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Table 5-7 (Cont.) Application Definition, Error Handling

Attribute

Description

To Learn More

Error Handling
Function

Enter the name of a PL/SQL error
function to be called to modify the
existing error message and display a
more user-friendly message or log the
error if one occurs. This function can
reference a package function or
standalone function in the database. For
example:

log apex error

When referencing a database PL/SQL
package or standalone function, use the
#OWNER# substitution string to reference
the parsing schema of the current
application. For example:

#OWNER#.1log apex error

You must implement error handling

functions using the syntax described in
the apex_error package.

function <name of function> (
p_error in

apex error.t error )
return

apex error.t error result

Note: Error handling specified at the
page-level overwrites any error handling
function specified here.

See APEX_ERROR in Oracle APEX API
Reference

5.8.1.2.5 Global Notification

Use the Global Notification attribute to communicate system status to application
users. If the page templates used in your application contain the

#GLOBAL NOTIFICATION# substitution string, the text entered here displays in that
string's place. For example, you can use this attribute to notify users of scheduled
downtime, or communicate other messages regarding application availability.

To create a global notification:

1. Include the #GLOBAL NOTIFICATION# substitution string in your page template.

2. Navigate to the Edit Application Definition page and enter a message in the Global
Notification attribute.

3. Click Apply Changes.

ORACLE
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¢ See Also:

e Using Substitution Strings

e Page Templates

5.8.1.2.6 Substitutions

Use Substitutions to define static substitution strings for your application. You can use static
substitution string for phrases or labels that occur in many places within an application. To
create a substitution string, enter the string name in the Substitution String column and the
string value in the Substitution Value column.

Defining static substitution strings centrally enables you to change text strings in multiple
places in your application by making a single change to the Substitution Value defined on
this page.

¢ See Also:

Using Substitution Strings

5.8.1.2.7 Build Options

Build Options displays existing build options in the current application. Most applications
have a build option attribute. Build Options have two possible values: INCLUDE and EXCLUDE. If
you specify an attribute to be included, then the Oracle APEX engine includes and enables it
at runtime. However, if you specify an attribute to be excluded, then the APEX engine
disables it and excludes it at runtime.

Do not specify a build option unless you plan to exclude that object from specific installations.

¢ See Also:

Using Build Options to Control Configuration

5.8.1.2.8 Report Printing

ORACLE

Report Printing controls the print server of the application. These settings override the
settings from Instance Administration. Available options include:

* Native Printing - Use native printing. No external print server required.

* Remote Print Server - Choose a remote server of the type Print Server that is
configured in the Workspace Utilities.

* Use Instance Settings - Use the Report Printing settings defined in Instance
Administration.
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Click the Add Remove Print Server button to open a wizard to create a Remote Print
Server, including the credentials. To create a Remote Server, choose the Print Server
Type, specify an Endpoint URL and click Next. If Authentication is required, specify the
credentials. Click Apply Changes to add the Remote Print Server and Credentials to
your workspace, and update the Report Printing attributes for the application. For
detailed steps, see Configuring Report Printing at the Application-Level.

¢ See Also:

e Printing Report Regions
e Configuring Report Printing in Oracle APEX Administration Guide

5.8.1.2.9 Copyright Banner

Use Copyright Banner for copyright banner text. This text will be included in the
application export file. You can use #APP_NAME# substitution string to refer to current
application name and #YEAR# to refer to the current year, for example:

Name: #APP NAME#

Copyright (c) 1999, #YEAR#, Company Name.

¢ See Also:

Exporting Workspaces, Applications, and App Components

5.8.2 Configuring Security Attributes

Use the Security page to set application-wide security settings.

Tip:

Edit application components directly to manage more granular settings. To
learn more about security best practices, see Managing Application Security.

* Accessing the Security Page
Access the Security page page from the Application home page.

e Security Page
The Security page is divided into the following sections: Authentication,
Authorization, Session Management, Session State Protection, Browser Security,
and Database Session.

5.8.2.1 Accessing the Security Page

Access the Security page page from the Application home page.
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To access the Security page:
1. On the Workspace home page, click the App Builder icon.
2. Select an application.
The Application home page appears.
3. From the Application home page, you can access the Security page in two ways:
» Edit Application Definition button:
a. Click Edit Application Definition to the right of the application name.
b. Click the Security tab.
* From Shared Components:
a. Click Shared Components.
b. Under Security, click Security Attributes.
The Edit Security Attributes page appears.
4. Edit the appropriate attributes.
5. Click Apply Changes to save your changes.

5.8.2.2 Security Page

The Security page is divided into the following sections: Authentication, Authorization,
Session Management, Session State Protection, Browser Security, and Database Session.

Use the Security page to set application-wide security settings. Edit application components
directly to manage more granular settings.

" Note:

Required values are marked with a red asterisk (*).

e Authentication

e Authorization

e Session Management

* Session State Protection
*  Browser Security

e Database Session

5.8.2.2.1 Authentication

Authentication is the process of establishing users' identities before they can access an
application. Although you can define multiple authentication schemes for your application,
only one scheme can be current at a time.
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Table 5-8 Authentication Attributes
]

Attribute

Descriptions To Learn More

Public User

Authentication
Scheme

Identifies the Oracle schema (or See HOME_LINK and Understanding
user) used to connect to the database Conditional Rendering and

through the Database Access Processing

Descriptor (DAD). Once a user has

been identified, the Oracle APEX

engine keeps track of each user by

setting the value of the built-in

substitution string APP_USER.

When APP_USER equals this value,
the APEX engine considers the
current session to be a "public user"
session. The APEX engine supports
the following built-in display
conditions:

« USER_IS PUBLIC_USER
+ USER IS NOT PUBLIC USER

If the current application user
(APP_USER) equals the value of this
attribute, then the user is logged on
as a public user. Some applications
have public (not logged in) and
private (logged in) modes. By
determining if the user is the public
user, you can conditionally display or
hide information.

For example, you can show a login
button if the user is the public user
and a logout link if the user is not a
public user. Reference this value
using

APEX APPLICATION.G PUBLIC USE
R.

Identifies the current authentication See How Authentication Works and
method used by this application. The Creating an Authentication Scheme
purpose of authentication is to

determine the application users

identity. To create an authentication

scheme, click Define Authentication

Schemes.

5.8.2.2.2 Authorization

Application authorization schemes control access to all pages within an application.
Unauthorized access to the application, regardless of which page is requested, causes
an error page to display.

Table 5-9 Authorization Attributes
]

Attribute Descriptions
Define Authorization Click the Define Authorization Schemesbutton to create an
Schemes authorization scheme.

ORACLE
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Table 5-9 (Cont.) Authorization Attributes
|

Attribute

Descriptions

Authorization Scheme

Run on Public Pages

Source for Role or
Group Schemes

Specify an authorization scheme for your application. Application
authorization schemes are defined for an application for the purpose
of controlling access. Setting a required authorization scheme here at
the application level will require all pages of the application to pass
the defined authorization check.

Controls whether the application-level authorization scheme is
checked on public pages (that is, pages that do not require
authorization). Options include:

* On - If you select On and the page is public, the application
authorization is checked.

*  Off - If you select Off and the page is public, the application
authorization is ignored.

Note: This attribute is ignored if you select Must Not Be Public

User as Authorization Scheme.

Define what APEX should use as the source for authorization
schemes of type Is In Role or Group. The available values are:

* Access Control User Role Assignments - Enable the user's
assigned roles (under Shared Components / Application Access
Control).

* Authentication Scheme - If the application's authentication
scheme is APEX Accounts, enable the workspace user's
assigned groups. If the application's authentication scheme is
Database Accounts, database roles are checked when the
authorization scheme is enabled. If the authentication scheme
uses Real Application Security, enable RAS Dynamic Roles.

e Custom Code - Call the procedure
apex_authentication.enable_dynamic_groups in a Post-
Authentication process, to populate dynamic groups.

¢ See Also:

Attaching an Authorization Scheme to an Application

5.8.2.2.3 Session Management

Use Session Management attributes to reduce exposure at the application-level for
abandoned computers with an open web browser.

ORACLE
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Table 5-10 Session Management

______________________________________________________________________|
Attribute Descriptions

Rejoin Sessions Control at the application-level whether URLSs in this application
contain session IDs. When Rejoin Sessions is enabled, APEX
attempts to use the session cookie to join an existing session,
when a URL does not contain a session ID.

To use Rejoin Sessions at the applicaion-level, administrators
must enable Rejoin Sessions at the instance-level. A more
restrictive instance-level setting overrides application and page
settings.

Rejoin Sessions options include:

e Application Default - The application-level setting applies.
. Disabled - If the URL does not contain a session ID APEX
creates a new session.

* Enabled for Public Sessions - If the URL goes to a public
page and does not contain a session ID, APEX attempts to
utilize the existing session cookie established for that
application. APEX only joins using the cookie when the
session is not yet authenticated.

* Enabled for All Sessions - If the URL does not contain a
session ID, APEX attempts to utilize the existing session
cookie established for that application, providing the
following conditions are met:

—  Session State Protection is enabled for the application
and the URL includes a valid checksum. For public
bookmarks, the most restrictive item level protection
must be either Unrestricted or Checksum Required -
Application Level.

—  OR, the URL does not contain payload (a request
parameter, clear cache or data value pairs).

This option requires you set Embed In Frames to Allow

from same origin or Deny. This is not tied to a condition

about the URL payload, but also applies to session state
protected URLSs.

Warning: Enabling rejoin sessions may expose your application

to possible security breaches, as it can enable attackers to take

over existing end user sessions. To learn more, see About Rejoin

Sessions.

See Also:

e Session Management to configure Rejoin Sessions at the
application-level.

e Configuring Rejoin Sessions for an Instance in Oracle APEX
Administration Guide
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Table 5-10 (Cont.) Session Management

Attribute

Descriptions

Deep Linking

Maximum Session Length in
Seconds

Session Timeout URL

Maximum Session Idle Time
in Seconds

ORACLE

Enables or prevents deep linking to an application. Options
include:

* Enabled - The URL to a specific page ultimately redirects
there, possibly after the user has logged in.

« Disabled - If the URL does not contain a valid session ID,
APEX starts a new session and redirects to the application's
home page.

For example, browsers often save the URLs of opened tabs and

try to restore the sessions after a restart, causing a deep link.

This behavior may be undesirable (for example if a URL points to

a page in the middle of a multi-step wizard). Selecting Disabled,

starts a new session and redirects to the application's home

page.

Defines how long (in seconds) sessions can exist and be used

by this application.

*  Enter a positive integer to control how long a session can
exist.

e Enter 0 to have sessions exist indefinitely.

e Leave the value empty in order to use the session duration
defined at the workspace-level or the instance level.

Enter an optional URL to redirect to when the maximum session
lifetime has been exceeded. The target page in this URL, if
implemented in APEX, should be a public page.

A common use for this page would be to inform the user of the
session expiration and to present a login link or other options. If
you do not enter a URL, users will see the message "Your
session has timed out" and a link to the application home page.
If you enter #L.OGOUT _URL#, APEX will execute a logout, just like
when the user clicked on the application's logout link.

Only three substitution items are supported:

e &APP SESSION.

*  &SESSION.

e &APP_ID.

Because of the particular purpose of this URL. it is not
necessary to include either ¢APP_SESSION. or &SESSION. in
the link.

The Session Idle Time is the time between the last page request

and the next page request. Options include:

e Enter a positive integer to control the idle time for sessions
used by this application.

e Leave the value empty in order to use the idle time defined
at the workspace level or the instance level.
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Table 5-10 (Cont.) Session Management

______________________________________________________________________|
Attribute Descriptions

Session Idle Timeout URL  Enter an optional URL to be redirected to when the maximum
session idle time has been exceeded. The target page in this
URL, if implemented in APEX, should be a public page. A
common use for this page would be to inform the user of the
session expiration and to present a login link or other options. If
you do not enter a URL, users will see the message "Your
session has timed out" and a link to the application home page.
If you enter #L.OGOUT_URL#, APEX will execute a logout, just like
when the user clicked on the application's logout link..

Only three substitution items are supported in this URL:
+  &APP SESSION.

° &SESSION.

e &APP ID.

Because of the particular purpose of this URL, it is not
necessary to include either &APP_SESSION. or &SESSION. in the

link.
Session Timeout Warning in  The session timeout warning time defines (in seconds) how long
Seconds before a session times out (either maximum session length, or

maximum session idle time), to warn the user. For the maximum
session idle time warning, the user will have the opportunity to
extend the session. For maximum session length warning, the
user will be prompted to save any work, to avoid loss of data
when the session maximum time is reached.

- Enter a positive integer to control the session timeout
warning time for sessions used by this application.

e Enter 0 to switch off session timeout warnings for sessions
used by this application.

e Leave the value empty in order to use the warning time
defined at the workspace-level or the instance-level.

¢ See Also:

e About Utilizing Session Timeout

e Configuring Session Timeout for a Workspace and Configuring Session
Timeout for an Instance in Oracle APEX Administration Guide

5.8.2.2.4 Session State Protection

Enabling Session State Protection can prevent hackers from tampering with URLs
within your application. URL tampering can adversely affect program logic, session
state contents, and information privacy. This table describes the attributes available
under Session State Protection.
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Table 5-11 Session State Protection

Attribute

Descriptions

Expire Bookmarks

Manage Session State
Protection

Session State Protection

Allows URLS Created After

Bookmark Hash Function

Click Expire Bookmarks to reset this hidden application attribute (a
checksum salt) salt attribute at any time. Clicking this button causes

any bookmarked URLs that contain previously generated checksums
to fail when they are subsequently used to access the application.

Tip: You can also click Expire Bookmarks to change the Bookmark
Hash Function to switch to a different algorithm for computing
checksums.

Click Manage Session State Protection to configure Session State
Protection.

Make a selection from the Session State Protection list, to enable or
disable Session State Protection for your application. Selecting
Enabled turns on session state protection controls defined at the
page and item-level. To learn more, see field-level Help.

Lists the date and time after which bookmarked links are usable to
access pages in this application if the bookmarked link contains a
checksum and Session State Protection is enabled for the application.

Bookmarks created before this date and time are not usable to access
this application if the bookmarked link contains a checksum and
Session State Protection is enabled for the application. Bookmarks
that do not contain checksums or bookmarks that contain checksums
that are unnecessary are not affected by this attribute. Their usability
is determined using other criteria. A hidden application attribute (a
checksum salt) is used during the computation and later verification of
checksums included in f?p= URLs generated during page rendering.
Checksums are included when Session State Protection is enabled for
the application. You can reset this checksum salt attribute at any time
by clicking the Expire Bookmarks button.

Used to create checksums for application-level and user-level
checksums in bookmarkable URLs.

¢ See Also:

Preventing URL Tampering

5.8.2.2.5 Browser Security

This table describes the attributes available under Browser Security.

ORACLE
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Table 5-12 Browser Security

______________________________________________________________________|
Attribute Descriptions

Cache Use Cache to enable or disable browser caching of application
page contents. If enabled, the browser saves the contents of
pages for this application in its cache, both in memory and on
disk. Typically when caching is enabled and the browser back
button is clicked, the page is loaded from the cache instead of
from the server. If disabled, the browser is instructed not to save
application page contents and requests the latest page content
from the server whenever the URL changes.

To avoid the possibility of saving sensitive data, Oracle
recommends that this attribute be disabled. Otherwise, it is
possible to go back in the browser history after a logout and see
cached content from a previous session. Disabling the browser
cache also prevents issues with pages that use partial page
refreshes, such as is the case with interactive reports.

If this attribute is set to Disabled, APEX sends the HTTP header
cache-control: no-store which instructs the browser to not
cache the page contents on disk or in memory. Note that this
feature requires modern browsers that support the HTTP header
response variable cache-control.

Embed in Frames Controls if a browser may display your application's pages within
a frame. Available options include:

*  Deny - The page cannot be displayed in a frame, regardless
of the site attempting to do so.

* Allow from same origin - The page can only be displayed
in a frame on the same origin as the page itself.

e Allow - The page can be displayed in any frame.

Displaying pages within frames can be misused with
"clickjacking” attacks. In a “clickjacking” attack, the attacker uses
multiple layers to trick a user into clicking a button or link on
another page when they were intending to click the top level
page. Thus, the attacker is hijacking clicks (or keystrokes) meant
for their page and routing them to another page.

To learn more, see field-level Help.

HTML Escaping Mode Defines how APEX escapes special characters. Options include:
e Basic: Escape &, ", <and >
. Extended: Escape &, ", <, >, ', / and non-ASCII characters
if the database character set is not AL32UTF8

HTTP Response Headers Enter additional application specific HTTP headers that APEX
should send on each response and that it does not support in
another way (for example, X-Frame-Options using the Embed
in Frames attribute).

Example:
X-XSS-Protection: 1; mode=block

X-Content-Type-Options: nosniff

ORACLE 5-68



Tip:

5.8.2.2.6 Datahase Session

Chapter 5
Managing Application Attributes

Both Cache and Embed in Frames require modern browsers that support the
HTTP header response variable X-Frame-Options.

This table describes the attributes available under Database Session.

Table 5-13 Database Session

Attribute

Descriptions

Parsing Schema

Initialization PL/SQL Code

Cleanup PL/SQL Code

Runtime API Usage

Specifies the schema that all SQL and PL/SQL in the application
will be parsed as. You may use #OWNER# to reference this value in
SQL queries and PL/SQL (for example, in a region or a process).

Use this attribute to enter a PL/SQL block that sets a context for the
database session associated with the current "show page" or
"accept page" request. The block you enter here is executed at a
very early point during the page request, immediately after the

APP USER value is established. The value of APP_USER

(using :APP_USER or v("APP_USER')) may be used within the block.
Values of other items in session state may be referenced as well,
but any such items must have been established in session state
before the initiation of the current page request. To view examples,
see field-level Help.

Use this attribute to enter a PL/SQL block that runs at the end of
page processing. It can be used to free or clean up resources that
were used, like VPD contexts or database links. To view examples,
see field-level Help.

Control how this application can access APEX APIs that modify

applications and workspace data while it is running. Options

include:

*  Modify This Application: The application can modify itself.

*  Modify Other Applications: The application can change other
applications in the workspace.

*  Modify Workspace Repository: The application can change
workspace users and groups.

¢ See Also:

Guide

Providing Security Through Authorization and Oracle Label Security Administrator’s

5.8.3 Configuring Globalization Attributes

Edit attributes on the Globalization page to configure application globalization options. In App
Builder you can develop applications that can run concurrently in different languages.

ORACLE
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A single application can be translated to support different languages. Use the
attributes on the Edit Globalization Attributes page to specify globalization options
such as the primary application language and defaults for date format, time format,
timestamp format, time zone format, and CSV encoding.

Accessing the Globalization Page
Access the Globalization page page from the Application home page.

Globalization Page
The Globalization page has one section: Globalization.

¢ See Also:

Managing Application Globalization

5.8.3.1 Accessing the Globalization Page

Access the Globalization page page from the Application home page.

To access the Globalization page:

1.
2.

4.
5.

On the Workspace home page, click the App Builder icon.
Select an application.
The Application home page appears.

From Application home page, you can access the application Globalization page in
two ways:

» Edit Application Definition button:
a. Click Edit Application Definition to the right of the application name.
b. Click the Globalization tab.
e From Shared Components:
a. Click Shared Components.
b. Under Globalization, click Globalization Attributes.
The Globalization page appears.
Edit the appropriate attributes.
Click Apply Changes to save your changes.

5.8.3.2 Globalization Page

The Globalization page has one section: Globalization.

ORACLE

Application Primary Language
Application Language Derived From
Document Direction

Application Date Format

Application Date Time Format
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* Application Timestamp Format

*  Application Timestamp Time Zone Format
*  Character Value Comparison

e Character Value Comparison Behavior

*  Automatic Time Zone

e Automatic CSV Encoding

¢ See Also:

Specifying the Primary Language for an Application

5.8.3.2.1 Application Primary Language

Identifies the language in which an application is developed. This language is the base
language from which all translations are made. For example, suppose application 100 was
authored in English, translated into French, and published as application 101. English would
be the Application Primary Language.

All modifications to the application should be made to the primary language specified here.

5.8.3.2.2 Application Language Derived From

Specifies how Oracle APEX derives the translated application language. The application
primary language can be static, derived from the Web browser language, or determined from
a user preference or item.

To learn more about the available options, see Field-level Help.

5.8.3.2.3 Document Direction

Sets the document direction. Options include:
e Left-To-Right
e Right-To-Left

5.8.3.2.4 Application Date Format

ORACLE

Determines the date format to be used in the application.

Use this date format to alter the NLS DATE FORMAT database session setting before showing
or submitting any page in the application. This value can be a literal string containing a valid
Oracle date format mask or an item reference using substitution syntax. If no value is
specified, the default date format is derived from the database session at runtime. Consider
the following examples:

e Month DD, YYYY

e &MY DATE FORMAT.
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5.8.3.2.5 Application Date Time Format

Specify the date time format to be used in the application.

This date time format can be referenced in an application using the substitution
reference «APP DATE TIME FORMAT., or in PL/SQL using the function

v ('"APP DATE TIME FORMAT'). This attribute does not alter any NLS settings. This
value can be a literal string containing a valid Oracle date format mask or an item
reference using substitution syntax. If this attribute value is not specified, then a
reference to APP DATE TIME FORMAT returns the NLS database session date format
and the NLS time format. Consider the following examples:

e Month DD, RRRR HH24:MI

*  §MY DATE TIME FORMAT.

5.8.3.2.6 Application Timestamp Format

Determines the timestamp format to be used in the application. Select a timestamp
format from the list of values.

Use this timestamp format to alter the NLS_TIMESTAMP FORMAT database session
setting before showing or submitting any page in the application. This value can be a
literal string containing a valid Oracle timestamp format mask or an item reference
using substitution syntax. If no value is specified, the default timestamp format is
derived from the database session at runtime. Consider the following examples:

e DD-MON-RR HH.MI.SSXFF AM

° &MY TIMESTAMP FORMAT.

5.8.3.2.7 Application Timestamp Time Zone Format

Determines the timestamp with time zone format to be used in the application.

Use this date format to alter the NLS TIMESTAMP TZ FORMAT database session setting
before showing or submitting any page in the application. This value can be a literal
string containing a valid Oracle timestamp with time zone format mask or an item
reference using substitution syntax. If no value is specified, the default timestamp with
time zone format is derived from the database session at runtime. Consider the
following examples:

° DD-MON-RR HH.MI.SSXFF AM TZR

e &MY TIMESTAMP TZ FORMAT.

5.8.3.2.8 Character Value Comparison

ORACLE

Determines the collating sequence for character value comparison in various SQL
operations and clauses, for example, ORDER BY, LIKE, MIN/MAX.

Use this value to alter NLS_SORT database session parameter for the execution of SQL
gueries in classic report and interactive report regions. If no value is specified, the
default value is derived from the database session at runtime. Consider the following
examples:
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BINARY
GERMAN
CANADIAN M

5.8.3.2.9 Character Value Comparison Behavior

Determines the collation behavior of SQL operations, for example, LIKE, MIN/MAX.

This value is used to alter NLS_COMP database session parameter for the execution of SQL
queries in classic report, interactive report, and List view regions, as well as in plug-in API.
Options include:

» Database session NLS setting (default) - The NLS_COMP value is derived from the
database session at runtime.

* Binary - Comparisons in WHERE clauses and other SQL operations are binary.

* Linguistic - Comparisons in WHERE clauses and other SQL operations use the linguistic
sort specified in the Character Value Comparison attribute (NLS_SORT).

5.8.3.2.10 Automatic Time Zone

Controls the setting of the database session time zone. When set to On, the client time zone
is derived from the client's web browser and set for the duration of the APEX session.

Subsequent page views have the database session time zone set properly per page view.
Once set, this setting can be overridden using APEX UTIL.SET SESSION TIME ZONE, or reset
using APEX UTIL.RESET SESSION TIME ZONE.

¢ See Also:
Oracle APEX API Reference

5.8.3.2.11 Automatic CSV Encoding

ORACLE

Automatic CSV Encoding controls the encoding of all comma-delimited (CSV) report output in
an application. The default value for Automatic CSV Encoding is On. When Automatic CSV
Encoding is set to On, CSV report output is converted to a character set compatible with
localized desktop applications. The character set for the CSV encoding is determined by the
Application Language Derived From setting.

The encoding of pages in App Builder is determined by the character set of the Database
Access Descriptor (DAD) used to access Oracle APEX. For example, if the character set of
the Database Access Descriptor is AL32UTF8, all pages in all applications in the APEX user
interface are encoded in UTF-8.

By default, the CSV output from report regions is encoded in the same character set as the
Database Access Descriptor. However, some desktop spreadsheet applications require that
the data is encoded in the client desktop operating system character set. In the case of
multibyte data, the CSV output from report regions often appears corrupted when opened by
a desktop spreadsheet application. This is because the CSV output from report regions is
encoded differently than what is required by the desktop application. Enabling Automatic CSV
Encoding resolves this issue.
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For example, if the user's language preference for an application is de, the CSV data is
encoded in Western European Windows 1252, regardless of the Database Access
Descriptor character set setting. If the user's language preference is zh-cn, the CSV
data is encoded in Chinese GBK.

5.8.4 Editing User Interface Attributes

Use the User Interface page to control the default characteristics of the application and
optimize the display.

* Accessing the User Interface Page
Access the User Interface page from the Application home page.

* User Interface Page
The User Interface page is divided into the following sections: Icon, Logo,
Attributes, Navigation Menu, Navigation Bar, JavaScript, CSS, Concatenated
Files, and Advanced.

5.8.4.1 Accessing the User Interface Page

Access the User Interface page from the Application home page.

To access the User Interface page:
1. On the Workspace home page, click the App Builder icon.
2. Select an application.

The Application home page appears.

3. From the Application home page, you can access the User Interface page in two
ways:

» Edit Application Definition button:
a. Click Edit Application Definition to the right of the application name.
b. Click the User Interface tab.
e From Shared Components:
a. Click Shared Components.
b. Under User Interface, click User Interface Attributes.
The User Interfaces page appears.
4. Edit the appropriate attributes.
5. Click Apply Changes to save your changes.

5.8.4.2 User Interface Page

The User Interface page is divided into the following sections: Icon, Logo, Attributes,
Navigation Menu, Navigation Bar, JavaScript, CSS, Concatenated Files, and
Advanced.
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< Note:

Required values are marked with a red asterisk (*).

Tip:

To learn more about the attributes on this page, see field-level Help.

* lcon

* Logo

e Attributes

* Navigation Menu

* Navigation Bar

e JavaScript

e CSS

* Concatenated Files

Advanced

5.8.4.2.1 Icon

Tip:

If an application uses legacy icons, a note displays at top of the Icon region. Oracle
recommends replacing legacy icons by clicking Change Icon button.

Use the Icon region to manage Favicon, the PWA icon, the Apple touch icon, and the App
Builder icon. Any uploaded icons are automatically resized and propagated to the appropriate
places at runtime.

Click Edit to view details or update an existing icon. In the Edit Application Icon dialog, you
can either navigate to the file by clicking Choose File, or drag and drop a new file to the
region provided.

To choose a new icon from library, click the Change Icon button. In the Choose Application
Icon dialog you can:

* Upload an icon. Click the plus (+) sign and navigate to the icon, or drag and drop the
icon to the Upload your own icon region.

» Select an icon from the library. Select the icon color and then the icon.
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Use Logo attributes to define an application logo that displays in the top navigation
bar. An application logo can be an image, text, image and text, or based on custom

markup.

Table 5-14 User Interface, Logo

Attribute

Description

Logo

For Logo, select a logo type. Options include:

* None

* Image

o Text

* Image and Text
e Custom

Additional atttibutes appear based depending upon your selention.
To learn more about an attribute see item Help.

If you select Image, Text, Image and Text, or Custom, additional
attributes display and your page template your page template must
include the #LOGO# substitution string.

¢ See Also:

Managing Application Logos

5.8.4.2.3 Attributes

ORACLE

Table 5-15 Attributes
]

Attribute Description To Learn More
Enable End If set to On, end users can choose a See Enabling Users to Select a
Users to Theme Style for their sessions within  Theme Style

choose Theme
Style

Add "Built with
APEX" to
Footer

Home URL

Login URL

a customization dialog. Only Theme
Styles marked as Public are eligible
for selection.

If set to On, Oracle APEX adds the

text "Built with ¥ using Oracle APEX"

to the footer of every page.

Specify the home page of the
application.

Specify the login page of the
application.

n/a

n/a

n/a
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Table 5-15 (Cont.) Attributes

_______________________________________________________________________|
Attribute Description To Learn More

Theme Shows the theme currently associated See Switching Themes
with the user interface.

Theme Style Select a theme style. This option only See Using Theme Styles
displays for newer themes that
support theme styles.

Global Page If defined, displays the global page for See Creating a Global Page to
the application. Display Components on Every Page

5.8.4.2.4 Navigation Menu

Applications using newer themes, such as Universal Theme - 42, provide navigation with
navigation menus.

Table 5-16 Navigation Menu
]

Attribute Description

Display Navigation Select On to include or Off to exclude a navigation men in your
application.

Navigation Menu List Select the list utilized for the navigation menu for the application.

Position Select the position where you would like your navigation menu to be

placed on this application.

e Side renders the navigation menu list template in the
#SIDE GLOBAL NAVIGATION LIST# position on your page
template.

* Top renders the navigation menu list template in the
#TOP_GLOBAL NAVIGATION LIST# position on your page
template.

For example, if you choose Side, your navigation could be rendered

as a tree on the left side of your pages; and choosing Top can render

your navigation as a menu bar in the header of your pages.

List Template Select the List Template used to render the navigation menu for this
application.
Template Options Set Template Options for the List Template used for the navigation

menu list for the application.

¢ See Also:

Managing Navigation Menus

5.8.4.2.5 Navigation Bar

Applications using newer themes, such as Universal Theme - 42, include navigation bar lists.
Navigation Bar settings enable you to select list and list templates. Selecting classic
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implementation uses tabs instead of a list. Navigation Bar attributes only display with

newer themes.

Table 5-17 Navigation Bar
|

Attribute

Description

Implementation

Navigation Bar List

List Template

Template Options

Select how to you wish to implement the navigation bar in this

application.

* Classic renders the navigation bar as a classic navigation
bar in the #NAVIGATION BAR# position on your page
template.

e List renders the navigation bar as a list, using the selected
list and list template in the #NAVIGATION BAR# position on
your page template.

Select the list utilized for the navigation bar on this application.

Select the List Template used to render the navigation menu for
this application.

Set Template Options for the List Template used for the
navigation menu list for the application.

¢ See Also:

Managing Navigation Bar Lists

5.8.4.2.6 JavaScript

Use these attributes to control or modify how an application handles JavaScript.

ORACLE
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Attribute

Description

File URLs

Include Deprecated or
Desupported Javascript
Functions

Enter JavaScript file URLs for code to be loaded on every page. Each
URL has to be written into a new line. If you provide a minified version
of your file, you can use the substitution string #MIN# to include .min
or #MIN DIRECTORY# to include minified/ in your file URL for a regular
page view and an empty string if the page is viewed in debug mode.
JavaScript file URLSs you enter here replaces the

#APPLICATION JAVASCRIPT# substitution string in the page
template.

Note: You do not need to include opening or closing script tags. Just
write the URL.

Examples:
. Standard file reference:

/myjs/main.js

e Standard file reference which loads the minified file
main.min.js from /myjs/minified/ for regular page views
and main.js from /myjs/ in debug mode:

/myjs/#MIN DIRECTORY#main#MIN#.js

e Use this syntax if the library is also used from a RequireJS
require call. The define name must match what is used in the
requirejs.config paths and the value must be the global symbol
exposed by the library. Only applies when using RequireJS. This
avoids RequireJS loading that library a second time.

[define hammerjs=Hammer]/myjs/hammer.js

e Use this syntax if the file has a dependency on RequireJS. This
will automatically load RequireJS before this file.

[require requirejs]/myjs/main.js

*  Use this syntax if the file has a dependency on Oracle JET. This
will automatically load RequireJS and the Oracle JET RequireJS
configuration before this file.

[require jet]/myjs/main.js

Specifies if deprecated or desupported JavaScript functions are
included on every page in the application. The functions deprecated
or desupported are listed in the Release Notes for every release. If
you are confident your application does not contain any references to
deprecated or supported functions, do not make a selection and
reduce the overall size of the JavaScript files loaded.
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Table 5-18 (Cont.) JavaScript

_________________________________________________________________________|
Attribute Description

Include j Query Migrate Specifies if the jQuery Migrate plug-in should be included on every
page in the application.

The plug-in restores deprecated features and behaviors of jQuery so
that old JavaScript code and jQuery plug-ins will still run properly with
the j Query version loaded by APEX.

If you are confident your application and any used jQuery plug-in does
not contain any references to deprecated jQuery features, set this to
No to reduce the overall size of the JavaScript files loaded.

5.8.4.2.7 CSS

In File URLS, enter CSS file URLs to be loaded on every page. Each URL has to be
written into a new line. If you provide a minified version of your file you can use the
substitution string #MIN# to include .min or #MIN DIRECTORY# to include minified/ in
your file URL for a regular page view and an empty string if the page is viewed in
debug mode. You also have access to the substitution string #APP_VERSION# if you
want to include the application's version in the file URL.

File URLs you enter here will replace the #APPLICATION CSS# substitution string in the
page template.

Note: You do not need to include opening or closing 1ink tags. Just include the file
URL.

Examples:

«  Standard file reference.
/mycss/main.css

e Standard file reference which loads the minified file main.min.css from /mycss/
minified/ for regular page views and main.css from /mycss/ in debug mode.

/mycss/#MIN DIRECTORY#main#MIN#.css
*  Conditional media query.

[media="only screen and (max-device-width: 480px)"]/mycss/
smartphone.css

«  File reference using a query string in the URL referencing the application version,
such that when the application is upgraded (and the version is incremented), the
browser is instructed to always load the new file and ignore any previously cached
files.

/mycss/main.css?version=#APP VERSION#
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Using a concatenated file can increase the performance of loading your page because
instead of issuing multiple HTTP requests for each single file, the browser only loads one file.
This approach gives you the option to use smaller, more modular files during development
and to use a single concatenated file when running the application outside of the APEX

development environment.

To create a concatenated file, click Concatenated File and follow the on-screen instructions.
To learn more and view examples, see field-level Help.

5.8.4.2.9 Advanced

Use the attributes under Advanced to define the virtual path the Web server uses to point to
the images directory distributed with Oracle APEX.

Table 5-19 User Interface, Advanced

Attribute

Description

#APP_FILES# Path

#APEX_FILES# Path

Media Type

Determines the virtual path the Web server uses to point to the static
files when using the #APP FILES# substitution string.

Do not specify anything to reference files which are stored with your
application definition in the database.

For performance reasons you can also store your application files on
your Web Server. Use any valid URL to reference them.

Examples:
e /myFiles/
e http://contentDeliveryNetwork.com/myFiles/

Determines the virtual path the web server uses to point to the images
directory distributed with App Builder. During installation, the virtual
path is configured as /i/. If you are unsure, contact your
administrator.

When embedding an image in static text (for example, in page or
region headers or footers), you can reference an image using the
substitution string #APEX FILES#. For example, to reference the
image go.gif, you would use the following syntax:

<img src="#APEX FILES#go.gif">

Note: If the entered image prefix is equal to the instance image prefix,
then the application-level attribute will always be null. This easily
facilities the movement of an application across different instances that
may have different image prefixes.

See Also: APEX_FILES

Enter the Internet media type. An Internet media type is two-part
identifier for file formats on the internet. A Media Type is composed of
at least two parts: a type, a subtype, and one or more optional
parameters. This Media Type is used in the Content-Type HTTP
header when rendering the page.

The page-level Media Type overrides the application-level Media Type.
The default value for this attribute is NULL. If both the page-level and
application-level values for Media Type are NULL, the Media Type
text/html is used.

ORACLE
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5.8.5 Configuring Progressive Web App Attributes

Use the Progressive Web App page to configure attributes for both new and existing
Progressive Web App applications.

Tip:

Progressive Web App attributes only display if the Application Definition,
Properties, Friendly URLSs attribute is On.

e Accessing the Progressive Web App Page
Access the Progressive Web App page from the Application home page.

»  Progressive Web App Page
The Progressive Web App page is divided into the following sections: General,
Appearance, and Service Worker Configuration.

¢ See Also:

Creating a Progressive Web App (PWA)

5.8.5.1 Accessing the Progressive Web App Page

Access the Progressive Web App page from the Application home page.

To access the Progressive Web App page:
1. On the Workspace home page, click the App Builder icon.
2. Select an application.

The Application home page appears.

3. From the Application home page, you can access the User Interface page in two
ways:

» Edit Application Definition button:
a. Click Edit Application Definition to the right of the application name.
b. Click the Progressive Web App tab.
e From Shared Components:
a. Click Shared Components.
b. Under User Interface, click Progressive Web App.
The Progressive Web App page appears.
4. Edit the appropriate attributes.
5. Click Apply Changes to save your changes.
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The Progressive Web App page is divided into the following sections: General, Appearance,
and Service Worker Configuration.

Tip:
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To learn more about the attributes on this page, see field-level Help.

e General

* Appearance

*  Service Worker Configuration

5.8.5.2.1 General

ORACLE

Tip:

Progressive Web App attributes only display if the Application Definition,
Properties, Friendly URLSs attribute is On. See Properties, Friendly URLs.

Use General attributes to enable and disable to configure Progressive Web App applications.

Table 5-20 Progressive Web App, General

Attribute

Description

To Learn More

General

Installable

Enable Progressive Web App
functionality.

Enabling this option:
»  Serves static files more efficiently
using advanced caching.

»  Enables the display of declarative
Progressive Web App settings.

Only displays if Enable Progressive
Web App is On.

A Progressive Web App can be installed

on devices. Installing a Progressive Web

App, adds an icon to the device home

screen to feel like a native application.

Enabling this option:

e Add a new navigation bar entry:
Install App.

*  Enables users to install the APEX
app on devices.

See Creating a Progressive Web App
(PWA)

See Creating a Progressive Web App
(PWA)
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Appearance attributes only display if the Progressive Web App, General
attributes Enable Progressive Web App and Installable attribute are On.

Use Appearance attributes to configure Progressive Web App (PWA) attributes for
display, screen orientation, theme color, background color, 10S status bar style, app
description, and custom manifest as well as upload screenshots and shortcuts.

Table 5-21 Progressive Web App, Appearance

Attribute

Description To Learn More

Display

Screen
Orientation

Select the preferred display mode for  See Creating a Progressive Web App
the application. This option controls (PWA)

how much of the browser Ul the user

sees. Options include:

e Fullscreen - Opens the PWA
without any browser Ul. This
option takes the entirety of the
screen or window.

e Standalone- Opens the PWA to
look like a standalone application.
The app runs in a distinct window,
separate from the browser.
Standard browser Ul components
like the URL bar and buttons are
not visible.

*  Minimal Ul - Similar to
standalone, except with browser
controlling navigation buttons like
back and refresh.

*  Browser - Opens the PWA is a
regular browser Ul.

Note: Some devices and browsers

ignore this attribute. Oracle APEX is

only relaying this information to the
device which handles the Progressive

Web App appropriately. For more

information, see https://web.dev/add-

manifest//

Select the preferred screen orientation See Creating a Progressive Web App
when using this Progressive Web App. (PWA)

This option applies mostly for mobile

devices.

Note: Some devices and browsers
ignore this attribute. APEX is only
relaying this information to the device
which handles the Progressive Web
App appropriately.
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Table 5-21 (Cont.) Progressive Web App, Appearance

Attribute

Description To Learn More

Theme Color

Background
Color

iOS Status Bar
Style

App
Description

Defines the default theme color for the See Creating a Progressive Web App
application. (PWA)

This attribute affects how the
operating system displays the
application (for example, for an
Android's task switcher, the theme
color surrounds the application).

Note: Some devices and browsers
ignore this attribute. Oracle APEX is
only relaying this information to the
device which handles the Progressive
Web App appropriately

Select the background color. See Creating a Progressive Web App

The background color defines a (PWA)
placeholder background color for the
application to display before its

stylesheet is loaded. Therefore, the
background color should match the

theme body background color for a

smooth transition between launching

the web application and loading the
application content.

This affects how the operating system
displays the application (for example,
for an Android's task switcher, the
theme color surrounds the
application).

Note: Some devices and browsers
ignore this attribute. Oracle APEX is
only relaying this information to the
device which handles the Progressive
Web App appropriately

Determines the style of the iOS status See Creating a Progressive Web App
bar of your progressive web app. (PWA)
Apple offers three distinct choices:

*  Black Text and White
Background

*  Black Text and Black
Background - This option makes
it appear completely black

e Translucent - This option has
white text takes the same
background color as the body of
your web app. The text color will
remain white even if you use a
light background color. If using
translucent, the page content is
displayed on the entire screen.

Explains what the application does. See Creating a Progressive Web App
Use this attribute to provide more (PWA)

information to users when they are

prompted to install the application.
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Table 5-21 (Cont.) Progressive Web App, Appearance

Attribute

Description

To Learn More

Custom
Manifest

Screenshots

Shortcuts

Used to store additional JSON
properties for the Web App Manifest
file. The properties found here will be
used to extend the declarative options
above, by overriding existing
properties or appending new
properties.

Include screenshots for promotional
purposes when users are prompted to
install the Progressive Web App. Click
Add Screenshot to upload a
promotional screenshot.

For best results, Oracle recommends
all screenshots have the same aspect
ratio.

Note: An APEX application can only
use PWA Shortcuts if Rejoin Sessions
is enabled. Before configuring
shortcuts, click either Enable for
Public Sessions or Enable for All
Sessions. To learn more, see
Session Management.

Use shortcuts enable users of
installed PWAs to quickly access a
specific page. For touch-enabled
devices, shortcuts are accessible
when doing a long-press on the
application icon on the home screen.
For other devices, shortcuts are
accessible when doing a right click on
the application icon on the task bar.

Click Add Shortcut to provide users
with a shortcut to quickly access a
specific page.

See Creating a Progressive Web App
(PWA)

For more information on building a
Custom Manifest, you can read the
Web App Manifest specifications:
https://www.w3.0org/TR/appmanifest/.

See Creating a Progressive Web App
(PWA)

See Creating a Progressive Web App
(PWA)

5.8.5.2.3 Service Worker Configuration

Use the Service Workers Configuration attributes to configure service workers. Service
workers are JavaScript files that can execute code even when the app is not in use.

Service Workers can listen to events such as fetching resources or handling
notifications. You can modify a service worker through hooks, or by replacing events

completely.

Service Worker options include:

» Default - The APEX engine generates it with the following strategy:

— Install and activate the service worker

— Serve resources from cache if cache exists

— Otherwise serve from network, then put resource in cache

ORACLE
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— Serve an offline page if network fails

Configure Hooks - Fill in the placeholders in the service worker code to add your own.
Hooks locations are provided by Oracle APEX. When using this option, you can choose
to "Download Configuration” and use it as a File URL.

File URL - Provide a URL reference to a file that contains the service worker hooks
interface. This is useful for sharing service worker hooks across multiple applications. If
using the file reference, make sure to follow the interface architecture appropriately or
else the service worker will fail at runtime.

To view the interface structure, see field-level Help for this attribute.

5.9 Managing Application Logos

Add and update an application logo in an Oracle APEX application.

An application logo displays in the top navigation bar of your application at runtime.

Tip:

To include a logo in your application, your page template must include the #L0GO#
substitution string.

Managing Logos in the User Interface Attributes
Edit User Interface attributes to add or update an application logo.

Editing App Logos at Runtime
Use Edit Logo on the Runtime Developer toolbar to quickly change an app logo that
displays at runtime.

5.9.1 Managing Logos in the User Interface Attributes

Edit User Interface attributes to add or update an application logo.

ORACLE

To manage an application logo by editing User Interface attributes:

1.
2.

On the Workspace home page, click the App Builder icon.
Select an application.
The Application home page appears.
From the Application home page, you can access the User Interface page in two ways:
- Edit Application Definition button:
a. Click Edit Application Definition to the right of the application name.
b. Click the User Interface tab.
e From Shared Components:
a. Click Shared Components.
b. Under User Interface, click User Interface Attributes.
The User Interfaces page appears.

Under Logo, select a logo type. Additional attributes appear depending upon your
selection.
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None - No logo is shown in the app.
Image- Creates a logo based on a valid image file type.
— Logo - Select Image.

— Image URL - Enter the URL for the image to be used as the logo,
including the filename extension. Note your page template must include
the #L0GO# substitution string. For example:

#APP FILES#my-logo.png
Text - Defines a text only logo.
— Logo - Select Text.

— Text - Select Text - Enter the text that should be display in the application
logo.

Image and Text - Defines an image and text logo.
— Logo - Select Image and Text.

— Image URL - Enter the URL for the image to be used as the logo,
including the filename extension. Note your page template must include
the #L0GO# substitution string. For example:

#APP_FILES#my-logo.png

— Text - Select Text - Enter the text that should be display in the application
logo.

Custom
— Logo - Select Custom.

— Custom HTML - Enter markup of your application's logo. The value in this
field will be inserted into the #1.0G0# substitution string of your page
template.

5. Click Apply Changes.

Tip:

You can also reference an image uploaded to the static file repository using a
substitution string. See Referencing Static Application Files and About
Referencing Static Workspace Files.

See Also:

* Managing Static Application Files
e Managing Static Workspace Files
e Creating Custom Themes

e Page Templates
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5.9.2 Editing App Logos at Runtime

Use Edit Logo on the Runtime Developer toolbar to quickly change an app logo that displays
at runtime.

To add or update an application logo at runtime use Edit Logo:

1.

ORACLE

Preview the page by running it.
The Runtime Developer toolbar displays at the bottom of any editable running page.

On the Runtime Developer Toolbar. click Customize and then select Edit Logo.

= Demonstration - Projects O instaliapp ©O @~ 8 admin v

Milestones

Q~ | Search: All Text Columns Go Actions ~

Edit E Add Row

=  Project Name Description Due Date

= Train Developers Train the Trainers Rather than all developers being tra... 123172021

= Train Developers All Developers Trained Train the Trainers will have successt... 14472022

=  Migrate Legacy Applications Move Data Structures Move all of the tabies 3 aaaaae 3/11/2022
=  Migrate Legacy Applications Redevelop HR Applications Build applications to repy L30T 3/19/2022
= Migrate Legacy Applications Redevelop Project Tracking Applicat..  Build applications to rep| bl “ 3/25/2022

= Develop Pariner Portal POC Define Requirements e olED 3/28/2022

0 @3 [Srages

Work with key stakehold

k] QuickEdit = S Customize Total 30

(DSession @ {8 Debug @ ® £
The Edit Logo dialog appears.
Type - Select the type of logo. Options include:
* None - No logo is shown in the app.
e Text - Defnes a text only logo.
— Type - Select Text.
— Text - Enter the text that should be display as the application logo.
* Image - Creates a logo based on a valid image file type and under 500 kb in size.
— Type - Select Image.

— Specify the image - Drag and drop the file, or click Choose File and navigate to
the image.

* Image and Text:
— Type - Select Image and Text.

— Specify the image - Drag and drop the file, or click Choose File and navigate to
the image.

e Custom define custom HTML to serve as the application's logo:

Due to security concerns, however, this cannot be configured using Edit Logo. When
you select Custom, the User Interface Attibutes button appears. Click User
Interface Attibutes and add the Custom logo on the User Interface Attributes page.
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In following example, Type is set to Text and the Text reads IT Projects for My
Company. Note that the revised logo, IT Projects for My Company, displays at the
top of the page.

= IT Projects for My Company & Installapp O @ v R admin v

.
Milestones
Edit Logo
Qv Search: All Text Columns Application Logo
ype oct

= Project Type L= Due Date
= Train Developers Text IT Projects for My Company i 12/31/2021
= Train Developers 1/4/2022
= Migrate Legacy Applications 31172022
= Migrate Legacy Applications 3/19/2022
= Migrate Legacy Applications Redevelop Project Tracking Applicat.. | Build applications to replace the pr.. 3/25/2022

= Develop Partner Portal POC Define Requirements Work wi

] [ZAop363  [Pages = Total 30

holders t

3/28/2022

Click Save.
The confirmation message appears:

Logo saved successfully

Click Cancel to exit the dialog.

¢ Note:

You can also edit an application logo by editing the application User Interface
attributes. See Managing Logos in the User Interface Attributes.

5.10 Managing Application Icons

Add and update the icon that displays as the Favicon, the PWA icon, the Apple touch
icon, and the App Builder icon in Oracle APEX applications.

About Application Icons
Learn about managing application icons in your APEX application.

Managing Icons in User Interface Attributes
Edit or upload application icons from the Icon region on the User Interface page.

Using Edit App Icon on the Runtime Developer Toolbar
Edit icons in runtime using the Use Edit App Icon option on on the Runtime
Developer toolbar, Customize menu.

5.10.1 About Application Icons

Learn about managing application icons in your APEX application.

ORACLE

When you add an icon to an application it is propagated to the following places in your
application:

Favicon (browser tab icon)
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PWA icon

App Builder icon (that is the icon that displays on Application home page)
Sign In page

Home page breadcrumb region

Apple touch icon (when adding a PWA app to iOS)

Application icons are stored in Shared Components, Static Application Files in three
sizes, 32x32, 192x192 or 512x512.

Tip:

When editing an individual icon, you take ownership of the icon. Be sure to upload
an icon that matches the right size (that is 32x32, 192x192, or 512x512).

You can edit or upload app icons in the following ways:

When Creating a New App - When creating a new application, click Set Icon on the
Create an Application page in the Create Application Wizard. See Running the Create
Application Wizard.

By Editing User Interface Attributes - By editing the attributes under Icon on the User
Interface page. See Managing lcons in User Interface Attributes.

By Editing the Icon in Runtime - In runtime, click Customize, Edit App Icon on the
Runtime Developer Toolbar. See Using Edit App Icon on the Runtime Developer Toolbar

By Uploading Icons to Static Application Files - Application icons are stored in Shared
Components, Static Application Files in three sizes, 32x32, 192x192 or 512x512.

To control the upload for all icon sizes, upload your icons to the Shared Components,
Static Application Files and use the following file paths:

— #APP_FILES#icons/app-icon-32.png
— #APP_FILES#icons/app-icon-192.png

— #APP_FILES#icons/app-icon-512.png

¢ See Also:

Managing Static Application Files

5.10.2 Managing Icons in User Interface Attributes

Edit or upload application icons from the Icon region on the User Interface page.

ORACLE

Tip:

If an application uses legacy icons, a note displays at top of the Icon region. Oracle
recommends replacing legacy icons by clicking Change Icon button.
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To manage application icons by editing User Interface attributes:

1.
2.

7

On the Workspace home page, click the App Builder icon.
Select an application.
The Application home page appears.

From the Application home page, you can access the User Interface page in two
ways:

» Edit Application Definition button:
a. Click Edit Application Definition to the right of the application name.
b. Click the User Interface tab.
*  From Shared Components:
a. Click Shared Components.
b. Under User Interface, click User Interface Attributes.
The User Interfaces page appears.
Find Icon.
Existing icons display in a table on the left side of the page.
To edit or update an icon, click Edit.
a. Inthe Edit Application Icon dialog you can either:
» Click Choose Fileto navigate to the new icon.
» Drag and drop a new file to the region provided.
b. Click Close.
To choose a new icon from the library, click Change Icon.
a. Inthe Edit Application Icon dialog, you can either:

* Upload an icon. Click the plus (+) sign and navigate to the icon, or drag
and drop the icon to the Upload your own icon region.

If you upload a custom icon, it is resized to a number of sizes and will be
propagated to the appropriate places at runtime.

» Select an icon from the library. Select the icon color and then the icon.
b. Click Close.
Click Apply Changes to save your changes.

5.10.3 Using Edit App Icon on the Runtime Developer Toolbar

Edit icons in runtime using the Use Edit App Icon option on on the Runtime Developer
toolbar, Customize menu.

ORACLE

To use Edit App Icon:

1.

Preview the page by running it.

The Runtime Developer toolbar displays at the bottom of any editable running
page.

On the Runtime Developer toolbar. click Customize and then select Edit App
Icon.
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The Edit Applicatioin Icon dialog appears.
3. Inthe Edit Application Icon dialog, you can either:
» Drag and drop the file to the Upload a new icon region.
» Click the Upload a new icon region and navigate to the file.
4. When the new icon appears, use the Zoom slider to reposition it within the frame.
When focused on the icon cropper, the following keyboard shortcuts are also available:
e Left Arrow - Move the image left
* Up Arrow - Move the image up
* Right Arrow - Move the image right
*  Down Arrow - Move the image down
e |-Zoomin
e O-Zoom out
* L - Rotate left
* R - Rotate right
Press Shift to move faster.
5. To save your changes, click Save.

6. To exit the dialog without saving, click Cancel

5.11 Adding Developer Comments

ORACLE

Add comments to an application, a page, or a group of pages using the Developer Comment,
Bug, or To Do button. You can use developer comments to communicate application
changes, report issues, or record developer suggestions.

e Locating Developer Comment Button
Locate the Developer Comment button.

e Adding Developer Comments to an Application
Add developer comments to an application, a page, or a group of pages.

e Viewing and Editing Developer Comments
Click the Developer Comment button to view or edit existing comments.

e Deleting Developer Comments
Delete specific developer comments or delete multiple comments at once.

e Accessing the Developer Comments from Shared Components
Access the Developer Comments page from Shared Components.

e Viewing the Developer Comments Calendar
View the Developer Comments Calendar page.

" See Also:

Adding Application Comments
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5.11.1 Locating Developer Comment Button

Locate the Developer Comment button.

The Developer Comment button resembles a small word balloon. This button displays
on most pages in App Builder that relate to a specific application or application page.

O APEX App Builder SQL Workshop Team Development Gallery () search 8‘- @ m

N

(1) Application 363 1% & [CEdtrageds ®

Application 363 - Demonstration - Projects Edit Applicatiof| Developer Comment

Use the Application home page
to run, edit, import, export,
copy, or delete an application.
Select a page to edit the page

properties, or click Create Page
E E to add & page to the application.
Learn More .

Run Application Supporting Objects  Shared Components Utilities Export / Import
Tasks

J

Go oo == Actions w Create Page > Delete this Application

e
€

Copy this Application
Add Feature Page
Manage Backups

Browse by Facets
0 - Global Page 1 - Home 2 - Dashboard 2 - Projects

5.11.2 Adding Developer Comments to an Application

Add developer comments to an application, a page, or a group of pages.

To add a developer comment:

1. On the Workspace home page, click the App Builder icon.
2. Select an application.

3. Click the Developer Comment button.

4. In Comment, enter up to 4000 characters of text.

5. Click Create.

5.11.3 Viewing and Editing Developer Comments

Click the Developer Comment button to view or edit existing comments.

To edit a developer comment:
1. On the Workspace home page, click the App Builder icon.

2. Select an application.
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Click the Developer Comment button.

Click View Comments.

The Developer Comments page appears.
Locate the comment to be edited.

Click the Edit icon.

The Edit Comment page appears.

In Comment, enter up to 4000 characters of text.

Click Apply Changes.

Tip:

You can also view and edit Developer Comments on the Shared Components page.
Navigate to the Shared Components page and click Developer Comments in the
Tasks region.

5.11.4 Deleting Developer Comments

Delete specific developer comments or delete multiple comments at once.

Deleting a Specific Developer Comment
Learn about deleting a developer comment.

Deleting Multiple Developer Comments
Learn about deleting multiple developer comments.

5.11.4.1 Deleting a Specific Developer Comment

Learn about deleting a developer comment.

To delete a developer comment:

1.

2
3.
4

o

7.

On the Workspace home page, click the App Builder icon.
Select an application.

Click the Developer Comment button.

Click View Comments.

The Developer Comments page appears.

Locate the comment to be deleted.

Click the Edit icon.

The Edit Comment page appears.

Click Delete.

5.11.4.2 Deleting Multiple Developer Comments

Learn about deleting multiple developer comments.

To delete multiple developer comments:

ORACLE
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On the Workspace home page, click the App Builder icon.
Select an application.

Click the Developer Comment button.

Click View Comments.

Click Delete Comments.

© g M w N PR

Select one of the following actions:

* Delete all comments

» Delete comments created by a developer
* Delete comments by date

7. Follow the on-screen instructions.

5.11.5 Accessing the Developer Comments from Shared Components

Access the Developer Comments page from Shared Components.

To view and edit Developer Comments from Shared Components:
1. On the Workspace home page, click the App Builder icon.

2. Select an application.

3. Click Shared Components.

4. Under Tasks, click Developer Comments.

The Developer Comments page appears.

o

Locate the comment to be edited.
6. Click the Edit icon.
The Edit Comment page appears.
7. In Comment, enter up to 4000 characters of text.

8. Click Apply Changes.

5.11.6 Viewing the Developer Comments Calendar

ORACLE

View the Developer Comments Calendar page.
To view the Developer Comments in a calendar:

1. On the Workspace home page, click the App Builder icon.
2. Select an application.
3. Click Shared Components.
4. Under Tasks, click Developer Comments.
The Developer Comments page appears.
5. Click Developer Comments Calendar.
The Developer Comments Calendar page appears.

6. Use the Previous, Today and Next buttons to navigate.
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5.12 Using the Find Icon

Click the Find icon to search for items, pages, queries, tables, PL/SQL code, view debug
reports, view session state, and view errors.

The Find icon resembles a flashlight and displays on many pages in App Builder including the
Application home page, Shared Components, and the Edit Application Definition.

Locating the Find Icon
Learn about the Find Icon.

Searching for Items
Search for items using the Item Finder.

Searching for Pages
Search for pages using the Page Finder.

Searching for Queries
Search for queries using the Query Finder.

Searching for Tables
Search for tables using the Table Finder.

Using the PL/SQL Finder
Locate and view details about stored procedures, functions, and packages using the
Procedure Finder.

Viewing Application Errors
View a report of application errors.

5.12.1 Locating the Find Icon

Learn about the Find Icon.

ORACLE

To use the Find icon:

1.

Click the Find icon.
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Fary N -
'\T/' Application 363

App Builder - SQL Workshop -

Application 363 - Demonstration - Projects

=

Team Development -

Gallery

Ediit Application Dg

Run Application Supporting Objects  Shared Companents Utilities Export / Import
0 - Globzl Page 1- Home 2 - Dashboard 3 - Projects
The Items Finder appears.
Im Pages Queries Tables PL/SQL Debug Session Errors
e &[]0 E3
Q. ~ Go Actions

MName Label Type

P2_ASSIGNED TO Assigned To Page ltem

PZ_BUDGET Budget Page ltem

P2_COST Cost Page Item

P2_EMD_DATE End Date Page ltem

Click one of the following tabs:

* Items - See Searching for Items.

* Pages - See Searching for Pages.

* Queries - See Searching for Queries.

* Tables - See Searching for Tables.
e PLISQL - See Using the PL/SQL Finder.
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$ 0o

e _
O & [ Edit Page 1 »

Use the Application home page
to run, edit, import, export,
copy, or delete an application.
Select a page to edit the page
properties, or dlick Create Page
to add a page to the application.

Lezarn More ...

Tasks

Delete this Application
Copy this Application
Manage Backups

Browse by Facets

Recently Edited Pages

Reset

Page

* Debug - See Viewing Debug Messages for an Application.

» Session - See Viewing Session State

* Errors - See Viewing Application Errors.

ORACLE"
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5.12.2 Searching for Iltems

Search for items using the Item Finder.

In App Builder, an item can be a text field, text area, password, select list, checkbox, and so
on. You can use the Item Finder to search for items within the current application or within the
schema associated with the workspace.

To search for items:
1. Click the Find icon.

The Items Finder appears.

A navigation bar displays in the center the page (see previous illustration) and contains
the following controls:

» Select columns to search - Resembles a magnifying glass. Click this icon to narrow
your search to specific columns. To search all columns, select All Columns.

* Text area - Enter case insensitive search criteria (wildcard characters are implied)
and click Go.

*  Go button - Executes a search.

* Actions menu - Clicking the icon displays the Actions menu. Use this menu to
customize the display.

2. To edit a specific item, navigate to the appropriate item.

# See Also:

Understanding Page Items

5.12.3 Searching for Pages

Search for pages using the Page Finder.

A page is the basic building block of an application. You can use the Pages Finder to search
for pages within the current application or within the schema associated with the workspace.

To search for a page:

1. Click the Find icon.
2. Click the Pages tab.
The Pages Finder appears. A search bar displays at the top of the page.

3. To link to the Items page, click the page number.

5.12.4 Searching for Queries

Search for queries using the Query Finder.

You can use the Queries Finder to locate a query within your application or within the schema
associated with the workspace.
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To search for a query using the Queries Finder:

1.
2.

3.

Click the Find icon.
Click the Queries tab.
The Queries Finder appears. A search bar displays at the top of the page.

To link to the Items page, click the page number.

5.12.5 Searching for Tables

Search for tables using the Table Finder.

You can use the Tables Finder to view tables within the schema associated with the
workspace.

To view tables associated within the current schema:

1.
2.

Click the Find icon.

Click the Tables tab.

The Tables Finder appears. A search bar displays at the top of the page.
Select a table name.

A table definition appears.

This report displays the column names, data type, length, precision, and scale and
the SQL necessary to re-create the table appears at the bottom of the page.

¢ See Also:
Managing Tables in Oracle APEX SQL Workshop Guide

5.12.6 Using the PL/SQL Finder

Locate and view details about stored procedures, functions, and packages using the
Procedure Finder.

ORACLE

You can use the Procedure Finder to locate and view details about stored procedures,
functions, and packages associated with each object within the schema associated
with the workspace.

To search for PL/SQL code in the current schema:

1.
2.

Click the Find icon.

Click the PL/SQL tab.

The PL/SQL Finder appears. A search bar displays at the top of the page.
To view additional details, select the procedure, function, or package name.

The procedure, package, or function name appears and additional information
including the owner, source name, source type, return type, argument names, data
types, and IN/OUT parameters.
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¢ See Also:

Managing Database Objects with Object Browser in Oracle APEX SQL Workshop
Guide

5.12.7 Viewing Application Errors

View a report of application errors.
To view a report of application errors:
1. Click the Find icon.

2. Click the Errors tab.

The Application Errors report appears.

5.13 Adding Application Comments

Use Application Comments to describe an application or track developers involved in the
application development.

To create an application comment:

1. Navigate to the Workspace home page.

2. Click the App Builder icon.

3. Select an application.

4. On the Application home page, click Shared Components.
The Shared Components page appears.

5. Under Tasks, click Edit Application Comment.
The Application Comments page appears.

6. Enter comments in the Comments field and click Apply Changes.

5.14 Managing Application Groups

ORACLE

Organize applications by assigning them to application groups. To use application groups,
first create a group and then assign applications to it.

e About Using Application Groups
Application groups are an ideal way to filter applications on the App Builder home page

e Viewing Application Groups
View existing application groups on the Workspace Utilities, Application Groups page.

e Creating an Application Group
Create application groups on the Workspace Utilities, Application Groups page.

e Assigning a Application to an Application Group
Assign an application to application group on the Manage Application Group
Assignments page.
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* Removing an Application from an Application Group
Remove an application from an application group on the Manage Application
Group Assignments page.

* Deleting an Application Group
Delete an application from an application group on the Manage Assignments
page.

¢ See Also:

Accessing Page Specific Utilities

5.14.1 About Using Application Groups

Application groups are an ideal way to filter applications on the App Builder home
page

Adding the Group Column to the App Builder Home Page

Selecting View Report on the App Builder home page displays applications as an
interactive report. By default, the Group column is hidden.

To add the Group column to the report:

1. Click View Report on the App Builder home page navigation bar.
2. Click the Actions menu and select Columns.

3. Inthe Select Columns dialog, move Group to Display in Report and click Apply.

Creating a Group Filter
Create filters on App Builder home page in either View Report or View lcon mode.
To create a filter that only displays the members of a particular application group:

1. Click the Actions menu and select Filter.
2. Inthe Filter dialog:

a. From Column, select Group. Then use the Operator and Expression lists to
create filter criteria and click Apply.

5.14.2 Viewing Application Groups

ORACLE

View existing application groups on the Workspace Ultilities, Application Groups page.
To view application groups:
1. On the Workspace home page, click the App Builder icon.
2. Click Workspace Utilities.
3. Click Application Groups.
The Application Group page appears, displaying the Search bar.

Available controls include:
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» Select columns to search - Resembles a magnifying glass. Click this icon to narrow
your search. To search all columns, select All Columns.

» Text area - Enter case insensitive search criteria (wildcard characters are implied) to
search for a group by name and click Go.

* Go button - Executes a search or applies a filter.

* View Icons (the default) displays each group as a large icon. To edit a group, click
the appropriate icon.

* View Report displays each group as a line in a report with the columns: Group
Name, Description, Applications, Percent of Total, and Graph. To edit a group, click
the name.

To edit a group or see the applications assigned to a group, click the group name.

The applications assigned to the group display on the right side of the page.

5.14.3 Creating an Application Group

Create application groups on the Workspace Utilities, Application Groups page.

To create an application group:

g M @ b P

On the Workspace home page, click the App Builder icon
Click Workspace Utilities.

Click Application Groups.

On the Application Group page, click Create.

Enter a name, a description (optional), and click Create.

5.14.4 Assigning a Application to an Application Group

Assign an application to application group on the Manage Application Group Assignments
page.

ORACLE

Tip:

You can also assign an application to an application group by editing the application
definition. Select the group from the Application Group list. See Editing the
Application Definition.

To assign an application to a group:

1
2
3.
4

On the Workspace home page, click the App Builder icon.
Click Workspace Utilities.

Click Application Groups.

On the Tasks list, click Manage Unassigned.

The Manage Application Group Assignments page appears.

Filter the report:
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Application - Enter a case insensitive query for the application name, alias, or
ID and click Set.

Group - Select an application group and clicking and click Set.

Show - Filter the display and click Set. Available options include All,
Assigned, and Unassigned.

Show - Select the number of applications to display and click Set.

From the New Group list, select a group.

Select the applications to be assigned and click Assigned Checked.

5.14.5 Removing an Application from an Application Group

Remove an application from an application group on the Manage Application Group
Assignments page.

To remove an application from an application group:

1
2
3.
4

On the Workspace home page, click the App Builder icon.

Click Workspace Utilities.

Click Application Groups.

On the Tasks list, click Manage Assignments.

The Manage Application Group Assignments page appears.

Filter the report:

a.

d.

Application - Enter a case insensitive query for the application name, alias, or
ID and click Set.

Group - Select an application group and click Set.

Show - Filter the display and click Set. Available options include All,
Assigned, and Unassigned.

Show - Select the number of applications to display and click Set.

From the New Group list, select Unassign.

Select the pages to be unassigned and click Assigned Checked.

Tip:

You can also remove an application from an application group by editing the
application definition. Select Unassigned from the Application Group list.
See Editing the Application Definition.

5.14.6 Deleting an Application Group

Delete an application from an application group on the Manage Assignments page.

To delete an application group:

1.
2.

ORACLE

On the Workspace home page, click the App Builder icon.

Click Workspace Utilities.
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Click Application Groups.

Assign all applications in the group to Unassign:

a. On the Tasks list, click Manage Assignments.

b. From the New Group list, select Unassign.

c. Select the pages to be unassigned and click Assighed Checked.
Return to the Application Groups page.

Select the application group to be deleted.

On the Application Group page, click Delete.

A confirmation page appears.

Confirm your request.

5.15 Using Application Utilities

Access the Utilities page to view useful application summaries and reports.

ORACLE

Accessing Application Utilities
Access the Application Utilities page by selecting the application and then clicking the
Utilities icon.

Application Utilities Page

Use the Application Utilities page to access the Application Dashboard, Advisor, Upgrade
Application, Recently Updated Pages, Attribute Dictionary, Change History, Debug
Messages, Oracle APEX Views, Export Repository, Manage Backups, and the
Embedded Code Utility.

Viewing the Application Dashboard
View a report that summarizes application components and attributes.

Viewing the Recently Updated Pages Report
Displays a report of pages recently updated by the current user.

Viewing the Change History Report
The Change History report displays a summary report of edits to the current applications
by developer, component type, and page number

Accessing APEX Views
Query various views against APEX metadata.

Managing Application Backups
Review backup history, perform manual backups, or restore an application from a
backup.

Using the Embedded Code Utility

Review all embedded code used in an APEX application on one page. Embedded code is
defined as code (such as SQL, PL/SQL and JavaScript) entered in the App Builder but
does not include code such as PL/SQL packages or JavaScript libraries that code may
reference.

Viewing Page and Application Checksums
View page and application checksums to compare to compare different application
deployments and determine if the application or pages are different.

Accessing Font APEX
View the Font APEX page to search for Font APEX icons and view HTML markup.
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» Accessing Page Specific Utilities
Use the links in the Page Specific Utilities region to access Cross Page Utilities
and Page Groups as well as access handy utilities for regions, buttons, items,
computations, validations, process, dynamic actions, and branches.

* Accessing Cross Page Utilities
Use Cross Page Utilities to perform edits across pages in the application.

* Using Interactive Report Utilities
View and delete saved interactive reports and interactive report subscriptions.

# See Also:

Creating Custom Activity Reports Using APEX_ACTIVITY_LOG

5.15.1 Accessing Application Utilities

Access the Application Utilities page by selecting the application and then clicking the
Utilities icon.

To access Application Utilities page:

1. On the Workspace home page, click the App Builder icon.
2. Select the application.
3. Click the Utilities icon.

The application Utilities page appears.

¢ Note:

To learn more about this page, see Application Utilities Page.

¢ See Also:

e Accessing Cross Page Utilities

e Accessing Page Specific Utilities

5.15.2 Application Utilities Page

ORACLE

Use the Application Utilities page to access the Application Dashboard, Advisor,
Upgrade Application, Recently Updated Pages, Attribute Dictionary, Change History,
Debug Messages, Oracle APEX Views, Export Repository, Manage Backups, and the
Embedded Code Utility.

The following table describes the links on the Application Utilities page.
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Link Description To Learn More
Application View a summary of application See: Viewing the Application Dashboard
Dashboard components and attributes
Advisor Performs various checks on your See: Running Advisor to Check
application, including checks for Application Integrity
programming errors, security issues,
quality assurance, and other best
practice
Upgrade Upgrade the current application to a new See: Upgrading Oracle APEX
Application release. Review components eligible for ~ Applications
upgrading to include the latest features.
Recently View a history of page updates made to  See Viewing the Recently Updated
Updated Pages this application. Pages Report
Attribute Manage item and column user interface  See: Using the Attribute Dictionary
Dictionary defaults for a selected page.

Change History

View a report of component updates
made in this application.

See: Viewing the Change History Report

Debug Review debug messages generated by ~ See: Debugging an Application
Messages this application.

Oracle APEX Query various views against APEX See: Accessing APEX Views

Views metadata.

Export Manage Export Files in the Export See: Installing Export Files
Repository Repository.

Manage View and manage application backups in See: Managing Application Backups
Backups the current workspace. Backups provide

a simple way to recover applications that
may have been unexpectedly modified or
deleted.

Embedded Code

View all embedded code (such as SQL,
PL/SQL and JavaScript) from all pages in
an APEX application presented in easy-
to-use faceted search page.

See: Using the Embedded Code Utility

Page Specific
Utilities

Page Specific Utilities display in a
region on the right-side of the Utilities
page.

Use the links in the Page Specific
Utilities region to access Cross Page
Utilities and Page Groups as well as
access handy utilities for managing
regions, buttons, items, computations,
validations, process, dynamic actions,
and branches.

See:
»  Accessing Page Specific Utilities
* Accessing Cross Page Utilities

Interactive
Report Utilities

Interactive Report Utilities display in a
region on the lower right-side of the
Utilities page..

Click Saved Reports to delete saved
interactive reports in the current
application. Click Subscriptions to
manage interactive report subscriptions.

See: Using Interactive Report Utilities

Application
Checksum

View the application checksum to
determine if the same application is
deployed in different workspaces.

See Viewing the Application Checksum
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Link Description To Learn More
Font APEX Icons Search Font APEX icons and HTML See Accessing Font APEX
markup.

Page Checksum View the page checksum to compare two See Viewing the Page Checksum

application deployments and determine
which pages are the same and which are
different.

5.15.3 Viewing the Application Dashboard

View a report that summarizes application components and attributes.

ORACLE

To view the Application Dashboard:

1.
2.
3.

Navigate to the Workspace home page.

Click the App Builder icon.

Select an application.

The Application home page appears.
Click Utilities.

Click Application Dashboard.

The Application Dashboard appears and contains the following sections:

Application Overview lists detailed information and statistics about the
current application, including the ID, name, alias, parsing schema, associated
group, number of pages, and associated theme.

Security lists the current authentication scheme, number of public and non
public pages, and the number of authorization schemes used within the
current application.

Templates contains links to reports of templates used within the current
application.

Pages by Type lists counts of components, including types of reports and
forms and dynamic HTML.

Application Components contains links to reports of application-level
controls and logic, including lists, shortcuts, lists of value, tabs, application
computations, application items, plug-ins, and application processes.

Page Components contains links to reports of page-level controls and logic,
including regions, items, branches, computations, validations, dynamic
actions, classic report columns, interactive report columns, and button.

Native Region Component Utilization charts the total number of all types of
region components used in the app. This is a visualization of the information
provided in the Pages by Type section, the Page Components, and others.

Plugin Region Utilization charts the total number of plug-ins used in the app.

To view a specific report, click the number link to the right of the component type
or template.
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¢ See Also:

Identifying At Risk Password Items

5.15.4 Viewing the Recently Updated Pages Report

Displays a report of pages recently updated by the current user.

To view the Recently Updated Pages report:

1.
2.
3.

Navigate to the Workspace home page.

Click the App Builder icon.

Select an application.

The Application home page appears.

Click Utilities.

Click Recently Updated Pages.

The Recently Updated Pages report appears.

5.15.5 Viewing the Change History Report

The Change History report displays a summary report of edits to the current applications by
developer, component type, and page number

To view the Change History report:

1.
2.
3.

Navigate to the Workspace home page.
Click the App Builder icon.

Select an application.

The Application home page appears.
Click Utilities.

Click Change History.

The Change History report appears. Use the Since list to control the amount of time to
include in your report.

From Since at the top of the page, select the amount of time to include in your report and
click Set.

5.15.6 Accessing APEX Views

Query various views against APEX metadata.

ORACLE

APEX Views are data dictionary views that expose the metadata for applications. In APEX
Views, you cannot only see the view, but you can also see the data they contain.

To access the APEX Views page:

1.
2.

Navigate to the Workspace home page.

Click the App Builder icon.
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Select an application.

The Application home page appears.
Click Utilities.

Click Oracle APEX Views.

The APEX Views report appears. Use the Search bar at the top of the page to
customize the display.

Tip:

Click Tree View to switch to a relational view of this information with
expandable parent and children entries.

Select a view.
On Selected Columns, configure the columns.

a. From Select Columns use the controls to add and remove columns or change
the column order.

b. Click the Results button.

The Results report appears.

To view the executed query, expand the Query region.

You can also copy this query for reuse with SQL Commands or SQL Developer.

To download the Results, click the Download link.

5.15.7 Managing Application Backups

Review backup history, perform manual backups, or restore an application from a
backup.

About Application Backups
Backups provide a simple way for developers to automatically recover applications
that may have been unexpectedly modified or deleted.

Viewing All Application Backups
View a summary of all application backups on the Manage Backups page.

Managing Backups for a Specific Application
Manage Backups for all application on the Manage Backup page.

5.15.7.1 About Application Backups

Backups provide a simple way for developers to automatically recover applications
that may have been unexpectedly modified or deleted.

ORACLE

Oracle APEX backs up modified applications as a part of daily maintenance. Backups
are automatic and do not require an administrator or developer involvement. However,
applications are not backed up if they meet the following criteria:

If no changes have been made to the application since the last backup, then the
application is not backed up again.

Run-time only applications are not be backed up.
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» Applications that are installed into runtime-only instances are not backed up.

About Configuring the Number of Backups

By default, APEX only retains the 25 most recent backups. Older backups are deleted to
make room for new ones.

Instance administrators can configure the number of backups per application, or disable
automatic backups all together. To configure the number of backups for each application, sign
in to the Administration Services application and navigate to Manage Instance, Feature
Configuration, Application Development, and update the Number of backups per
application attribute. Valid values are between 0 and 30. A value of zero (0) disables the
backup feature.

¢ See Also:

Configuring the Number of Application Backups in Oracle APEX Administration
Guide

Viewing the Backup Log

Instance administrators monitor the performance of the backup job in the Backup Log. To
view the Backup Log, sign in to the Administration Services application and navigate to
Monitor Activity, Backup Log. The Backup Log reports when a backup job ran, the number
of applications backed up by the job, and the elapsed time required to backup the
applications.

¢ See Also:

Viewing the Backup Log in Oracle APEX Administration Guide

Managing Backups

Developers can view all backups in App Builder in Workspace Utilities, Manage Backups.
To view backups for a specific application, click the application name.

5.15.7.2 Viewing All Application Backups

ORACLE

View a summary of all application backups on the Manage Backups page.
App Builder automatically backs up modified applications on a daily basis.
To view the Manage Backups page:
1. Navigate to the Workspace Utilities page:

a. Sign in to Oracle APEX.

b. On the Workspace home page, click the App Builder icon.

c. Click the Workspace Utilities icon.
2. Click Manage Backups.

The Manage Backups page appears displaying the following columns:
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Application  Application Name I;?:; Il;:iup
477 Demonstration - Projects 88KB 19 hours ago
444 Employess 53KB 19 hours ago
487 Sample Reports 52KB 7 days ago
2324 fe:et—?c_l Search: Multi Value 49KB 8 days ago
Column
359 Faceted Search - Manual S0KB &8 days ago
239 .:.é..:ﬂec' Search - Create App S0KB 8 davs 20
Wizard -
439 Faceted Search - Projects - S0KB & days 220

Create App Wizard
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* Application - Displays the Application ID
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* Application Name - Displays the application name when the backup occurred.
If the name has changed, both names display in the report.

e Last Size
e Last Updated

*  Application Exists

e # Backup - Displays the number of backups.

Manage Backups

Last
Updated

42 hours
ago

23 hours
ago

7 days ago

9 days ago

9 days ago

Application
Exists

u

#
Backups

w

un

w

w

w

3

[, Edit Page 1 O]

About

Automated backups are
performed as part of daily
maintenance. Only applications
that have been modified will be
backed up.

Learn More _.

Seftings

Only the 25 most recent
application backups are
retained. Older backups will be
deleted to make room for new
Ones.

To view backup details for a specific application, click the Application Name.

The Manage Backups page for the application appears.

Q Tip:

You can also access the Manage Backups page from the App Builder home
page. Select Manage Backups from the Tasks region.

5.15.7.3 Managing Backups for a Specific Application

ORACLE

Manage Backups for all application on the Manage Backup page.

To manage backups for a specific application:

1.

Navigate to the Manage Backups page:

a. On the Workspace home page, click the App Builder icon.

b. Click the Workspace Utilities icon.

c. Click Manage Backups.

The Manage Backups page appears.

To view backups for a specific application, click the Application Name.

The application, Manage Backups page appears displaying the following columns:
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Name - Application hame at the time of backup.
Revision - Revision number.
Date - Backup date.

Change Summary - Indicates the number of new, modified, or deleted pages and
components since the last backup.

Created By - Indicates whether the back up was automated or manual. If manual, the
user who created the backup displays.

Size - Backup size.

Status - Generally displays a Lock or Unlock status icon. Locking a backup prevents
it from being removed if the backup limit is reached. If a developer restores an
application, then a Restore icon appears.

Action - Menu options include: Restore, Download, View Details, Manage Lock, or
Delete. These options are discussed in detail in the steps that follow.

Utilities | Manage Backups Ol % || & [ Edit Page 1 @
—, About
Go Actions : Reset Remowve All Create Backup ou

Automated backups are
performed as part of daily

Date Change Summary Created By Size Status Action maintenance. Only applications
that hawve been madified will be
7 davs Automated _ backed up.
T e 2k T =
asv =GLRLp To manually back up the
— PO application, outside of daily
B days Pages: 1 Maodified ':Etdmc'w 52KB ia) = - maintenance, click Create
3go Backup
Backup.
Pages: 2 New, 1 Learn More ..
3 days Meodified, 2 Deleted Automated . -
ago Companents: 2 Backup =2ks ?_] =
Medified, 1 Deleted Application
\.;'EE\S Pages: 1 Modified 'EEE':ﬂf:e: SIKB ?_] = . Last Update: 7 days ago
ago Backup Last Backup: 7 days ago
::;ﬁ\:” Initizl application backup :Ltirce: S1KB ia) = -
80 =ecElp Settings
259KB

Onlv the 25 most recent

3. To restore a backup:

a.
b.

C.

Locate the application and click the Actions menu.
From the Actions menu, select Restore.

In the Restore Application dialog:

i. Install As Application - Select one of the following:

* Restore Application ID - The existing application ID will be used. This
option overwrites the existing application without changing the ID.

* Auto Assigh New Application ID - A new application ID will be created for
you.

* Change Application ID - You specify a new application ID.

ii. Click Restore Application.

4. To download a backup:
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a. Locate the application and click the Actions menu.
b. From the Actions menu, select Download.
c. Import the Export Files.
5. To view backup details:
a. Locate the application and click the Actions menu.
b. From the Actions menu, select View Details.
6. To manage backup locks:
a. Locate the application and click the Actions menu.
b. From the Actions menu, select Manage Lock.
Locking a backup prevents it from being deleted during daily maintenance.
c. Inthe Manage Backup Lock dialog, select Unlock Backup or Lock Backup.
7. To delete a backup:
a. Locate the application and click the Actions menu.
b. From the Actions menu, select Delete.
c. Inthe Delete Backup dialog, select Delete Backup.
8. To backup an application manually:
a. Click Create Backup.
b. Inthe Create a Backup dialog, enter comments and click Backup.
9. To remove all backups for an application:
a. Click Remove All.

b. Inthe Remove All Backups dialog, confirm your selection by clicking Remove
All Backups.

# Note:

You can also access the backups for a specific application from the
Application home page. Navigate to the application and select Manage
Backups from the Tasks list.

# See Also:

Importing an Application, Page or Component Export

5.15.8 Using the Embedded Code Utility

Review all embedded code used in an APEX application on one page. Embedded
code is defined as code (such as SQL, PL/SQL and JavaScript) entered in the App
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Builder but does not include code such as PL/SQL packages or JavaScript libraries that code
may reference.

The Embedded Code Utility displays all embedded code from all pages in an application in an
easy-to-use faceted search page. Using the Embedded Code Utility is ideal for tasks such as
code reviews, security evaluations, and application turning where historically developers
would need to click on every property in a page or Shared Component.

To access the Embedded Code Utility:
1. Navigate to the Workspace home page.
2. Click the App Builder icon.
3. Select an application.
The Application home page appears.
4. Click Utilities.
5. Click Embedded Code.

The Embedded Code page appears. Note that large applications may take longer to
display.

O APEX App Builder SQL Workshop Team Development Gallery | search ,-9(. @ m
irj Application 510 . Utilities | Embedded Code D S (| & [% Edit Page 4 ()
Search Search Resulis Download

Total Row Count 4 Shared Component Settings

Authorization: Administration Rights PL/SQL Function Body
(. search..
return true;
B Language 3
. Page 9999 - Login Page Source
FL/SQL (4 Process: Login PL/SQL Code
ﬂ Scope 5 apex_authentication.loging
p_username =» P3955%_USERNAME,
Shared Component (1 p_password =» P9999_PASSWORD );
Page 9999 - Login Page (3
Page 9999 - Login Page Source
Process: Set Username Cookie PL/SQL Code

B Component Type

Process (3

Authorization (1

ORACLE

aeg

apex_authentication.send_legin_username_ccckie (
p_username =»> lower(:P93%9_USER bl
p_consent =» :P93959%_REMEMEER = '

Page 9999 - Login Page Source
Process: Get Username Cookie PL/SQL Code

P PO999_USERNAME :

1 P9999_REMEMBER

apex_authentication.get_login_username_cockie;
case when :P9999_USERNAME is not null then 'v' end;
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The left region contains facets that enable you to filter the Search Results report.
The values of the facets depend upon the embedded code in the application. The
left region contains the following facet filters:

* Language - Identifies the programming language of the embedded code.
Currently, SQL, PL/SQL and JavaScript are supported.

Only those languages that are included in the application appear. For
example, if an application uses SQL and PL/SQL, but not JavaScript, then
only the first two options will appear as filters. Selecting a filter refreshes the
report and only displays the code that matches the languages selected.

* Scope - Identifies where in the application the embedded code is used.

Shared Component refers to any application component that is not part of a
page such as application processes, authentication schemes, lists of values
and so on. All other values refer to a specific page of an application. Selecting
a page limits the results to only the embedded code for that page.

» Component Type - Identifies the type of component that contains the
embedded code.

Only those component types that contain embedded code display in the filter.
For example, a classic report that uses a SQL query results in a Region
component type to be included. Similarly, if an application does not have any
buttons, then a Button filter does not appear. Note that not all conditions
require embedded code.

A Search Results report displays in the right region and includes identifying
information about the component as well as where the embedded code is used by
the component. For example, a page item may have a Source query used to
populate the item's value, and it can also have a Server-side Condition to
determine if the item should be included on the page.

6. Click Download to create a ZIP archive containing files for each of the
components by language type.

The directory hierarchy of the files is similar to what is created when you split
export files into separate scripts. The difference is that all files will be located
below the embedded code directory as opposed to the application directory.

5.15.9 Viewing Page and Application Checksums

View page and application checksums to compare to compare different application
deployments and determine if the application or pages are different.

*  Viewing the Application Checksum
View the application checksum to compare if the same application is deployed in
different workspaces.

* Viewing the Page Checksum
View the page checksum to compare two application deployments and determine
which pages are the same and which are different.
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5.15.9.1 Viewing the Application Checksum

Application

Details

View the application checksum to compare if the same application is deployed in different
workspaces.

The application checksum is a unique identifier consisting of number and character strings.
View the application checksum to verify if the same application is deployed across
workspaces.

To view the application checksum:
1. Navigate to the Workspace home page.
2. Click the App Builder icon.
3. Select an application.
The Application home page appears.
4. Click Utilities.
5. Click Application Checksum.

The Checksum window appears displaying the application name and details such as the
number of pages, regions, or items. The application checksum displays in the center of
the window.

Checksum X

Demonstration - Projects

32 Pages, 81 Regions, 0 ltems

SH1:LOusVag+hatvOaxaUuplLbS4sa3o=

&

The application checksum provides an easy way to determine whether the same application is deployed
across workspaces. You can cormnpare this checksum to determine whether there is a match.

6. Copy the checksum.

5.15.9.2 Viewing the Page Checksum

ORACLE

View the page checksum to compare two application deployments and determine which
pages are the same and which are different.

A page checksum is a unigue identifier consisting of number and character strings. Use the
page checksum to verify if the same page is deployed across workspaces.

To view the page checksum:
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Navigate to the Workspace home page.
Click the App Builder icon.

Select an application.

The Application home page appears.
Click Utilities.

Click Page Checksum.

The Page Checksum Report appears and includes the following columns: Name,
Page (number), Alias, Checksum, Updated By, Group, and Updated.

To view the page checksum in Page Designer:
a. From the Page Checksum Report, click the page name.
Page Designer appears.

b. From the Page Designer toolbar, click the Utilities menu

) and select Checksum.

The Checksum window appears displaying the page name and details such as
the number of regions, items, or buttons. The checksum displays in the center
of the window.

c. Copy the checksum.

5.15.10 Accessing Font APEX

View the Font APEX page to search for Font APEX icons and view HTML markup.

Font APEX Icons
Font APEX is the icon library for Oracle APEX and the Universal Theme.

Browsing Icons
You can search and filter icons on the Font APEX page.

5.15.10.1 Font APEX Icons

Font APEX is the icon library for Oracle APEX and the Universal Theme.

ORACLE

Small icons are based on a 16x16 grid and are ideally suited for buttons and menus.
Large icons are based on a 32x32 grid and are well suited for places where you need
to provide a larger graphic, such as cards, media lists, or hero regions.

Many APEX components automatically use the large or small icons based on the
context (such as Template Options). For example, when using Cards, the Block and
Featured template option automatically shows the larger versions of the icons. In
contrast, the Basic and Compact template options use icons from the smaller set. Font
APEX contains over 1150 icons. You can choose from 25 modifiers that you can place
on top of any existing icons so you can customize any icon to fit your needs.
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5.15.10.2 Browsing Icons

ORACLE

You can search and filter icons on the Font APEX page.

Once you find the appropriate icon, you can customize the icon by configuring attributes. As
you make selections, the icon image changes and HTML and Icon attributes are updated.
You can then copy the updated HTML Markup and icon property for use in your applications.

To view Font APEX icons:

1.
2.
3.

Navigate to the Workspace home page.

Click the App Builder icon.

Select an application.

The Application home page appears.

Click Utilities.

Click Font APEX Icons.

The Font APEX page appear.

Use the Search region on the right side of the page to narrow the display.
e Choose Small or Large

e Inthe Search field, enter keywords and click Go.
e Select a Category.

Under Icons, select an icon.

The following example shows fa-gear.
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fa-gear fa-lg

8. Configure the attributes:

Size
Scale
Animation
Rotate
Modifier

&

[
)

fa-gear
Size Smizll (@) Large
Scale (@) Ix &
Animation  Static
Rotate  Mormal
Modifier MNone
HTML [ copy
leon [ Copy

<span aria-hidden="trus"
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class="fa fa-gear fa-lg"s></span:

As you configure attributes, the icon image changes and the HTML and Icon
attributes are updated to reflect your selections.

9. HTML - Displays the HTML Markup. Click Copy to copy the HTML Markup.

10. Icon - Displays the icon property for buttons, regions, and other components. Click
Copy to copy the icon..

11. Click Reset Icon in the upper right corner to revert the attributes to the default
settings.

ORACLE
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5.15.11 Accessing Page Specific Utilities

Use the links in the Page Specific Utilities region to access Cross Page Utilities and Page
Groups as well as access handy utilities for regions, buttons, items, computations,
validations, process, dynamic actions, and branches.

To access Page Specific Utilities page:

1.
2.

Navigate to the Workspace home page.
Click the App Builder icon.

The App Builder home page appears
Select an application.

The Application home page appears.
Click Utilities.

Under Page Specific Utilities, select one of the following:
e Cross Page Utilities

 Page Groups

e Region Utilities

*  Button Utilities

* Item Utilities

e Computations Utilities

* Validation Utilities

*  Process Utilities

e Dynamic Action Utilities

e Branch Utilities

# See Also:

Accessing Cross Page Utilities

5.15.12 Accessing Cross Page Utilities

Use Cross Page Utilities to perform edits across pages in the application.

ORACLE

To access the Cross Page Utilities page:

1
2
3.
4

On the Workspace home page, click the App Builder icon.
Select an application.
Click Utilities.

From Page Specific Utilities, click Cross Page Utilities.

Chapter 5
Using Application Utilities

The Cross Page Ultilities page provides access to the following tools and reports:
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» Grid Edit of all Pages. Use this report to edit the page name, alias, title, page
template, and security options. To link to a specific page, click the Edit icon
adjacent to the page number. To save your changes, click Apply Changes.

» Delete Multiple Pages. Delete multiple pages at once.

* Page Attributes. View a report of details for all pages in the current
application including the page name, page title, defined groups, type and
number of components and controls, and application logic. To customize the
report, use the search bar at the top of the page. To link to a specific page,
click the page number.

» Page Locks. Use Page Locks to prevent conflicts during application
development. By locking a page, you prevent other developers from editing it.

¢ See Also:

— Locking and Unlocking a Page
— Deleting Multiple Pages
— Using Application Utilities

5.15.13 Using Interactive Report Utilities

View and delete saved interactive reports and interactive report subscriptions.

Deleting Saved Interactive Reports
View and delete saved interactive reports in the current application.

Viewing Subscriptions
View and delete interactive report subscriptions.

5.15.13.1 Deleting Saved Interactive Reports

ORACLE

View and delete saved interactive reports in the current application.

To delete saved interactive reports:

1.
2.

On the Workspace home page, click the App Builder icon.
Select an application.

The Application home page appears.

Click Utilities.

Under Interactive Report Utilities, select Saved Reports.

The report displays all of the saved report for the application which are not primary
defaults. Each row includes the page number, region name, report type, report
name, report alias, and owner.

To view private saved reports, deselect the checkbox for the Primary Default filter
located below the search bar.

To delete a report, select the checkbox adjacent to the page number and click
Delete Checked.

To view the page containing the report, click the page number.
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# See Also:

e Linking to Shared Interactive Reports
e Saving Interactive Reports

* Managing Saved Interactive Reports in Oracle APEX Administration Guide

5.15.13.2 Viewing Subscriptions

View and delete interactive report subscriptions.

End users can receive updated versions of a report by subscribing to it. Workspace
administrators can view and manage these subscriptions on the Subscriptions page.

To manage interactive report subscriptions:

1. On the Workspace home page, click the App Builder icon.
2. Select an application.
The Application home page appears.
3. Click Utilities.
4. Under Interactive Report Utilities, select Subscriptions.
The Subscriptions report appears.

5. To delete a subscriptions, select the checkbox adjacent to the page number and click
Delete Checked.

5.16 Using Workspace Utilities

Use the Workspace Utilities page to acccess REST Enabled SQL Services, Remote Servers,
Application Groups, Web Credentials, Workspace Themes, Export, Oracle APEX Views,
Manage Backups, and REST Source Catalogs.

e Accessing Workspace Utilities
Access Workspace Utilities by clicking the Workspace Utilities icon in the center of the
{Conref}App Builder home page.

*  Workspace Utilities Page
The Workspace Utilities page contains links to common workspace utilities including
REST Enabled SQL Services, Remote Servers, Application Groups, Web Credentials,
Workspace Themes, Export, Oracle APEX Views, Manage Backups, and REST Source
Catalogs.

* Viewing Cross Application Reports
Use the links under Cross Application Reports page to view and edit information across
multiple applications in the current workspace.

5.16.1 Accessing Workspace Utilities

Access Workspace Utilities by clicking the Workspace Utilities icon in the center of the
{Conref}App Builder home page.
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To access Workspace Utilities:

1. Sign into Oracle APEX.
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2. On the Workspace home page, click the App Builder icon.

The App Builder home page appears.

3. On the App Builder home pack, click the Workspace Utilities icon.

The Workspace Utilities page appears.

5.16.2 Workspace Utilities Page

The Workspace Utilities page contains links to common workspace utilities including
REST Enabled SQL Services, Remote Servers, Application Groups, Web Credentials,
Workspace Themes, Export, Oracle APEX Views, Manage Backups, and REST
Source Catalogs.

The following table describes the links on the Workspace Utilities page.

Link

Description

To Learn More

REST Enabled
SQL Services

Manage references to external REST
Enabled SQL services.

See: Managing REST Enabled SQL
References

Remote Manage Remote Server objects used See: Managing Remote Servers
Servers in REST Data Sources and

Authentications.
Application Organize applications by assigning See: Managing Application Groups
Groups them to application groups. To use

application groups, first create a

group and then assign applications to

it.
Web Manage secure credentials to connect See: Managing Web Credentials
Credentials to REST Enabled SQL or other REST

services.
Workspace Manage workspace themes that can  See: Managing Workspace Themes
Themes be utilized by any application within

the workspace.
Export Export workspace components. See: Exporting Workspaces,

Applications, and App Components

Oracle APEX  Query the various views against See: Accessing APEX Views
Views APEX meta data.
Manage View and manage application See: Managing Application Backups
Backups backups in the current workspace.

Backups provide a simple way to
recover applications that may have
been unexpectedly modified or
deleted.

REST Source

Manage catalogs of REST Sources

See: Managing REST Source

Catalogs for integration into applications. Catalogs

Cross Cross Application Reports display on  See: Viewing Cross Application
Application the right side of the Workspace Reports

Reports Utilities page. Access these reports to

view and edit information across
multiple applications in the current
workspace.
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Use the links under Cross Application Reports page to view and edit information across

multiple applications in the current workspace.

To access cross application reports:
1.

Sign in to Oracle APEX.

The Workspace home page appears.

Click the App Builder icon.

The App Builder home page appears.

Click the Workspace Utilities icon.

Locate the Cross Application Reports region on the right side of the window. Available
reports include:

All Reports

Application Attributes
Build Options
Developer Comments
Comments Calendar
Application Comparison
Component Comparison
Security Profiles
Authentication Schemes
Password Items

Theme Summary

To view all reports:

a.

Click All Reports.

b. On the Cross Application Reports page, select a report to review.
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Managing Pages in an Application

A page is the basic building block of an application. Developers add pages to an application
by running the Create Page Wizard.

Adding a New Page to an Application
Add a new page by running the Create Page Wizard from the Application home page.

Understanding Page Types in the Create Page Wizard
Run the Create Page Wizard to add a new page to existing application. How the wizard
works depends upon the type of page you are creating.

Managing Feature Pages
Learn about adding and removing Feature pages.

Creating Dialog Pages

Oracle APEX includes support for modal and non-modal dialog pages. Modal and non-
modal dialog pages are only supported if the current application theme contains at least
one page template of template type Dialog Page.

About Copying Application Pages
Copy a page from the current application or from another application.

About Deleting Application Pages
Deleting a page deletes the corresponding tabs, breadcrumbs, and list entries. You can
only delete unlocked pages or pages that you have locked.

Managing Page Groups
Organize pages into page groups to make them to access easier. To use page groups,
you create a group and then assign pages to the group.

Locking and Unlocking a Page
Prevent conflicts during application development by locking pages in your application. By
locking a page, you prevent other developers from editing it.

" See Also:

Editing Pages in Page Designer and Using Application Utilities

6.1 Adding a New Page to an Application

Add a new page by running the Create Page Wizard from the Application home page.

ORACLE

To create a new page:

1.
2.

On the Workspace home page, click App Builder.
Select an application.
The Application home page appears.

Click the Create Page button.
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The Create Page Wizard appears.

Create a Page

Component Feature Legacy Pages
— [ ] ® ] c
o . . | || |
[l II 1 H
Blank Page Calendar Cards Chart Dashboard
*t: _—
-
Faceted Search Smart Filters Form Interactive Grid Interactive Report
my — -
w 0 .
® .
9 -
m -
Map Master Detail Classic Report Plug-in Page Tree

L]
LE X
aea

Data Loading Wizard Unified Task List

Cancel Help m

4. Select a page type:

* Component - Component pages provide page-level functionality. Examples
of Component pages include Blank Page, Calendar, Cards, Chart, Dashboard,
Faceted Search, Smart Filters, Form, Interactive Grid, Interactive Report, Map,
Search Page, Master Detail, Classic Report, Plug-In Page, Tree, Data
Loading, Wizard, and Unified Task List.Report, Form, Plug-in Page, Tree, Data
Loading, Wizard, and Unified Task List.

For more details about Component pages, see Component Page Types.

* Feature - Feature pages provide application-level functionality. Examples of
Feature pages include About Page, Access Control, Activity Reporting,
Configuration Options, Email Reporting, Feedback, Login Page, and Theme
Style Selection.

For more details about Feature pages, see Feature Page Types.

* Legacy - Legacy pages are pages that Oracle still supports but does not
recommend using.

For more details about Legacy pages, see Legacy Page Types and Managing
Application Legacy Components.

What appears next depends upon the page type you select.
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5. Click Next and follow the on-screen instructions. To learn more about an attribute, see
field-level Help.

Tip:

To learn more, see the Create Page Wizard discussion for each component.

6.2 Understanding Page Types in the Create Page Wizard

Run the Create Page Wizard to add a new page to existing application. How the wizard
works depends upon the type of page you are creating.

Tip:

Universal Theme - 42 is optimized to work equally well in either a mobile or desktop
environment. In previous releases and in earlier themes, the Mobile user interface
was based on jQuery Mobile. Because jQuery Mobile is desupported, you must
migrate existing mobile applications to the Universal Theme.

*  Component Page Types

Learn about available Component page types when running the Create Page Wizard and
using the Universal Theme.

* Feature Page Types
Learn about available Feature page types when running the Create Page Wizard and
using the Universal Theme.

* Legacy Page Types
Learn about Legacy page types available when running the Create Page Wizard. Oracle
still supports legacy pages, but does not recommend using them.

6.2.1 Component Page Types

Learn about available Component page types when running the Create Page Wizard and
using the Universal Theme.

Table 6-1 Create Page Wizard Component Page Types

|
Page Type Description To Learn More

Blank Page Creates a page with no built-in functionality. Once  See online Help when
you create the application, you can create regions  creating this page.
on the page in Page Designer.

Calendar Generates a calendar with monthly, weekly, and See: Creating Calendars
daily views.
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Table 6-1 (Cont.) Create Page Wizard Component Page Types

Page Type

Description To Learn More

Cards

A cards page features an orderly layout of See: Managing Cards
information tiles. Developers choose between three
layouts: Grid, Float, or Horizontal (Row).

Features:

»  Customize every aspect of a cards region's Ul
(including layout, appearance, icon, badge, and
media).

»  Declaratively create links from a cards page by
adding actions. Action types include Button,
Full Card, Title, Subtitle, or Media.

e Supports advanced HTML expressions
including template directives for client-side
conditional formatting.

Chart

Creates a new page containing a chart. Supported See: Creating Charts
chart types include area, bar, box plot, bubble,

combination, status meter gauge, donut, funnel,

gantt, line, line with area, pie, polar, pyramid, radar,

scatter, and stock charts.

Dashboard

Creates a dashboard page. Choose from four See: Creating a Dashboard
different chart layouts which you can easily Page Using the Create
customize in Page Designer. Available chart layouts Application Wizard

include Primary and 2 secondary charts, Grid of

4 charts, Primary and 3 secondary charts, and

Grid of 6 charts.

Faceted Search

A faceted search page displays and filters data See: Managing Faceted
using an intuitive experience users recognize from  Search

ecommerce sites (a left Search region and report

region). Displays search results as cards or a

classic report.

Features:
»  Select options from facets in the left Search
region to narrow down search results.

«  Set filters using facets that show possible
values together with the occurrence count
within the result set.

e Built-in search capability.

e Optionally include a chart for any facet.

»  Toggle between a bar chart (which is the
default) and pie chart type.

«  Create facet groups for data models having
multiple flag columns.

ORACLE
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Table 6-1 (Cont.) Create Page Wizard Component Page Types

Page Type

Description To Learn More

Smart Filters

A smart filters page features single search field at See: Managing Smart Filters
the top of the page and a search results report

(classic report, cards, map, or calendar). While a

Smart Filter behaves similarly to faceted search, it

features a more space efficient layout.

Features:

* Includes a search field at the top of the page
with filters that display as suggestion chip.

e The Search Results can display as a classic
report, cards, map, or calendar.

e Clicking a filter name displays a list of values.

e Clicking to right of a suggestion chip changes it
to an applied filter chip and moves to the
Applied Filters Area. Clicking the applied filter
chip again displays a list.

e Built-in search capability.

Form Forms enable users to update a single row or See: Creating a Form
multiple rows in a table.
When a local table which has foreign keys is
selected as the data source, then for those
columns, the item type is set as Select List.
ORACLE
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Table 6-1 (Cont.) Create Page Wizard Component Page Types

Page Type

Description To Learn More

Interactive Grid

An interactive grid presents data in a searchable, See: Managing Interactive

customizable report. Includes similar customization Grids
capabilities available in interactive reports plus the

ability to rearrange the report interactively using the

mouse or keyboard.

Features:

e Extensive customization capabilities using
menus or inline editing.

e Turn editing on or off using the region Attribute,
Edit, Enabled.

e Built-in search capability.

. For both editable and non-editable reports,
users can change the report layout and create
private reports:

—  Column Heading menu - Change the
report layout with Control Break,
Aggregations, Freeze, Hide, and Filter.

— Actions menu:

*  Columns - Configure the columns to

show or hide.

*  Filters - Create filters to alter the
display.

*  Data - Sort, Aggregate, Refresh,
Flashback.

*  Format - Control Break, Highlight,
Stretch Column Widths.

*  Selection - Cell Selection, Copy to
Clipboard, Refresh Rows.

*  Chart - Create chart.

*  Report - Create, edit, and manage
saved Private or Alternative reports.

*  Download - Download or email the
report as a CSV, HTML, PDF, or Excel
file

» |If editable, users can edit the data directly:

— Row Actions menu - Single Row View, Add
Row, Duplicate Row, Delete Row, Refresh
Row, Revert Changes.

— Add Rows - Add new rows by clicking the
Add Row button.

—  Edit Rows - Edit a row by selecting or
double-clicking a cell with the mouse,
editing the content, and clicking the Save
button.

ORACLE
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Table 6-1 (Cont.) Create Page Wizard Component Page Types

Page Type

Interactive Report

Description To Learn More

An interactive report page features a searchable, See: Managing Interactive
easily customizable report. Reports

Features:

* Report can display as a standard application
page or as a modal dialog.

e Enable the Include Form option to create a
report and update form combination.

e Built-in search capability.

«  Change the report layout and create private
reports using menus:

—  Column Heading menu: Change the report
layout with Sort Ascending, Sort
Descending, Hide Column, Control Break,
and Filter.

— Actions menu:

*  Columns - Configure the columns to

show or hide.

*  Filters - Create filters to alter the
display.

*  Data - Sort, Aggregate, Compute,
Flashback.

*  Format - Control Break, Highlight,
Rows Per Page.

*  Chart - Create a chart.

*  Group By - Group sets of results by
one or more columns with Group By.

*  Pivot - Pivot reports transpose rows
into columns to generate results in a
cross tab format.

*  Report - Create, edit, and manage
saved Named reports.

*  Download - Download or email the
report as a CSV, HTML, Excel, or
PDF.

*  Subscription - Subscribe to report
updates in CSV, HTML, Excel, or PDF

format.

Map The map component consists of a background map See: Creating Maps
and spatial geometry objects (or layers) sourced
from data in a local table. Supported spatial
geometry objects (or layers) include: Points, Lines,
Polygons, Heat Map, or Extruded Polygons. Spatial
geometry objects can be either:

*  Geometry Column - Supported datatypes
include SDO_GEOMETRY, VARCHARZ, or CLOB.
VARCHAR2 and CLOB columns must contain
geometry information in GeoJSON format.

*  Two Numeric Columns - These columns must
contain longitude and latitude values. This
option only applies to Point and Heat Map
layers.

ORACLE
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Table 6-1 (Cont.) Create Page Wizard Component Page Types

Page Type

Description To Learn More

Search Page

Create a decalarative search for an application by ~ See Adding Search to an
creating a search configuration that contain Application

information about a searchable data source and

then creating a search page that displays the

results.

Master Detail

A master detail reflects a one-to-many relationship  See: Creating Master Detail
between two tables in a database. Master detail Forms

forms enable users to insert, update, and delete

values from two tables or views. Master Detail

options include:

e Stacked - Creates a single page master detalil
with editable interactive grids. Users select a
row in the master grid to update the detail
grids.

* Side by Side - Create a single page master
detail utilizing side by side layout and report
regions with modal edit windows. The left side
contains a master list to navigate to the master
record. The right side contains the selected
master record and the associated detail report.

e Drill Down - Creates a two page (or Drill
Down) master detail. The first page contains an
interactive report for the master table. The
second page features a standard form for the
master and interactive grids for the detail.

Classic Report

A classic report features a simple report page See: Managing Classic
based on the formatted result of a SQL query. Reports
Features:

*  Report can display as a standard application
page or as a modal dialog.

e Enable the Include Form option to create a
report and update form combination.

«  Enable column sorting in Page Designer by
selecting a column and configuring Column,
Sorting attributes.

e The most versatile report as it is template-
driven. Choose from the predefined report
templates, including Media List, Comments,
Timeline, Badge List, Value Attributes Pairs,
and so on. Or, create your own template to
customize and visualize data.

. Download the report as a CSV, HTML, Excel,
or PDF.

e Supports Report Layouts to format PDF
exports.

Plug-in Page

Creates a new page based on a region type plug-in. See: Importing a Plug-in from
Plug-ins enable developers to declaratively extend, the Plug-in Page

share, and reuse the built-in types available with

Oracle APEX.

ORACLE
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Table 6-1 (Cont.) Create Page Wizard Component Page Types

Page Type Description

To Learn More

Tree Creates a tree to graphically communicate
hierarchical or multiple level data and optionally
navigating to a page or URL specific to each tree

node.

See: Managing Trees

Data Loading If a Data Load Definition exists, you can create a
Data Loading page. The Create Page Wizard
creates a single page with the Native Data Loading
page process to provide the ability to upload data
from a file or by copy and paste, and then upload
the data. This Data Loading page enables end

users to manage the loading of data.

See: Creating a Data Loading
Page Using the Create Page
Wizard

Wizard Create a collection of pages to be used as a wizard.
Generally wizards are used for entering data across

multiple steps.

See online Help when
creating this page.

Unified Task List Create a page that allows users to view, action, or

edit their approval tasks.

See: Managing Unified Task
Lists

6.2.2 Feature Page Types

Learn about available Feature page types when running the Create Page Wizard and using

the Universal Theme.

Table 6-2 Create Page Wizard Feature Page Types

Page Type Description

To Learn More

About Page Include an About this Application page which
features a description field that describes the
application, includes the application version, and a

count of the number of pages.

See online Help when
creating feature.

Access Control Creates pages to manage an access control list.
Use the Application Access Control shared
component to associate application roles with
application users. This wizard also adds

areader, contributor and administrator role and
corresponding authorization scheme to your
application. Apply these authorization schemes to
pages and page components to manage access by
user and role.

See Controlling Access to
Applications, Pages, and
Page Components

Activity Reporting Includes numerous reports on end user activity for
your application. Determine the most active users,
the most used pages, the performance of pages,
and errors raised, to better understand how your
application is being utilized and areas for

improvement.

Not applicable.

ORACLE
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Table 6-2 (Cont.) Create Page Wizard Feature Page Types

___________________________________________________________________________________________|]
Page Type Description To Learn More

Configuration Options Enables application administrators to enable or Not applicable.
disable specific functionality within the application.
This feature is useful if you select features that need
additional development effort before they can be
used by end users.

You can expand this feature to application-specific
features. If developers define additional build
options and associate them with specific
functionality throughout the application, then they
can be added to the configuration settings for
administrators.

Email Reporting Include numerous reports on emails queued from Not applicable.
this application, emails sent, and errors sending
emails.
Feedback Provides a mechanism for end users to post See Managing Feedback.

general comments for application administrators
and developers. The posts include useful session
state information to help developers determine
where the end user sent the feedback from.

Creating Feedback:

e Creates Navigation bar icon which users can
click to leave feedback.

«  Creates an report for viewing and updating
feedback.

e Captures the application and page ID, feedback
comments, date and time, and user
information.

Login Page Creates a Login Page which enables the user to Not applicable.
enter login credentials for accessing your
application. Developers can select a template and
labels for the Username and Password fields as
well as determine if the Username value is stored a
system-generated cookies.

Theme Style Selection Enables administrators to select a default color Not applicable.
scheme (theme style) for the application.
Administrators can also choose to allow end users
to choose their own theme style. End users can
simply click on the Customize button at the bottom
of the home page, and select from the available
theme styles. For example, users with visual
impairment may prefer to utilize the Vista theme
style which has a much higher color contrast.

¢ See Also:

Managing Feature Pages
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6.2.3 Legacy Page Types

Learn about Legacy page types available when running the Create Page Wizard. Oracle still
supports legacy pages, but does not recommend using them.

Legacy page available when running the Create Page Wizard include:

Form on Local Procedure
Summary Page

Legacy Data Loading

¢ See Also:

Managing Application Legacy Components

6.3 Managing Feature Pages

Learn about adding and removing Feature pages.

About Feature Pages

Feature pages provide application-level functionality. Examples of Feature pages include
About Page, Access Control, Activity Reporting, Configuration Options, Email Reporting,
Feedback, Login Page, and Theme Style Selection.

Adding Features to an Existing App
Add a Features page to an existing application by selecting Add Feature Page from the
Tasks list on the Application home page.

About Removing Features Created with the Create Page Wizard
Remove features created with a wizard using build options.

6.3.1 About Feature Pages

Feature pages provide application-level functionality. Examples of Feature pages include
About Page, Access Control, Activity Reporting, Configuration Options, Email Reporting,
Feedback, Login Page, and Theme Style Selection.

ORACLE

Tip:

See Feature Page Types for details about available Feature pages.

Add Feature pages in the following ways:

Create a new application. Run the Create Application Wizard and select options under
Features. See Running the Create Application Wizard and Available Features in the
Create Application Wizard.

Create a new page. Run the Create Page Wizard. On the Features tab, select a feature.
See Adding a New Page to an Application and Feature Page Types.
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* Add to an existing application. Add a Features page to an existing application.
Navigate to the application. On the Application home page, select Add Feature
Page from the Tasks list. On the Features tab, select a feature. See Feature Page
Types.

6.3.2 Adding Features to an Existing App

Add a Features page to an existing application by selecting Add Feature Page from
the Tasks list on the Application home page.

To add a Features page to an existing application:
1. On the Workspace home page, click App Builder.
2. Select an application.
The Application home page appears.
3. From the Tasks list, select Add Feature Page button.
The Create Page Wizard, Feature tab appears.
4. Select a feature.
For more details about Feature pages, see Feature Page Types.
What appears next depends upon the Feature type you select.

5. Click Next and follow the on-screen instructions. To learn more about an attribute,
see field-level Help.

6.3.3 About Removing Features Created with the Create Page Wizard

Remove features created with a wizard using build options.

When you add a feature using a wizard, the wizard creates one or more pages and
other components and processes to seamlessly integrate it into your application. Each
feature is associated with a build option which contains one or more components. You
can use the associated build option to enable, disable, or permanently remove
features.

Using Build Options to Include or Exclude Features

Build options have two possible values: Include and Exclude. If you select the build
option status of Include, then the Oracle APEX engine considers the associated
components (in this case features) as part of the application definition at runtime.
Conversely, if you specify the build options status as Exclude, then the APEX engine
treats it and any associated components as if it did not exist.

Removing Features Permanently

You remove features created with a wizard by first removing the components
associated with the build option and then deleting the build option.
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¢ See Also:

e Including or Excluding Build Options

e Deleting Build Options and Associated Components

6.4 Creating Dialog Pages

Oracle APEX includes support for modal and non-modal dialog pages. Modal and non-modal
dialog pages are only supported if the current application theme contains at least one page
template of template type Dialog Page.

*  About Supported Dialogs
When you create a new page, the wizard prompts you to select a Page Mode. The Page
Mode determines if the page is a normal application page or a dialog page.

* Creating a Dialog Page Template
Create a dialog template if your theme does not include one and how to edit dialog
template attributes to change the display.

» Editing a Dialog Page in Page Designer
Change how a dialog page displays by editing attributes in Page Designer.
* Generating a Cancel Dialog Dynamic Action on the Dialog Page

For dialog pages that contain a Cancel button, create a dynamic action that controls what
happens when the button is clicked.

* Generating a Close Dialog Page Process on the Dialog Page
Close a dialog page by creating a Close Dialog page process.

*  About Branching with Dialog Pages
Open dialog pages using buttons or links.

* Handling Refresh Actions on Parent Page
Learn about handling refresh actions on parent pages.

6.4.1 About Supported Dialogs

ORACLE

When you create a new page, the wizard prompts you to select a Page Mode. The Page
Mode determines if the page is a normal application page or a dialog page.

Oracle APEX supports two types of dialog pages:

* Modal Dialog - A modal dialog is an overlay window positioned within the same browser
window. A modal dialog remains active and focused until the user has finished with it and
closes it. While a modal dialog is active, the user is unable to interact with the rest of the
page until the dialog is closed.

* Non-modal Dialog - A non-modal dialog displays a separate popup browser window. A
user can interact with a non-modal dialog and content on the page. Use a non-modal
dialog when the requested information is not essential to continue. This type of window
can be left open while work continues elsewhere.

Oracle APEX includes dialog page templates in the Universal Theme - 42. When you set the
Page Mode to either Modal or Non-Modal, APEX automatically uses the default dialog page
template.
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You can further define the appearance and layout of a dialog by specifying the Dialog
Template.

6.4.2 Creating a Dialog Page Template

ORACLE

Create a dialog template if your theme does not include one and how to edit dialog
template attributes to change the display.

The dialog page template contains JavaScript function calls that handle the
initialization, closure, and cancellation of a dialog page. When you create a dialog
page template, you must define these and other Dialog Page Templates attributes.

¢ See Also:

Required Dialog Page Template Attributes

If you are using an existing application and the theme does not contain a dialog page
template, then you must create one. While you can create one from scratch, the
easiest option is to copy an existing dialog template.

To create a dialog page template:

1. Navigate to the Shared Components, Templates page:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Click Shared Components.
d. Under User Interface, select Templates.
2. Click Create.
3. Inthe Create Template Wizard:.
a. Template Type - Select Page and click Next.
b. Creation Method - Select As a Copy of an Existing Template and click Next.
c. Copy From - Select the application to copy from and click Next.

d. Identify Theme - Select the theme you are copying from and the theme you
are copying to and click Next.

e. New Templates - Locate the Modal Dialog templates to copy (for example,
Drawer, Modal Dialog, or Wizard Modal Dialog) and select Yes.

f. Select Copy Page Templates.

4. Verify the dialog page template is active in the current theme

# See Also:

Selecting a Default Page Template
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6.4.3 Editing a Dialog Page in Page Designer

ORACLE

Change how a dialog page displays by editing attributes in Page Designer.

To edit a dialog page in Page Designer:
1. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears. Attributes are organized in groups.
2. In Page Designer locate the Appearance group.
3. Appearance, Page Mode - Select one of the following:

» Modal Dialog - The page is presented as a modal dialog. A modal dialog is an
overlay window positioned within the viewport, which remains active and focused
until the end user dismisses (or closes) it. The underlying page is grayed out and the
end user is prevented from interacting with the rest of the page until the dialog is
closed.

* Non-Modal Dialog - The page is presented as a non-modal dialog. A non-modal
dialog is an overlay window positioned within the viewport, where the end user can
interact with the dialog, and content on the page that launched the dialog. A non-
modal dialog can be used when the requested information is not essential to
continue; work can continue elsewhere while the window is still open.

Note that options Modal and Non-Modal Dialog will only be available for selection when
the current application theme contains a default Dialog Page Template.

4. Appearance, Dialog Template - Select a dialog template to define the appearance and
layout of this page. Making a selection here overrides the default dialog template.

Options include:

*  Theme Default

*  Drawer

* Modal Dialog

*  Wizard Modal Dialog

Dialog templates are defined in the application theme. When a dialog page is created, the
template is automatically set to Theme Default which renders the page using the default
page template defined in the current theme.

5. Edit the remaining attributes in Appearance group as needed.
To learn more about an attribute, see field-level Help.
6. Under Dialog, edit the appropriate attributes:
a. Width - Enter the width of the dialog, in pixels or a percentage.

The substitution string #DIALOG _WIDTH# in the dialog initialization code of the page
template is replaced with the value entered in this item. For a page using a Desktop
user interface, the value is set in pixels, such as 500.

b. Height - Enter the height of the dialog, in pixels, for example, 500.
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The substitution string #DIALOG HEIGHT# in the dialog initialization code of the
page template is replaced with the value entered.

c. Maximum Width - Enter the maximum width of the dialog in pixels.

The substitution string #DIALOG MAX WIDTH# in the dialog initialization code of
the page template is replaced with the value entered in this item.

d. Attributes - Dialog support varies depending on the user interface of the page.
A subset of dialog attributes are declaratively supported: height, width, and
maximum width.

To define any additional attributes for the dialog, enter the name/value pairings
in a comma separated list. The substitution string #DIALOG ATTRIBUTES# in the
dialog initialization code defined at page template level, is replaced by any
value(s) entered in this item.

e. CSS Classes - Enter classes to add to this component. You may add multiple
classes by separating them with spaces.

f. Chained - Select On if this dialog is opened by another dialog, and should
reuse the same dialog window.

For example, if this dialog is part of a multiple page dialog wizard, and you
wish to reuse the dialog window for each step of the wizard. Select Off if this
dialog is opened by another dialog and should be opened in a new dialog
window. For example, when this dialog is modal, and you wish to open it within
a parent modal dialog window.

7. To save your changes, click Save.

6.4.4 Generating a Cancel Dialog Dynamic Action on the Dialog Page

For dialog pages that contain a Cancel button, create a dynamic action that controls
what happens when the button is clicked.

The dynamic action must have True Action event which is set to Cancel Dialog. This
dynamic action will use the cancellation JavaScript call contained in the page template
(apex.navigation.dialog.cancel) to handle the canceling the dialog.

¢ See Also:

Managing Dynamic Actions

6.4.5 Generating a Close Dialog Page Process on the Dialog Page

ORACLE

Close a dialog page by creating a Close Dialog page process.

In previous releases, this Close Dialog page processes were referred to as a Close
Popup Window. This dialog will use the closure JavaScript call contained in the page
template (apex.navigation.dialog.close), to handle the closing of the dialog. The
page process also supports the return of dialog page items, which you may wish to
reference on the parent page.
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Tip:

You can also close a dialog page with the Close Dialog dynamic action. Both the
dynamic action and the process support returning dialog page items. Use the page
process when the page needs to be submitted and use the dynamic action when
the page does not need to be submitted. Both end up calling the closure JavaScript
call. Alternatively, you can create a page branch, which will close a dialog page and
redirect to the page specified in the branch.

" See Also:

e Understanding Page Processes

e Controlling Navigation Using Branches

6.4.6 About Branching with Dialog Pages

Open dialog pages using buttons or links.

Dialog pages support the following branching options:

Dialog page to dialog page.

You can branch from one dialog page to another dialog page if:

Both pages have the same Page Mode. For example, a Modal Dialog page and a
page where the dialog Chained attribute is set to On. Setting the Chained attribute to
On enables support for chained or nested dialogs such as the dialogs that appear in
many internal APEX wizards. Chained or nested dialogs enable you to re-use a
dialog window to display each page.

Dialog page to Normal page.

When branching from a dialog page to a normal page, the dialog page is closed and
the user navigates to a new page in the browser. The new page can be a parent (or
launching) page or another Normal page in an application.

6.4.7 Handling Refresh Actions on Parent Page

Learn about handling refresh actions on parent pages.

If you have generated a Close Dialog page process on the dialog page, you must implement
refresh actions on the parent page using the new Dialog Closed dynamic action event type.
You can use the set type Dialog Return Item when creating a Set Value True Action, to set a
single value, based on the return item of a dialog.

ORACLE
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Q Tip:

For a partial page refresh of a parent page, implement the close dialog with
dynamic action (for example, for report and form pages where you want to
edit data in a modal dialog form and only want the report refreshed on close).
In contrast, branching is the best approach if you have a multi-step modal
wizard or if you have several possible target pages when closing the dialog.

¢ See Also:

Managing Dynamic Actions

6.5 About Copying Application Pages

Copy a page from the current application or from another application.

During the copy process, you can also copy shared components or change mappings
to shared components in the target application.

About Copying Pages Between User Interfaces in Older Themes

The Copy Page Wizard enables you to copy a page to a different user interface.
During the copying process, the user can select the user interface for the new page. If
the application contains a Desktop and a Mobile theme, both user interface options
display.

" See Also:

Copying an Application Page

6.6 About Deleting Application Pages

Deleting a page deletes the corresponding tabs, breadcrumbs, and list entries. You
can only delete unlocked pages or pages that you have locked.

¢ See Also:

Deleting Pages
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6.7 Managing Page Groups

Organize pages into page groups to make them to access easier. To use page groups, you
create a group and then assign pages to the group.

Tip:

Page groups do not have any function other than to aid developers in organizing
their application pages.

Viewing Page Groups
View page groups on by navigating to Utilities, Page Specific Utilities.

Creating a Page Group
Create a page group by navigating to Utilities, Page Specific Utilities.

Editing a Page Group Definition
Create a page group by defining a group name and description.

Assigning a Page to a Page Group
Assign a page to a page group in Page Designer.

Viewing Pages by Page Group
View pages by page group.

Deleting a Page Group

6.7.1 Viewing Page Groups

View page groups on by navigating to Utilities, Page Specific Utilities.

ORACLE

To view page groups:

1.

2
3.
4

On the Workspace home page, click the App Builder icon.

Select the application.

Click the Utilities icon.

From Page Specific Utilities, click Page Groups.

The Page Groups page appears.

A Search bar displays at the top of the page. Available controls include:

» Select columns to search - Resembles a magnifying glass. Click this icon to narrow
your search. To search all columns, select All Columns.

» Text area - Enter case insensitive search criteria (wildcard characters are implied) to
search for a page group by name and click Go.

« Go button - Executes a search or applies a filter.

* View Icons - Displays each group as a large icon. To edit a group, click the
appropriate icon.

* View Report - Displays each group as a line in a report. To edit a group, click the
name.

e Actions menu - Use the Actions menu to customize the report view.
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To view the pages associated with a group, click Pages by Page Group.

6.7.2 Creating a Page Group

Create a page group by navigating to Utilities, Page Specific Utilities.

To create a page group:

1
2
3
4,
5
6

On the Workspace home page, click the App Builder icon.
Select the application.

Click the Utilities icon.

From Page Specific Utilities, click Page Groups.

On the Page Groups page, click Create.

Enter a name, a description (optional), and click Create.

6.7.3 Editing a Page Group Definition

Create a page group by defining a group name and description.

To edit the Page Group definition:

1.
2.
3
4.
5
6
7

On the Workspace home page, click the App Builder icon.

Select the application.

Click the Utilities icon.

From Page Specific Utilities, click Page Groups.

Select a page group.

On the Page Group page, edit the name or description and click Apply Changes.

To move to the next Page Group definition, click the Previous (<) and Next (>)
buttons and repeat the previous step.

6.7.4 Assigning a Page to a Page Group

Assign a page to a page group in Page Designer.

ORACLE

To assign pages to a page group:

1.

2
3
4.
5

On the Workspace home page, click the App Builder icon.
Select the application.

Click the Utilities icon.

From Page Specific Utilities, click Page Groups.

Click the Page Assignments tab.

The Page Assignments page appears.

Click the page number.

The page displays in Page Designer appears.
Identification, Name - Select a page group.

Click Apply Changes.
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6.7.5 Viewing Pages by Page Group

View pages by page group.

To access the Pages by Page Group page:

1.

2
3
4,
5

On the Workspace home page, click the App Builder icon.
Select the application.
Click the Utilities icon.
From Page Specific Utilities, click Page Groups.
Click the Pages by Page Group tab.
The Pages by Page Group page appears. Click the Page Name to view the page.
To remove a page from a group:
a. Click the page number.
The page displays in Page Designer appears.
b. Identification, Name, - Select - Select -.

c. Click Apply Changes.

6.7.6 Deleting a Page Group

To delete a page group:

1.

5.

Remove all pages from the group to be deleted:
a. On the Workspace home page, click the App Builder icon.
b. Select the application.
c. From Page Specific Utilities, click Page Groups.
d. Click the Pages by Page Group tab.
e. Click the page number.
The Page Attributes page appears.
f. Under Name, Group, select - No Group Assigned -.
g. Click Apply Changes.
When you have deleted all pages in the group, click the Page Groups tab.
Select the group to be deleted.
Click Delete.
A confirmation page appears.

Confirm your request.

6.8 Locking and Unlocking a Page

Prevent conflicts during application development by locking pages in your application. By
locking a page, you prevent other developers from editing it.

ORACLE
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» Determining If a Page Is Locked
Learn how to determine if a page is locked.

* Locking a Page
Learn how to lock a page.

* Unlocking a Page
Learn how to unlock a page.

6.8.1 Determining If a Page Is Locked

Learn how to determine if a page is locked.

A lock icon indicates whether a page is currently locked. If a page is unlocked, the icon
appears as an open padlock. If the page is locked, the icon appears as a locked
padlock. A lock icon appears on the Application home page and on the page.

To view the lock icon on the Application home page, click the View Report icon. A
report appears. The lock icon appears on the right side of the page.
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Application 363 - Demonstration - Projects Edit Application Definfrion About

Use the Application home page
to rumn, edit, import, export,
copy, or delete an application.
Select a page to edit the page
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>
O E E Learn More __

Run Application Supporting Objects  Shared Components Utilities Export / Import Tasks
Delete this Application
O~ Go s EE Actions v Create Page > Copy this Application
Add Feature Page
Page Name Alias Updated :pdated Type Group Lock Run
v Manage Backups
0 Global Page - .jg“oc-u = admin Global Pags Unassigned s} Browse by Facets
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Home home TgA:LI = admin Home Unassigned Irs) ™ Recently Edited Pages
° U
3hours . . = 4. Milestones
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6.8.2 Locking a Page

Learn how to lock a page.

Developers can lock a page on the Application home page, Page Locks page, and in
Page Designer.

e Locking a Page from the Application Home Page
e Locking a Page from the Page Locks Page

e Locking a Page in Page Designer
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6.8.2.1 Locking a Page from the Application Home Page

To lock a page from the Application Home Page:

On the Workspace home page, click the App Builder icon.
Select an application.

On the search bar, click the View Report or View Detail icon.
Click the Lock icon.

Enter a comment in the Comment field.

Click Lock Page(s).

o o p W NP

6.8.2.2 Locking a Page from the Page Locks Page

To lock a page from the Page Locks Page:

On the Workspace home page, click the App Builder icon.
Select an application.

Click the Utilities icon.

On the Page Specific Utilities list, click Cross Page Utilities.
Click Page Locks.

Select the appropriate pages and click Lock Checked.
Enter a comment in the Comment field.

Click Lock Page(s).

@ N o g k8w b PR

6.8.2.3 Locking a Page in Page Designer

ORACLE

The Page Lock button on the Page Designer toolbar indicates whether a page is locked. If
the page is unlocked, the Page Lock button displays as an unlocked padlock.

To lock a page in Page Designer:

1. Navigate to the appropriate page in Page Designer.
2. Onthe Page Designer toolbar, click the Page Unlocked button.
3. Enter a comment in the Comment field.
4. Click Lock.
When a page is locked, the Page Lock button displays as a locked padlock.

¢ See Also:

Viewing a Page in Page Designer
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6.8.3 Unlocking a Page

Learn how to unlock a page.

Only the developer who locks a page can unlock it. However, a developer with
administrative privileges can unlock pages locked by other developers.

Tip:

To view information about an existing page lock, navigate to the Lock Details
page and expand the Lock History region.

Unlocking Pages from Utilities
Unlocking Pages from the Application Home Page
Unlocking a Page in Page Designer

Unlocking Pages As a Workspace Administrator

6.8.3.1 Unlocking Pages from Utilities

To unlock a page from the Page Locks page:

1
2
3
4,
5
6
7

On the Workspace home page, click the App Builder icon.
Select an application.

Click the Utilities icon.

On the Page Specific Utilities list, click Cross Page Utilities.
Click Page Locks.

Select the appropriate pages.

Click Unlock Checked.

6.8.3.2 Unlocking Pages from the Application Home Page

To unlock a page from the Application Home Page:

1
2
3.
4

5.

On the Workspace home page, click the App Builder icon.
Select an application.

On the search bar, click the View Report icon.

Click the Lock icon.

The Lock Details page appears.

Click Unlock.

6.8.3.3 Unlocking a Page in Page Designer

The Page Lock button on the Page Designer toolbar indicates whether a page is
locked. If the page is locked, the Page Lock button displays as a locked padlock.

ORACLE

6-24



Chapter 6
Locking and Unlocking a Page

Passing your cursor over a locked Page Lock button displays a tooltip that indicates who
locked it.

To unlock a page in Page Designer:

1.

Navigate to the appropriate page in Page Designer.
If a page is locked, the Page Lock button displays as a locked padlock.
On the Page Designer toolbar, click the Page locked by you button.

If the page has been locked by another user the Lock button appears in red. You cannot
unlock a page locked by another user.

Click Unlock.

When a page is unlocked, the Page Lock button displays as an unlocked padlock.

Viewing a Page in Page Designer

6.8.3.4 Unlocking Pages As a Workspace Administrator

ORACLE

To unlock pages as a Workspace Administrator:
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On the Workspace home page, click the App Builder icon.
Select an application.

Click the Utilities icon.

On the Page Specific Utilities list, click Cross Page Utilities.
Click Page Locks.

Click Lock Administration.

Select the appropriate pages.

Click Unlock Page(s).
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Editing Pages in Page Designer

Developers view and edit application pages in Page Designer. Page Designer is a full
featured Integrated Development Environment (IDE) that includes a toolbar and multiple
panes.

About Page Designer

Use Page Designer to maintain and enhance pages within an Oracle APEX application.
Page Designer is a full featured Integrated Development Environment (IDE) that includes
a toolbar and multiple panes.

Understanding Page Designer Ul Elements

The Page Designer window features three panes: a left pane, a central pane, and a right
pane. You select a component in the left or central pane and then edit the component’s
attributes in the Property Editor located in the right pane.

Using Page Designer
Use Page Designer to view and edit application pages.

Managing Page Attributes

Edit page attributes to control basic information and functionality for a given page,
including the page name or title, header and footer text, navigation menus, inclusion of
page-level JavaScript or CSS files, error handling, and the selected authorization
scheme.

Running a Page from Page Designer

The Oracle APEX engine dynamically renders and processes pages based on data
stored in database tables. To view a rendered version of an application, you run or submit
it to the APEX engine.

Runtime Developer Toolbar
Use the Runtime Developer toolbar to quickly edit the current application or currently
running page, or view session state.

Copying an Application Page

You can copy a page from the current application or from another application. During the
copy process, you can also copy shared components or change mappings to shared
components in the target application.

Deleting Pages
Deleting a page deletes the corresponding tabs, breadcrumbs, and list entries.

7.1 About Page Designer

Use Page Designer to maintain and enhance pages within an Oracle APEX application. Page
Designer is a full featured Integrated Development Environment (IDE) that includes a toolbar
and multiple panes.

ORACLE
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The Page Designer window is divided into three main panes:

Identification
Tiile
Project Task - IR
Type

Interactive Report hd

Source

Location

Local Database v
Type

Table / View W
Table Owner

Parsing Schema W

Table Mame
EBA_PROJECT_TASKS

R —

* Left Pane - Includes four tabs that display as a tree: Rendering, Dynamic Actions,

Processing, and Shared Components.

* Central Pane - Includes the following tabs: Layout, Component View, Page

Search, and Help.

* Right Pane - Displays the Property Editor. Use the Property Editor to update
attributes for the selected component. When you select multiple components, the
Property Editor only displays common attributes. Updating a common attribute
updates that attribute for all of the selected components.

You can adjust the size of each pane by selecting and dragging the horizontal and
vertical splitters. To expand or collapse each pane, click the small triangle labeled

Collapse in the center of each splitter.

Q Tip:

ORACLE

You can view an online summary that describes the Page Designer window.
View a page in Page Designer, click the Help menu at the top of the page,
and select Getting Started with Page Designer.
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¢ See Also:

e Understanding Page Designer Ul Elements
*  Viewing Help in Page Designer

e Editing Pages in Page Designer

7.2 Understanding Page Designer Ul Elements

The Page Designer window features three panes: a left pane, a central pane, and a right
pane. You select a component in the left or central pane and then edit the component’s
attributes in the Property Editor located in the right pane.

The left pane includes four tabs: Rendering, Dynamic Actions, Processing, and Page Shared
Components. The central pane contains four tabs: Layout, Component View, Page Search,
and Help and a Gallery pane at the bottom. The right pane contains the Property Editor.

Tip:

You can view an online summary of this information. View a page in Page Designer,
click the Help menu at the top of the page, and select Getting Started with Page
Designer.

e Page Designer Toolbar
The Page Designer toolbar displays at the top of the page and contains both buttons and
menu options. Passing your cursor over an active button and menu displays a tooltip.

e Left Pane of Page Designer
Use the left pane in Page Designer to select or add containers and components on a

page.

e Central Pane of Page Designer
The top of the central pane in Page Designer contains the Layout, Page Search, and
Help tabs. The lower part of the central pane contains the Gallery.

* Right Pane of Page Designer (Property Editor)
Learn about the Property Editor in the right pane of Page Designer.

« Code Editor
Learn about using the Code Editor in Page Designer.

¢ See Also:

Using Page Designer
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Designer Toolbar

The Page Designer toolbar displays at the top of the page and contains both buttons
and menu options. Passing your cursor over an active button and menu displays a
tooltip.

App Builder

Gallery

Page Designer

o

il

Tip:

You can view an online summary of how to use Page Designer. To view a
page in Page Designer, click the Help menu at the top of the page, and
select Getting Started with Page Designer.

The Page Designer toolbar features the following buttons and menu options.

Page Selector

Go

e

2

The Page Selector displays the current page. Click the down arrow (labeled Page
Finder) to search for pages. Alternatively, enter a page number in the field and click
Go. To navigate to the previous or next page, click Navigate to Next Page (up arrow)
and Navigate to Previous Page (down arrow).

" See Also:

Searching for Pages

Show Messages

Lo
When you add a new component to a page, the Show Messages icon displays

current errors and warnings. Clicking a message changes the focus within Property
Editor to the corresponding attribute associated with the error or warning.
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Page Unlocked and Page Locked

(o

Indicates the lock status of a page. Page Unlocked indicates the current page is unlocked
and editable. Page Locked indicates the page is unavailable for editing. The appearance of
the padlock icon changes depending upon the lock status:

e Clear unlocked padlock — Indicates the page is unlocked.
¢ Red locked padlock — Indicates the page is locked by you.

* Red locked padlock with person — Indicates the page is locked by another user. To view
the lock owner or update the lock comment, click the red padlock.

" See Also:

Locking and Unlocking a Page

Undo and Redo

s
)

Applies to actions that result in a change to the page data. Undo reverts the previous update
you made within Page Designer. Redo reapplies the last update that was undone using
Undo.

Create

'

Features a graphical plus sign (+). Create menu options include:
» Page. Access to the Create Page Wizard. See Adding a New Page to an Application.
* Page as Copy. Access the Copy Page Wizard. See Copying an Application Page .

* Breadcrumb Region. Access to the Create Breadcrumb Wizard. See Creating
Breadcrumbs and Adding a Breadcrumb Region with a Wizard.

» Shared Component. Access to the Create Application Component Wizard. Shared
components are common elements that can display or be applied on any page within an
application. See Managing Shared Components.

« Page Group. Links to the Page Group page. Use page groups to organize pages. See
Managing Page Groups.

- Developer Comment. Access the Developer Comments dialog. Developers can add
comments to an application, a page, or a group of pages. See Adding Developer
Comments.

* Issue. Create a new issue in Team Development. See Creating an Issue.
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Utilities

%
{f/F "
Features a graphic of a wrench. Utilities menu options include:

» Delete Page. Delete the current page. See Deleting Pages.

* Advisor. Access Oracle APEX Advisor (Advisor). Use Advisor to check the
integrity and quality of your APEX application. SeeRunning Advisor to Check
Application Integrity.

* Caching. Links to the Caching page which displays a report of Cached Pages and
Cached Regions. Enabling caching is an effective way to improve the
performance. See Enabling Region Caching.

* History. Displays a report of changes to the current page.

* Checksum. View the page checksum. You can also access the page checksum
from the Application Utilities page. See Viewing the Page Checksum and Using
Application Utilities.

»  Export. Export the current page. See Exporting Workspaces, Applications, and
App Components.

*  Show. Includes the following options:
— Tooltips. Disable and enable tooltips within the UI.

— Layout View. Disable or enable the Layout tab in the central pane of Page
Designer. See Layout Tab.

* Layout. Controls the number of panes that display in Page Designer. See
Switching Between Three Pane and Two Pane Mode.

Shared Components

Fat

(&]m]

Links to the Shared Components page. Shared components can display or be applied
on any page within an application. See Managing Shared Components.

Save and Save and Run Page

Click Save to save the current page. Click Save and Run Page to save and then run
the current page. See Running a Page from Page Designer.

7.2.2 Left Pane of Page Designer

ORACLE

Use the left pane in Page Designer to select or add containers and components on a
page.

Once selected, edit the container or component attributes in the Property Editor
located in the right pane.
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About the Left Pane of Page Designer
The left pane in Page Designer includes four tabs: Rendering, Dynamic Actions,
Processing, and Page Shared Components.

Rendering Tab
Learn about the Rendering tab in the left pane of Page Designer.

Dynamic Actions Tab
Learn about the Dynamic Actions tab in the left pane of Page Designer.

Processing Tab
Learn about the Processing tab in the left pane of Page Designer.

Page Shared Components Tab
Learn about the Page Shared Components tab in the left pane of Page Designer.

7.2.2.1 About the Left Pane of Page Designer

The left pane in Page Designer includes four tabs: Rendering, Dynamic Actions, Processing,
and Page Shared Components.

Each tab displays a list of the corresponding component types and components created on
the current page.

(1) Application 487

Page Designer

2
[¥al
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m
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Pape 8: Project Tasks
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CREATE SUE REGIONS

Region Aftributes Printing

Identification
SREVIOUS Tile
 Project Task - IR

Type

Interactive Report hd i=

Source

Location

Local Database e
- Type

. Table / View v
Regions [tems Buttons = ., — !
Table Owner

Parsing Schema hd

Key features of the Left pane include:

ORACLE

Context menus. Right-click a component or control to display a context menu. You can
also click the Rendering menu to select options for the selected component.

Quick Access to the Property Editor. Select a component or multiple components to
display the corresponding attributes in the Property Editor in the right pane.

Drag and Drop. Drag components up and down within the tree to change the position or
sequence of the selected component.
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* Tooltips. Position the mouse over a component or control to view a tooltip of basic
information, such as the region type, item type, and so on.

7.2.2.2 Rendering Tab

Learn about the Rendering tab in the left pane of Page Designer.

The Rendering tab displays containers and components that are rendered on a page.
Components include regions, page items, and buttons. Application logic such as
Dynamic Actions and Validations display inside of regions, page items, and buttons
when applicable.

Components can placed at the page-level at a specific page position, or they can be
nested inside regions at a specific region position. Additionally, the Rendering tab
displays Pre-Rendering and Post-Rendering application logic such as Processes,
Computations, and Branches. The Rendering tab groups and orders components
based on how Oracle APEX processes them at runtime

To create a new component, right-click and select an option from the context menu.
Alternatively, select an option from the Rendering menu.

(: I:} Application 487 | Page Designer b 8 Go o
= o0 Rendering menu Sk Page Search Help
Page 8: Project Tasks =P £ =,
S Project Tasks
Con PAGE HEADER

Page lterm PAGE NAVIGATION

Create Button BREADCRUME BAR

' BEFORE CONTENT BODY
Right of Interactive Report Search CONTENT BODY

Project Task - IR

Regions Items Buttons =

7.2.2.3 Dynamic Actions Tab

Learn about the Dynamic Actions tab in the left pane of Page Designer.

The Dynamic Actions tab displays dynamic actions defined on the current page. By
creating a dynamic action, you can define complex client-side behavior declaratively
without the need for JavaScript. To create a new dynamic action, right-click and select
an option from the context menu.
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-\D Application 487 Page Designer - a2 Go '-'“ ) b o
{} [, Ao Layout Page Search Help
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Events = < —
Page Load
Change Create Dynamic Action Ll
Click @ PAGE HEADER
Dialog Closed
- PAGE MAVIGATION
BREADCRUME BAR
4
BEFORE COMTENT BODY
CONTENT BODY

Project Task - IR

Regions ltems Buttons =

1]

¢ See Also:

Managing Dynamic Actions

7.2.2.4 Processing Tab

Learn about the Processing tab in the left pane of Page Designer.

The Processing tab displays application logic defined on the page and groups and orders
components based on how APEX processes them. To create a new process, right-click and
select an option from the context menu.
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_ Project Tasks
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e D PAGE HEADER
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Ajax Callb
PAGE MAVIGATION
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i
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COMTENT BODY
Project Task - IR
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\J
# See Also:

Managing Computations, Validations, and Processes

7.2.2.5 Page Shared Components Tab

Learn about the Page Shared Components tab in the left pane of Page Designer.

The Page Shared Components tab displays shared components associated with the
current page. To edit a Shared Component, select it in the Page Shared Components
tab and then click Edit Component in right pane.

In the following example, Navigation Bar is selected in the left pane and the cursor is
positioned on Edit Component button in the right pane.
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" See Also:

Layout Page Search Help

Project Tasks
PAGE HEADER
PAGE NAVIGATION
BREADCRUME BAR
BEFORE CONTENT BODY
CONTENT BODY
Project Task - IR

Regions ltermns Buttons

Managing Shared Components

7.2.3 Central Pane of Page Designer

The top of the central pane in Page Designer contains the Layout, Page Search, and Help

tabs. The lower part of the central pane contains the Gallery.

Layout Tab

Learn about the Layout tab in the central pane of Page Designer.

Pag

e Search Tab

Chapter 7

Understanding Page Designer Ul Elements

'/. o :L:._' save n

List

Edit Component

Identification @

Name

Mavigation Bar

Learn about the Page Search tab in the central pane of Page Designer.
Help Tab

Learn about the Help tab in the central pane of Page Designer.

Gallery

Learn about the Gallery in the central pane of Page Designer.

7.2.3.1 Layout Tab

ORACLE

Learn about the Layout tab in the central pane of Page Designer.

The Layout tab is a visual representation of how the components are positioned on the page.
The Layout tab features context menus. By selecting a component and right-clicking, you can

delete, move, or copy the component to other regions, or new regions on the page. You can

also move existing regions, items, and buttons relative to other components by simply
clicking on the component and dragging it to the new location. For example, you can place

items next to one another by dragging the second item to the end of the first item and

dropping it in the dark yellow box that appears when you hover in the desired location. You
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can quickly add new components to an existing page by dragging the component from
the Gallery up to the desired position within the Layout tab.

You can adjust the size of each pane by selecting and dragging the horizontal and
vertical splitters. To expand or collapse each pane, click the small triangle labeled
Collapse in the center of each splitter. Alternatively, you can click the Expand button
to make the Layout tab larger and then Restore to return it to the previous size.

D APEX App Builder SQL Workshop Team Development Gallery Q gﬁ- @ m

.}. Application 487 ' Page Designer M 2] Go i o~ F & Save m

= Bl In] Layout Page Search Help Region Aftributes Printing
Page 8: Project Tasks = @ = w Filter o, w

. " )
CONTENT Bar] Epend QAlt=F11) Identification
. Project Task - IR Vertical Splitter Trle
Project Task - IR

Vertical Splitter

Type

EGICHN BOD Interactive Report A i=

REGION CONTEMT b
W Source

Location

Loczl Database w

CREATE

Collapse
Soeies Type

3 - Table / Wiew "
ttems Buttons Horizontal Splitter

Table Owner

B.. Q. (£, . ::: : Parsing Schema b

) Table Mame
= = H.. X EBA_PROJECT TASKS 3=

Q Tip:

Hidden items do not display in the Layout tab, but do display in the
Rendering tree.

Key features of the Layout tab include:

* Context menus. Right-click a component or control to display a context menu.

* Quick Access to the Property Editor. Select a component or multiple
components to display the corresponding attributes in the Property Editor in the
right pane.

» Drag and Drop . Move, copy, and reorder regions, items, and buttons by dragging
and dropping. You can also add new regions, items, and button by dragging them
from the Gallery and dropping them to the desired position on the page.

* Tooltips. Position the mouse over a component or control to view a tooltip of basic
information, such as the region type, item type, and so on.
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When dragging components to a new position, such as dragging an item onto the
same line as an exiting item, you need to drag the component into the desired
position and wait until the grid changes and the new drop position displays. See
Adding a Region, Item, or Button by Dragging and Dropping.

The Layout menu displays on the right side of the pane. Use this menu to customize the type
and amount of information that displays and to delete, move, and copy selected components.
To have a specific region fill the the Layout tab, select the region and select Display from
Here from the Layout menu. The selected region fills the Layout tab. To restore the view,

select Display from Page.

.:}:. Application 487 Page Designer ] 8

B & () & Layout  Page Search

Contert Body PAGE HEADER

Project Task - IR PAGE MAVIGATION

BREADCRUME BAR

BEFORE CONTENT BODY
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g [HELE ~ Project Task - IR
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¢ See Also:

re-Rendering
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Components

Page
w Filter W
Expand Alt+FT
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+ Hide Global Page Components
Hide Buttons
Hide ltems
—_—

Adding a Region, Item, or Button by Dragging and Dropping

ORACLE
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7.2.3.2 Page Search Tab

Learn about the Page Search tab in the central pane of Page Designer.

The Page Search tab displays to the right of Layout in the central pane. Use Page
Search to search all page metadata including regions, items, buttons, dynamic actions,
columns, and so on. To search a page, enter a search terms in the field provided. To
match the case, select Match Case. To search for a regular expression, select
Regular Expression.

D APEX App Builder 5QL Workshop Team Developmen Gallery Q gp @ m
.i- Application 487 Page Designer h g Go o ~ Pl én Save m
= Bl In] Layout Page Search Help Region Aftributes Printing
Page 8: Project Tasks = 0y X Filter L
=-Rendering Regular Expression Match Case \dentification

Tiile
Project Task - IR
Type

Interactive Report 4 i=

enorts Source
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CREATE Loczl Database “

Type

 Table / Views v i

7.2.3.3 Help Tab

ORACLE

Learn about the Help tab in the central pane of Page Designer.

Page Designer includes Help for every Property Editor attribute. To view Help, select
the attribute and click the Help tab. Once you activate the Help pane, the content that
displays changes every time you select another attribute. In this example, the Source,
Type attribute is selected and the Help tab describes what the attribute is for and the
available options.
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Enter a valid SQL where condition, used to limit the records
retrieved. Identification
Examples Title Depariments
Only include those employees which have a manager or Type Interactive Report W i=
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{ MGR is not null or JOB = 'SALESMAN" ) Source
q 3
Additional Information Location Local Database W
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= Supported Bind Variables: Application, Page ltems and
_— i Table Owner Parsing Schema W
System Varizbles
Table Name DEFT i=
Include ROWID C' w
Bost-Rendering Colurmn

Where Clause E]|

¢ See Also:

Viewing Help in Page Designer

7.2.3.4 Gallery

Learn about the Gallery in the central pane of Page Designer.

The Gallery displays beneath the Layout tab in the central pane of Page Designer. The
Gallery contains three tabs: Regions, Items, and Buttons. When you pass the cursor over a
control or component, a tooltip displays that describes it. You can adjust the size of the pane
by dragging the horizontal and vertical splitters. To collapse or restore the Gallery pane, click
the small triangle in the center of each splitter.
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. REGION CONTENT Type
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in the application.

Include ROWID Column

[}:L\st TY | M- D.. Where Clause 7]

You can add new controls and components to a page by selecting the control or
component from the Gallery and dragging and dropping them into the Layout tab.
Alternatively, you can select a control or component in the Gallery and right-click to
view a context menu.

Gallery Menu

The Gallery menu displays on the right side of the Gallery pane. By default, the Gallery
only displays supported controls and components.

* Adding a Region, Item, or Button by Dragging and Dropping
e About Adding Components Using Gallery Context Menus

e Managing Application Legacy Components
7.2.4 Right Pane of Page Designer (Property Editor)

Learn about the Property Editor in the right pane of Page Designer.

Property Editor

Use the Property Editor to edit the attributes of the currently selected component.
Property Editor displays all attributes for the currently selected component. When you
select multiple components, the Property Editor only displays common attributes.
Updating a common attribute updates that attribute for all of the selected components.
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Page Designer ]~ =] Go o) v P e Save m

GO to G
I o s

Tiile
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Project Task - IR

EGICHN BOD Type

Interactive Report hd i=

ACTIVE REPORT SEARCH BAR TS

Table owner

Parsing Schema v

Property Editor organizes attributes into functional groups. To quickly access a group, click
Go to Group and select the group. To return the default display, click Go to Group again and
select Expand All.

Searching for Attributes

To search for a group or an attribute, enter a keyword in the Filter Properties field. The groups
and attributes containing the keyword appear. To return to the default display, delete the
keyword in the Filter Properties field.

Click the Pin Filter button on the right side of the search field to search across different
items, regions, and processes. You can “pin” keywords to have them persist as you click
around Page Designer. To “unpin” the search, click the Pin Filter button again.
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¢ See Also:

e Using Page Designer
* Managing Page Attributes

7.2.5 Code Editor

Learn about using the Code Editor in Page Designer.

For attributes requiring large amounts of code (for example, a region Source), you can
enter text directly into the field or access a full-featured Code Editor.
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Accessing Property Editor
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Region Attributes Printing
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Type
SQL Query w
[SOL Query 2]
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Code Editor: SQL Query

MAME
DESCRIPTION,
ASSIGMEE,
START_DATE,
ENDL_DATE,

COST,
1S_COMPLETE_YN,

FEEATER

You access Code Editor by clicking the Code Editor button, which resembles an arrow within

a square.

Code Editor Key Features

The Code Editor displays as a modal dialog and provides an enhanced code editor to edit PL/
SQL, SQL, HTML, CSS, and JavaScript component properties. The code highlighting is

determined by the input required for the specific property.

ORACLE"
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Context Menu

. select ROWID,
2 1D,
3 PROJECT_ID,
4 MILESTOME_ID, Change All Occurrences Ctrl+F2
5 MAME, -
5 DESCRIPTION, Lut I’\‘?
7 ASSIGMEE, Copy
8 START_DATE,
g END_DATE, Command Palette F1
18 COST,
11 IS_COMPLETE_YN,
12 CREATED,
13 CREATED_BY,
14 UPDATED,
15 UPDATED_BY
16 from EBA_PROJECT_TASKS
Code Editor controls include:
L]
Undo - Ctrl+Z
L]
Redo - Ctrl+Shift+Z
Q,
L[]
Find - Ctrl+F
P
L]
Query Builder
A
L]
Auto Complete - Ctrl+Space
(\_ \I
LAl
L]
Validate - Ctrl+Alt+V
e Context Menu - Right-click and select one of the following:
ORACLE’
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— Change All Occurrences (Ctrl+F2) - Right click and select Change All Occurrences
from the context menu.

— Cut
— Copy
— Command Palette (F1) - Displays the Command Palette.

Command Palette

Right click to display a context menu and select Command Palette. The Command Palette
includes over 80 commands including:

* Replace (Ctrl+H)
* Replace with Next Value (Ctrl+Shift+.)
*  Replace with Previous Value (Ctrl+Shift+,)

Multi Cursor Selection

e Add cursors at arbitrary positions - Select a position with your mouse and press
Shift+Alt+click (Shift+Option+click on macOS).

»  Set cursors above the current position - Select a position with your mouse and press
Ctrl+Alt+Up (Option+Command+Up on macOS).

e Set cursors below the current position - Select a position with your mouse and press
Ctrl+Alt+Down (Option+Command+Down on macOS).

Settings Menu

The Settings menu

-
$0L
e

displays on the right side and includes the following options:

e Indentation - Options include: Tab Inserts Spaces, Tab Size, and Indent Size
e Themes - Options include: Automatic, Light, Dark, and High Contrast Dark

*  Show Ruler

7.3 Using Page Designer

Use Page Designer to view and edit application pages.

Tip:

To view a list of keyboard shortcuts, press Alt+Shift+F1. Alternately, click the Help
menu at the top of the page and select Shortcuts.

* Viewing a Page in Page Designer
To view a page in Page Designer, select an application and then a page.
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Searching for Pages
Use the Page Selector to search for pages within the current application.

Dragging and Dropping Tabs Between Panes
Drag and drop tabs within a Page Designer pane.

Switching Between Three Pane and Two Pane Mode
Use the Layout options on the Utilities menu on the Page Designer toolbar to
switch between pane modes.

Accessing Property Editor
The Property Editor displays in the right pane of Page Designer and displays all
attributes for currently selected components.

Adding a Region, Item, or Button by Dragging and Dropping
Add regions, page items and buttons by dragging and dropping from the Gallery.

About Adding Components Using Gallery Context Menus
Add a component to a page by right-clicking a component in the Gallery to view a
context menu.

Adding a Region, Item, or Button from the Rendering Tab
Add a component or container from the Rendering tab by right-clicking an existing
component or container to display a context menu.

Copying a Region, Item, or Button
Copy regions, items, and buttons by using context menus or pressing CTRL and
dragging and dropping with the mouse.

Creating Pre-Rendering Branches, Computations, and Processes
Create branches, computations, and processes that execute before rendering the

page:

Creating Page Submission Branches, Validations, Computations, and Processes
Create page submission branches, validations, computations, and processes in
the Processing tab.

" See Also:

* Understanding Page Designer Ul Elements

e Viewing Help in Page Designer

7.3.1 Viewing a Page in Page Designer

To view a page in Page Designer, select an application and then a page.

ORACLE

To view a page in Page Designer:

1
2
3.
4

Navigate to the Workspace home page.
Click the App Builder icon.

Select an application.

Select a page.

The default view, Page Designer, appears.
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You preview a page by running it. Running an application page displays the rendered
version as end users would see it.

¢ See Also:

Running a Page from Page Designer

7.3.2 Searching for Pages

Use the Page Selector to search for pages within the current application.

D APEX App Builder SQL Workshop Team Development Gallery Q 9}. @ m

IEI Application 487 . Page Designer 8 Go o b~ £ &y Save n

B £ & Layout  PageSearch  He Region  Aftribute ting
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The Page Selector is the first control in the Page Designer toolbar and displays the current
page number.

To search for pages within an application:
1. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.
2. On the Page Designer toolbar, click the Page Selector.
The Page Finder appears.
3. Click the tabs at the top of the window to change the view:
* All Pages - Displays all pages in the current application.
* Recently Edited - Displays recently edited pages.
4. Enter search terms in the Search field and press Enter or click Go.

Search for page numbers, page names, user interface, or group names. The search is
not case sensitive and supports regular expressions.
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¢ See Also:

* Running a Page from Page Designer

* Managing Page Groups

7.3.3 Dragging and Dropping Tabs Between Panes

Drag and drop tabs within a Page Designer pane.

By default, Page Designer displays three panes which contain one or more tabs. You
can drag and drop tabs within a pane or between panes by selecting the pane heading
(or icon) and then dragging and dropping it to a new location. To return to the default
display, click Utilities on the Page Designer toolbar and select Layout and then Reset
Layout.

To drag and drop tabs in Page Designer:

1. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.

Page Designer appears.

2. Select a tab heading (or icon) and then drag and drop it to a new location.

In the following example, the Page Shared Components tab is selected and
being moved within the left pane.

'iT:' Application 487 . Page Designer hES 8 Go a ] o~ PRy o Save “
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SQL Query W
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SQL Query T |

3. Toreturn to the default display:

a. On the Page Designer toolbar, click Utilities.
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b. Select Layout and then Reset Layout.

7.3.4 Switching Between Three Pane and Two Pane Mode
Use the Layout options on the Utilities menu on the Page Designer toolbar to switch between

pane modes.

Three Pane Mode (the default) displays the left pane, central pane, and the right pane. Two
Pane Mode displays just the central pane and the right pane. A typical use case for
accessing Two Pane Mode, is when you want to view just the Rendering tree and the
Property Editor. To return to the default display, click Utilities on the Page Designer toolbar
and then select Layout and then Reset Layout.

To hide and show Page Designer panes:
1. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.
2. To select a page mode:

a. On the Page Designer toolbar, click Utilities and then Layout.

I::T::I Application 487 . Page Designer M 2 Go i) ) b L & Saye n
B ¢ s Layout  PageSearch  Help Delete Page
. Advisor Chrl+/ U A
Page 3: Project Tasks = @ ¢ = Advisor  Clri/, (e
a_Rendering Caching
Components - Project Task - IR Histary
e PREVIOUS Checksum
[B Project Task - 1m
E Export
Columr -
REGION CONTENT Show b
L
gved Reports RIGHT OF INTERAL TVE Two Pane Mode Layout @j ]
CREATE - ocal Database b
_— Items Buttons Reset Layout hpe
50L Query v
SQL Query

The Layout menu has three options: Two Pane Mode, Three Pane Mode, and
Reset Layout.

b. From Layout, select one of the following:
» Two Pane Mode - Displays just the central pane and the right pane.

» Three Pane Mode (the default) - Displays the left pane, central pane, and the
right pane.
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3. To return to the default display:
a. On the Page Designer toolbar, click Utilities.

b. Select Layout and then Reset Layout.

7.3.5 Accessing Property Editor

The Property Editor displays in the right pane of Page Designer and displays all
attributes for currently selected components.

To access Property Editor:
1. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.

2. In either the left pane or the Layout tab, select components or controls to edit.
Passing the cursor over a control or component, displays a tooltip that describes it.

Tip:

Once you select a component, press ALT+6 to navigate directly to the
Property Editor. To learn more, see Oracle APEX Accessibility Guide

The Property Editor displays attributes for the selected component or control. As
you select different components in either the left pane or the Layout tab, the
Property Editor automatically updates to reflect the selected component. When
you select multiple components, the Property Editor only displays common
attributes. Updating a common attribute updates that attribute for all of the
selected components.

Tip:

To view help for an attribute, select the attribute in the Property Editor
and click the Help tab in the central pane.

¢ See Also:

Right Pane of Page Designer (Property Editor)
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7.3.6 Adding a Region, Item, or Button by Dragging and Dropping

Add regions, page items and buttons by dragging and dropping from the Gallery.

Each application page consists of regions, page items and buttons. Those components can
be added to page positions or region positions, under the overarching container called
Components.

To add a region, item, or button by dragging and dropping from the Gallery:

1. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.
2. If needed, select the Layout tab in the central pane.

3. Inthe Gallery at the bottom of the central pane, locate the component or control you want
to create.

The Gallery lists all controls or components you can add to a page. Passing the cursor
over a control or component displays a tooltip that describes it.

Tip:

In addition to dragging and dropping components from the Gallery, you can also
right-click a component in the Gallery to view a context menu. Select Add To
and then the location where you want to add the component.

4. Click and hold the mouse on the component to be created and drag it the desired location
in the Layout tab.

When the mouse is over the appropriate location, the Layout tab displays as a darkened
yellow tile. Release the mouse to drop the component. You can only drop components
into appropriate drop positions, as determined by the component type.

5. Page Designer indicates what to do next. If there is an error, the Show Messages icon
displays in the Page Developer toolbar.

a. Click the Show Messages icon on the Page Designer toolbar.

The Messages dialog displays errors that must be addressed.
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b. Select an error to highlight the associated attribute in the Property Editor.

6. Edit the appropriate attributes in the Property Editor.

Q Tip:

To view help for an attribute, select the attribute in the Property Editor
and click the Help tab in the central pane.

7. Click Save or Save and Run Page.

7.3.7 About Adding Components Using Gallery Context Menus

Add a component to a page by right-clicking a component in the Gallery to view a
context menu.

In addition to dragging and dropping components from the Gallery, you can also right-
click a component in the Gallery to view a context menu. Each context menu features
an Add To option which displays the actual locations where you can add the
component. In this example, the developer is adding a new report to before the
Content Body region.
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" See Also:

Adding a Region, Item, or Button by Dragging and Dropping

7.3.8 Adding a Region, Item, or Button from the Rendering Tab

Add a component or container from the Rendering tab by right-clicking an existing component

or container to display a context menu.

To create new component or container in the Rendering tab:

1. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.

2. In the left pane, select the Rendering tab.

3. Locate and select the appropriate region, item, or region button.

4. Right-click an existing component or container to display the context menu for that

component type.

5. Select a command (for example, Create Region, Create Sub Region, Create Page Item,
Create Button and so on). The options available depend upon the node you select.

ORACLE
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6. Edit the appropriate attributes in the Property Editor.

To view help for an attribute, select the attribute in the Property Editor and click the
Help tab in the central pane.

Tip:

To add a legacy component, from the Type attribute in the Property
Editor, select Show Legacy.... Legacy components are added to the list.
Although Oracle still supports legacy application components, Oracle
does not recommend using them.

7. Click Save or Save and Run Page.

" See Also:

e Right Pane of Page Designer (Property Editor)
e Managing Regions
* Viewing Page Items

e Creating a Button

7.3.9 Copying a Region, Item, or Button

ORACLE

Copy regions, items, and buttons by using context menus or pressing CTRL and
dragging and dropping with the mouse.

Each application page consists of regions, page items and buttons. Those
components can be added to page positions or region positions, under the overarching
container called Components. Developers can copy regions, items, and buttons by
using context menus or pressing CTRL and dragging and dropping with the mouse.

Copying a Region, Item, or Button Using Context Menus
To copy a region, item, or button using context menus:

View the page in Page Designer.
In the central pane, select the Layout tab.

Locate and select the appropriate region, item, or region button.

1

2

3

4. Right-click to display the context menu.

5. From the context menu, select Copy To and then select the location.
6

Edit the component attributes.
Copying a Region, Item, or Button by Dragging and Dropping
To copy a region, item, or button by dragging and dropping:

1. View the page in Page Designer.

2. Inthe left pane, select the Rendering tab.
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Locate and select the appropriate region, item, or region button.

Press CTRL and then use the mouse to drag and drop the component to the new
location.

A copy of the component appears in the new location.

Edit the component attributes.

Copying a Region, Item, or Button to Another Page

To copy a region, item, or button to another page:

1
2
3.
4

5.

View the page in Page Designer.

In the left pane, select the Rendering tab.

Locate and select the appropriate region, item, or region button.
Right-click the component, and select Copy to other Page.
The appropriate wizard appears.

Follow the on-screen instructions.

7.3.10 Creating Pre-Rendering Branches, Computations, and Processes

Create branches, computations, and processes that execute before rendering the page:

To create branches, computations, and processes that execute before rendering the page:

1.

ORACLE

View the page in Page Designer:

a. On the Workspace home page, click the App Builder icon.
b. Select an application.

c. Select a page.

Page Designer appears.

In the left pane, select the Rendering tab.

Expand the Pre-Rending node at the top of the Rendering tab.

Determine the processing point. Right-click Before Header, After Header, or Before
Regions to display the context menu for that processing point.

Select the appropriate option: Create Branch, Create Computation, or Create Process.

Edit the appropriate attributes in the Property Editor.

Tip:

To view help for an attribute, select the attribute in the Property Editor and click
the Help tab in the central pane.

Click Save or Save and Run Page.
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Tip:

If you have changed the default display to group components by component
type, then you must to navigate to the Processing tab to maintain pre-
rendering components.

¢ See Also:

Managing Computations, Validations, and Processes

7.3.11 Creating Page Submission Branches, Validations,
Computations, and Processes

ORACLE

Create page submission branches, validations, computations, and processes in the
Processing tab.

To create branches, validations, computations, and processes that execute when the
page is submitted:

1. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.
2. In the left pane, select the Processing tab.

3. Navigate to After Submit, Validating, Processing, or After Processing as
appropriate within the processing tree.

4. Right-click the identifier or an existing component to display the context menu for
that processing point.

5. Select Create Branch, Create Validation, Create Computation, or Create
Process.

6. Edit the appropriate attributes in the Property Editor.

Tip:

To view help for an attribute, select the attribute in the Property Editor
and click the Help tab in the central pane.

7. Click Save or Save and Run Page.
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/) Tip:

You can use context menus to duplicate, delete, and copy a component to other
pages.

" See Also:

Managing Computations, Validations, and Processes

7.4 Managing Page Attributes

Edit page attributes to control basic information and functionality for a given page, including
the page name or title, header and footer text, navigation menus, inclusion of page-level
JavaScript or CSS files, error handling, and the selected authorization scheme.

e Editing Page Attributes
Edit page attributes by viewing the page in Page Designer and selecting the page name.

e Incorporating JavaScript Using Page Designer
Include JavaScript on a page by editing the page attributes in the JavaScript group.

e Configuring Rejoin Sessions for a Page
Configure the Rejoin Sessions attribute to determine whether URLS to this application
page contain session IDs.

e Configuring Dialog Attributes
Configure Dialog attributes in Page Designer.

e Configuring Pages to Warn Users of Unsaved Changes
Enable the Warn on Unsaved Changes page attribute to warn users if they navigate away
from a page containing unsaved changes.

" See Also:

Right Pane of Page Designer (Property Editor)

7.4.1 Editing Page Attributes

Edit page attributes by viewing the page in Page Designer and selecting the page name.
To edit page attributes:
1. View the page in Page Designer:

a. On the Workspace home page, click the App Builder icon.

b. Select an application.

c. Select a page.

ORACLE 7-33



Chapter 7
Managing Page Attributes

Page Designer appears.
In either the Rendering tab or the Layout tab, select the page name.

Edit the appropriate attributes in the Property Editor.

Tip:

To view help for an attribute, select the attribute in the Property Editor
and click the Help tab in the central pane.

To save your changes, click Save or Save and Run Page.

" See Also:

Right Pane of Page Designer (Property Editor) and Viewing Field-level and
Page Designer Help

7.4.2 Incorporating JavaScript Using Page Designer

Include JavaScript on a page by editing the page attributes in the JavaScript group.

ORACLE

Including JavaScript on a page is a good approach for functions that are very specific
to a page and a convenient way to test a function before you include it in a . s file.

To add JavaScript code to a page:

1.

View the page in Page Designer:

a. On the Workspace home page, click the App Builder icon.
b. Select an application.

c. Select a page.

Page Designer appears.

In the Rendering tab, select the page name.

The Property Editor displays the Page attributes.

In the Property Editor, find the JavaScript group.

Under JavaScript, edit following attributes:

a. File URLs - Enter JavaScript file URLSs for code to be loaded on this page.
Each URL has to be written into a new line. If you provide a minified version of
your file you can use the substitution string #MIN# to include .min or
#MIN DIRECTORY# to include dignified/ in your file URL for a regular page
view and an empty string if the page is viewed in debug mode. You also have
access to the substitution string #APP_VERSION# if you want to include the
application's version in the file URL.

b. Function and Global Variable Declaration - Enter JavaScript code such as
functions or global variable declarations referenced on this page. If the same
JavaScript is required on multiple pages, consider putting the code into an
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external JavaScript file to avoid duplication and to leverage browser caching of static
files.

Code you enter here replaces the #PAGE JAVASCRIPT# substitution string in the page
template.

Tip:

Do not to include opening or closing script tags. Just include the JavaScript
code.

To reference a shortcut, use:
"SHORTCUTNAME"

c. Execute When Page Loads - Enter JavaScript code to execute when the page
loads. The code is executed after the JavaScript code generated by Oracle APEX.

Tip:

To learn more about an attribute and view examples, select the attribute and
click the Help tab in the central pane.

For example, adding the following to the Function and Global Variable Declaration
attribute would create a function called test, which you could then use from anywhere on
the current page.

function test () {
alert('This is a test.');

}

5. Click Save.

7.4.3 Configuring Rejoin Sessions for a Page

Configure the Rejoin Sessions attribute to determine whether URLS to this application page
contain session IDs.

The Rejoin Sessions attribute controls support for joining existing sessions (similar to deep
linking).

# Warning:

Enabling rejoin sessions may expose your application to possible security
breaches, as it can enable attackers to take over existing end user sessions. To
learn more, see About Rejoin Sessions.
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To use Rejoin Sessions at the page level, administrators must enable Rejoin
Sessions at the instance level. A more restrictive instance-level setting overrides
application and page settings.

To configure Rejoin Sessions for a page:
1. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.
2. In the Rendering tab, select the page name.
The Property Editor displays the Page attributes.
3. Inthe Property Editor, find the Security group.
4. Under Security, Rejoin Sessions, select an option:
* Application Default - Inherits the setting defined at application-level.

 Disabled - If the URL does not contain a session ID Oracle APEX creates a
new session.

- Enabled for Public Sessions - If the URL goes to a public page and does not
contain a session ID, APEX attempts to utilize the existing session cookie
established for that application. APEX only joins using the cookie when the
session is not yet authenticated.

Enabled for Public Sessions requires that Embed In Frames be set to Allow
from same origin or Deny. This is not tied to a condition about the URL
payload, but also applies to session state protected URLSs.

* Enabled for All Sessions - If the URL does not contain a session ID, APEX
attempts to utilize the existing session cookie established for that application,
providing the following conditions are met:

— Session State Protection is enabled for the application and the URL
includes a valid checksum. For public bookmarks, the most restrictive item
level protection must be either Unrestricted or Checksum Required -
Application Level.

— The URL does not contain payload (a request parameter, clear cache or
data value pairs).

This setting also requires that Embed In Frames is set to Allow from same
origin or to Deny for the application.

Tip:

The option Application Default inherits the setting defined at
application-level. See Browser Security .

5. Click Save.
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¢ See Also:

e About Rejoin Sessions
* Session Management to configure Rejoin Sessions at the application-level

«  Configuring Rejoin Sessions for an Instance in Oracle APEX Administration
Guide

7.4.4 Configuring Dialog Attributes

Configure Dialog attributes in Page Designer.

Tip:

Creating a dialog page is a multiple step process. To learn more, see Creating
Dialog Pages.

To configure Dialog attributes:
1. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.
2. In the Rendering tab, select the page name.
The Property Editor displays the Page attributes.

3. Inthe Property Editor, find Appearance and verify that the Page Mode is set to either
Modal Dialog or Non-Modal Dialog.

4. Find Dialog and configure these attributes:
a. Width
b. Height
c. Maximum Width
d. Attributes
e. CSS Classes
f. Chained

Tip:

To view help for an attribute, select the attribute in the Property Editor and click
the Help tab in the central pane.
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To save your changes, click Save or Save and Run Page.

¢ See Also:

Creating Dialog Pages and Right Pane of Page Designer (Property Editor)

7.4.5 Configuring Pages to Warn Users of Unsaved Changes

Enable the Warn on Unsaved Changes page attribute to warn users if they navigate
away from a page containing unsaved changes.

To enable the Warn on Unsaved Changes page attribute:

1.

ORACLE

View the page in Page Designer:

a. On the Workspace home page, click the App Builder icon.
b. Select an application.

c. Select a page.

Page Designer appears.

In the Rendering tab, select the page name.

The Property Editor displays the Page attributes.

In the Property Editor, find the Navigation group.

For Warn on Unsaved Changes, select On to warn users if they navigate away
from a page that contains unsaved changes.

Click Save.

" Tip:

The Warn on Unsaved Changes attribute is implemented using the
apex.page.warnOnUnsavedChanges API.

¢ See Also:

e Configuring Button Attributes to Warn Users of Unsaved Changes
e Configuring Item Attributes to Warn Users of Unsaved Changes

e warnOnUnsavedChanges in Oracle APEX JavaScript APl Reference
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7.5 Running a Page from Page Designer

The Oracle APEX engine dynamically renders and processes pages based on data stored in
database tables. To view a rendered version of an application, you run or submit it to the
APEX engine.

Q Tip:

You cannot run Modal and Non-Modal dialog pages directly using the Save and
Run Page button. To view a Modal and Non-Modal dialog page, run the normal
page that is responsible for opening the dialog page and access it from there.

To run a page in Page Designer:

1. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.

Page Designer appears. You preview a page by running it. Running an application page
displays the rendered version as end users would see it.

2. Click the Save and Run Page button in the upper right corner. The Save and Run Page
button resembles a green right-facing arrow.
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A rendered version of the application page appears.
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# See Also:

e Running an Application or Page

¢ Runtime Developer Toolbar

7.6 Runtime Developer Toolbar

Use the Runtime Developer toolbar to quickly edit the current application or currently
running page, or view session state.

When you run an application from App Builder and view a page, the Runtime
Developer toolbar displays at the bottom of any editable page.

Q Tip:

The Runtime Developer toolbar only displays if the Availability, Status
attribute on the Application Definition page is set to Available with
Developer Toolbar. See Editing the Application Definition.
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Project Description Assignee Start Date End Date Cost Complete?

Define main requirements for
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Tracker Data Model support customer satisfaction tracking. Tyson King 1/4/2022 /6/2022 $3,000.00
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The Runtime Developer toolbar contains of the following controls:

* Oracle APEX Home
(

) - Links to the Workspace home page. See Understanding the Workspace Home
Page.
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App XX (where XX is the app ID) - Links to the Application home page. See
Understanding the Application Home Page.

Page XX (where XX is the page number) - Displays the currently running page ID. Click
the page ID to view the page in Page Designer and then edit the page.

Session - Displays two menus:

— View Session State - Displays session state information for the current page. See
Viewing Session State.

— Session Overrides - Displays the Session Overrides dialog which lists session
values that can be overidden in the current application. See Managing Session State
Overrides.

Debug - Controls the display of debug information. Available options include:
— Enable Debug - Specifies the level of detail included when you click View Debug .
*  No Debug - Enables and disables Debug mode

*  Info (default) - The debug log contains the default or normal amount of
information. This corresponds with a log level of 4 and a Debug URL argument of
YES.

*  App Trace - The debug log contains messages up to level 6. This corresponds
with a Debug URL argument of LEVELG6.

*  Full Trace - The log will contain the maximum amount of information. This
corresponds with a Debug URL argument of LEVEL9. Full Trace can slow request
processing but provides the most amount of detail.

See Utilizing Debug Mode.
— View Debug - Displays debug information for the current page.

Quick Edit - Enables developers to enter either Quick Edit mode or access Live
Template Options.

— Quick Edit Mode - Click Quick Edit and then select the desired component to
instantly access the component in Page Designer. Press ESCAPE or click outside a
component to exit quick edit mode.

— Edit Live Template Options - Click Quick Edit and then move the mouse over the
component for which you want to modify template options and click the Wrench icon
in the upper right corner. See Using Quick Edit to Modify Live Template Options.

Customize - Customize menu options include:

— Theme Roller - Access a live CSS editor that enables you to quickly change the
theme style, colors, rounded corners and other application attributes. This option only
displays for themes supporting Theme Roller. See Using Theme Roller.

— Edit Logo - Change the logo users see at runtime. See Managing Application Logos.

— Edit App Icon - Update or upload a new application icon. See Managing Application
Icons.

Info

(

) displays two menus:
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— Show Layout Columns - Toggles between Show Layout Columns and Hide

Layout Columns. This option only applies if a layout is used and that layout
supports showing layout columns and the page has more than one column.

— Show Page Timing - Displays the Page Performance Timing dialog. Click
Copy to copy the data in table form and then paste it into another application.
Click Clear to remove the current timing events.

— Show Landmarks - Landmarks provide a powerful way to identify the
structure of an APEX application and should be used to complement, but not
replace Heading structure. See Landmarks in Oracle APEX Accessibility
Guide.

— Show Headings - View headings on the current page. See Headings in
Oracle APEX Accessibility Guide.

» Developer Toolbar Options

(

) - Displays on the far right and resembles a mechanical gear. Click Developer
Toolbar Options to control how the Runtime Developer Toolbar displays.

About Developer Toolbar Options
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Project Description Assignee Start Date End Date Cost Complete?
Define main requirements for Define the scope and timelines for the development of the trackin Bernard
tracking customer p pment g 1/2/2022 1/3/2022 s200000 Y

. N app. Jackman
satisfaction.
Finalize Customer Satisfaction Define the data model for new and existing entities required to y X 1A R . "
Tracker Data Model support customer satisfaction tracking. Tysen King 1#4/2022 /6/2022 33.000.00
Finalize User l.Ex_per.erce for Write de'.'eloper stanc.ards on UX and development s.ta_rca.rds on how Va_mson 14442022 1/5/2022 5300000 v
Customer Satisfaction app the company will acguire and report on customer satisfaction. Smith
Define Admin Screens for Define screens to maintain all of the base tables for the Customer Brock Shilli 1/6/2022
Customer Satisfaction App Satisfaction apps. rock sniling fHE Auto Hide

Show Icons Only

Populate Data Structures for Upload actual data provided from other IT systems. Eva Jelinek 1/7/2022

Customer Satisfaction Apps
Display Position
Cesign production screer

fcrtr:‘e cl:stomer to provi m &, App 363 [‘}Page 12 @Sﬁs[on @ ¥ Debug @ [®] Quick Edit §3,500.00 Y
Clicking Developer Toolbar Options (ﬂ) displays a submenu containing the
following controls:

e Auto Hide - Hides the toolbar, making more of the page visible.
e Show Icons Only - Removes the labels from the buttons to make the toolbar
smaller.
- Display Position - Controls the placement of the Developer toolbar. Options
include: Top, Left, Bottom, or Right.
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About Runtime Toolbar and the Environment Banner

If a workspace or instance-level environment banner is enabled, the text and color will be
applied to Runtime Developer toolbar.

An environment banner displays a colored banner with text at either the left or top of page.
You can define an environment banner for a given workspace or an entire development
instance. Workspace-level environment banners override those defined at the instance-level.

¢ See Also:

Configuring a Workspace Environment Banner and Configuring an Environment
Banner in Administration Services in Oracle APEX Administration Guide

About JavaScript Error Detection

If a page has one or more JavaScript errors, a red error button displays on the left side of the
Runtime Developer toolbar. If you have enabled Auto Hide, the Runtime Developer toolbar
displays indicating the error.

Click the red error button to view an alert dialog which explains you should view the Browser
console. The red error button persists until error has been resolved, the Browser console is
cleared, and you refresh the page.

7.7 Copying an Application Page

You can copy a page from the current application or from another application. During the
copy process, you can also copy shared components or change mappings to shared
components in the target application.

To copy a page:
1. View the page you want to copy in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.

2. On the Page Designer toolbar, click the Create menu and then select Page as Copy.
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I':i“:l Application 457 | Page Designer [~ 8 Go n_ L ‘//'5. v 5’5_-, Save ﬂ
= _7 '] -j— Layout Page Search Help Page Ciri+/, C.P
Page as Copy Cirt+/, C,C
Page &: Project Tasks = @ e 3 @ L,
Pre-Rendering Page Compenent
~ Project Task - IR . -

Conternt Rods PREVIOUS < C.S
Content Body Shared Component  Cirl+/,C.5

B Project Tosk - IR EETTET
I Page Group

Developer Comment

o o q RIGHT OF INTERACTIVE REPORT SEARCH BAR
Saved Reports Issue
Right of Interactive Report Searck LOCETIaon
g CREATE - Local Database ~
Post-Rendering Items Buttons =w Type
L - 5 Table / View v
R.. o T - Table Cwner
Parsing Schema v
R.. o :_ Table Name

3.  On Copy Page Option, select one of the following and click Next:
e Page in this application
* Page in another application

4. Follow the on-screen instructions.

7.8 Deleting Pages

Deleting a page deletes the corresponding tabs, breadcrumbs, and list entries.

* Deleting a Page
Delete a page in Page Designer.

» Deleting Multiple Pages
Delete multiple pages in Cross Page Utilities.

» Deleting a Range of Pages
Delete a range of pages in Cross Page Ultilities.

¢ See Also:

Locking and Unlocking a Page

7.8.1 Deleting a Page

Delete a page in Page Designer.

To delete a page:

1. View the page in Page Designer:
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a. On the Workspace home page, click the App Builder icon.

b. Select an application.

c. Select a page.

Page Designer appears.

Verify the page number.

On the Page Designer toolbar, select the Utilities menu and click Delete Page.
The Confirm Page Delete page appears.

Click Permanently Delete Page.

# See Also:

Page Designer Toolbar

7.8.2 Deleting Multiple Pages

Delete multiple pages in Cross Page Utilities.

To delete multiple pages:

1
2
3
4.
5
6

On the Workspace home page, click the App Builder icon.
Select an application.

Click Utilities.

From Page Specific Utilities, click Cross Page Utilities.
Click Delete Multiple Pages.

Select the pages to be deleted and click Delete Pages.

7.8.3 Deleting a Range of Pages

Delete a range of pages in Cross Page Ultilities.

ORACLE

To delete a range of pages:

N o o kM w d PR

On the Workspace home page, click the App Builder icon.
Select an application.

Click Utilities.

From Page Specific Utilities, click Cross Page Utilities.
Click Delete Multiple Pages.

Click the Delete Pages by Range tab.

Enter the pages to be deleted and click Delete Pages.
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In Oracle APEX, a report is the formatted result of a SQL query. You can generate the SQL
query by selecting a table or view in a wizard or by defining the SQL query manually.

Tip:

To view examples, install the sample app, Sample Reporting. To learn more, see
Sample Apps.

Understanding Report Page Types
Learn about the available report page types when running the Create Application Wizard
and Create Page Wizard.

Creating a Report Using the Create Application Wizard

Run the Create Application Wizard to create a new application containing one or more
pages. Supported report pages include cards, faceted search, interactive grid, interactive
report, and classic report.

Creating a Report Using the Create Page Wizard
Run the Create Page Wizard from an existing application to create a variety of different
reports.

Creating a Report by Dragging and Dropping from the Gallery
Create a report by dragging and dropping a report type from the Gallery.

Managing Cards
A cards page features an orderly layout of information tiles. Developers choose between
three layouts: Grid, Float, or Horizontal (Row).

Managing Smart Filters

A smart filters page features a single search field at the top of the page and a search
results report (classic report, cards, map, or calendar). While a smatrt filter behaves
similarly to faceted search, it features a more space efficient layout.

Managing Faceted Search

A faceted search page displays and filters data using an intuitive experience users
recognize from ecommerce sites (a left Search region and report region). Displays search
results as cards or a classic report.

Managing Interactive Grids

An interactive grid presents data in a searchable, customizable report. Includes similar
customization capabilities available in interactive reports plus the ability to rearrange the
report interactively using the mouse or keyboard.

Managing Interactive Reports
An interactive report page features a searchable, easily customizable report.

Managing Classic Reports
A classic report features a simple report page based on the formatted result of a SQL

query.
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* Managing Sorting with Order By Item
Create an inline static LOV by configuring region-level Order By Item attributes.

*  Printing Report Regions
Configure a report region to print by exporting it to several different formats.

* Understanding BLOB Support in Forms and Reports
Oracle APEX includes declarative BLOB support to enable developers to
declaratively upload files in forms, and download or display files in reports.

¢ See Also:

Developing Forms and Managing Application Components

8.1 Understanding Report Page Types

Learn about the available report page types when running the Create Application
Wizard and Create Page Wizard.

The Create Application Wizard and Create Page Wizard include a number of pages for
displaying data. Some of these page types, such as classic reports, interactive reports,
and interactive grids, are straightforward reports. However, others include a report
region and an associated search region. For example, a faceted search page contains
a search region and a report region which can display as either a cards region or a
classic report. Similarly, a smart filters page includes a search region and a search
results report which can be a classic report, cards, map, or calendar.

¢ Note:

To learn more about reports and forms optimized for mobile devices, see
Creating Applications for Mobile Devices and Forms Optimized for Mobile
Environments.

*  Report Page Type Use Cases
Review common use cases for available report page types.

e Comparison of Report Page Types
Compare report pages types available when running the Create Application
Wizard and Create Page Wizard.

8.1.1 Report Page Type Use Cases

ORACLE

Review common use cases for available report page types.

The following table describes the report page types available in the Create Page
Wizard and Create Application Wizard and the use cases in which each is most
appropriate.
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< Note:
For a more detailed comparison of report page types, see Comparison of Report
Page Types.
Report Page Type Use Case Learn More...
Cards - Display data at a glance using See:

information tiles that can easily Managing Cards
include an image.

*  Choose between three cards
page layouts: Grid, Float, or
Horizontal (Row).

*  Provides summary information
from a modern layout with one-
click access to more details on
another report or form page.

«  Example Cards Page

e Install the Sample Cards sample
app. See Installing Apps from
the Gallery.

Classic Report » Display data in a simple report ~ See:
region. _ _ «  Managing Classic Reports
» Update data by including a «  Example Classic Report

repotr)t_ arlq up:jda;e form i e Install the Sample Reporting
combination during creation. sample app. See Installing Apps

e Column sorting configurable. from the Gallery.
Faceted Search « Display and filter data using an  See:
intuitive experience users «  Managing Faceted Search

recognize from ecommerce sites
(a left Search region and report
region).
e Show search results as cards or
a classic report.
e Includes built-in search
capability.
e Users select facets in the
Search region to narrow down
the search results.

Example Faceted Search

Install the Sample Reporting
sample app. See Installing Apps
from the Gallery.
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Report Page Type

Use Case

Learn More...

Interactive Grid .

Display data in a searchable,
customizable report that
supports inline editing at runtime
using the mouse or keyboard.
Enable end users to create
highly customized reports. Users
can alter the report layout by
using either the Column
Heading menu or Actions menu.
Move columns by using the
Actions menu, Column dialog, or
by dragging and dropping with
the mouse.

Save customizations and report
layout by saving a private or
alternative report just for
yourself, a public report, or as a
primary report that can be
viewed by others.

Save a report layout by creating
an Alternative or Private report.
Download or email the report as
a CSV, HTML, PDF, or Excel file.
Enable and disable editing
capability at by editing attributes
in Page Designer.

If editable:

—  Select options from the Row
Action menu.

— Add and remove rows or
edit data by directly editing
a cell.

See:

e Understanding Report Page
Types

« Understanding Report Page
Types

¢ Install the Sample Reporting
sample app. See Installing Apps
from the Gallery.

Interactive Report .

Display data in a searchable,
customizable report.
Enable end users to create

highly customized reports. Users

can alter the report layout by
using either the Column
Heading menu or Actions menu.
Update data by including an
update form during creation.
Save customizations and report
layout by saving a private report
just for yourself, a public report,
or as a default report that can be
viewed by others.

Download, email, or subscribe to
report update subscriptions in
CSV, HTML, Excel, or PDF
format.

See:
e Managing Interactive Reports
«  Example Interactive Report

Install the Sample Reporting
sample app. See Installing Apps
from the Gallery.

ORACLE
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Report Page Type

Use Case

Learn More...

Smart Filters

Display data using a single
search field region at the top of
the page and results report.
Offers a more compact Ul when
compared to faceted search.
Search results report can
display as a classic report,
cards, map, or calendar.

End users select filters that
display as suggestion chips.
Includes built-in search
capability.

Configurable search suggestions

Managing Smart Filters
Example Smart Filters

Install the Sample Reporting
sample app. See Installing Apps
from the Gallery.

8.1.2 Comparison of Report Page Types

Compare report pages types available when running the Create Application Wizard and

Create Page Wizard.

The following table describes the commonly used report page types available in the Create
Page Wizard and Create Application Wizard.

Report Page Type

Description

Learn More...

Cards

A cards page features an orderly

layout of information tiles. Developers

choose between three layouts: Grid,
Float, or Horizontal (Row).

Features:

Customize every aspect of a
cards region's Ul (including
layout, appearance, icon, badge,
and media).

Declaratively create links from a
cards page by adding actions.
Action types include Button, Full
Card, Title, Subtitle, or Media.
Supports advanced HTML
expressions including template
directives for client-side
conditional formatting.

Managing Cards
Example Cards Page

Install the Sample Cards sample
app. See Installing Apps from
the Gallery.

ORACLE
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Report Page Type

Description

Learn More...

Classic Report

A classic report features a simple
report page based on the formatted
result of a SQL query.

Features:

Report can display as a
standard application page or as
a modal dialog.

Enable the Include Form option
to create a report and update
form combination.

Enable column sorting in Page
Designer by selecting a column
and configuring Column, Sorting
attributes.

The most versatile report as it is
template-driven. Choose from
the predefined report templates,
including Media List, Comments,
Timeline, Badge List, Value
Attributes Pairs, and so on. Or,
create your own template to
customize and visualize data.
Download the report as a CSV,
HTML, Excel, or PDF.

Supports Report Layouts to
format PDF exports.

Limitations compared to other report
types:

Using templates requires
changing the SQL query column
names to match the chosen
template (for row templates)

No support for scroll pagination
or virtual scrolling. Other
pagination options available.

No column header groups,
frozen columns, and template
directives.

See:

Managing Classic Reports
Example Classic Report

Install the Sample Reporting
sample app. See Installing Apps
from the Gallery.

ORACLE
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Report Page Type

Description

Learn More...

Faceted Search

A faceted search page displays and See:
filters data using an intuitive
experience users recognize from
ecommerce sites (a left Search
region and report region). Displays
search results as cards or a classic
report.

Features:

Select options from facets in the
left Search region to narrow
down search results.

Set filters using facets that show
possible values together with the
occurrence count within the
result set.

Built-in search capability.
Optionally include a chart for
any facet.

Toggle between a bar chart
(which is the default) and pie
chart type.

Create facet groups for data
models having multiple flag
columns.

Managing Faceted Search
Example Faceted Search

Install the Sample Reporting
sample app. See Installing Apps
from the Gallery.

ORACLE
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Report Page Type Description

Learn More...

Interactive Grid An interactive grid presents dataina See:

searchable, customizable report.
Includes similar customization
capabilities available in interactive
reports plus the ability to rearrange
the report interactively using the
mouse or keyboard.

Features:

*  Extensive customization
capabilities using menus or
inline editing.

»  Turn editing on or off using the
region Attribute, Edit, Enabled.

e Built-in search capability.

*  For both editable and non-
editable reports, users can
change the report layout and
create private reports:

—  Column Heading menu -
Change the report layout
with Control Break,
Aggregations, Freeze, Hide,
and Filter.

— Actions menu:

*  Columns - Configure
the columns to show or
hide.

*  Filters - Create filters to
alter the display.

*  Data - Sort, Aggregate,
Refresh, Flashback.

*  Format - Control Break,
Highlight, Stretch
Column Widths.

*  Selection - Cell
Selection, Copy to
Clipboard, Refresh
Rows.

*  Chart - Create chart.

*  Report - Create, edit,
and manage saved
Private or Alternative
reports.

*  Download - Download
or email the report as a
CSV, HTML, PDF, or
Excel file

* If editable, users can edit the
data directly:

— Row Actions menu - Single
Row View, Add Row,
Duplicate Row, Delete Row,
Refresh Row, Revert
Changes.

Understanding Report Page
Types

Understanding Report Page
Types

Install the Sample Reporting
sample app. See Installing Apps
from the Gallery.
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Report Page Type

Description Learn More...

— Add Rows - Add new rows
by clicking the Add Row
button.

—  Edit Rows - Edit a row by
selecting or double-clicking
a cell with the mouse,
editing the content, and
clicking the Save button.

Limitations compared to other report

page types:

*  Rows are fixed height. No
variable height option.

e Does not remember current
page.

e Tabular form limitations: submit
selected rows, always edit for
small number of records

* Interactive report features not
supported: Pivot view, Group By
view, Computed columns, and
complex filters.

ORACLE
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Report Page Type

Learn More...

Interactive Report

Description

An interactive report page features a See:
searchable, easily customizable .
report. .
Features: o

* Report can display as a
standard application page or as
a modal dialog.

e Enable the Include Form option
to create a report and update
form combination.

e Built-in search capability.

*  Change the report layout and
create private reports using
menus:

—  Column Heading menu:
Change the report layout
with Sort Ascending, Sort
Descending, Hide Column,
Control Break, and Filter.

— Actions menu:

*  Columns - Configure
the columns to show or
hide.

*  Filters - Create filters to
alter the display.

*  Data - Sort, Aggregate,
Compute, Flashback.

*  Format - Control Break,
Highlight, Rows Per
Page.

*  Chart - Create a chart.

*  Group By - Group sets
of results by one or
more columns with
Group By.

*  Pivot - Pivot reports
transpose rows into
columns to generate
results in a cross tab
format.

*  Report - Create, edit,
and manage saved
Named reports.

*  Download - Download
or email the report as a
CSV, HTML, Excel, or
PDFE

*  Subscription -
Subscribe to report
updates in CSV, HTML,
Excel, or PDF format.

Limitations compared to other report

page types:

*  No scroll pagination.

»  Freeze columns not supported.

Managing Interactive Reports
Example Interactive Report

Install the Sample Reporting
sample app. See Installing Apps
from the Gallery.

ORACLE
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Report Page Type

Description

Learn More...

Column groups not supported.

Charts not as powerful as
interactive grid.

Smart Filters

A smart filters page features a single See:

search field at the top of the page
and a search results report (classic
report, cards, map, or calendar).
While a smart filter behaves similarly
to faceted search, it features a more
space efficient layout.

Features:

Includes a search field at the top
of the page with filters that
display as suggestion chip.

The Search Results can display
as a classic report, cards, map,
or calendar.

Clicking a filter name displays a
list of values.

Clicking to right of a suggestion
chip changes it to an applied
filter chip and moves to the
Applied Filters Area. Clicking the
applied filter chip again displays
a list.

Built-in search capability.

Managing Smart Filters
Example Smart Filters

Install the Sample Reporting
sample app. See Installing Apps
from the Gallery.

8.2 Creating a Report Using the Create Application Wizard

Run the Create Application Wizard to create a new application containing one or more pages.
Supported report pages include cards, faceted search, interactive grid, interactive report, and

classic report.

Q Tip:

To learn more, see the Create Application Wizard discussion for each component.

Report Options When Running the Create Application Wizard

Learn about supported report options available when running the Create Application

Wizard.

8.2.1 Report Options When Running the Create Application Wizard

Learn about supported report options available when running the Create Application Wizard.

ORACLE

Available Reports When Creating Applications

The Create Application Wizard supports the following report types.
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Table 8-1 Create Application Wizard - Available Reports

Report Type

Description

Cards

A cards page consists of individual boxes, which resemble index
cards, laid out on a page. Each card displays three pieces of
information: Card Title, Description Column, and Additional Text
Column. First, you select a table or view on which to build the page.
Second, you select the Card Title, Description Column, and Additional
Text Column.

See Also: Managing Cards

Faceted Search

Creates a faceted search region and report. First, you select a report
type (Report or Cards. Second, you select the Table or View on which
to build the faceted search region and report.

If you select a Table, facets are auto discovered using APEX Data
Dictionary Cache. If you select a View, facets are not auto-discovered.
Developers can create the faceted report page based on a View, but
the only Search facets included are searchable VARCHAR?2 columns.

See Also: Managing Faceted Search

Smart Filters

A smart filters page features a single search field at the top of the
page with filters and a report. Each filter displays as a suggestion chip
with a single count of how often the specific suggestion value occurs.
Users can search, or click a smart chip to quickly filter the report.

While a smart filters page behaves similarly to faceted search, it
features a more space efficient layout. Smart filter pages feature a
single search field at the top of the page with filters which display as
smart chips with counts that show how often a specific value occurs.
Users can search, or click a smart chip to quickly filter the report.

See Also: Managing Smart Filters

Interactive Grid

An interactive grid presents users a set of data in a searchable,
customizable report. Functionally, an interactive grid includes most
customization capabilities available in interactive reports plus the
ability to rearrange the report interactively using the mouse.

First, you select a page source (that is, Table or View or SQL Query).
Second, you determine if the interactive grid is editable by selecting
Allow Editing or Read Only.

If you select Allow Editing, users can add to, modify, and refresh the
data set directly on the page. Functionally, an interactive grid includes
most customization capabilities available in interactive reports plus the
ability to rearrange the report interactively using the mouse or
keyboard. You choose a table on which to build the interactive grid.

See Also: Managing Interactive Grids

Interactive Report

Creates a page that contains the formatted result of a SQL query.
First, you select a page source (that is, Table or View or SQL Query).
Second, you select a report type,Interactive Report. To include a
form page for creating or updating records, select Include Form.

Select Include Form to include a form page for creating or updating
records.

If the report is based on table which has a foreign key constraints to
another table, the developer can also define Lookup Columns. Use
Lookup Columns to replace identifiers with a display column, such as
showing the department name instead of the department number.

See Also: Managing Interactive Reports
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Table 8-1 (Cont.) Create Application Wizard - Available Reports
|

Report Type Description
Additional Pages, Creates a page that contains the formatted result of a SQL query.
Classic Report First, you select a page source (that is, Table or View or SQL Query).

Second, you select the report type Classic Report). To include a form
page for creating or updating records, select Include Form.

If the report is based on table which has a foreign key constraints to
another table, the developer can also define Lookup Columns. Use
Lookup Columns to replace identifiers with a display column, such as
showing the department name instead of the department number.

See Also: Managing Classic Reports

Additional Pages, Creates multiple report pages containing an interactive report with

Multiple Reports form. For each page, you choose a table on which to build the
interactive report with form. Click Edit to change the default options
(such as providing a custom SQL Query), specifying another report
type (such as, selectingClassic Report instead of Interactive
Report).
Select Include Form to include a form page for creating or updating
records.

See Also: Managing Classic Reports

¢ See Also:

Creating an Interactive Report Using the Create Application Wizard and Available
Page Types in the Create Application Wizard

8.3 Creating a Report Using the Create Page Wizard

Run the Create Page Wizard from an existing application to create a variety of different
reports.

* Report Options When Running the Create Page Wizard
Learn about available report options when running the Create Page Wizard and using the
Universal Theme.

» Creating a Report on New Page
Use the Create Page Wizard to create a wide variety of reports on a local database or on
an external data source.
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8.3.1 Report Options When Running the Create Page Wizard

Learn about available report options when running the Create Page Wizard and using
the Universal Theme.

Tip:

Universal Theme - 42 is optimized to work equally well in either a mobile or
desktop environment. In previous releases and in earlier themes, the Mobile
user interface is based on jQuery Mobile. Oracle recommends migrating
existing mobile applications to the Universal Theme as soon as possible.

Available Reports in the Create Page Wizard

The Create Page Wizard supports the following reports when running the Create Page
Wizard with the Universal Theme.

Table 8-2 Create Page Wizard — Available Reports

Report Type

Description To Learn More

Cards

A cards page consists of individual boxes, which See: Managing Cards
resemble index cards, laid out on a page. Each card

displays three pieces of information: Card Title,

Description Column, and Additional Text Column.

First, you select a table or view on which to build the

page. Second, you select the Card Title, Description

Column, and Additional Text Column.

Faceted Search

Creates a faceted search page which contains a left See: Managing Faceted
Search region and a report. Search

You select a table or view on which to build the
page. The wizard shows facet selections with
options, enabling you to select or deselect the facet
columns. When a page is based on local table, then
facet recommendations display based on the
statistics of the data in the selected table. In all
other cases (that is, when the page is not based on
local table), only VARCHAR2 columns are displayed
for facet selections. You choose if the report is a
classic report or a cards report.

ORACLE
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Table 8-2 (Cont.) Create Page Wizard — Available Reports

Report Type

Description To Learn More

Smart Filters

A smart filters page features a single search field at See: Managing Smart Filters
the top of the page with filters that display

suggestion chips. While a smart filters page

behaves similarly to faceted search, a smart filters

page features a more space efficient layout.

You select a table or view on which to build the
page. When a page is based on local table, then
filter recommendations are displayed based on the
statistics of the data in the selected table. In all
other cases (that is, when the page is not based on
local table), only VARCHARZ columns are displayed
for filter selection.

Each suggestion chip displays a single count for the
specific suggestion values. The suggestion chip
count only displays for filters that support counts,
such as LOV-based filter types. Users can search or
click a suggestion chip to quickly filter the report.
You choose if the report is a classic report or a
cards report.

Interactive Grid

An interactive grid presents users a set of dataina See: Managing Interactive
searchable, customizable report. Functionally, an Grids

interactive grid includes most customization

capabilities available in interactive reports plus the

ability to rearrange the report interactively using the

mouse or keyboard.

Enabling Include Form Page includes a modal
form page. Then, you select the Data Source and
the Source Type (that is, Table or SQL Query).

If the Data Source contains BLOB columns, then
those columns are automatically excluded from the
region source since interactive grid regions do not
support BLOB columns. If the Data Source is a
local table which has foreign keys selected, then for
those columns, the column type is set as Select
List. If a if matching LOV already exists, a Shared
LOV is automatically created or re-used.

You determine if the interactive grid is editable by
enabling or disabling Editing Enabled. When this
option is enabled, then the grid is rendered read-

only and separate form page is created to create

and edit the data.

ORACLE
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Table 8-2 (Cont.) Create Page Wizard — Available Reports
]

Report Type Description To Learn More
Interactive Report Creates a page that contains the formatted result of See: Managing Interactive
a SQL query. Enabling Include Form Page Reports

includes a modal form page. Then, you select the
Data Source and the Source Type (that is, Table or
SQL Query).

If a Data Source contains BLOB columns and if a
local table with primary key constraints is selected
as the Data Source, then BLOB columns are set as
Download BLOB type, with proper BLOB
attributes. If the Data Source is a local table, which
has foreign keys selected, then for those columns,
the column type is set as Plain Text (based on List
of Values). If a if matching LOV already exists, a
Shared LOV is automatically created or re-used.

Classic Report Creates a page that contains the formatted result of See: Managing Classic
a SQL query. You choose a table on which to build a Reports
report or provide a custom SQL SELECT statement
or a PL/SQL function returning a SQL SELECT
statement.

When a Data Source contains BLOB columns and if
a local table with primary key constraints is selected
as the Data Source, then BLOB columns are set as
Download BLOB type, with proper BLOB
attributes. When a local table, which has foreign
keys is selected as the Data Source, then for those
columns, column type is set as Plain Text (based
on List of Values). If a if matching LOV already
exists, a Shared LOV is automatically created or re-
used.

Enable Include Form Page to include a form page
for creating or updating records.

With the exception of sorting and simple filtering,
end users cannot customize a classic report.

8.3.2 Creating a Report on New Page

Use the Create Page Wizard to create a wide variety of reports on a local database or
on an external data source.

The component(s) described in this topic include built-in support for REST Enabled
SQL and REST Data Sources which enables read and write access to remote data
sources. In order to build a component on a remote data source, you must first create
the application and configure the external data source.

Tip:

To learn more about external data sources, see Managing REST Enabled
SQL References and Managing REST Data Sources.
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To add a report on a new page by running the Create Page Wizard:
1. On the Workspace home page, click the App Builder icon.

2. Select the application.

3. Click Create Page.

Create a Page appears and features three tabs: Component, Feature, and Legacy
Pages.

4. Under Component, select a report type. Options include:
* Cards
* Faceted Search
*  Smart Filter
* Interactive Grid
* Interactive Report

* Classic Report

Tip:

To learn more about each report type, see Report Options When Running the
Create Page Wizard.

5. What displays next changes based on your selection. Follow the on-screen instruction. To
learn more about an attribute, see field-level Help.

Tip:

When prompted to select a Data Source, select Local Database, REST
Enabled SQL or REST Data Source.

6. To view the report, click Save and Run Page.

The rendered page appears.

Tip:

You can also run the Create Page Wizard in Page Designer by clicking the Create
menu and selecting Page.
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8.4 Creating a Report by Dragging and Dropping from the
Gallery

Create a report by dragging and dropping a report type from the Gallery.

Tip:

When you drag and drop a report region from the Gallery, you must provide
the underlying SQL query.

To add a report by dragging and dropping from the Gallery:

1. View the page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.

2. Inthe Gallery at the bottom of the central pane, locate the report type you want to
create.

The Gallery lists all controls or components you can add to a page. Passing the
cursor over a control or component displays a tooltip that describes it.

Tip:

In addition to dragging and dropping components from the Gallery, you
can also right-click a component in the Gallery to view a context menu.
Select Add To and then the location where you want to add the
component.

3. Click and hold the mouse on the component to be created and drag it the desired
location in the Layout tab.

When the mouse is over the appropriate location, the Layout tab displays as a
darkened yellow tile. Release the mouse to drop the component. You can only
drop components into appropriate drop positions, as determined by the component
type.

4. Page Designer indicates what to do next. If there is an error, the Show Messages
icon displays in the Page Developer toolbar.

a. Click the Show Messages icon on the Page Designer toolbar.

The Messages dialog displays errors that must be addressed.
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b. Select an error to highlight the associated attribute in the Property Editor.
Edit the appropriate attributes in the Property Editor.

Q Tip:

To view help for an attribute, select the attribute in the Property Editor and click
the Help tab in the central pane.

To save your changes click Save. To save and run the page, click Save and Run Page.

8.5 Managing Cards

A cards page features an orderly layout of information tiles. Developers choose between
three layouts: Grid, Float, or Horizontal (Row).

ORACLE

A cards report region declaratively supports customizations of layout and appearance and the
inclusion of icons, badges, media, and actions. Use cards to embed and share media
sourced from a BLOB column, URL or video in iFrame.

Example Cards Page
View an example cards page.

Creating a Cards Page Using the Create Application Wizard
Run the Create Application Wizard to create a new application that contains a cards
page.

Creating a Cards Page Using the Create Page Wizard
Run the Create Page Wizard to add a new cards page to an existing application.
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» Editing Cards Region Attributes
Edit region attributes to alter the SQL source, change the region layout and
appearance, or create region conditions.

» Editing Card Attributes
Edit card specific attributes by clicking the Attributes tab in the Property Editor.

* Using Actions to Link from a Cards Page
Create actions to link from a cards page.

8.5.1 Example Cards Page

ORACLE

View an example cards page.

Both the Create Application Wizard and Create Page Wizard support the creation of
cards pages. First, you select a table or view or provide a SQL query on which to build
the page. Then, you specify the general page layout, for example, Grid, Float, or
Horizontal (Row). Finally, you specify the Title Column, Body Column, and optionally
Icon Initials Column.

The following is an example of a cards page built on the EBA PROJECTS table.

= Demonstration - Projects O insallpp O @~ L admin v
-

Projects
0 Configure Web Environment 0 Train Developers
Determine the hardware and software required to Ensure all developers who will be developing with
develop with Web development tool. the new tool get the appropriate training.
@ Migrate Legacy Applications Q Develop Partner Portal POC
Move the data and redevelop the applications cur- Develop a proof of concept that partners can use to
rently running on top of legacy servers work more collaboratively with us.

In this card example, each card displays the following attributes:
* Title - Maps to the NAME column.
» lIcon - Maps to the PROJECT LEAD column.

* Body - Maps to the DESCRIPTION column.
Key features of cards pages include:

» Customize every aspect of a cards region's Ul (including layout, appearance, icon,
badge, and media).

» Declaratively create links from a cards page by adding actions. Action types
include Button, Full Card, Title, Subtitle, or Media.

*  Supports advanced HTML expressions including template directives for client-side
conditional formatting.
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Tip:

To view an example, install the sample app, Sample Cards. To learn more, see
Installing Apps from the Gallery.

8.5.2 Creating a Cards Page Using the Create Application Wizard

Run the Create Application Wizard to create a new application that contains a cards page.

ORACLE

A cards page consists of individual boxes, which resemble index cards, laid out on a page.
Each card displays three pieces of information.

To create an application that contains a cards page:

1.

2
3.
4

© N o o

On the Workspace home page, click the App Builder icon.

Click the Create button.

Click New Application.

Set Icon - Click Set Icon to select an application icon. The icon you select is used as the
Favicon, the PWA icon, the Apple touch icon, and the App Builder icon.

Name - Enter the name used to identify the application to developers.

Appearance - Accept the default or click Set Appearance to change it.
Click Add Page and select Cards.
On Add Cards Page:

a.
b.

C.

Page Name - Enter a name for this page.

Set Icon - Select an icon to display in the navigation menu for this page.
Table or View - Select a table or view on which to build the page.

Select a layout. Options include: Grid, Float, or Horizontal (Row)
Select the information to display on each card. Options include:

* Title Column

e Body Column

* Icon Initials Column

e Badge Column

The Title Column and Body Column are pre-selected from the Data Dictionary
Cache. Developers can change these defaults.

Advanced - Expand Advanced to configure these options:

e Set as Home Page - Enable this to make this page the home page for the
application.

e Set as Administration Page - Enable this to have this page display under
Administration.

e Page Help - Enter text to be displayed when the user selects Page Help.
Click Add Page.
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Features - Select features to include with the application. Features provide
application-level functionality and can only be added once per application. To learn
more, click the Help icon adjacent to Features.

Settings - Specify settings used to generate this application. To learn more about
an attribute, click the Help icon adjacent to Settings.

Click Create Application.

¢ See Also:

Accessing the Data Dictionary Cache Report from Workspace Administration
or Accessing the Data Dictionary Cache Report from Administration Services
in Oracle APEX Administration Guide

8.5.3 Creating a Cards Page Using the Create Page Wizard

Run the Create Page Wizard to add a new cards page to an existing application.

ORACLE

To create a cards page by running the Create Page Wizard:

1.
2.
3.

On the Workspace home page, click the App Builder icon.
Select the application.
Click Create Page.

Create a Page appears and features three tabs: Component, Feature, and
Legacy Pages.

Under Component, select Cards.
Under Page Definition:

a. Page Number - The page number is an integer value that identifies a page
within an application.

b. Name - Specify a text name for this page.

Tip:
This text is also used for page Title. After page creation, you can
modify the Title in Page Designer.
c. Page Mode - Identify the page mode. To learn more, see field-level Help.
Data Source - Select a Data Source for the page:
* Local Database - Data is sourced from the local database.

* REST Enabled SQL Service - Data is sourced from a remote database,
where the connection is defined using REST Enabled SQL. To create or
maintain REST Enabled SQL references, navigate to Shared Components,
REST Enabled SQL.

* REST Data Source - Data is sourced from a RESTful web service defined
using REST Data Sources. To create or maintain REST Data Sources,
navigate to Shared Components, REST Data Sources.
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The steps that follow differ depending upon the selected Data Source. This task assumes
the Data Source is Local Database.

7. Source Type - Specify the source of the new page. Options include:

* Table:
— Table /View Owner - Select the owner of the table on which you are building the
page.
— Table/View Name - Select the table or view on which the page will be based.
*  SQL Query:

— Enter a SQL SELECT statement - Enter the SQL query. To see an example,
expand the SQL Query Example region.

8. Navigation - Expand the region and enable or disable navigation. If either flag is enabled,
additional attributes appear. To learn more about an attribute, see field-level Help.

a. Use Breadcrumb - Enable to create a breadcrumb entry for this page. By default, the
page name is used as breadcrumb entry name.

b. Use Navigation - Enable to create a navigation menu entry for this page.By default,
the page name is used as navigation menu name.

9. Click Next.
10. Cards Layout - Select a layout. Options include: Grid, Float, or Horizontal (Row)
11. Card Attributes - Select the information to display on each card. Options include:
a. Title Column
b. Body Column
c. Icon Initials Column
d. Badge Column
12. Click Create Page.

Tip:

To learn more about external data sources, see Managing REST Enabled SQL
References and Managing REST Data Sources.

¢ See Also:

e Accessing the Data Dictionary Cache Report from Workspace Administration

e Accessing the Data Dictionary Cache Report from Administration Services in
Oracle APEX Administration Guide

e Understanding Page Types in the Create Page Wizard
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8.5.4 Editing Cards Region Attributes

Edit region attributes to alter the SQL source, change the region layout and
appearance, or create region conditions.

To edit a region attributes:
1. View the cards page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select a page.
Page Designer appears.

2. In the Rendering tab under Content Body, locate and select the cards region (for
example, Projects).

In the Property Editor, the Region tab displays the attributes. Attributes are
organized in groups.

(i‘) Application 543 ' Page Designer h 2 Go e e Pu A o m
= r a5 Layout age Se Helf Region  Aftribute
Page 2: Projects = v G:-'k o = Filter [
~ BODY Identification
B IType Cards v §— I
- I Source
1 * Location Local Database W
Actions o . Type Table / View v
Post-Rendering Table Owner Parsing Schema v
T TiwE = Table Mame EBA_PROJECTS -
Include ROWID (:.
Column
Where Clause 2]

In the previous example, note that the Type attribute indicates that Projects is a
Cards region.

3. Edit the appropriate attributes.

Q Tip:

To view help for an attribute, select the attribute in the Property Editor
and click the Help tab in the central pane.
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4. To find a group or attribute:

5.

» Search for the group or attribute - Enter keywords in the Filter Properties field. The
Property Editor displays the group or attributes. To return to the default display, delete
the keywords.

* Use Go to Group - Click Go to Group and select the group. To return the default
display, click Go to Group again and select Expand All.

Click Save or Save and Run Page.

8.5.5 Editing Card Attributes

Edit card specific attributes by clicking the Attributes tab in the Property Editor.

ORACLE

Customize a cards page by editing the following attribute groups: Appearance, Title,
Subtitle, Body, Secondary Body, Icon and Badage, or Media.

To edit a cards Attributes:

1.

View the cards page in Page Designer:

a. On the Workspace home page, click the App Builder icon.
b. Select an application.

c. Select a page.

Page Designer appears.

In the Rendering tab, select the Cards region.

In the Property Editor, select the Attributes tab.

The Property Editor displays the attributes. Attributes are organized in groups. To find a
group or attribute, enter keywords in the Filter Properties field. The Property Editor
displays the group or attributes. Or, you can click Go to Group and select the group.

Select the cards region:

a. Inthe Rendering tab under Content Body, locate and select the cards region (for
example, Projects).

b. Inthe Property Editor, select the Attributes tab.

In the Property Editor, the Atributes tab displays the card page attributes. Attributes
are organized in groups.
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A T
] Save

Region Attributes

Appearance
Layout
Grid Columns

(S5 Classes

Card

(S5 Classes
Primary Key
Column 1

Title

Advanced
Formatting

Caolumn

(S5 Classes

Grid e

Auto v

- Salect - e

MANE V

Title, Subtitle, Body, Secondary Body, and Media include an Advanced
Formatting option which enables support for HTML expressions and supported
substitution strings. All free form text attributes, such as CSS Classes, Icon or
Image Description, or Badge Label, support column substitutions through standard
substitution string syntax (for example, sENAME. Or §DNAME..

Q Tip:

To find a group or attribute:

To view help for an attribute, select the attribute in the Property Editor
and click the Help tab in the central pane.

» Search for the group or attribute - Enter keywords in the Filter Properties
field. The Property Editor displays the group or attributes. To return to the

default display, delete the keywords.

e Use Go to Group - Click Go to Group and select the group. To return the
default display, click Go to Group again and select Expand All.

Click Save or Save and Run Page.

" See Also:

ORACLE

Using Substitution Strings
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8.5.6 Using Actions to Link from a Cards Page

(1) application 543

1

Page Z: Projects

ORACLE

Create actions to link from a cards page.

A cards page functions as a colorful way to display a subset of information and then enable
the user to link to more detail. To create a link from a cards page, you create an action and

then select an action type. You can create an action to link from a full card, a title, a subtitle,
media, or a button.

To create an action:

1. View the Cards page in Page Designer:
a. On the Workspace home page, click the App Builder icon.
b. Select an application.
c. Select the Cards page.
Page Designer appears.
2. Add an action:
a. Inthe Rendering tab under Content Body, locate the cards region.
b. Under the cards region, right-click Actions and select Create Action.

Page Designer

Projects

tems Buttons

8-27



Chapter 8
Managing Cards

A new Action appears and the Action tab displays in Property Editor.

(: I:) Application 543 . Page Designer h 2 o e ia) <) F P oy Save n

= C. At Layout Page Search Help Action
Page 2: Projects = w e = Filter I,
FETIE FULL WIDTH CONTENT o
Identification
Sreadcrumb Bar o Type Button w
Breadcrumb Projects L= pew =
Body REGICN BOD Layout
LEDIEcts i e ~CHTENT M Position Primary v
b Sequence 10
Link
ost-Rendening
- Type Redirect to Page in this App i=
ions Itermns = w
! © Terget Mo Link Defined
Buttons
Appearance
Display Type Text v
Hot I:.

Edit the action in the Property Editor (right pane).
3. ldentification, Type - Select the type of action to add to the card:
*  Button - Adds button to the card.
* Full Card - Adds link to the full card.
* Title - Adds link to the card title.
« Subtitle - Adds link to the card subtitle.
¢ Media - Adds link to the card media.

You can define multiple actions of the same type. However, only button actions are
rendered multiple times. For all other action types, the first TRUE display condition
gets rendered, and the rest are ignored. If defining multiple action, add a display
condition based on the column value and set it to check for each row.

4. ldentification, Label - (Button only) Enter the text to display on the button. If button
display type is icon, this text becomes the ALT text for the icon image.

5. Define the Link:

a. Link, Type - Select the action to be performed when the specified action type
is clicked. Options include:

* Redirect to Page in this Application - Redirect to a page in the current
application, with optional additional attributes for resetting pagination,
setting the request value, clearing cache and setting item values, on the
target page.

* Redirect to Page in a different Application - Redirect to a page in a
different application, with optional additional attributes for resetting
pagination, setting the request value, clearing cache and setting item
values, on the target page.
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Tip:

Redirecting to a page in different application relies on deep linking
being enabled in the target application. To enable deep linking, go to
the application's Security attributes and enable Deep Linking. See
Configuring Security Attributes.

Redirect to URL - Redirect to the target URL you specify.

b. Link, Target - Click No Link Defined.

The Link Builder Target dialog appears. The attributes that display differs depending
upon the Link Type. When redirecting to a page, the following attributes appear:

Target, Page - Enter a page number or page alias, or select the page number
from the select list.

Set Iltems, Name - Enter or select page items (for example, P3_ID), application
items (for example, LAST PAGE) or interactive report filters (for example,
IR _EMPNO) to be set into session state.

Set Items, Value - Enter or select a report column (for example, «ID.), enter an
application or page item (for example, P2 EMPNO.), or enter a static value (for
example, 2).

Clears/Reset, Clear Cache - Enter a comma-delimited list of page numbers (for
example, 2, 3), items (for example, P3_EMPNO, LAST PAGE), and report settings to
be cleared. To reset pagination for a report enter Rp. To clear or reset interactive
report settings enter CR or RR.

Action - Select None, Clear Regions, Reset Regions, or Reset Pagination.

Reset Pagination resets the pagination back to the first set of records, for
reports on the target page. This has the same affect as passing RP in Clear
Cache.

Advanced: Request - Enter the request to be used.

Click OK to save your changes and exit the dialog.

6. Server Side Condition, Type - Select a condition type that must be met in order for this
component to be rendered or processed.

If you refer to Columns in your condition, you must specify For Each Row in order for the
condition to be evaluated for each card. Otherwise, set to Once to evaluate the
validations one time for the region.

7. Click Save or Save and Run Page.

The Cards page loads.

8. Click a project to view the Maintain Project form.

8.6 Managing Smart Filters

A smart filters page features a single search field at the top of the page and a search results
report (classic report, cards, map, or calendar). While a smart filter behaves similarly to
faceted search, it features a more space efficient layout.

ORACLE
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You can create a smatrt filters page with either the Create Application Wizard or Create
Page Wizard, or add a smatrt filters region to an existing report in Page Designer.

Example Smart Filters
View an example smart filters page.

About Creating Smart Filters Pages
Create a smatrt filters page by running either the Create Application Wizard or
Create Page Wizard.

Creating Smart Filters Using the Create Application Wizard
Run the Create Application Wizard to create a new application that contains a
smart filters page.

Creating Smart Filters Using the Create Page Wizard
Run the Create Page Wizard to add a new smart filters search page to an existing
application.

Creating a Smart Filters Page Manually
Create a smatrt filters page by manually adding the page and smart filter
components.

Editing a Smart Filters Page
Learn about how attributes can change the behavior of a smart filters page.

8.6.1 Example Smart Filters

View an example smart filters page.

Employees

While a smart filters page behaves similarly to faceted search, it features a more
space efficient layout. Smart filter pages include a single search field at the top of the
page with filters that display as suggestion chips with counts that show how often a
specific value occurs.

The following example shows a smart filters page built on the EMP table. Note the filter
suggestion chips that display beneath the Search field.

= Smart Filters - Manual 9, admin v

Q. Search

Department SALES (6)

Mznager BLAKE (5)  Job CLERK (4)  Salary 2,000 - 2,500 (5)

Employee Name
CLARK

JONES

BLAKE

ALLEN

WARD

MARTIN

TURNER

ORACLE

Job Manager Hired Salary Commission Department
MAMNAGER KING 6/9/1981 2450 ACCOUNTING
MAMNAGER KING 4/2/1981 2975 RESEARCH
MAMNAGER KING 5/1/1981 2,850 SALES
SALESMAN BLAKE 2/20/1981 1,600 300 SALES
SALESMAN BLAKE 2/22/1981 1,250 500 SALES
SALESMAN BLAKE 9/28/1981 1,250 1400 SALES
SALESMAN BLAKE 9/8/1981 1,500 0 SALES
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Clicking a the filter name displays a list of values. In this example the department, Sales, is
selected and displays three values: SALES, RESEARCH, and ACCOUNTING.

= Smart Filters - Manual 8, admin v

Q Department SALES = X
SALES (6)

Emg Manager
RESEARCH 3

BLAJ KING
ACCOUNTING 3

ALLE BLAKE

WARD SALESMAN BLAKE

MARTIN SALESMAN BLAKE

Hired

5/1/1981

2/20/1931

2/22/1981

9/28/1981

Salary
2,850
1,600
1,250

1,250

Commission

300

500

1400

Department
SALES
SALES
SALES

SALES

If you click any place to right of the name, the suggestion chip becomes an applied filter chip
and moves to the Applied Filters Area. Clicking the applied filter chip again displays the list. In
this example, the Manager applied filter chip displays six managers.

= Smart Filters - Manual

Q. admin ¥

Employees

Q Manager BLAKE X

BLAKE (5)

Em| Manager Hired Salary Commission Department
KING 3

ALLE BLAKE 2/20/1981 1,600 300 SALES
JOMES (2)

WA BLAKE 2/22/1981 1,250 500 SALES
CLARK (1)

MAF BLAKE 9/28/1981 1.250 1400  SALES
FORD 1)

TUR BLAKE 9/8/1981 1,500 0 SALES
SCOTT (1)

JAM BLAKE 12/3/1981 930 SALES

To see other filters, click the Search field again. The other filters display.
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= Smart Filters - Manual 8 admin v

Employees

IQ Manager BLAKE = X |

%) Department
D Job

& Salary
MARTIN

TURNER

JAMES

SALESMAN BLAKE 9/28/1981 1,250 1400 SALES
SALESMAN BLAKE 9/8/1981 1,500 0 SALES
CLERK BLAKE 12/3/1981 950 SALES

To remove a filter, the click the X after the filter name.

Q Tip:

To view an example, install the sample app, Sample Reporting. To learn
more, see Installing Apps from the Gallery.

8.6.2 About Creating Smart Filters Pages

ORACLE

Create a smart filters page by running either the Create Application Wizard or Create
Page Wizard.

Both the Create Application Wizard and Create Page Wizard support the creation of a
smart filters page which contains a single search field at the top of the page with filters
that display suggestion chips. Alternatively, you can add a smart filters region to an
existing report in Page Designer. Each suggestion chip displays a single count for the
specific suggestion values. The suggestion chip count only displays for filters that
support counts, such as LOV-based filter types. Users can search, or click a
suggestion chip to quickly filter the report. You choose if the report is a classic report or
a cards report. If you create a smart filters page using the Create Application Wizard,
you can also choose to include an update form.

Smart Filters, Breadcrumbs, and the Create Page Wizard

When adding a new smart filters page using the Create Page Wizard, breadcrumbs
function a little differently. If breadcrumbs are disabled, the Smart Filters region is
added to the Body container. However, if breadcrumbs are enabled, the Smart Filters
region is added to the Breadcrumb container and a Breadcrumb displays at the top the

page.
About Auto-Discovered Filters

When you build a smart filters page with either wizard, you can select a table or view
on which to build the page. If you create the page based on a table, the filters are auto
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discovered using the Data Dictionary Cache. In contrast, if you build the page on a view or a
SQL query, the facets (filters) are not auto-discovered. Instead, the wizard creates a filter
region which only searches VARCHAR2 columns.

About the Data Dictionary Cache

The Data Dictionary Cache report displays statistics and a data analysis of schema tables
and caches in a workspace. Both the Create Application Wizard and Create Page Wizard use
the Data Dictionary Cache when creating new applications and pages. You can preview how
the wizards will render facets (filters) on the Data Dictionary Cache page by viewing the Table
Column Cache report. The wizard uses the first top five facet (filter) search score columns
with score greater than or equal to 20.

If a table changes due to DDL or DML modifications, the Oracle APEX nightly job

ORACLE APEX DICTIONARY CACHE refreshes the Data Dictionary Cache. However, you can
refresh the cache manually by navigating to the Data Dictionary Cache and clicking either
Gather Statistics and Refresh Cache or Refresh Cache Only at the workspace or table-
level.

# See Also:

Accessing the Data Dictionary Cache Report from Workspace Administration or
Accessing the Data Dictionary Cache Report from Administration Services in Oracle
APEX Administration Guide

8.6.3 Creating Smart Filters Using the Create Application Wizard

ORACLE

Run the Create Application Wizard to create a new application that contains a smatrt filters
page.

A smart filters page can include a classic report or a cards report. If you select classic report,
you can also choose to include an update form.

Tip:

If you are creating a smatrt filters page that displays as a report, clicking Include
Form automatically creates a form page for creating or updating records. This
option is not available in the Create Page Wizard.

To create an application that includes a smart filters search page:
1. On the Workspace home page, click the App Builder icon.

2. Click the Create button.

3. Click New Application.
4

Set Icon - Click Set Icon to select an application icon. The icon you select is used as the
Favicon, the PWA icon, the Apple touch icon, and the App Builder icon.

5. Name - Enter the name used to identify the application to developers.
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Appearance - Accept the default Theme Style and menu layout (Vita, Side Menu),
or change it by clicking the Set Appearance icon adjacent to the Appearance
field.

Click Add Page and select Smart Filters.

In the Add Smart Filters Page dialog:

a. Page Name - Enter a name for this page.

b. Setlcon - Select an icon to display in the navigation menu for this page.
c. Select areport type: Report or Cards.

d. Table - Select a table.

e. What appears next depends upon whether you selected Report or Cards.

* If Report - Select Include Form to include a form page for creating or
updating records.

» If Cards - Select the display: Grid, Float, and Horizontal (Row).

Select the information to display on each card: Title Column, Body
Column, Icon Initials Column, and Badge Column.

f. Advanced - Expand Advanced to configure these options:

* Set as Home Page - Enable this to make this page the home page for the
application.

» Page Help - Enter text to be displayed when the user selects Page Help.
g. Click Add Page.

Features - Select features to include with the application. Features provide
application-level functionality and can only be added once per application. To learn
more, click the Help icon adjacent to Features.

Settings - Specify settings used to generate this application. To learn more about
an attribute, click the Help icon adjacent to Settings.

Click Create Application.

8.6.4 Creating Smart Filters Using the Create Page Wizard

Run the Create Page Wizard to add a new smart filters search page to an existing
application.

ORACLE

If you are using the latest Universal Theme, breadcrumbs function a little differently

when adding a new smart filters page using the Create Page Wizard. If breadcrumbs

are disabled, the Smart Filters region is added to the Body container. However, if
breadcrumbs are enabled, the Smart Filters region is added to the Breadcrumb
container and a Breadcrumb displays at the top the page.

Tip:

To learn more about breadcrumbs, see Editing Breadcrumbs

To create a smart filters page by running the Create Page Wizard:

1.

On the Workspace home page, click the App Builder icon.
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Select the application.
Click Create Page.

Create a Page appears and features three tabs: Component, Feature, and Legacy
Pages.

Under Component, select Smart Filters.
Under Page Definition:

a. Page Number - The page number is an integer value that identifies a page within an
application.

b. Name - Specify a text name for this page.

Tip:
This text is also used for page Title. After page creation, you can modify
the Title in Page Designer.

Data Source - Select a Data Source for the page:

* Local Database - Data is sourced from the local database.

e REST Enabled SQL Service - Data is sourced from a remote database, where the
connection is defined using REST Enabled SQL. To create or maintain REST
Enabled SQL references, navigate to Shared Components, REST Enabled SQL.

e REST Data Source - Data is sourced from a RESTful web service defined using
REST Data Sources. To create or maintain REST Data Sources, navigate to Shared
Components, REST Data Sources.

The steps that follow differ depending upon the selected Data Sour